
Appendix 3: Air Resource Specialists Standard Operating Procedures 



Clean Air Status and Trends Network 
 
 

Quality Assurance Project Plan 
 
 

Revision 8.3 
 
 
 
 
 
 
 

Appendix 3: 
 

 
 
 
 
 

Air Resource Specialists Standard Operating Procedures 
 
 
 
 
 
 
 
 
 
 
 
 

October 2015 



 

Page 1 of 5 Updated 10/25/12 

NPS GASEOUS POLLUTANT MONITORING PROGRAM 
List of Standard Operating Procedures and Technical Instructions to be Referenced 

from the CASTNET QAPP 
 
 
I. NPS AIR MONITORING NETWORK FIELD OPERATOR PROCEDURES 
  
3176 Station Operator Maintenance Procedures for Meteorological
 Monitoring Sites Using the DataView System 
 (Version 0.2 January 2005) 

3176_003.pdf

  
 3176-3100 Checklist Instruction - Weekly Station Visit
   Wind Speed / Wind Direction Sensor (Climatronics) 
   (Version 3 January 2011) 

31763100_003.pdf

  
 3176-3101 Checklist Instruction - Weekly Station Visit
   Wind Speed / Wind Direction Sensor (R.M. Young) 
   (Version 3 January 2011) 

31763101_003.pdf

  
 3176-3103 Checklist Instruction – Weekly Station Visit
   Wind Speed / Wind Direction Sensor 
   (Climatronics – No Translator) (Version 0 April 2006) 

31763103_000.pdf

  
 3176-3110 Checklist Instruction - Weekly Station Visit
   Temperature/ Delta Temperature Sensor (Climatronics) 
   (Version 3 January 2011) 

31763110_003.pdf

  
 3176-3111 Checklist Instruction - Weekly Station Visit
   Temperature/Delta Temperature Sensor 
   (R.M. Young) (Version 2 January 2006) 

31763111_002.pdf

  
 3176-3115 Checklist Instruction - Weekly Station Visit
   Air Temperature and Relative Humidity Sensor (Rotronics) 
   (Version 1 January 2006)

31763115_001.pdf

  
 3176-3116 Checklist Instruction – Weekly Station Visit
   Air Temperature and Relative Humidity Sensor (Vaisala) 
   (Version 1 January 2006)

31763116_001.pdf

  
 3176-3120 Checklist Instruction - Weekly Station Visit
   Relative Humidity Sensor (Rotronics) 
   (Version 2 January 2011)

31763120_002.pdf

  
 3176-3121 Checklist Instruction – Weekly Station Visit

   Relative Humidity Sensor (Vaisala) 
   (Version 2 January 2011)

31763121_002.pdf

  
 3176-3130 Checklist Instruction - Weekly Station Visit
   Solar Radiation Sensor (Climatronics) 
   (Version 2 January 2011)

31763130_002.pdf

  
 3176-3131 Checklist Instruction - Weekly Station Visit
   Solar Radiation Sensor (R.M. Young) 
   (Version 2 January 2011)

31763131_002.pdf
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 3176-3132 Checklist Instruction – Weekly Station Visit
   Solar Radiation Sensor (Licor) 
   (Version 2 January 2011)

31763132_002.pdf

  
 3176-3150 Checklist Instruction - Weekly Station Visit 
   Precipitation Sensor (Climatronics) 
   (Version 3 January 2011) 

31763150_003.pdf 

  
 3176-3151 Checklist Instruction - Weekly Station Visit 
   Precipitation Sensor (Texas Electronics) 
   (Version 2 January 2011) 

31763151_002.pdf

  
 3176-3153 Checklist Instruction - Weekly Station Visit 
   Precipitation Sensor (RM Young) 
   (Version 1 March 2011) 

31763153_001.pdf

  
 3176-3155 Checklist Instruction – Monthly Check

   Precipitation Sensor (Various) 
   (Version 2 August 2009)

31763155_002.pdf

  

3178 Station Operator Maintenance Procedures for Gaseous Monitoring
 Sites Using the DataView System (Version 0.4 July 2012)

3178_004.pdf

  
 3178-3112 Checklist Instruction - Weekly Station Visit 
   Ozone Analyzer ( TEI 49i), Ozone Calibrator (TEI 49i) 
   CASTNet Dry Deposition 
   (Version 0 July 2012) 

31783112_000.pdf

  
 3178-3116 Checklist Instruction - Weekly Station Visit

   Ozone Analyzer (TEI 49C) Ozone Calibrator (TEI 49C) 
   CASTNet Dry Deposition (Version 4 January 2006)

31783116_004.pdf

  
 3178-3315 Checklist Instruction - Multipoint Calibration

   Ozone Analyzer (TEI 49C) Ozone Calibrator (TEI 49C) 
   (Version 2 July 2012)

31783315_002.pdf

  
 3178-3316 Checklist Instruction - Multipoint Calibration 
   Ozone Analyzer (TEI 49i), Ozone Calibrator (TEI 49i) 
   (Version 0 July 2012) 

31783316_000.pdf

  
3180 Calibration of Mass Flowmeters and Mass Flow Controllers 
 (Version 2.0 November 2004) 

3180_002.pdf

  
 3180-2100 Calibration and Routine Maintenance of CASTNET 
   Filter Pack Flow Systems 
   (Version 0.0 August 2012) 

31802100_000.pdf

 
II. INFORMATION MANAGEMENT CENTER (IMC) PROCEDURES 
  
3340 Information Management Center (IMC) Concept and Configuration for 
 the National Park Service Gaseous Pollutant Monitoring Program 
 (Version 4.2 February 2010) 

3340_009.pdf

  
3345 Day-to-Day Network Operations Technical Support for the National 
 Park Service Gaseous and Meteorological Monitoring Program 
 (Version 1.1 February 2010) 

3345_007.pdf
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3350 Collection of Ambient Air Quality and Meteorological Monitoring Data 
 (Version 1.5 February 2010) 

3350_006.pdf

  
 3350-4000 Collection of Ambient Air Quality and Meteorological
   Monitoring Data Via Modem 
   (Version 2.2 February 2010) 

33504000_006.pdf

  
 3350-4005 Collection of DataView Files via Telephone Modem
   (Version 0.2 February 2010)

33504005_002.pdf

  
3450 Ambient Air Quality and Meteorological Monitoring Data Validation 
 (Version 2.2 February 2010) 

3450_009.pdf

  
 3450-5000 Ambient Air Quality and Meteorological Monitoring Data –
   Level 0 Validation (Version 1.6 February 2010

34505000_007.pdf

  
 3450-5010 Ambient Air Quality and Meteorological Monitoring Data –
   Preliminary Validation (Version 1.7 February 2010)

34505010_008.pdf

  
 3450-5020 Ambient Air Quality and Meteorological Monitoring Data –
   Final Validation (Version 2.1 February 2010)

34505020_007.pdf

  
3550 Ambient Air Quality and Meteorological Monitoring Data Reporting 
 (Version 5.1 February 2010) 

3550_007.pdf

  
  3550-5000 Ambient Air Quality and Meteorological Monitoring Data –
   Weekly and Monthly Reporting 

   (Version 4.1 February 2010)

35505000_007.pdf

  
 3550-5100 Ambient Air Quality and Meteorological Monitoring Data –
   Annual Reporting (Version 4.0 January 2009)

35505100_006.pdf

  
 3550-5200 Handling Requests for Ambient Air Quality and
   Meteorological Monitoring Data 

   (Version 2.5 February 2010)

35505200_007.pdf

  
 3550-5300 Submitting Ambient Air Quality and Meteorological
   Monitoring Data to the EPA AQS Database 

   (Version 2.2 January 2009)

35505300_004.pdf

  
3650 IMC Manager’s Maintenance Responsibilities for the Ambient Air  
 Quality Data Base Management System (AQDBMS) 
 (Version 2.2 February 2010) 

3650_004.pdf

  
Air Quality Data Base Management System (AQDBMS)
 User’s Guide (January 2008) 

AQDBMS_User’s Guide 2008.pdf

  
Air Quality Data Base Management System
 (AQDBMS) Database Manager/Programmer’s 
 Guide (January 2001) 

AQDBMS_Programmer’s Guide 2001.pdf

  
STKWIN User Documentation (January 2008) Stackplot User’s Guide 2008.pdf
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III. FIELD MAINTENANCE AND CALIBRATION PROCEDURES
  
3000 Procedures for Semiannual Maintenance Visits to a National Park
 Service Ambient Air Monitoring Station (Version 1.4 January 2008)

3000_008.pdf

  
3050 Siting of Ambient Air Quality Monitoring Stations
 (Version 0.2 November 2009) 

3050_002.pdf

  
3100 Calibration of Ambient Air Quality Analyzers
 (Version 2.3 November 2009) 

3100_005.pdf

  
 3100-2004 Calibration and Routine Maintenance of Thermo
   Environmental Instruments Model 49C or 49i Ozone 
   Analyzers (Version 0.2 March 2007)

31002004_002.pdf

  
3150 Calibration and Routine Maintenance of Meteorological Monitoring
 Systems (Version 3.6 November 2009) 

3150_009.pdf

  
 3150-2100 Calibration and Routine Maintenance of Climatronics
   F460 or Qualimetrics 12XX Wind Speed and Direction 
   Sensor Systems (Version 1.4 November 2005)

31502100_005.pdf

  
 3150-2102 Calibration and Routine Maintenance of Climatronics
   F460 Wind Speed and Wind Direction Sensors Used 
   With a Campbell Scientific 21XL Datalogger 
   (Version 0.5 May 2005)

31502102_005.pdf

  
 3150-2103 Calibration and Routine Maintenance of R.M. Young
   Model 05305 Wind Monitor-AQ Wind Speed and Direction 

   Sensor Systems (Version 0.4 November 2005)

31502103_004.pdf

  
 3150-2105 Calibration and Routine Maintenance of Climatronics or  
   Qualimetrics Temperature/Delta Temperature Systems  
   (Version 1.3 September 2005)

31502105_004.pdf

  
 3150-2113 Calibration and Routine Maintenance of R.M. Young
   Temperature/Delta Temperature Systems 

   (Version 0.3 June 2002)

31502113_003.pdf

  
  3150-2114 Laboratory Calibration and Repair of Rotronics MP-101A 
   AT/RH Sensors, Rotronics MP-601A Relative Humidity  
   Sensors, or Vaisala 45AC AT/RH Sensors 

   (Version 3.0 September 2004)

31502114_004.pdf

  
 3150-2115 Field Calibration and Routine Maintenance of Rotronics 
   MP-101A AT/RH Sensors or Rotronics MP-601A Relative 
   Humidity Sensors (Version 1.3 November 2005)

31502115_005.pdf

  
 3150-2116 Field Calibration and Routine Maintenance of Vaisala 
   HMP 45AC AT/RH Sensors 
   (Version 0.2 November 2005)

31502116_002.pdf

  
 3150-2120 Field Calibration and Routine Maintenance of R.M. Young 
   Solar Radiation System (Version 0 June 2002)

31502120_000.pdf

  
 3150-2123 Field Calibration and Routine Maintenance of LI-COR 
   Model LI-200 Pyranometers (Version 0 September 2005) 

31502123_000.pdf
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 3150-2130 Field Calibration and Routine Maintenance of a Tipping 
   Bucket Rain Gauge (Version 1.0 April 2006)

31502130_001.pdf

  
 3150-2150 Field Calibration and Routine Maintenance of R.M. Young 

   Model 58101 Wetness Sensors (Version 0 September 2005) 
31502150_000.pdf

  
3160 Calibration of Data Acquisition Systems
 (Version 1.1 November 2005) 

3160_002.pdf

  
 3160-2100 Calibration ofESC 8816 or 8832 Analog Input Card
   (Version 0 April 2006)

31602100_000.pdf

  
3300 Certification of Ozone Transfer Standards
 (Version 2.1 November 2005) 

3300_003.pdf
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1.0 PURPOSE AND APPLICABILITY 
 

This standard operating procedure (SOP) outlines the steps for performing semiannual 
maintenance visits to National Park Service (NPS) owned and/or operated ambient air 
monitoring stations. The primary purpose of a semiannual maintenance visit is to assure quality 
data capture and minimize data loss by: 

 
• Calibrating and certifying ambient air quality analyzers, samplers, and meteorology 

sensors to meet U.S. Environmental Protection Agency (EPA) quality assurance 
requirements. 

 
• Performing preventive maintenance on analyzers, samplers, sensors, and support 

equipment. 
 
• Providing operator training. 

 
 This SOP serves as a guideline to facilitate: 
 

• Trip preparation and notification of appropriate personnel. 
 
• Shelter and tower integrity checks. 
 
• Support systems integrity checks. 
 
• Calibration and maintenance of air quality analyzers. 
 
• Calibration and maintenance of dry deposition sampling systems. 
 
• Calibration and maintenance of meteorology sensors. 
 
• Calibration and maintenance of data acquisition equipment. 
 
• Station modification and enhancements. 
 
• Station operator training. 
 
• Site inventory verification and update. 
 
• Trip reporting and documentation. 

 
 Due to the variation of site configurations within the NPS network, portions of this SOP 
may not apply to every station. Some stations that are unique may require preventive 
maintenance or other activities not covered within this document. Maintenance personnel are 
requested to document additional procedures as necessary. 
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2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 

The project manager shall: 
 
• Coordinate with the NPS Contracting Officer’s Technical Representative (COTR) to 

identify stations to be visited by Air Resource Specialists, Inc. (ARS) personnel, 
schedule these visits, and see that the park superintendent, NPS Regional Air Quality 
Coordinator, NPS Regional Air Quality Field Specialists, and park station operators 
are adequately notified at least two weeks prior to the semiannual visit. 

 
• Review with the ARS field specialist the requirements of the visit depending upon the 

station configuration, known technical problems, and review of recently collected 
data. 

 
• Review written trip reports and calibration documents for accuracy and completeness 

following the site visit. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Review with the project manager the requirements of the visit depending upon the 
station configuration, known technical problems, and review of recently collected 
data. 

 
• Complete the Pre-Trip Preparation Checklist in preparation for the semiannual visit. 
 
• Contact the station operator and verify that he/she will be available for the 

semiannual visit and that special transportation or other arrangements can be made. 
 
• Ensure that all calibration standards to be used have been verified and/or calibrated 

within the appropriate time limits. 
 
• Perform all integrity checks, preventive maintenance, and calibrations in accordance 

with this SOP. 
 
• Make shipping arrangements for any equipment needed at the site. 
 
• Observe and train the station operator. 
 
• Verify and update site inventories and photographic documentation. 
 
• Complete Equipment Maintenance/Repair Records. 
 
• Update site specifications when appropriate. 

 
• Perform any required station or system modifications or enhancements. 
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• Complete semiannual station checklists. 
 
• Prepare complete, accurate, written trip reports and calibration documents. 
 
• Follow-up on repairs or calibrations to be completed during the station visit. 
 
• Identify and document any additional action required. 

 
2.3 ADMINISTRATIVE ASSISTANT 
 
 The administrative assistant shall: 
 

• Prepare and forward notification letter(s) to the park superintendent, Regional Air 
Quality Coordinator, Regional Air Quality Field Specialist, and station operator. 

 
• Prepare a trip packet for the field specialist (containing a list of equipment currently 

at the station to be visited), appropriate maintenance/repair records, and site visit 
checklists. 

 
• Compile, reproduce, and forward the field specialist’s trip reports and documentation. 
 
• Update the electronic status board to document significant repairs or instrument 

changes made during the station visit. 
 
• Update the equipment inventory database to reflect any changes in monitoring station 

inventory. 
 
• Update the equipment inventory database to reflect maintenance/repairs recorded on 

Equipment Maintenance/Repair Records. 
 
• Prepare questions or request specific training to be addressed by the field specialist 

during the semiannual visit. 
 
2.4 STATION OPERATOR 
 
 The station operator shall: 
 

• Be available for the semiannual visit to assist the field specialist and receive training 
on new equipment or procedures. 

 
• Make any special transportation or other arrangements as necessary for the visit. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Equipment generally required to support a semiannual visit is listed in the Semiannual 
Site Visit Pre-Trip Preparation Checklist, presented as Figure 3-1.  Equipment lists are further 
detailed in the specific-instrument system SOPs and technical instructions (TIs).  Pre-trip and 
post-trip equipment and materials include a personal computer, word processing and spreadsheet 
software, and access to the NPS inventory database and the Information Management Center 
database. 
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SEMIANNUAL SITE VISIT PRE-TRIP PREPARATION CHECKLIST 
 TOOLS AND MISCELLANEOUS EQUIPMENT AND SUPPLIES 
 Tools 
 Datel voltage source and input voltage harness 
 Datalogger program and software (direct connect cabling) 
 Digital voltmeter 
 Laptop computer 
 Forms 
 Calculator, notebook 
 Digital camera  
 Telephone list with site addresses, motel list, site information table 
 Trip pack (from Administrative Assistant): inventory, maintenance cards 
 AC power cords and power strip (at least 4 plugs) 
 Strapping tape 
 Calibration stickers, labels, shipping folder, ARS luggage tags 
 Road maps, atlas 
 Various equipment batteries (WS motor, flashlight) 9v, AAA, AA 
 First aid kit 
 Pump rebuild kit (Thomas, KNF, Brailsford) 
 “Quick-connect” with tubing to reach BIOS  (white color keyed for existing system) 
 Balston filters 
 Equipment documentation (usually does not exist on-site) 
 Climbing belt and bucket 
 GASEOUS CALIBRATION AND MAINTENANCE EQUIPMENT AND SUPPLIES 
 Transfer standard (ozone) 
 Zero air source 
 Charcoal column 
 Gas regulator 
 Flow calibrator 
 Calibration gas 
 Calibration/audit tubing capped or sealed (1/8”, 3/8”, 1/2” as required) 
 Dilution system 
 Flow pumps if suspect 
 Teflon fittings/spare glass manifold fittings and o-rings 
 Filters 
 Alcohol, Kimwipes, and Q-Tips 
 Extra lamps (both photometer and generator) (TECO, DASIBI, Monitor Labs) 
 Ozone scrubbers (Dasibi, Monitor Labs) 
 Canned air and Snoop 
 Solenoid valves (ML, TECO, Dasibi, 115 VAC, 24 VDC, etc.) 
 METEOROLOGICAL CALIBRATION AND MAINTENANCE EQUIPMENT AND SUPPLIES 
 Sling psychrometer and MP601 reference RH sensor 
 Digital thermometer 
 Thermos bottles and 12 V heater 
 Calibration WS motor and controller (test jigs, torque wheel, WD torque tester) 
 Translator extender card (Climatronics) 
 Precipitation calibrator (drip bottle, pipette) 
 Parasitic RH reference holder (Climatronics/Rotronics) 
 WS/WD bearings, pots, spare keepers OR replacement WS/WD sensors (Climatronics/RMYoung) 
 Reference solar radiation sensor 
 Barometer and GPS 
 Compass and tripod assembly 
 Campbell datalogger with charger and program instructions 
 Solar azmuth calculating software 

 
Figure 3-1.  Semiannual Site Visit Pre-Trip Preparation Checklist. 
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4.0 METHODS 
 
 This section describes the procedures for semiannual site visits to ambient air quality and 
meteorological monitoring sites. This section includes three (3) major subsections: 
 

4.1 Pre-Semiannual Site Visit Preparation 
 4.2 Semiannual Site Visit Procedures 
 4.3 Post-Semiannual Site Visit Procedures 
 
4.1 PRE-SEMIANNUAL SITE VISIT PREPARATION 
 
 The project manager coordinates with the COTR and other personnel to identify what 
sites require a semiannual maintenance visit and the scheduling of the visits. After the schedule 
has been agreed upon, all appropriate personnel are notified about the pending visit. The project 
manager will then discuss specific site maintenance or other requirements needed to be 
performed during the visit with the assigned field specialist. 
 
 The field specialist will contact the station operator and discuss any special arrangements 
that need to be made for the visit. To ensure that all required equipment and materials will be 
available for each visit, the field specialist will complete the Semiannual Site Visit Pre-Trip 
Preparation Checklist (see Figure 3-1). The field specialist will verify that all calibration 
standards are currently calibrated. 
 
 The administrative assistant will prepare and send site visit notification letters two weeks 
prior to each site visit to the: 
 

• Park superintendent. 
 
• Regional air quality coordinator. 
 
• Regional air quality field specialists. 
 
• Station operator. 

 
The administrative assistant will also prepare a trip pack for the field specialist, which will 
include: 

 
• A Semiannual Site Visit Pre-Trip Preparation Checklist. 
 
• The current equipment inventory. 
 
• Equipment Maintenance/Repair Records. 
 
• Other pertinent information. 
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4.2 SEMIANNUAL SITE VISIT PROCEDURES 
 
 Semiannual site visits involve several components, including integrity checks, preventive 
maintenance, calibrations, and corrective actions. The checklist used to ensure that all 
components of a visit have been adequately addressed is presented in Figure 4-1. Some items on 
the checklist only require one check. Other items, which relate to the calibration and 
maintenance of monitoring systems, require three checks as follows: 
 

• Pre-Maintenance Calibration Check - Upon arrival and prior to any repairs or 
adjustments, perform instrument audits, including zero, span, and precision level checks. 
This audit procedure will help confirm the repeatability confidence established by 
routine site operations. Document and investigate inconsistencies to identify problems. 

 
• Preventive/Routine Maintenance - Perform routine preventive maintenance and 

make necessary corrective action repairs to stabilize instrument performance and 
minimize future instrument down time and data loss. 

 
• Post-Maintenance Calibration - Following preventive or routine maintenance, 

perform final calibrations, flow rate, and leakage tests on all instrumentation. 
 
The following subsections detail the procedures to be performed during the semiannual visits. 
 
4.2.1 Shelter and Tower Integrity Check 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 1.  Upon arriving at the 
monitoring station, check the following: 
 

• Shelter exterior – Check the integrity of the exterior components of the shelter, 
focusing on the structural and aesthetic conditions, including the roof, siding, door, 
caulking, weather stripping, power lines, etc. 

 
• Shelter interior – Check the integrity of the interior components of the shelter, 

focusing on the structural and aesthetic conditions, including the floor, walls, ceiling, 
door, and racks. 

 
• Shelter electrical – Check the integrity of the outlets, lights, grounding, and polarity. 
 
• Shelter heating and air conditioning – Check the integrity of the heating and cooling 

systems.  Inspect, clean, and check function of thermostats. Review recent shelter 
temperature values and review DataView for any temperature alarms. Adjust thermostat 
as necessary to maintain the shelter temperature required for the station instrumentation. 

 
• Meteorological tower – Check the integrity of the tower, including supports, guys, 

hardware, and grounding prior to climbing or lowering. 
 
• Flow tower – Check the integrity of the tower, including supports, guys, hardware, 

and grounding prior to tipping. 
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Figure 4-1.  Semiannual Site Visitation Checklist for the NPS Ambient Air Quality 

            Monitoring Program. 
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Figure 4-1 (Continued).  Semiannual Site Visitation Checklist for the NPS Ambient 
    Air Quality Monitoring Program. 
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 Correct any condition considered unsafe before continuing any further station activities.  
Perform standard preventive maintenance and other necessary repairs, and coordinate with the 
station operator any painting and repair or replacement of any system component deemed 
unsightly or needing ongoing preventive care. 
 
4.2.2 Support Systems Integrity Checks 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 2.  Verify the condition 
and proper operation of the following monitoring support systems: 
 

• Lightning Protection Panel (LPP) - Verify the proper operation and check all 
connections and transorbs. The LPP provides lightning surge protection for 
instrument AC power, telephone modem, and meteorological signal conditioning 
cards. 

 
• Quality Assurance Monitor (QAM) - Verify proper operation, and verify that the 

shelter temperature measurement is within 1°C of a NIST-traceable thermometer. 
 
• Power and Telephone Lines - Verify the proper operation of the telephone line, and 

check line polarity, grounding, and lightning protection connections. Check the 
integrity of the cables. 

 
• Interconnect Cabling - Verify that all signal wiring and tower cabling are in good 

condition, properly strain-relieved, and securely connected. 
 
• Intake and Exhaust Manifolds - Verify the integrity and proper assembly and 

operation of the system (if applicable). Replace intake manifold pump diaphragm 
annually. Clean and maintain as necessary. 

 
Correct any malfunctions and/or replace system components. 
 
4.2.3 Air Quality Equipment Calibrations and Maintenance 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 3. Document in the 
DataView electronic logbook any preventive maintenance, repair, or adjustments made. 
Summarize in a written trip report, and note on the instrument’s Equipment Maintenance/Repair 
Record (blue card) as shown in Figure 4-2. Document instrument or sensor response on the 
appropriate Excel calibration forms. 
 
 Pre- and post-maintenance calibrations of ambient air quality analyzers will be made in 
accordance to ARS SOP 3100, Calibration of Ambient Air Quality Analyzers, NPS SOPs, 
instrument-specific technical instructions, manufacturer’s specifications, and other supporting 
documentation. All sites that have ozone (O3) monitoring systems; perform the following 
preventive maintenance tasks for UV photometric-type O3 analyzers and/or transfer standards: 
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EQUIPMENT MAINTENANCE/REPAIR RECORD 
 
 
 Item:                          Manufacturer:                     Model #:               Serial #:                Owner:           
 

 
Date 

Repair 
Location 

 
Maintenance or Repair Description 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

 
 

Figure 4-2.  Equipment Maintenance/Repair Record (Blue Card). 
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• Ozone analyzers - Inspect and clean the entire absorption cell, including tube(s), 
mirrors, and windows. Replace the O3 scrubber (converter) as needed. Check the 
solenoid valve for leaks across ports (intra-port leak) and replace the solenoid if 
faulty. Check the entire sample flow path for leaks and seal leaks if found. Replace 
the ultraviolet source lamp annually or when performance is below manufacturer’s 
specifications, and replace pumps or other components when required. 

 
• Consumable reagents –  Replace the charcoal or desiccant, as required. 

 
 Perform calibration and maintenance procedures on other air quality analyzers (e.g., SO2, 
NOx) as specified in instrument-specific technical instructions. Procedures for some 
instrumentation may only be practical at an air quality laboratory. The field specialist is 
responsible for arranging for instrument removal, transport, maintenance, and coordinating 
removal and installation. 
 
4.2.4 Dry Deposition Sampling Equipment 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 4. Complete a calibration 
check of the filter pack sampling system before and after performing any preventive 
maintenance. See ARS SOP 3180, Calibration of Mass Flowmeters and Mass Flow Controllers, 
for assistance.  Perform the following tasks during calibration checks: 
 

• Sampling system leak check - Check the entire sample flow path for leaks and seal 
leaks if found. 

 
• Flow controller calibrated - Calibrate the flow of the mass flow controller. 

Calculate and adjust the mass flow controller and datalogger to indicate proper flow 
rate. Finally, document pre- and post-maintenance flow rate, and control setting. 

 
Perform the following preventive maintenance tasks: 
 

• Replace Balston particulate filter - Replace the Balston particulate filter. 
 
• Rebuild pump – Rebuild the pump semiannually and tighten all fittings and tubing. 
 
• Replace system tubing as required. 
 

4.2.5 Meteorological Equipment Calibrations and Maintenance 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 5.  Calibration of 
meteorological sensors shall be made in accordance with ARS SOP 3150, Calibration and 
Routine Maintenance of Meteorological Monitoring Systems, instrument-specific TIs, NPS 
SOPs, manufacturer’s specifications, and other supporting documentation. A summary of 
meteorological checks follow: 
 

• Wind speed/wind direction - Replace the bearings annually or more frequently, 
depending upon the pre-maintenance calibration check. Inspect the wind vane or 
anemometer cups for damage or corrosion that may affect performances. Inspect and 
repair wiring and/or connectors, and verify the operation of the heater sleeves. 
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• Temperature/Delta temperature - Inspect for corrosion or damage, and replace if 
necessary.  Check the sensor’s response with three known temperature baths. 

 
• Relative humidity – Perform pre- and post-maintenance checks with a reference 

relative humidity sensor and replace the sensor every 6 months for laboratory 
calibration. 

 
• Aspirators - Clean the temperature/relative humidity aspirator housings or non-

aspirated shields, and replace the aspirator motor as necessary (i.e., noisy bearings). 
 
• Solar radiation - Clean the glass cover and inspect the sensor and cabling. Replace 

the leveling bubble assembly if broken.  Level and tighten the sensor to the mounting 
arm. 

 
• Precipitation - Inspect and clean the tipping bucket type gauge and remove foreign 

material. Observe free movement of the bucket, level the sensor if necessary, and 
verify that the heater operates properly. 

 
• Wetness - Inspect the sensor for damage and secure the mounting. Test for proper 

operation. 
 
4.2.6 Data Acquisition Calibrations, Maintenance, and Operational Verification 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 6. Calibration of all data 
acquisition system and strip chart recorders will be made in accordance to ARS SOP 3160, 
Calibration of Data Acquisition Systems, and ARS SOP 3170, Calibration of Strip Chart 
Recorders. Proper operation of the DataView system will also be verified. Perform the following 
preventive maintenance tasks: 
 

• Datalogger – Check all SIP connections, lightning protection circuits through the 
LPP and AC, and telephone circuits, and tighten or repair if necessary. Check the 
datalogger’s date and time. Verify the operation of the display and clean the display. 

 
• Datalogger Keyboard – Clean the keyboard and check for correct operation. 
 
• Datalogger Modem – Check the datalogger modem for correct operation. 
 
• DataView System – Verify that the DataView computer and software are fully 

functional, and that the communications links to the datalogger, modem, and printer 
are operational. 

 
• Printer – Check the printer for correct operation, and change the ink cartridge if 

necessary. 
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4.2.7 Station Modifications and Configuration Enhancements 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 7. The configuration of 
network stations will evolve in response to changes in instrumentation, technology, quality 
assurance requirements, or monitoring program goals. Reconfiguration goals include:  enhancing 
accommodation of EPA quality assurance requirements and simplifying regular maintenance; 
troubleshooting; and calibration tasks performed by station operators, maintenance personnel, 
and system auditors. ARS will perform any required station modifications or configuration 
enhancements in response to COTR guidance.   
 
 In addition, assistance will be provided to the NPS ARD (National Park Service Air 
Resources Division) staff, as required, to revise the Quality Assurance Program Plan, standard 
operating procedures, or technical instructions, or to develop and write new components of 
quality assurance documentation to account for any system modifications or configuration 
enhancement. 
 
4.2.8 Observe/Train Station Operator 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 8. Following the 

completion of all scheduled calibrations and maintenance, spend as much time as required with 
station operators to ensure that the operators have a complete and working knowledge of their 
required duties. The overall quality of network operators directly translates to the quality of 
network data. The field specialist will: 
 

• Observe operator – Observe the operator perform a complete station check and 
review procedures for zero checks, precision span checks, and multipoint calibrations. 

 
• Review log notes - Review operator log notes, station checklists, calibration forms, 

other data documentation, and overall station organization. 
 
• Train - Further train the station operator on any aspect of multipoint calibrations, 

precision checks, data reporting, data transmittal, or other operational requirement 
where deficiencies are observed. 

 
• Review changes – Thoroughly review any changes in SOPs or operations with the 

station operator. 
 
• Verify on-site SOPs - Verify that the current versions of all SOPs are available 

on-site, and update if necessary to reflect any changes in instrumentation, procedures, 
or protocols.   

 
• Verify inventory - Verify that the operator has an adequate inventory of all required 

forms and consumable supplies, including desiccant, particulate filters, gloves, printer 
ink, and similar items. 

 
• Encourage/answer questions – Encourage station operator comments and fully 

answer any questions the operator may have.  Note any operator comments or 
suggestions. 

 
• Inform - Update the operator on the monitoring program goals and objectives.  Instill 

in each operator a sense of purpose to stimulate self-interest and responsibility. 



           Number 3000 
           Revision 1.4 
           Date JAN 2008 
      Page 14 of 17 
 

 
4.2.9 Verify and Update Site Equipment Inventories and Documentation 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 9. Verify the 
manufacturer, description, model number, serial number, and government property number of all 
monitoring site equipment against the equipment inventory database listing for the site. 
Document any inconsistencies noted or changes in system hardware performed during a site 
visit. A computer printout of inventory items currently at the site is used to verify site equipment. 
An example printout is presented in Figure 4-3. If the site is new, a Capital Equipment Inventory 
Checklist is used to list equipment at each site. The checklist is presented in Figure 4-4. 
 
 Take site documentation photographs of: 
 

• The four cardinal directions (North, West, South, East) 
• A close-up of the shelter exterior 
• The meteorological tower(s) with instrumentation 
• All other exterior instrumentation 
• Interior instrumentation 
• A scenic view 

 
4.2.10 Supplemental Flow Checks 
 
 Refer to Figure 4-1, Semiannual Site Visitation Checklist, Item 11. In addition to 
performing sample flow rate checks on the gaseous monitors and dry deposition monitors, 
document flow checks also performed on any collocated particulate samplers, such as 
IMPROVE samplers, operated by the NPS. Perform all flow supplemental checks with a mass 
flowmeter traceable to NIST standards. 
 
4.3 POST-SEMIANNUAL VISIT PROCEDURES 
 
 The field specialist will compile a written trip report following each semiannual site visit. 
Each report will summarize conditions found upon arrival, problems noted, corrective actions, 
training, inventory lists, site visitation checklist, pre- and post-maintenance calibration 
documents, and problems requiring further attention. Example trip reports can be found in the 
Monthly Technical Progress Reports forwarded to the COTR. The administrative assistant will 
word process the trip reports and forward them to the project manager for review. After review, 
copies of the trip reports will be delivered to the: 
 

• Station operator (within 14 days of return from site visit). 
• IMC Manager. 
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INVENTORY REPORT FROM FILE LINPSINV.vws 
FOR SITE BIBE 

01/06/97  16:35:21 
 

ITEM SITE 
ID #    NAME 

ITEM NAME MAN’F MODEL SERIAL # 
 

PROPERTY # BAR CODE # 

88             BIBE ASPIRATOR (UPPER) CLIMATRONICS 
 

1000325 1275   

89 ASPIRATOR (LOWER) CLIMATRONICS 100325 1386 01497 ---- 
173 CALIBRATOR - O3 DASIBI 1003-PC 5169 02262 NP1200065050 
1582 CROSSARM CLIMATRONICS 100487 1496   
222 DATALOGGER SUMX SX444 028 01566 ---- 
1433 DATA STORAGE MODULE SUMX  14923   
1646 DESK WW GRAINGER 32385    
398 JUNCTION BOX CLIMATRONICS   01501 NP1200002973 
447 KEYBOARD TANDY 102 802003220   
499 LPP DRI  116   
538 MAINFRAME CLIMATRONICS 100081 1379   
2002 MASS FLOW CONTROLLER TYLAN  FP9403014   
32 MODEM VIVA 24 10042-CT   
1700 MOUNTAIN PLATE DAN WILSON     
633 POWER SUPPLY CLIMATRONICS 101074 806 01500 NP12000002974 
655 PPT SENSOR CLIMATRONICS 100508 414 01498 NP1200002976 
729 PRINTER TANDY DMP-107 0219910   
1335 QAM INTERMOUNTAIN AC  021   
792 RECORDER CHESEL 300D 8607-718 01140 ---- 
2003 RH SENSOR CLIMATRONICS   EPA 01342  
2053 RH SENSOR CLIMATRONICS   23380C EPA 03251  
2052 RH TRANSLATOR CARD CLIMATRONICS 100224 196 EPA 00376  
1642 SHELTER CORNERSTONE     
1416 SOLAR RAD SENSOR CLIMATRONICS 101655 13178   
2001 TEMP SENSOR (LOWER) CLIMATRONICS     
2000 TEMP SENSOR (UPPER)  CLIMATRONICS   EPA 0270  
1110 WD SENSOR CLIMATRONICS 100076 1521   
1164 WD VANE CLIMATRONICS  50   
1999 WETNESS SENSOR R.M. YOUNG 58120  EPA 03014  
1222 WS CUPS CLIMATRONICS  069   
1205 WS SENSOR CLIMATRONICS 100075 1806   
 
 
 
 
 
 
 

 
 

Figure 4-3.  Example Computer Printout of Inventory Items. 
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NPSAIR CAPITAL EQUIPMENT INVENTORY CHECKLIST 
Site: Date: Taken by: 

 Description Manufacturer Model # Serial # NPS # 
 Analyzer - O3   
 Analyzer - SO2   
 Transfer Standard - O3   
 Transfer Standard - SO2   
 O3   
 SO2   
 Calibrator(s)   
 Zero air source   
 Power supply   
 Mainframe   
 Aspirator (upper)   
 Telephone   
 Modem   
 Datalogger   
 Computer (laptop)   
 Printer   
 Junction box   
 Crossarm   
 LPP   
 SIP   
 Wind speed cups   
 Wind vane   
 QAM   
 Wind speed sensor   
 Wind direction sensor   
 Temperature sensor (upper)   
 Station temp reference   
 Solar radiation sensor   
 Precipitation sensor   
 Relative humidity sensor   
 Radiation card   
 Wind card   
 Temperature card   
 Temperature sensor (lower)   
 Aspirator (lower)   
 Wetness sensor   
 Filter pack flow controller   
 RH aspirator   
    
    
    

EQUIPMENT REMOVED 
    
    
    
AAQ inventory checklist.doc (12/99) 
 
 

Figure 4-4.  NPSAIR Capital Equipment Inventory Checklist. 
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Trip reports should include the following sections: 
 
1.0   INTRODUCTION 
 
2.0   SITE VISIT    Station Operator 
      Monitoring Shelter 
      Meteorological Instrumentation 
      Ozone (O3) Instrumentation 
      Other Instrumentation 
      Additional Action Required 
  
3.0  CALIBRATION FORMS  Ozone (O3) Calibration Pre-Maintenance 
      Ozone (O3) Calibration Post-Maintenance 
      Sulfur Dioxide (SO2) Calibration 
      Carbon Monoxide (CO) Calibration 
      Oxides of Nitrogen (NO,NO2, NOx) Calibration 
      Meteorological Calibration -  
      Wind Speed/Wind Direction 
      Meteorological Calibration - Weather Parameters: 
      Temperature, Delta Temperature, Relative Humidity,  

Solar Radiation, Precipitation, Wetness 
      Dry Deposition Sampler Flow Data 
          Semiannual Site Visitation Checklist 
          Site Inventory Checklist 
 
 The field specialist shall also follow-up on repairs or other action required at the sites, 
and ensure these actions are performed, as documented in the trip report. 
 
 The administrative assistant will update the Electronic Status Board to document repairs 
or instrument changes at the site, update the Equipment Inventory database to reflect changes in 
inventory at the site, and document maintenance or repairs made to equipment. Finally, the 
administrative assistant will produce, deliver, and file the trip reports and repair records. 
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1.0 PURPOSE AND APPLICABILITY 
 
 This standard operating procedure (SOP) outlines the site selection criteria required for 
ambient air monitoring stations. Proper siting of a monitoring station can help ensure that 
collected on-site data are valid. In all cases, the meteorological data collected should be of the 
quality of data collected by the National Weather Service. The objective is to characterize the 
ambient air in proximity to the monitoring location.  
 
 Monitoring sites are representative of the regional, national, and global spatial scales of 
representativeness defined in 40 CFR Part 58, Appendix D. Site locations and placement of 
gaseous sample inlet probes meet the requirements of 40 CFR Part 58, Appendix E.  
 
 This procedure specifically describes: 
 

• General site criteria. 
 
• Meteorological monitoring site criteria. 
 
• Gaseous monitoring site criteria. 
 

2.0 RESPONSIBILITIES 
 
2.1 PROGRAM MANAGER 
 
 The program manager shall: 
 

• Inform the project manager of the location area and site-specific monitoring 
objectives for a proposed ambient air monitoring site. 

 
• As required, review the selected site with the project manager and the project-specific 

Contracting Officer’s Technical Representative (COTR). 
 
2.2 PROJECT MANAGER 
 
 The project manager shall: 
 

• Prepare project-specific siting and operational objectives, guidelines, and 
considerations. 

 
• Review with the field specialist photographic documentation, maps, and other 

information to determine the suitability of a site. 
 
• Select the site based on the criteria outlined in this SOP. 
 
• As required, review the selected site with the program manager. 
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2.3 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Initiate the search for potential sites by sending pertinent siting criteria and associated 
materials to a local contact (if available). 

 
• Conduct a siting visit if required. 
 
• Contact the local power and telephone companies for information concerning 

availability and installation. 
 
• Obtain permission to perform any site preparation that may be required. 

 
• Obtain permission from private or public landowners for permanent access to the 

monitoring location. 
 
• Obtain permits or Environmental Impact Statements if required. 
 
• Work with the local contact or sponsoring agency to identify a site operator and local 

primary contact to service the equipment. 
 
• Review with the project manager photographic documentation, maps, and other 

information to determine the suitability of a site. 
 

• Forward all site selection information to the Information Management Center (IMC) 
for input into the Air Quality Data Base Management System. 

 
2.4 LOCAL (ON-SITE) CONTACT 
 
 The local contact (if available) shall: 
 

• Locate and document potential sites upon receiving the siting criteria and associated 
materials from the field specialist. 

 
• Provide the field specialist with any pertinent site-related information. 

 
• Assist the field specialist in obtaining any site access and/or installation-related 

clearances or permissions. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are generally required to complete the site 
selection process: 
 

• Topographic maps of the area of interest 
 

• Camera(s) to photograph the proposed site and area 
 

• A list of monitoring objectives, requirements, and associated air quality monitoring 
equipment 



             Number 3050 
             Revision 0.2 
             Date NOV 2009 
             Page 3 of 11 
 

• A list of local sources affecting the air in the area of interest 
 

• Information about the availability of AC power and telephone service 
 
• New Site/Site Relocation Form 

 
4.0 METHODS 
 
 This section describes site selection procedures and includes four (4) major subsections: 
 
 4.1  General Site Criteria 
 4.2  Meteorological Monitoring Site Criteria 
 4.3  Gaseous Monitoring Site Criteria 
 4.4  Site Documentation 
 
4.1 GENERAL SITE CRITERIA 
 
 General site criteria to consider when locating potential ambient air monitoring sites are: 
  

• The site is representative of the air mass to be monitored. 
 
• The site is representative of regional, not local meteorological conditions. 
 
• The site has year-round accessibility. 
 
• A power supply is available nearby. 
 
• The site is in open space away from obstructions. 
 
• The site is secure from vandalism or damage due to animals. 
 
• The site’s proximity to a nearby town. 
 
• The monitoring station will be aesthetically pleasing and blend in with the 

surrounding environment. 
 

• The site is at least 500 meters (1,650 feet) from heavily traveled roadways. 
 
• The site is at least 2 km (1.2 miles) from major highways, airports, navigable 

waterways, and rail yards. 
 
• The site is at least 200 meters (660 feet) from large parking lots and at least 100 

meters from small parking lots. 
 
• The site is at least 500 meters from intensive agricultural operations. 
 
• The site is at least 200 meters (660 feet) from grazing animals or range used by 

livestock. 
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4.2 METEOROLOGICAL MONITORING SITE CRITERIA 
 
 Site criteria to consider for meteorological monitoring instrumentation are: 
 

• The standard exposure height of wind instruments should be 10 meters (33 feet). 
 
• The distance between the instrument and an obstruction should be at least 10 times 

the height of that obstruction. 
 
• Wind instruments should be mounted on booms at 90° to the predominant wind 

direction (for up-valley and down-valley flows). 
 
• The recommended vertical heights for measuring temperature difference are 2 meters 

(6.6 feet) and 9 meters. 
 
• The site elevation is between the highest and lowest elevations within the nearest 

Class I area. 
 
• Aspirated shields should be used to ventilate instruments. 
 
• Temperature sensors should be located at a distance of at least 4 times the height of 

any obstruction. 
 
• Temperature sensors should be located at least 30 meters (100 feet) from large paved 

areas. 
 
• Heated rain gauges should be used to properly measure frozen precipitation. 
 
• Rain gauges should be located at 1-2 meters above ground level so the mouth is 

horizontal to the sky. 
 
• Wind shields should be used where significant snowfall occurs. 
 
• Pyranometers (measuring incoming solar radiation) should be located where no 

shadows are cast. 
 
• Pyranometers should have an unrestricted view of the sky from all directions in all 

seasons at 1-2  meters above ground level. 
 
• Barometric pressure sensors should be located at 2 meters above ground level. 
 
• Wetness sensors should be located at 2 meters above ground level. 
 
• Approval and/or permits are obtained to clear land for site installation. 
 

4.3 GASEOUS MONITORING SITE CRITERIA 
 
 Monitoring site criteria to consider when locating gaseous instrumentation are detailed in 
the following subsections. 
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4.3.1 Ozone Probe Site Criteria 
 

• Vertical probe placement is 3-15 meters above ground. 
 
• Spacing from supporting structures is more than 1 meter. 
 
• Obstacle distance is at least twice the height the obstacle protrudes above the probe. 
 

• The probe must have unrestricted airflow. It must include the predominant wind;  
270°, otherwise 180° if the probe is located on the side of a building. 

 

• Spacing between the station and roadway (see Table 4-1). 
 

Table 4-1 
 

 Minimum Separation Distance Between Roadways and Probes or 
 Monitoring Paths for Monitoring Neighborhood and Urban Scale 

 Ozone and Nitrogen Dioxide 
 

Roadway average daily 
traffic, vehicles per day 

Minimum separation 
distance1 in meters 

≤ 10,000 
15,000  
20,000  
40,000  
70,000 

               ≥ 110,000 

10 
20 
30 
50 

100 
250 

  1 Distance from the edge of the nearest traffic lane. The distance 
   for intermediate traffic counts should be interpolated from the 
   table values based on the actual traffic count. 
 

• Spacing from trees should be at least 20 meters from dripline, and must be at least 10 
meters if blocking daytime wind from an urban core. 

 
• The probe material must be of Teflon or Pyrex glass. 
 
• Residence time must be less than 20 seconds. 
 

4.3.2 Sulfur Dioxide Probe Site Criteria 
 

• Horizontal and vertical probe placement is 3-15 meters above ground and more than  
1 meter from a supporting structure.  

 
• Probe placement must be away from dirty, dusty areas, and if on the side of a 

building, should be on the side of the prevailing winter wind. 
 
• The probe should be at least 1 meter  from walls, parapets, penthouses, etc. 
 
• If neighborhood scale, the probe must be at a distance at least twice the height the 

obstacle protrudes above the probe. 
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• The probe must have at least a 270° arc of  unrestricted airflow around vertical probes 
(180° if on the side of a building), and wind during the peak season must be included 
in the arc. 

 
• No furnace or incineration flues or other minor sources of SO2 should be nearby. 
 
• Spacing from trees should be at least 20 meters from dripline, and must be at least 10 

meters if trees act as an obstruction. 
 

4.3.3 Carbon Monoxide Probe Site Criteria 
 

• Horizontal and vertical probe placement is 3 (±1½) meters above ground for 
microscale and 3-15 meters above ground for middle and neighborhood scale. 

 
• Spacing from obstructions is at least 270°, or 180° if the probe is located on the side 

of a building. 
 

• Spacing from roads is 2-10 meters from the edge of the nearest traffic lane for 
microscale, or at least 10 meters from an intersection, preferably at midblock. See 
Table 4-2 for middle and neighborhood scale. 

 
Table 4-2 

 
Minimum Separation Distance Between Roadways and Probes or 

Monitoring Paths for Monitoring Neighborhood Scale 
Carbon Monoxide 

 
Roadway average daily traffic, 

vehicles per day 

Minimum separation 
distance1 for probes or 90% of a 

monitoring path (meters) 
≤ 10,000 

15,000  
20,000  
30,000  
40,000  
50,000  

  ≤ 60,000 

10 
25 
45 
80 

115 
135 
150 

  1 Distance from the edge of the nearest traffic lane. The distance for  
   intermediate traffic counts should be interpolated from the table values 
   based on the actual traffic count. 
 

• Spacing from trees should be at least 10 meters from dripline, if tree is at least 5 
meters above sampler and is between the probe and the road. 

 
4.3.4 Nitrogen Dioxide Probe Site Criteria 
 

• Vertical probe placement is 3-15 meters above ground. 
 
• Spacing from supporting structures is more than 1 meter. 
 

• Obstacle distance is at least twice the height the obstacle protrudes above the probe. 
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• The probe must have unrestricted airflow; 270° or 180° if the probe is located on the 
side of a building. 

 

• Spacing between station and roadway (see Table  4-1). 
 

• Spacing from trees should be at least 20 meters from dripline, if tree is above the 
height of the probe by 5 meters or more. 

 

• Probe material must be of Teflon or Pyrex glass. 
 
• Residence time must be less than 20 seconds. 

  
4.4 SITE DOCUMENTATION 
 
 The IMC maintains records of the characteristics of the sites (refer to SOP 3650, IMC 
Staff’s Maintenance Responsibilities for the Ambient Air Quality Data Base Management System 
(AQDBMS). These records are intended to provide a permanent history of the following site 
information (see Figure 4-1): 

 
• Site identification 
 
• Site classification 
 
• Topographic characteristics 
 
• Meteorology and climatology 
 
• Obstructions that influence the site 
 
• Characteristics of the sampling probes 
 
• Pollutant parameter monitors 
 
• Site and data record histories 
 
• Site representativenss 
 
• Custody and control of data 
 

 These records will be upgraded as changes occur and will be used to document 
compliance with the Part 58 network design and siting criteria.  
 
5.0 REFERENCES 
 
Environmental Protection Agency, 2007, 40 CFR Part 58 Appendix D, June. 
 
Environmental Protection Agency, 2006, 40 CFR Part 58 Appendix E, October. 
 
Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for 
 Regulatory Modeling Applications, Office of Air Quality Planning and Standards,  
 EPA-450/R-99-005, Research Triangle Park, NC, February. 



              

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-1.  Information Management Center (IMC) New Site / Site Relocation Form. 
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Figure 4-1 (continued).  Information Management Center (IMC) New Site / Site Relocation Form. 
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Figure 4-1 (continued).  Information Management Center (IMC) New Site / Site Relocation Form. 
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Figure 4-1 (continued).  Information Management Center (IMC) New Site / Site Relocation Form. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of this standard operating procedure (SOP) is to outline the steps for 
calibration and maintenance of air quality analyzers and/or transfer standards. This document 
applies to calibrations of ozone (O3), sulfur dioxide (SO2), nitrogen dioxide (NO2), and carbon 
monoxide (CO) analyzers. This document also addresses the calibration of in-station, 
gas-dilution calibration devices that support SO2, NO2, and CO monitoring systems. 
 
 Detailed instrument-specific calibration procedures are not included in this SOP. 
Separate technical instructions (TIs) are developed for each specific monitoring system. 
 
 Calibrations (including multipoint, zero, and span) are required under any of the 
following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of three months 

 
 Continuous gas analyzer calibrations will follow protocols as established by 
EPA/600/4-77/027a Quality Assurance Handbook for Air Pollution Measurement System: 
Volume II, and Appendix B of 40 CFR 58 Quality Assurance Requirements for Prevention of 
Significant Deterioration (PSD) Air Monitoring. All measurement devices and calibration 
standards will be traceable to the National Institute of Standards and Testing (NIST). 
 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration schedule and coordinate with the client as necessary. 
 

• Establish the calibration reporting protocol to satisfy client requirements. 
 

• Review calibration results. 
 

• Identify inconsistencies in calibration results and initiate corrective action as required. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in the appropriate TIs. 
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• Verify that the calibration standards are in good working order and are in current 
calibration. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Document all calibration results and maintenance procedures performed. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All calibration equipment must be under current calibration or certification (traceable to 
NIST standards). 
 
3.1 O3 ANALYZER CALIBRATION 
 
 The following equipment is required for ozone analyzer calibration: 
 

• Digital voltmeter (DVM) 
 

• Certified O3 transfer standard or verified O3 primary standard 
 

• Zero air supply 
 

• Clean Teflon tubing and fittings 
 

• Field service tools 
 

• Instrument-specific ARS technical instruction 
 

• Instrument-specific manufacturer's manual 
 

• Station log book 
 

• Ozone calibration forms 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel spreadsheet form (Calibrations.XLT) and 
CALCU program software 

 
• Cleaning supplies 

 
• Replacement analyzer parts 

 
3.2 SO2, NO2, OR CO ANALYZER CALIBRATION 
 
 The following equipment is required for SO2, NO2, or CO analyzer calibration: 
 

• Digital voltmeter (DVM)  
 

• Certified gas cylinder with 300 or greater psi and stainless steel regulator 
 

• Clean Teflon tubing and fittings 
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• Instrument-specific ARS technical instruction 
 

• Gas dilution calibrator and zero air supply 
 

• Field service tools 
 

• Instrument-specific manufacturer's manuals 
 

• Station log book 
 

• Gas dilution calibration forms 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel spreadsheet form (GASDIL.XLT) and CALCU 
program software 

 
• Replacement analyzer parts 

 
• Gas phase titrator 

 
4.0 METHODS 
 
 Detailed methods for calibrating and maintaining analyzers are discussed in specific TIs 
for each type of analyzer. This section discusses general procedures common to any of these 
analyzers, and includes five (5) major subsections: 
 
 4.1 Principles and Policy 
 4.2 Preparation for Analyzer Calibration 
 4.3 Multipoint Calibration of Analyzers 
 4.4 In-station Calibrator Verification 
 4.5 Documentation 
 
4.1 PRINCIPLES AND POLICY 
 
 The philosophy of ambient air monitoring instrument calibration has evolved as 
instrument manufacturers have improved instrument stability and repeatability. Current EPA 
guidelines do not specify a time-established schedule (i.e., once per quarter), but only state that 
calibrations be performed “as necessary.” Each project manager may establish the calibration 
protocols and other routine analyzer checks (zero, span, and precision checks) to suit the 
requirements of the project and client. Practical considerations such as established maintenance 
schedules, budget limitations, audit schedules, and site operator competence must also be 
considered. Unless an individual project specifically specifies an alternate calibration interval, 
calibrations of ambient gas analyzers will be performed every three (3) months. 
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4.1.1 Equipment Applications and Use 
 
IN-STATION 
CALIBRATORS 

In-station calibrators may be used only to make: 

• Zero checks 

• Span checks 

• Precision checks 

• Multipoint calibration checks 

 
In-station calibrators are not to be used to make adjustments to 
analyzers (other than zero), unless calibration of the in-station 
calibrator immediately precedes the analyzer adjustment. 
 

REFERENCE 
CALIBRATORS 

Reference calibrators may be used to make: 
 
• Zero checks 

• Span checks 

• Precision checks 

• Multipoint calibration checks 
 

4.1.2 Instrument Adjustments 
 
ZERO 
ADJUSTMENTS 

Zero adjustments are required whenever the zero response (zero 
check) of the analyzer exceeds control limits. Zero adjustments 
may be made to continuous analyzers without the need for a 
multipoint calibration check. A span check must follow a zero 
adjustment. 
 

ANALYZER 
ADJUSTMENTS 

Calibrations (adjustments) of continuous analyzers (other than 
zero) should only be performed after a pre-maintenance 
multipoint calibration check. A post-maintenance multipoint 
calibration check must follow an analyzer adjustment. 
 

4.2 PREPARATION FOR ANALYZER CALIBRATION 
 
 Before performing a calibration check, ensure adequate preparation of the operational 
environment, calibration device (gas dilution unit or transfer standard), and the analyzer by 
determining the following: 
 

• The station is at the proper temperature. 
 

• Instruments are adequately warmed up. 
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• Calibration documentation is current, complete, and available. 
 

• All required support tools, diagnostic equipment, supplies, and calibration forms are 
available. 

 
 The above points are detailed in instrument manufacturer's manuals and in the TIs 
specific to each analyzer. 
 
4.3 MULTIPOINT CALIBRATION OF ANALYZERS 
 
 The steps of a five-point calibration check are outlined below. Calibration of an 
instrument infers an adjustment to the instrument response after a calibration check. Detailed 
steps will vary with each instrument type and are detailed in instrument-specific TIs. 
 
INTRODUCE 
GAS 

Known concentrations of gas that cover the response range of the 
analyzer are introduced. 
 

EVALUATE 
ANALYZER 
RESPONSE 

Allow the analyzer to fully respond and stabilize on each of the 
five introduced gas concentrations. If response fails to stabilize, 
abort the calibration check, investigate the problem, and take 
corrective action. After the analyzer response stabilizes, note and 
record the analyzer front panel display, analyzer voltage output, 
and data acquisition response on the appropriate calibration form 
(or laptop computer Excel spreadsheet) and on the strip chart. 
 
Review the percent difference (Δ%) between designated input and 
analyzer response calculated by the calibration spreadsheet.  
 
Compare the Δ% at each point with the average Δ%. If the Δ% at 
any individual point differs from the average Δ% by more than 
5%, re-calculate the flow rates or transfer standard setting and 
re-run the point. If, on this second run, the point falls within 5% 
of the average, accept the new point and re-calculate the average. 
If not, troubleshoot the analyzer and calibrator to determine the 
problem and take corrective action. 
 
Review the data to determine if analyzer adjustment (calibration) 
is required: 
 
If  the slope is <0.950 or >1.050, analyzer adjustment is required. 
 
If the intercept is <3.0 ppb (0.3 ppm for CO) analyzer adjustment 
is required. 
 
If the correlation is <0.9950 analyzer adjustment (or repair) is 
required. 
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CALIBRATE 
(ADJUST) 
ANALYZER 

If analyzer calibration is required, perform the following steps: 
Introduce a known concentration of gas into the analyzer at 80% 
to 90% of full scale of the normal operating range. Allow the 
analyzer to stabilize, then adjust the span accordingly. If the span 
adjustment is not adequate to bring the analyzer response to 
within control limits, troubleshoot the analyzer to determine the 
problem and take corrective action. 
 

CALCULATE SPAN 
NUMBER (OZONE 
ANALYZERS) 

Following adjustment, check the zero response of the analyzer 
and perform a post-maintenance calibration check. 
 
Record all data on the strip chart and calibration forms (or in 
Excel spreadsheet). Reevaluate the slope, intercept, and 
correlation. 

 
4.4 IN-STATION CALIBRATOR VERIFICATION 
 
 Verification of the in-station calibrator should be completed whenever a calibration 
check is performed.  The method of verification depends upon the type of in-station calibrator.  
 
 Ozone transfer standards are verified (re-certified) using similar methods as calibrating a 
photometer-based ozone analyzer. Refer to SOP 3300, Certification of Ozone Transfer 
Standards, for re-certification procedures. 
 
 In-station gas dilution calibrators may be verified by comparing to a reference calibrator. 
 This may be done by comparing the analyzer response from the in-station calibrator to the 
analyzer response from the reference calibrator. Refer to SOP 3180, Calibration of Mass 
Flowmeters and Mass Flow Controllers, for calibrating gas dilution systems. 
 
4.5 DOCUMENTATION 
 
 Analyzer calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet should 

be completed entirely. Where possible, use the Excel spreadsheet 
so that both a hard copy and digital record of the calibration are 
maintained.  Review and sign all calibration forms. 
 

STRIP CHARTS Strip chart records should be annotated to clearly document both 
the input concentration values and the analyzer data acquisition 
system response. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes.  Note any abnormalities in 
analyzer or calibration operation that could affect the quality of 
data. 
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CALIBRATION 
STICKER 

An ARS calibration sticker is placed on the analyzer, marking the 
date the instrument was calibrated and the name of the technician 
who calibrated it. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip report. 
 

5.0 DEFINITIONS 
 
 ACCURACY - The extent to which measurement, or the average of several 

measurements agree with the true value. 
 
 ANALYZER - Instrument that continuously samples ambient air for a specific 

constituent, determines the concentration, and provides an electrical output to a recording 
device. 

 
 AUDIT - Independent challenge of an analyzer or instrument.  Must be completed by 

personnel and calibration standards not normally used for the operation, certification, 
calibration, or repair of the equipment subjected to the audit. 

 
 CALIBRATION - Adjustment of analyzer (or measurement system) to provide 

agreement between known inputs and analyzer or output. 
 
 CALIBRATOR - Device for generating known outputs. 
 
 CALIBRATION CHECK - The method for determining the relationship between a 

known input and the analyzer response to a certain percentage of agreement. 
 
 CONTROL LIMIT - Guidelines for taking action on analyzer maintenance or 

adjustments when limits are exceeded. 
 
 ERROR - The difference between the true and the measured value is defined as the 

error. Often described as a percent difference from the designated (actual) value. 
 
 IN-STATION CALIBRATOR - Equipment located within the monitoring station that is 

used to generate gas concentrations (zero, span, precision, multipoint values) to the 
analyzer on a routine, possibly automated basis.  It is not to be used to make analyzer 
adjustments. 

 
 MULTIPOINT CALIBRATION CHECK - A calibration check comprising of multiple 

known inputs to determine the linearity and accuracy of response.  A multipoint 
calibration check will consist of zero and at least four input concentrations distributed 
over the analyzers operating range. 

 
 PRECISION - An assessment of the repeatability of an analyzer to a known 

concentration input. 
 
 PRECISION CHECK - A span check of an analyzer at a designated concentration of 

0.08 to 0.10 ppm for SO2, NO2, and O3, and 8.0 to 10.0 ppm for CO.  These checks are 
required by PSD regulations to be performed every two weeks.  The results of precision 
checks are used to calculate precision (repeatability) of an analyzer on a quarterly basis. 
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 PRIMARY STANDARD - Method, device, or material having known, stable, 
measurable, and readily-reproducible characteristics. 

 
 REFERENCE CALIBRATOR - Equipment brought to the monitoring station to 

generate gas concentrations for analyzer or in-station calibrator adjustments.  This 
equipment is typically a calibrator that is not normally used to make routine zero, 
precision, or span checks to an analyzer.  The flow devices and calibration standards are 
different from those in the in-station calibrator. 

 
 SPAN CHECK - The method of determining the relationship between a known 

concentration or known electrical impulse generated from a calibrator and the response 
measured by an analyzer or sensor.  This check is used to verify analyzer performance.  
Span check results demonstrate whether or not the instrument is performing within 
control limits.  Typically a high level value at approximately 80% of the full scale 
measurement capability of the instrument under test. 

 
 TRANSFER STANDARD - (Secondary Standard) A method, device, or material that is 

calibrated against a primary standard for comparison with a third method, device 
(analyzer), or material. 

 
6.0 REFERENCES 
 
Environmental Protection Agency (EPA), 2008, Quality Assurance Requirements for SLAMS, 

SPMs and PSD Air Monitoring, 40 CFR 58, Appendix A. 
 
Environmental Protection Agency (EPA), December 2008, Quality Assurance Handbook for Air  
          Pollution Measurement Systems: Volume II, Ambient Air Monitoring Program.              
  (EPA-454/B-08-003). 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of Thermo Environmental Instruments Model 49C or 49i ozone analyzers and 
transfer standards. This TI is referenced in Standard Operating Procedure (SOP) 3100, 
Calibration of Ambient Air Quality Analyzers, and serves as a guideline to facilitate the 
following: 
 

• Performing calibration checks 
 

• Evaluating analyzer response 
 

• Calibrating (adjusting) the analyzer 
 

• Performing analyzer maintenance 
 

• Replacing analyzer components 
 
 Calibrations (including multipoint, zero, and span) are required under any of the 
following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of six months 

 
 Continuous gas analyzer calibrations will follow protocols as established by 
EPA/600/4-77/027a Quality Assurance Handbook for Air Pollution Measurement System: 
Volume II, and Appendix B of 40 CFR 58 Quality Assurance Requirements for Prevention of 
Significant Deterioration (PSD) Air Monitoring. All measurement devices and calibration 
standards will be traceable to the National Institute of Standards and Technology (NIST). 
 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration schedule and coordinate with the client as 
necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 
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• Review calibration results. 
 

• Identify inconsistencies in calibration results and initiate corrective action as 
required. 

 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Verify that the calibration standards are in good working order and are in current 
calibration. 

 
• Document all calibration results and maintenance procedures performed. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment is required for ozone analyzer calibration: 
 

• Digital voltmeter (DVM) 
 

• Certified O3 transfer standard or verified O3 primary standard 
 

• Zero air supply 
 

• Clean Teflon tubing and fittings 
 

• Field service tools 
 

• Model 49C or 49i instrument manual 
 

• Station log book 
 

• Ozone calibration forms 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel spreadsheet form (Calibrations_edits.xlt) and 
CALCU and SolarAz program software 

 
• Kimwipes 

 
• Non-metallic rod 

 
• Cotton swabs 

 
Replacement parts may include: 

 
• Ozone converter 

 
• Solenoid valve 
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• UV photometer lamp 

 
• Sample or calibration pump 

 
• Ozone generator lamp 

 
4.0 METHODS 
 
 The procedures described in this TI are specific to 49C and 49i analyzers and transfer 
standards.  Calibration and maintenance include tasks that are detailed in the following seven (7) 
subsections: 
 
 4.1 Preparation for Analyzer Calibration 
 4.2 Calibration Checks 
 4.3 Ozone Transfer Standard Preparation 
 4.4 Multipoint Calibration 
 4.5 Analyzer Maintenance 
 4.6 Post-Maintenance Calibration Checks 
 4.7 Documentation 
 
4.1 PREPARATION FOR ANALYZER CALIBRATION 
 
 Before performing a calibration check, ensure adequate preparation of the operational 
environment, calibration device (transfer standard), and the analyzer by determining the 
following: 
 

• The station is at the proper temperature. 
 

• Instruments are adequately warmed up. 
 

• Calibration documentation is current, complete, and available. 
 

• All required support tools, diagnostic equipment, supplies, and calibration forms are 
available. 

 
4.2 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance checks. Refer to Figure 4-1, Example Ozone Calibration Form, when 
performing calibration checks.  Document calibration activities on the pre- or post-calibration 
form as appropriate, and note all maintenance activities or replaced components in the 
“Comments” field. The form is available as an Excel spreadsheet and should be used at all times. 
Results of each calibration should be in both hardcopy and digital form. 
 
 Before introducing calibration gas into the analyzer, complete the following operational 
checks.  Should any operational check be out of suggested tolerance, complete the calibration 
check before any maintenance or adjustments are made. 
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Figure 4-1.  Example Ozone Calibration Form. 
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ANNOTATE DATA 
RECORDS 

Make an entry in the station log book and annotate the strip chart 
recorder and data acquisition system (DAS) indicating the date and 
time (beginning and ending) of the calibration and maintenance 
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on the Ozone Calibration Form: 
network and station name, current date, name of technician 
performing the calibration, and date of the last calibration and 
maintenance visit.  Also complete information regarding model 
and serial numbers of the instruments to be calibrated. 
 

DETECTOR FREQUENCY 
OUTPUT 

Check the “A” and “B” detector frequency output by selecting 
<MENU> (   ). Scroll to DIAGNOSTICS using the arrow 
buttons and select <ENTER> (      ). Then scroll to INTENSITIES 
using the arrow buttons and select <ENTER> (   ). This 
frequency is directly proportional to the UV source light output 
reaching the detectors. Record the display values on the Ozone 
Calibration Form (Figure 4-1) in the “Sample Frequency” 
column. Expected values are 70 to 120 kHz.  
 

PRESSURE / 
TEMPERATURE 

Select <MENU> (    ). Scroll to DIAGNOSTICS using the arrow 
buttons and select <ENTER> (    ). Scroll to PRESSURE using 
the arrow buttons and select <ENTER> (    ) to display the cell 
pressure (in mmHg). Select <MENU> (    ) two more times to 
display the bench temperature. Record both values in the “Cell 
Temp/Pressure” column. 
 
NOTE:  Make sure the temperature correction and pressure 
correction are turned on so the ozone measurement is 
automatically corrected for temperature and pressure. Select 
<MENU> (  ), scroll to INSTRUMENT CONTROLS 
(<ENTER>) (     ), then to TEMP CORRECTION (or PRESSURE 
CORRECTION) (<ENTER>) (   ) and make sure both are 
selected “ON.”  
 

FLOW RATE CHECK Check the flow rate by selecting <MENU> (   ). Scroll to 
DIAGNOSTICS using the arrow buttons and select 
<ENTER> (    ). Scroll to FLOWS using the arrow buttons and 
select <ENTER> (    ). Record the values in the “Sample (lpm)” 
field of the calibration form. The flow rates should be even and 
show between 0.500 and 0.750 lpm for each cell. 

 
4.3 OZONE TRANSFER STANDARD PREPARATION 
 
 To prepare the ozone transfer standard: 
 
TURN ON Turn the transfer standard on and allow it to warm up for at least 

one hour. 
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CONNECT ZERO AIR 
SUPPLY 
 

Connect a zero air supply to the “ZERO AIR” inlet port. 

CONNECT TEFLON 
TUBING 

Connect a clean length of Teflon tubing from one “OZONE 
OUTPUTS” port of the transfer standard to the “INLET” port of 
the ozone analyzer. Be sure to provide a single vent via a Teflon 
tee on the calibration input line. 
 

CAP PORTS Cap all other “OZONE OUTPUTS” ports. 
 

COMPLETE CHECKS Complete and record the operational checks of the transfer 
standard as detailed on the Ozone Calibration Form. 

 
 Ozone transfer standards are verified (re-certified) using similar methods as calibrating a 
photometer-based ozone analyzer. Refer to SOP 3300, Certification of Ozone Transfer 
Standards, for re-certification procedures. 
 
4.4 MULTIPOINT CALIBRATION 
 
 The following subsections describe the steps of a five-point calibration check.  Calibration 
of an instrument infers an adjustment to the instrument response after a calibration check. 
 
4.4.1 Initiate Calibration 
 
TURN ON Place the instrument into Local Mode (<ENTER>) (   ) and 

select ZERO (<RUN>) (►). Make sure zero air is being 
supplied to the instrument. Turn the “sample pump” of the 
transfer standard on. 
 

ADJUST FLOW Adjust the transfer standard output flow appropriately. Adjust 
the pressure ozone generator regulator to ensure some airflow 
out the vent. Zero air is now flowing to both the transfer standard 
and the analyzer. 
 
Allow the instruments to stabilize and record the responses of 
both the transfer standard and analyzer on the Ozone Calibration 
Form as described in Section 4.4.2. 
 

GENERATE OZONE 
 
 
 
 
 
 
 
 
 
 

Known concentrations of gas that cover the response range of 
the analyzer are introduced. Select the desired ozone 
concentration output by incrementing the <RUN> (►) button to 
Level 1. Concentration ranges must include: 
 
0.0 to 0.5 ppm range  0.0 to 1.0 ppm range 
0.000 ppm   0.000 ppm 
0.350 to 0.450 ppm  0.700 to 0.900 ppm 
0.300 to 0.350 ppm  0.350 to 0.450 ppm 
0.150 to 0.200 ppm  0.300 to 0.350 ppm 
0.030 to 0.080 ppm  0.150 to 0.200 ppm 
    0.030 to 0.080 ppm 
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GENERATE OZONE 
(continued) 

Allow the values to stabilize and record the responses of the 
transfer standard and ozone output on the Ozone Calibration 
Form as described below in Section 4.4.2. 
 
Select additional ozone concentrations by selecting <MENU> 
(   ). Scroll to INSTRUMENT CONTROLS using the arrow 
buttons and select <ENTER> (   ). Scroll to OZONATOR 
LEVEL 1 using the arrow buttons and select <ENTER> (    ). 
Use the arrows to increase or decrease output concentrations. 
Record the analyzer and transfer standard responses on the 
Ozone Calibration Form. 

 
4.4.2 Record and Evaluate Analyzer Response 
 
 The following steps must be performed while calibrating the analyzers: 
 
RECORD ANALYZER 
RESPONSE 

Allow the analyzer to fully respond and stabilize on each of the 
five introduced gas concentrations. If response fails to stabilize, 
abort the calibration check, investigate the problem, and take 
corrective action. After the analyzer response stabilizes, note and 
record the analyzer front panel display, analyzer voltage output, 
and data acquisition response on the calibration form (or laptop 
computer Excel spreadsheet) and on the strip chart. 
 

CALCULATE Δ% Review the percent difference (<%) between the designated input 
and analyzer response calculated by the Excel calibration 
spreadsheet, or, if not automatically calculated by the  spreadsheet, 
calculate the percent difference (<%) with the following formula: 

Example: 

  

 

Note: Use the data acquisition system recorded response for the 
 analyzer response. 

AVERAGE Δ%’S Average the Δ%'s for all concentrations. Make sure to retain the 
correct signs (+ or -) during the calculation. Do not include the 
zero values in the Δ% calculations. 
 

REVIEW DATA 
 
 
 
 

Review the data to determine if analyzer adjustment (calibration) 
is required: 
 
If the slope is <0.950 or >1.050, analyzer adjustment or repair is 
required. 

100% x
InputDesignated

InputDesignatedponseResAnalyzerDifference −
=

%5.2100
400.0

400.0410.0% =
−

=Δ x
ppm

ppmppm
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REVIEW DATA (continued) 

 
If the intercept is >0.3 ppm, analyzer adjustment or repair is 
required. 
 
If the correlation is <0.9950, analyzer adjustment or repair is 
required. 
 

4.4.3 Calibrate (Adjust) Analyzer 
 
 The calibration factors set the effective span on the analyzer. The nominal value is 1.000. 
Adjust the O3 Coefficient to compensate for an under- or over-reporting instrument. In a 
properly operating instrument, any coefficient or background correction should be small (e.g., 
±0.1 for coefficient, ±5 for offset). 
 
 A certified transfer standard is required to adjust based upon known designated inputs. 
All maintenance activities must have been completed prior to this procedure. 
 
CONFIGURE ANALYZER Configure the analyzer and transfer standard as described in 

Sections 4.2 and 4.3. 
 

ADJUST ZERO Introduce zero air into the analyzer. Select <MENU> (    ), scroll 
to CALIBRATION (<ENTER>) (    ) then scroll to CALIBRATE 
ZERO (<ENTER>) (    ), and set to 0.0 when the instrument has 
stabilized.  
 

INTRODUCE OZONE Introduce a concentration of ozone approximately 80% of the 
operating full scale of the analyzer. 
 

ADJUST O3 COEFFICIENT Allow the analyzer to stabilize and adjust the O3 Coefficient 
until the analyzer output agrees with the designated input as 
reported by the transfer standard. In the Local Mode, select 
<MENU> (     ), scroll to CALIBRATION (<ENTER>) (    ) 
then scroll to CALIBRATE O3 (<ENTER>) (    ), and adjust the 
instrument for the proper response. 
 
CAUTION: Take care to operate the unit under calibration in 
  the exact condition it will be in while in routine 
  operation.  For instance: 

  -  Is the top on? 

  -  Is it positioned normally in the rack? 

  - Is the calibration pump turned on? (transfer standard)  
 
 Failure to calibrate the instrument in the exact condition in which it is operated may 
affect the absorption cell temperature. A multipoint calibration check must follow a O3 
Coefficient adjustment. 
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 Calibrations (adjustments) of continuous analyzers (other than zero) should be performed 
only after a pre-maintenance multipoint calibration check. A post-maintenance multipoint 
calibration check must follow an instrument adjustment. 
 
4.5 ANALYZER MAINTENANCE 
 
 A complete multipoint calibration check must be performed prior to (pre) and following 
(post) any maintenance activity. Analyzer maintenance should be performed on a semiannual 
basis. Replacement of consumable components will generally be required annually under most 
monitoring conditions. 
 
SYSTEM LEAK CHECK Remove the sample line from the “SAMPLE INLET” on the rear 

panel of the analyzer and hold your finger over the “SAMPLE 
INLET.” The sample flow, as indicated in DIAGNOSTICS 
should drop to “0.0” and stay at “0.0.” If it does not drop to 
“0.0,” there is a leak in the system that must be found and sealed. 
Tighten all fittings to and from the solenoid, scrubber, and 
absorption tube to alleviate the leak. 
 

SAMPLE PUMP 
REPLACEMENT 

A pump needs replacement whenever it cannot maintain at least 
0.5 lpm of flow. Intermittent starting or noisy bearings may also 
indicate need of replacement. Replacement of the pump is 
straightforward: 
 
• Unplug the instrument. 
 
• Unplug the pump from its motherboard connector. 
 
• Loosen and remove the four nuts from the bottom of the 

instrument. 
 
• Remove the pneumatic fittings and remove the pump. 
 
Installation is a reversal of the above procedures. Make sure to 
mark the pump with the date of installation. 
 

ABSORPTION CELL TUBE 
CLEANING 
 
 
 
 
 
 
 
 
 
 

Low detector frequencies (less than 70.0 kHz) may indicate 
contaminated absorption tubes or dirty mirrors. Inspect and clean 
them if necessary using the following procedures: 
 
• Remove the two absorption tubes and carefully pass a 

Kimwipe through each using a non-metallic rod. Do not pass 
any metal-tipped rod through the tubes. Use a wooden dowel 
or a length of ¼” Teflon tubing. This procedure will remove 
loose dust particles only. Any permanent (fixed) 
imperfections will not disturb the measurement process. 
After cleaning the tubes with a Kimwipe, blow them out with 
clean, oil-free air. 
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ABSORPTION CELL TUBE 
CLEANING (continued) 

 
• Use a cotton swab to access the window surfaces through the 

holes that the absorption tube fits into. 
 
• Leak check the reassembled analyzer as described above. 
 

OZONE CONVERTER 
REPLACEMENT 

The ozone converter should be replaced as necessary. Low span 
response could be attributed to a contaminated converter.  
Replace the converter as follows: 
 
• Loosen the tube fittings on each end of the converter. 

Remove the converter. 
 
• Replace the converter by reversing the above procedure. 

Make sure the fittings are tight. 
 
• Mark the converter with the replacement date and perform a 

system leak check as described above. 
 

UV LAMP 
REPLACEMENT 
 
 
 
 
 
 
 
 
 
 
 

The ultraviolet lamp (photometer lamp) requires replacement 
only when it fails, becomes excessively noisy, or when the 
detector frequency cannot be adjusted above 70.0 kHz. 
 
Lamp Replacement 
 
• Remove the old lamp by unplugging the three-wire 

connector. 
 
• Remove access hold cover on the back panel. 
 
• Loosen the Allen screw on the lamp holder and two screws 

holding the lamp to the base. 
 
• Slide the lamp out of the bench and instrument case through 

the access hole. 
 
• To replace the lamp, reverse the procedure. 
 
• Write the replacement date on a tag and attach it to the lamp 

wire. 
 
• After the lamp has stabilized (approximately 15 minutes), 

adjust the detector frequencies as described below. 
 
WARNING: DO NOT LOOK AT THE ILLUMINATED 
LAMP WITH THE NAKED EYE.  Permanent retina damage 
could result. 
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DETECTOR FREQUENCY 
ADJUSTMENT 

The detector frequency is proportional to the amount of light 
transmitted through the optical system. A wide range of 
frequencies can be tolerated, however, optimum values are 80 to 
120 kHz. 
 
Frequencies will decrease over time, as the lamp ages, and as the 
optical system gathers dirt. Make no adjustments until the optical 
path has been cleaned (see Absorption Cell Tube Cleaning). 
 
Adjust Frequencies 
 
• Place the instrument into Service Mode. 
 
• Select Lamp Setting. 
 
• Use arrows to adjust intensities to 80-120 kHz. 

 
4.6 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Sections 4.2 through 4.4 of this TI. 
 
4.7 DOCUMENTATION 
 
 Analyzer calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely for each analyzer calibrated and for 
all transfer standard certifications. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration 
forms. 
 

STRIP CHARTS Strip chart records should be annotated to clearly document 
standard response. 
 

LOG NOTES A copy of all log notes summarizing work performed and results 
of the certification. Note any abnormalities in standard 
operation. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the analyzer, marking 
the date the instrument was certified and the name of the 
technician who calibrated it. 
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  Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 

 
5.0 REFERENCES 
 

Environmental Protection Agency (EPA), 1989, Quality Assurance Requirements for 
Prevention of Significant Deterioration (PSD) Air Monitoring, 40 CFR 58, 
Appendix B. 

 
Environmental Protection Agency (EPA), July 1984, Quality Assurance Handbook for Air 

Pollution Measurement Systems: Volume II. (EPA/600/4-77/027a). 
 
Thermo Electron Corporation, 2004, Model 49C UV Photometric O3 Analyzer Instruction 

Manual, April, Franklin, MA. 
 
Thermo Electron Corporation, 2006, Model 49i UV Photometric O3 Analyzer Instruction 
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1.0 PURPOSE AND APPLICABILITY 
 
 This standard operating procedure (SOP) is a guide for performing weekly checks and 
periodic calibration and maintenance to various meteorological sensors. The purpose of this 
document is to provide calibration and maintenance procedures that will assure quality data 
capture and minimize data loss of the following sensors: 
 

• Wind speed 
 
• Wind direction 
 
• Temperature/delta temperature 
 
• Relative humidity 
 
• Solar radiation and net radiation 
 
• Barometric pressure 
 
• Precipitation 
 
• Wetness 
 
• SODAR (including RASS)-measured vertical wind and thermal profiles 

 
 Detailed manufacturer’s specific calibration procedures are not included in this SOP.  
Separate technical instructions (TIs) are developed for each specific monitoring system. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 
• Upon installation or removal of the instrument at a field station 
 
• Whenever control limits are exceeded 
 
• Prior to any corrective action, service, or maintenance to any portion of the 

instrument that affects its operation  
 
• At a maximum interval of six months 

 
 Meteorological calibrations will follow guidelines established in EPA-600/R-94/038d 
(March 1995), Quality Assurance Handbook for Air Pollution Measurement Systems: Volume 
IV.  Meteorological Measurements. All measurement devices and calibration standards will be 
traceable to the National Institute of Standards and Testing (NIST). 
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2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 
 
• Review calibration results. 
 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 
• Review and approve any changes to calibration procedures. 

 
2.2 FIELD SPECIALIST 
 

The field specialist shall: 
 
• Perform required calibrations and maintenance as described in instrument- or system-

specific TIs. 
 
• Document all calibration results and maintenance procedures performed. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Depending upon the sensor and manufacturer, the following equipment may be required: 
 

• Topographic maps of the area 
 
• Protractor 
 
• Magnetic compass and tripod 
 
• Decade resistence box 
 
• Digital voltmeter (4-1/2 digit) 
 
• Field service tools 
 
• Tower climbing belt and safety equipment 
 
• Station log book 
 
• Electronic calibration forms 
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• Pen or pencil 
 
• Laptop computer loaded with Excel workbook (Calibrations_edits.xlt) and CALCU 

program software 
 
• ARS calibration stickers 
 
• Calibrated (transfer standard) hand-held barometer 
 
• R.M. Young Model 18801 variable speed calibration motor 
 
• Notched compass wheel and wind direction linearity test jig 
 
• Torque disc and weights 
 
• Repair/replacement parts including wind speed and wind direction rebuilt parts 

(bearings and potentiometer) 
 
• R.M. Young Model 18801 anemometer drive motor 
 
• Model 18112 vane angle bench stand 
 
• Calibrated thermometers: -20° to +10°C, 0° to +30°C, and +20° to +50°C 
 
• Thermos bottles 
 
• One gallon of distilled water 
 
• Crushed ice 
 
• Portable water heater or hot water 
 
• Reference relative humidity sensor and audit aspirator 
 
• Reference solar and net radiation sensors 
 
• Campbell Scientific 21XL datalogger 
 
• Campbell Scientific 21XL datalogger manual 
 
• Instrument manuals for the specific meteorological sensors applied (e.g., 

Climatronics, Campbell Scientific, R.M. Young, Licor, etc.) 
 
4.0 METHODS 
 
 Meteorological systems must be dynamically checked (pre-maintenance calibration) 
before any adjustments are made to the signal conditioning software instructions or before 
servicing the meteorological sensors. Throughout the calibration and maintenance period, the 
datalogger, calibration forms, and strip chart (if used) must be annotated to indicate that data 
taken during the calibration period should not be included as standard observations. 
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 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensor. The 
pre- and post- maintenance calibration techniques are identical. Do not adjust the signal conditioning 
cards or perform any maintenance to the sensors until all pre-calibration checks are completed. 
 
 Calibration and maintenance include tasks that are detailed in the following five (5) 
major subsections: 
 
 4.1 Calibration Checks 
 4.2 Sensor Adjustments 
 4.3 Sensor Maintenance 
 4.4 Post-Maintenance Calibration Checks 
 4.5 Documentation 
 
4.1 CALIBRATION CHECKS 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and time 
(beginning and ending) of the calibration and maintenance 
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 

 
Complete the following fields on the appropriate calibration form: 
network and station name; current date; name of technician 
performing the calibration; manufacturer, model, and serial 
number of the instrument; and date of the last calibration. 
 

RECORD READINGS Connect a digital voltmeter (DVM) to the output of each sensor 
or signal conditioning card under calibration. Simultaneously 
record the  pre-maintenance DVM and DAS readings of the 
sensor under calibration and the output or values of the reference 
sensor or measuring device. Repeat recording after maintenance 
or adjustment (post-) for each sensor. 

  
Both pre- and post-maintenance calibrations of all sensors are required. Throughout the calibration 
and maintenance period, the datalogger, calibration forms, and strip chart (if used) must be 
annotated to indicate that data taken during the period should not be included as standard 
observations. Calibrations of sensors will be made by the field specialist in the following manner: 
 
WIND DIRECTION 
 
 
 
 
 
 

Orientation - Two horizon landmarks will be identified and the 
azimuth determined from a topographic map, compass or 
previous survey. Some situations may allow the use of a GPS. 
Use care to adjust the compass for proper declination or use the 
solar azimuth method in the CALCU program and laptop 
computer. The sensor’s vane will be pointed to each landmark, 
and the recorded output logged on the wind direction calibration 
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WIND DIRECTION 
(continued) 

form. The tail of the vane will then be aimed at each landmark 
and the outputs recorded. The difference between the designated 
landmark azimuths and the sensor indicated value will be 
calculated and averaged. Averaged differences of greater ±5° will 
require reorientation of the sensor. 
 
 Linearity - For vane-type sensors (Climatronics, Qualimetrics, 
etc.), affix the linearity test fixture to the wind direction sensor 
and replace the vane with the compass wheel. Cycle the index 
wheel through each of the eight 45° increments on the compass 
wheel, and record the values from each indexed location. If any 
value is greater than ±3° from 45° increments, the sensor is 
non-linear and requires service. 
 
 Use the R. M. Young vane angle fixture for prop-vane-type 
sensors, and follow similar procedures. 
 
 Starting Threshold - Affix the torque arm to the wind direction 
vane.  Deflect the vane, noting the grams of torque required to 
deflect it. Consult the appropriate TI for the instrument-specific 
threshold limit.  Sensors over limit require service. 
 

WIND SPEED 
(HORIZONTAL OR 
VERTICAL) 

Motor Response - Remove the anemometer cups or propeller 
from the sensor and mount the R. M. Young Model 18801 
variable speed motor assembly to the sensor shaft. Consult the 
appropriate sensor-specific TI to select appropriate test rpm levels 
(generally 4 or 5 levels from low to high rpms are tested). Record 
the sensor’s output for each tested rpm level on the Wind Speed 
Calibration Form. Refer to the applicable TI for designated wind 
speed values for suggested rpms. The measured instrument 
response must be within 5% of the designated value plus the 
sensor starting threshold. 
 
 Starting Threshold - Hold the sensor in the horizontal position 
and replace the anemometer cups or propeller with a torque disc.  
Adjust the weight on the torque disc until the starting threshold is 
determined.  Record the starting threshold and compare the value 
with the designated value in the appropriate TI. Any sensor 
exceeding its designated value requires service. 
 

IMMERSIBLE 
TEMPERATURE 

Remove the temperature probe from the aspiration system and 
suspend it in a water bath along with a certified  thermometer. 
Agitate the water bath until both the thermometer and sensor 
responses stabilize. Record values on the ARS temperature 
 calibration form.  Three baths should be prepared:  ice bath, 
ambient (about 20°C), and high range (40°-50°C).  Compare each 
measured bath temperature and instrument response. Any 
difference greater than the sensor-specific threshold (refer to 
appropriate TI) requires investigation and corrective action. 
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DELTA ( ) 
TEMPERATURE 
(TEMPERATURE 
DIFFERENCE) 

Remove both temperature and delta temperature probes from their 
aspirators and place them together in a water bath along with a 
certified thermometer. Agitate the water bath until the thermometer 
and sensor responses stabilize.  Record the values on the ARS 
calibration form. Prepare three baths:  ice bath, ambient (about 
20°C), and high range (40°-50°C), and repeat the procedure. The 
delta temperature value should not exceed the system-specific 
threshold (refer to the appropriate TI) at any bath temperature. 
 

NON-IMMERSIBLE  
TEMPERATURE 

The calibration of a thermistor/capacitive resistance-type air 
temperature sensor can be determined by comparing the ambient 
measurement to a transfer standard capacitive-resistance sensor. The 
on-site sensor and the transfer standard sensor should be aspirated or 
shielded in a similar manner. Temperature value differences greater 
than 3°C indicate the need for a replacement sensor. 
 

RELATIVE HUMIDITY Place the appropriate RH reference device and calibrated probe onto 
the forced-aspirated sensor housing. Attach the reference sensor to 
the 21XL datalogger and enter the appropriate program.  Allow as 
much time as possible (minimum of 3 hours) and compare the 
reference values with the sensor values. Follow comparison 
guidelines in the appropriate TI for replacement protocol. 
 

SOLAR RADIATION 
AND/OR NET 
RADIATION 

Attach a reference solar (or net) radiation sensor to the existing solar 
(or net) radiation support bracket. Connect the reference output to a 
datalogger and record several hours’ values. Compare values with 
data from the station’s solar (or net) radiation sensor. If comparisons 
exceed ±5%, corrective action will be required. 
 

SOLAR  (OR NET) 
RADIATION 
(ALTERNATE METHOD) 

Attach a reference solar (or net) radiation sensor to the existing 
solar (or net) radiation sensor support bracket. Ideally, several 
simultaneous measurements over 15-minute averaging periods 
will be taken over several hours with both the reference sensor 
and the on-site sensor. The average of all comparisons must be 
within ±5% of the reference sensor. If comparisons exceed ±5%, 
corrective action will be required. 
 

BAROMETRIC 
PRESSURE 

A reference (transfer standard) barometric pressure sensor will be 
used to record the on-site pressure simultaneously with the station 
sensor. The station sensor must be within ±.04 in hg (±1.5 mb) of 
the reference sensor. Corrective action, including sensor 
replacement, is required if the station sensor readings are 
beyond limits. 
 

PRECIPITATION 
 
 
 
 

A 900 ml calibration bottle will be used to drip (at a controlled 
rate) a volume into the tipping bucket rain gauge.  The number of 
tips will be recorded and compared to the designated value noted 
in the appropriate TI. Any discrepancy of ±5% will require 
corrective action. 



             Number 3150 
             Revision 3.6 
             Date NOV 2009 
             Page 7 of 9 
 

 

PRECIPITATION 
(continued) 

Weighing rain gauges will be calibrated by using a manufacturer 
supplied calibration weight set or water volume-based weight 
calibration unit. Any discrepancies of ±5% will require corrective 
action. 
 

WETNESS The leaf wetness sensor indicates whether liquid water is present 
on surfaces. To verify the operation of the sensor, deposit or 
spray water on the sensor. The output should go to its maximum 
value. Dry the sensor and verify that the sensor goes to its 
minimum value.  Any noted malfunction will require replacement 
of the sensor. 
 

SODAR Manufacturer-specific SODAR (including RASS options) 
diagnostic programs are run using the SODAR’s computer. 
Indicated error codes will isolate the potential system component 
requiring repair or replacement. Comparisons between 
measurements made at specific SODAR (and/or RASS) levels 
and adjacent tower, radiosonde, or tethersonde measurements can 
also be employed to verify system measurement accuracies. All 
tests are system- and site-configuration specific. 
 

SIGNAL CONDITIONING 
CARDS 

Signal conditioning cards will be individually tested for their 
internal zero and span reference checks. These values are 
recorded on the ARS calibration form. Any recorded value 
greater than ±0.1% of the designated value will require 
adjustment. The appropriate sensor will require a post-calibration 
if signal card adjustment was required. 

 
4.2 SENSOR ADJUSTMENTS 
 
 Consult the manufacturer for instructions if a large offset or adjustment is needed. 
 
WIND DIRECTION Reorient the sensor if adjustment is necessary. 

 
 

WIND  SPEED No adjustments are applicable. The sensor must be rebuilt or 
replaced. 
 

TEMPERATURE/ 
 DELTA ( ) 
TEMPERATURE 

Adjustments are only possible at the translator card or datalogger. 
 
 
 

RELATIVE HUMIDITY Field adjustment or repair is not recommended. If the sensor 
response is outside of specification or if the sensor has operated 
in the field for more than 5 months, replace it with a 
factory/laboratory calibrated unit. 
 

BAROMETRIC 
PRESSURE 

A trim potentiometer is normally available on the instrument for 
offset fine adjustment. 
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SOLAR (OR NET) 
RADIATION 

Adjustments are only possible at the translator card or datalogger. 
 
 

PRECIPITATION Adjust the tip sensitivity as necessary. 
 

WETNESS Adjust the sensitivity and voltage range as necessary. 
 

SODAR Adjust the physical alignment as required. Adjustments to the 
sensitivity, profile increments, and other system characteristics 
are performed through software options. 

 
4.3 SENSOR MAINTENANCE 
 
WIND DIRECTION Replace the potentiometer and bearings if necessary. 

 
 

WIND SPEED Inspect the sensor chopper disc and clean if necessary. Replace the 
sensor if response remains beyond tolerance. Replace the sensor 
bearings if the starting threshold is greater than the designated value. 
 

TEMPERATURE/ 
DELTA ( ) 
TEMPERATURE 

Inspect the temperature probe(s) and electrical connections for 
cleanliness and electrical continuity. Correct if necessary. Inspect 
the aspirator housing(s) and clean if any dirt or cobwebs have 
accumulated. Inspect the aspirator motor(s) and replace if necessary. 
 

RELATIVE HUMIDITY Field adjustment or repair is not recommended. If the sensor 
response is outside of specification or if the sensor has operated 
in the field for more than 5 months, replace it with a factory 
calibrated unit. 
 

BAROMETRIC 
PRESSURE 

Field repair other than offset adjustment is not recommended. 
Replace with a calibrated unit. 
 

SOLAR (OR NET) 
RADIATION 

Inspect and clean the sensor optics. Verify the sensors are level. 
Verify signal connections. 
 

PRECIPITATION Clean the system funnel, screen, tip buckets, and mechanisms. 
Adjust the tip sensitivity as required. Verify signal connections 
and electrical heater connections. 
 

WETNESS Clean the grid, adjust the sensitivity so that the sensor switches on at 
240 Kohms, and adjust the voltage range to output 1.00 VDC (100%) 
when wet and 0.00 VDC (0%) when dry. Verify signal connections. 
 

SODAR Run system diagnostic tests and procedures, mechanically align 
the antenna and clean antenna and transponder surfaces, verify all 
electrical and signal connections, and verify control computer 
operation. Maintenance procedures are instrument- and 
manufacturer-specific. 
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4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record the obtained values as the post-
maintenance values. 
 
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained.  Review and sign all calibration forms. 
 

LOG NOTES A summary of the calibration and maintenance activities must be 
included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

CALIBRATION 
STICKER 

An ARS calibration sticker is placed on the sensor, marking the 
date the instrument was calibrated and the name of the technician 
who calibrated it. 
 

TRIP REPORT Calibration and maintenance activities are documented in a 
written site trip report. 
 

MAINTENANCE CARDS The sensor-specific maintenance card must be kept current to 
indicate the most recent calibration, repair, and location of the 
sensor. 

 
5.0 REFERENCES 
 
Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution  
  Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
 EPA-454/B-08-002  (March). 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details to dynamically calibrate: 
 

• A Climatronics modular meteorological station (MMS) F460. 
 

• A Qualimetrics 1220/1250-A wind speed and wind direction system. 
 
 Both systems include a power supply mainframe, signal conditioning card, and 
meteorological sensors. 
 
 The two meteorological systems described above have nearly identical components. The 
notable difference is that the Climatronics system incorporates both wind speed and direction 
signal conditioning on one card, while the Qualimetrics system uses individual cards for wind 
speed and direction. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 
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• Review calibration results. 
 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 

• Review and approve any changes to calibration procedures. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are generally required to calibrate and maintain 
wind speed and direction sensor systems: 
 

• Topographic maps of the area 
 

• Protractor 
 

• Magnetic compass 
 

• Digital voltmeter (4-1/2 digit) 
 

• R.M. Young Model 18801 variable speed calibration motor 
 

• Notched compass wheel and linearity test jig 
 

• Torque disc and weights 
 

• Station log book 
 

• Wind Speed/Wind Direction Calibration Forms 
 

• Pen or pencil 
 

• Laptop computer loaded with EXCEL workbook (NPS.XLT) and CALCU program software 
 

• Climatronics or Qualimetrics instrument manual 
 

• Tower climbing belt and safety equipment 
 

• Field service tools 
 

• ARS calibration stickers 
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4.0 METHODS 
 
 The wind system must be dynamically checked (pre-maintenance calibration) before any 
electrical adjustments are made to the signal conditioning cards or before servicing the 
meteorological sensors. Throughout the calibration and maintenance period, the datalogger, 
calibration forms, and strip chart (if used) must be annotated to indicate that data taken during 
the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre- and post-maintenance calibration techniques are identical. Do not adjust the signal 
conditioning cards or perform any maintenance to the sensors until all pre-calibration checks are 
completed. 
 
 The procedures described in this TI are specific to Climatronics F460 or Qualimetrics 
12XX wind speed and direction sensors. Calibration and maintenance include tasks that are 
detailed in the following four (4) major subsections: 
 
 4.1  Calibration Checks 
 4.2  Wind Direction Sensor 
 4.3  Wind Speed Sensor 
 4.4  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks.  Refer to Figures 4-1 and 4-2, Example Wind Speed 
Calibration Form and Example Wind Direction Calibration Form, respectively, when performing 
calibration checks. Be sure to indicate on the forms whether the calibration is pre- or post-
maintenance and note all maintenance activities or replaced components in the “Comments” 
field. The forms are available as an Excel spreadsheet and should be used for both pre- and post-
maintenance checks. Results of each calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and 
time (beginning and ending) of the calibration and maintenance
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on the calibration forms: network 
and station name; current date; name of technician performing 
the calibration; manufacturer, model, and serial number of the 
instrument; and date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance DVM and DAS 
readings of the sensor to be calibrated. 
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Figure 4-1.  Example Wind Speed Calibration Form. 
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Figure 4-2.  Example Wind Direction Calibration Form. 
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4.2 WIND DIRECTION SENSOR 
 
4.2.1 Sensor Checks 
 
ORIENTATION CHECK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The wind direction sensor orientation check includes the 
following procedures: 
 
• Use a compass, protractor, and topographic map to 

familiarize yourself with the surrounding terrain. 
 
• Identify two outstanding features on the topographic map. 
 
• Determine the azimuth (to the nearest degree) of the selected 

feature from a topographic map and/or from a magnetic 
compass. 

 
• Record the selected features, azimuth measured (degrees 

true), and magnetic declination used (available from a 
topographic map) on the calibration form, using a laptop 
computer and Excel spreadsheet software. An example Wind 
Direction Calibration Form is presented in Figure 4-2. 

 
NOTE: When using a compass, calculate degrees true using 

magnetic declination carefully. If the declination is 
easterly, increase the measured magnetic azimuth by 
the amount of declination. If westerly, decrease the 
reading. For example: Fort Collins, CO, uses a 
declination of 14° east. If a horizon landmark is 
measured by compass as 210°, the landmark is 224° 
true. 

 
• Connect a digital voltmeter (DVM) to the output of the wind 

direction signal conditioning card. 
 
• Climb the tower and align the nose of the wind direction 

vane toward landmark 1. 
 
• Alert your assistant to record the data acquisition system 

wind direction value, DVM reading, and strip chart recorder 
value on the calibration form as “To Landmark 1.” 

 
• Align the tail of the wind direction vane toward landmark 1. 
 
• Alert your assistant to record the DAS, DVM, and strip chart 

output values as “From Landmark 1.” 
 
• Repeat this procedure for the remaining landmark. 
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LINEARITY CHECK The wind direction sensor linearity check includes the following 
procedures: 
 
• Attach the wind direction linearity test jig to the wind 

direction sensor. 
 
• Replace the wind direction vane with the notched compass 

wheel. 
 
• Index the compass wheel into one of the four notches. 
 
• Alert the assistant to record the DAS, DVM, and strip chart 

recorder values. 
 
• Repeat the procedure for the remaining indexed positions. 
 

STARTING THRESHOLD 
CHECK 

The sensor bearing starting threshold check includes the 
following procedures: 
 
• Remove the sensor from the crossarm.  Remove the vane or 

cups. 
 
• Install the torque disc. 
 
• Hold the sensor horizontal and note the weight required to 

overcome the shaft rotational threshold. 
 

SIGNAL CONDITIONING 
CARD CHECK 

The signal conditioning card electronic balance check includes 
the following procedures: 
 
• Select “ZERO” (0) on the card mode switch and record the 

DAS and DVM values. 
 
• Select “SPAN” (360) on the card mode switch and record the 

DAS and DVM values. 
 
• Select “SPAN 540” (+360) on the card mode switch and 

record the DAS and DVM values. 
 

4.2.2 Evaluation of Sensor Checks 
 
 Evaluate the results of the wind direction calibration checks to determine if the following 
specifications are met: 
 
ORIENTATION CHECK “To” and “From” values should not be more than ±5° from any 

corresponding designated value. 
 

LINEARITY CHECK Results of the eight indexed positions should increase in 45°  
increments ±3°. 
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STARTING THRESHOLD Starting threshold of the sensor should not be greater than 6 
gm/cm. 
 

SIGNAL CONDITIONING 
CARD BALANCE 

ZERO (0), SPAN (360), and SPAN 540 (+360) position values 
should be within 1° of the following values:  
 

 

Position DAS 0-5.000 
VDC System

0-1.000 
VDC System 

0-10 
mVDC System 

zero (0) 
span (360) 
span 540 (+360) 

0 
360 
360 

0.000 
3.333 
3.333 

0.000 
0.667 
0.667 

0.00 
6.67 
6.67 

 
4.2.3 Sensor Adjustments 
 
 If checks are beyond the designated values, perform the following adjustments: 
 
ORIENTATION Re-orient the sensor if the alignment check indicated is greater 

than !5° difference at any point by: 
 
• Loosening the alignment collar on the crossarm. 
 
• Aligning the wind direction vane to known landmark. 
 
• Twisting the collar until the designated azimuth is achieved. 
 
• Tightening the alignment collar. 
 

SIGNAL CONDITIONING 
CARD 

Adjust the signal conditioning card to the below-mentioned 
designated values:  

CLIMATRONICS QUALIMETRICS 
Position Adjust 

Potentiometer 
Position Adjust 

Potentiometer 
zero 
span 

span 540 

R-34 
R-33 
R-47 

0 
360 

+360 

R-202 
R-201 
R-320 

    
 
4.2.4 Sensor Maintenance 
 
LINEARITY Replace the potentiometer if the linearity check indicates greater

than !2° deviation from the suggested values. Consult the 
manufacturer’s instruction manual for the proper procedure. 
 

STARTING THRESHOLD Replace the bearings if the starting threshold is greater than 6 
gm/cm. Consult the manufacturer’s instruction manual for the 
proper procedure. 
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4.2.5 Post-Maintenance Calibration Checks 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.2.1, and record them as the post-maintenance values. 
 
4.3 WIND SPEED SENSOR 
 
4.3.1 Sensor Checks 
 
MOTOR RESPONSE 
CHECK (FOUR-POINT) 

The wind speed sensor speed response check includes the 
following procedures: 
 
• Connect the DVM to the wind speed signal conditioning card 

output. 
 
• Remove the anemometer cups and attach the R. M. Young 

variable speed calibration motor to the sensor input shaft. 
 
• Adjust the calibrator for 300 rpm and allow the sensor to 

stabilize. 
 
• Alert the assistant to record the DAS, DVM, and strip chart 

recorder output on the calibration form. 
 
• Repeat the procedure for 600, 900, and 1800 rpm. 
 

STARTING THRESHOLD 
CHECK 

The sensor starting threshold check includes the following 
procedures: 
 
• Remove the sensor from the crossarm. 
 
• Attach the torque disc to the input shaft. 
 
• Note the weight, size, and position when the shaft first starts 

to turn. Bearings will need to be replaced if the starting 
threshold is greater than 2 gm/cm. 

 
SIGNAL CONDITIONING 
CARDS CHECK 

Check the signal conditioning card balance by adjusting the 
mode switch on the card to “ZERO” (LOW) and “SPAN” (HI) 
and recording the output on the calibration form. 
 

4.3.2 Evaluation of Sensor Checks 
 
 Evaluate the results of the wind speed sensor tests to determine if the following 
specifications are met: 
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SENSOR RESPONSE Measured instrument response must be within !5% of the 

designated value: 
 

 

CLIMATRONICS QUALIMETRICS 
 

RPM 
Designated Value 
(0-50 m/s range) 
(meters/second) 

Designated Value 
(0-100 mph range) 

(miles/hour) 

Designated Value 
(0-44.7 m/s range) 

(meters/second) 
300 
600 
900 

1800 

 7.3 
14.3 
21.4 
42.5 

15.2 
30.0 
44.7 
88.8 

6.8 
13.4 
20.0 
39.7 

STARTING THRESHOLD Starting threshold of the sensor should not be greater than 0.25 
m/s or 0.5 mph. 
 

SIGNAL CONDITIONING 
CARD 
 
 
 
 
 
 
 
 
 

Zero and span position values should be as follows (to within 
!0.005 VDC): 
 

CLIMATRONICS QUALIMETRICS 
 

Mod
e 

DAS 
(m/s)

Designated 
Value 

(0-5.000 VDC 
System) 

 
Mode

DAS 
(mph) 

DAS 
(m/s) 

Designated 
Value 

(0-5.000 VDC 
System) 

Zero
Span

0.2 
25.0 

0.020 
2.500 

Low 
Hi 

0.4 
45.3 

0.2 
20.2 

0.020 
2.265  

4.3.3 Sensor Adjustments 
 
 No adjustments can be made to these sensors. 
 
4.3.4 Sensor Maintenance 
 
 If checks are beyond the values, perform the following maintenance: 
 
SENSOR RESPONSE Inspect the sensor chopper disc and clean if necessary.  Replace 

the sensor if response remains beyond tolerance. 
 

STARTING THRESHOLD Replace the sensor bearings if the starting threshold is greater 
than the designated value. 

 
4.3.5 Post-Maintenance Calibration Checks 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.3.1, and record them as the post-maintenance values. 
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4.4 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration 
forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in 
sensor or calibration operation that could affect the quality of 
data. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the sensor, marking the 
date the instrument was calibrated and the name of the 
technician 
who calibrated it. 
 
 
 
 
  
                          
               

Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip
report. 
 

5.0 DEFINITIONS 
 

Calibration Oscillator:  A component housed in the mainframe that supplies a test input to 
the wind speed signal conditioning card when the “span” (high) mode is selected. 

 
Dynamic Check:  A dynamic check implies subjecting a sensor to known conditions 
similar to those conditions under normal sampling. A dynamic check of a wind direction 
sensor would be to point the vane to a known landmark and comparing the sensor output 
with the measured landmark azimuth. 

 
Mainframe:  The 19-inch wide card cage that physically holds and electrically connects 
the signal conditioning cards. The mainframe also holds the system power supply. 

 
Power Supply:  The modular component that supplies positive and negative operating 
voltages to the signal conditioning cards. 
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Signal Conditioning Card:  An electronic circuit card that provides operational voltages to 
the meteorological sensor and converts the raw sensor signal to a linear analog output 
suitable for recording. The signal conditioning card is housed in a mainframe that is 
typically near the data acquisition system. Signal conditioning cards are also referred to as 
“translator cards.” 

 
Zero, Span, Span 540 (0, 360, +360):  Internal self-check switch positions on the signal 
conditioning cards that when selected, they supply stable known test conditions to the 
signal conditioning card. 

 
6.0 REFERENCES 
 
Climatronics Corporation, 1986, Instrument Manual, October. Bohemia, NY. 
 
Qualimetrics, Inc., 1986, Meteorological System Manual, March. Sacramento, CA. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of Climatronics F460 wind speed and wind direction sensors used with a Campbell 
Scientific 21XL or CR23X datalogger. This TI assumes general operating knowledge of the 
21XL or CR23X datalogger and only details the instructions and commands specific to the wind 
measurement system. The 21XL or CR23X datalogger supplied sensor power and signal 
conditioning eliminates the need for separate sensor power supply and signal conditioning cards. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 
• Upon installation or removal of the instrument at a field station 

 
• Whenever control limits are exceeded 

 
• Prior to any corrective action, service, or maintenance to any portion of the 

instrument that affects its operational principle 
 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 
• Review and approve any changes to calibration procedures. 

 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 
• Document all calibration results and maintenance procedures performed. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for Climatronics F460 wind speed 
and wind direction sensors (used with a Campbell Scientific 21XL or CR23X datalogger) 
calibration: 
 

• Topographic map with alignment landmarks 
 

• Protractor 
 

• Magnetic compass and tripod 
 

• Digital voltmeter (4-1/2 digit) 
 

• R.M. Young Model 18801 variable speed calibration motor 
 

• Notched compass wheel and linearity test jig 
 

• Torque disc and weights 
 

• Climatronics instrument manual 
 

• Campbell Scientific 21XL or CR23X datalogger manual 
 

• Tower climbing belt and safety equipment 
 

• Field service tools 
 

• Station log book 
 

• Wind Speed and Wind Direction Calibration Forms 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel workbook (Calibrations_edits.XLT) and CALCU 
program software 

 
• Repair/replacement parts including wind speed and wind direction rebuilt parts 

(bearings and potentiometer) 
 

• ARS calibration stickers 
 
4.0 METHODS 
 
 The wind system must be dynamically checked (pre-maintenance calibration) before any 
adjustments are made to the signal conditioning software instructions or before servicing the 
meteorological sensors. Throughout the calibration and maintenance period, the datalogger, 
calibration forms, and strip chart (if used) must be annotated to indicate that data taken during 
the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensor.  
The pre- and post- maintenance calibration techniques are identical. Do not adjust the signal 
conditioning program or perform any maintenance to the sensors until all pre-calibration checks 
are completed. 
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 The procedures described in this TI are specific to Climatronics F460 wind speed and 
direction sensors, operated with a Campbell Scientific 21XL or CR23X datalogger. Calibration 
and maintenance include tasks that are detailed in the following four (4) major subsections: 
 
 4.1 Calibration Checks 
 4.2 Wind Direction Sensor 
 4.3 Wind Speed Sensor 
 4.4 Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks. Refer to the appropriate calibration forms performing 
calibration checks. Be sure to indicate on the forms whether the calibration is pre- or post-
maintenance and note all maintenance activities or replaced components in the “Comments” 
field. The forms are available as Excel spreadsheets and should be used at all times. Results of 
each calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made.  The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and 
time (beginning and ending) of the calibration and maintenance 
procedures. “Down” the appropriate channels on the data 
acquisition system (DAS) or set the calibration flag as 
appropriate for the DAS being used. 
 
Complete the following fields on the appropriate calibration 
form: network and station name; current date; name of 
technician performing the calibration; manufacturer, model, and 
serial number of the instrument; and date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance digital voltmeter (DVM) 
and DAS readings of the sensor to be calibrated. Disregard any columns 
on the form that refer to translator cards or DVM readings. 

 
4.2 WIND DIRECTION SENSOR 
 
 Refer to Figure 4-1, Example Wind Direction Calibration Form, when performing 
calibration checks. 
 
4.2.1 Sensor Checks 
 
ORIENTATION CHECK The wind direction sensor orientation check is performed as follows: 

 
• Use a compass, protractor, and topographic map to 

familiarize yourself with the surrounding terrain. 
 
• Identify two outstanding features. Label these features on the 

map as “Landmark 1” and “Landmark 2.” 
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Figure 4-1.  Example Wind Direction Calibration Form. 
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ORIENTATION CHECK 
(continued) 

• Determine the azimuth (degrees from true north to the 
nearest degree) of the selected feature from a topographic 
map and/or from a magnetic compass. Determine the magnetic 
declination from the topographic map or, alternately, use the 
CALCU software program to determine the declination. 

 
• Record on the calibration form the features selected, azimuth 

measured (degrees true), and magnetic declination used. 
 

NOTE: When using a compass, calculate degrees true 
using magnetic declination carefully. If the 
declination is easterly, increase the measured 
magnetic azimuth by the amount of declination.  
If westerly, decrease the reading. For example: 
Fort Collins, CO, uses a declination of 14° East. If 
a horizon landmark is measured by compass as 
210° Magnetic, the landmark is 224° True. 

 
• Select the appropriate datalogger channel to display the 

instantaneous wind direction output. Review the execution 
interval and adjust it to a minimum of 10-second updates. 
Remember to return the execution interval to its original 
setting following the calibration. 

 
• Climb the tower and align the nose of the wind direction 

vane toward Landmark 1. Careful alignment of the vane is 
critical during all steps of this procedure. 

 
• Alert your assistant to record the wind direction value 

displayed on the datalogger and strip chart recorder value on 
the calibration form as “To Landmark 1.” 

 
NOTE: Good communication with your assistant is essential. 

 Tall or remote towers may require radios or other 
alternate communication techniques. 

 
• Align the tail of the wind direction vane toward Landmark 1. 
 
• Alert your assistant to record the datalogger and strip chart 

values as “From Landmark 1.” 
 
• Repeat this procedure for Landmark 2. 
 
• Additional alignment checks using the sensor crossarm may 

be useful if either landmarks are difficult to identify or 
measure.  Record these values in the “Comments” area of the 
calibration form. 

 
LINEARITY CHECK 
 
 
 
 
 
 

The wind direction sensor linearity check is performed as 
follows:  
 
• Attach the wind direction linearity test jig to the wind 

direction sensor. 
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LINEARITY CHECK 
(continued) 

• Replace the wind direction vane with the notched compass 
wheel. 

 
• Index the compass wheel into one of the eight notches. 
 
• Alert your assistant to record the datalogger and strip chart 

recorder values. 
 
• Repeat the procedure for the remaining indexed positions. 
 

STARTING THRESHOLD 
CHECK 

Check the wind direction sensor bearing starting threshold as 
follows: 
 
• Remove the sensor from the crossarm. 

• Remove the vane and install the torque disc on the sensor 
shaft. Hold the sensor in a horizontal position. 

• Note the weight size and position when the shaft first turns. 
 

4.2.2 Datalogger Program 
 
WIND DIRECTION 
SENSOR 

The wind direction sensor signal is processed using the P4 
“Excite, Delay, Volt (SE)” instruction. An example program 
instruction is listed below: 
 

P4  Excite, Delay, Volt (SE) 
 
01:01*  Number of Repetitions 
02:05  5000 mV Slow Range 
03:01*  Input Location 
04:01  Excite with EX channel 1 
05:20  Delay (units 0.01 sec) 
06:50  00  mV Excitation 
07:01  Location of Intermediate Data (example) 
08:0.144  Multiplier *sensor and cable specific* 
09:0.000  Offset 
 
*Response will be specific to station configuration. 

 
MULTIPLIER Although the multiplier can be changed to accommodate 

individual sensors or extremely long (>500 feet) sensor cables, 
this is rarely necessary. The following steps may be followed to 
determine an individual sensor/signal cable combination 
multiplier value. 
 
• Change the multiplier to “1.000.” 
 
• Rotate the sensor shaft slowly; note the highest value reached 

on the datalogger display. 
 
• Divide the highest value noted by 360. 
 
• Enter the calculated value for the multiplier response. 
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OFFSET Leave the offset at “0.000.” If the pre-calibration check indicates 
the sensor is misoriented, reorient the sensor as described in 
Section 4.2.1. 

 
4.2.3 Evaluation of Wind Direction Sensor Checks 
 
 Evaluate the results of the wind direction calibration checks to determine if the following 
specifications are met: 
 
ORIENTATION CHECK “To” and “From” values should not be more than !5° from any 

corresponding designated value. 
 

LINEARITY CHECK Results of the four indexed positions should increase in 
increments !2°. 
 

STARTING THRESHOLD The starting threshold of the sensor should not be greater than 6 
gm-cm. 

 
4.2.4 Sensor Adjustments 
 
 If checks are beyond the designated values, perform the following adjustments: 
 
ORIENTATION Reorient the sensor if the alignment check indicated is greater 

than !5° difference at any point by: 
 
• Loosening the alignment collar on the crossarm. 

• Aligning the wind direction vane to a known landmark. 

• Twisting the collar until the designated azimuth is achieved. 

• Tightening the alignment collar. 
 

4.2.5 Sensor Maintenance 
 
LINEARITY Replace the potentiometer if the linearity check indicates a 

greater than !2° deviation from the suggested values. Consult 
the 
manufacturer’s instruction manual for the proper procedure 
(Figure 4-2). 
 

STARTING THRESHOLD Replace the upper bearings and potentiometer if the starting 
threshold is greater than 6 gm-cm. Consult the manufacturer’s
instruction manual for the proper procedure. 

 
4.2.6 Post-Maintenance Calibration Checks 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.2.1 and record them as the post-maintenance values. 
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Figure 4-2.  Manufacturer’s Specifications for the Climatronics F460 Wind Speed 

              and Direction Sensors (Page 1). 
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 Figure 4-2.  (Continued).  Manufacturer’s Specifications for the Climatronics F460 
          Wind Speed and Direction Sensors (Page 2). 



Number 3150-2102 
Revision 0.5 
Date MAY 2005 

            Page 10 of 13 
 

 
4.3 WIND SPEED SENSOR 
 
 Refer to Figure 4-3, Example Wind Speed Calibration Form, when performing calibration checks. 
 
4.3.1 Sensor Checks 
 
MOTOR RESPONSE 
CHECK (FOUR-POINT) 

Check the wind speed sensor speed response as follows: 
 
• Select the appropriate datalogger channel to display the 

instantaneous wind speed output. Review the execution 
interval  and adjust it to a minimum of 10-second updates. 
Remember to  return the execution interval to its original 
setting following the  calibration. 

  
• Remove the anemometer cups and attach the R.M. Young 

variable speed calibration motor to the sensor input shaft. 
 
• Set the calibrator for 300 rpm and allow the sensor to stabilize. 
 
• Alert your assistant to record the datalogger and strip chart 

recorder output on the calibration form. 
 
• Repeat the procedure for 600, 900, and 1800 rpm. Other 

speeds may be selected as appropriate  Table 4-1 lists the 
designated values for selected rpms. 

 
 
 
 

 
 

 

Table 4-1
 

Climatronics F460 Sensor 
Designated Values 

Climatronics F460 Sensor 
with Vinyl or Aluminum Cups 

RPM Designated Value 
(meters/second) 

Designated Value 
(miles/hour) 

100 
300 
600 
900 

1200 
1800 

2.574         
 7.274         
14.324         
21.375         
28.425         
42.526         

5.8            
16.3         
32.0         
47.8         
63.6         
95.1         

STARTING THRESHOLD 
CHECK 

Check the sensor for the starting threshold as follows: 
 
• Remove the sensor from the crossarm. 
 
• Remove the anemometer cups and attach the torque disc to 

the sensor shaft. Hold the sensor in a horizontal position. 
 
• Note the weight size and position when the shaft first begins 

to turn. 
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Figure 4-3.  Example Wind Speed Calibration Form. 
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4.3.2 Datalogger Program 
 
 The data wind speed sensor signal is processed using the P3 “Pulse Input” instruction. 
Instruction Parameter 3 “CONFIGuration” utilizes Option 3 “High Frequency, 16 Bit” counts. 
This configuration allows wind speed calculation independent of the execution interval. An 
example program instruction is listed below: 
 
 P3  Pulse 
 
 01:01*  Number of Repetitions 
 02:02*  Pulse Input Channel in Use 
 03:20  High Frequency: Output Hz 
 04:01*  Location of Intermediate data (example) 
 05:0.105  Multiplier for Miles Per Hour Output (0.047 for meters per second output) 
 06:05  Offset for Sensor Starting Threshold in Miles Per Hour (0.2 for meters per second output) 
 
  *Response will be specific to station configuration. 
 
 Alteration of the datalogger program to correct a sensor response problem is not 
recommended; all corrective action should be made to the sensor. 
 
4.3.3 Evaluation of Wind Speed Sensor Checks 
 
 Evaluate the results of the wind speed calibration checks to determine if the following 
specifications are met: 
 
SENSOR RESPONSE Measured instrument response must be within !5% of the 

designated value (see Section 4.3.1). 
 

STARTING THRESHOLD Starting threshold of the sensor should not be greater than 
0.2 gm-cm (equivalent to 0.27 m/s). 
 

4.3.4 Sensor Adjustments 
 
 No adjustments can be made to the sensor. 
 
4.3.5 Sensor Maintenance 
 
 If checks are beyond the designated values, perform the following maintenance: 
 
SENSOR RESPONSE Inspect the sensor chopper disc and clean if necessary.  Replace 

the sensor if the response remains beyond tolerance. 
 

STARTING THRESHOLD Replace the sensor bearings if the starting threshold is greater 
than the designated value. 
 

4.3.6 Post-Maintenance Calibration Checks 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.3.1 and record them as the post-maintenance values. 
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4.4 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration 
forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in 
sensor or calibration operation that could affect the quality of 
data. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the sensor, marking the 
date the instrument was calibrated and the name of the 
technician  
who calibrated it. 
 
 
 
 
 
 
 

Figure 4-4.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip
report. 
 

5.0 REFERENCES 
 
Campbell Scientific, Inc., 1991, 21X Micrologger Operator’s Manual, Logan, UT. 
 
Campbell Scientific, Inc., 1998, CR23X Micrologger Operator’s Manual, Logan, UT. 
 
Climatronics Corporation, REV E, F460 Wind Speed Sensor Manual , Bohemia, NY. 
 
Climatronics Corporation, REV C F460 Wind Direction Sensor Manual, Bohemia, NY. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details to dynamically calibrate an 
R.M. Young model 05305 Wind Monitor-AQ. 
 
 The corrosion resistant Wind Monitor-AQ sensor measures both horizontal wind speed 
and direction. The sensor incorporates a horizontal propeller shaft and vertical direction shaft 
that use stainless steel precision grade ball bearings shielded from contamination and moisture 
all housed in one injection molded, U.V. stabilized plastic cowling. 
 
 Propeller rotation produces an AC sine wave signal with a frequency proportional to 
wind speed. Vane position is transmitted by a 10K Ohm precision conductive plastic 
potentiometer which requires a regulated excitation voltage. With a constant voltage applied to 
the potentiometer, the output signal is an analog voltage directly proportional to azimuth angle. 
 
 The sensor mounts on standard one-inch pipe, (OD 35 mm, 1.34”). An orientation ring is 
provided to ensure proper realignment after it has been removed for maintenance, and a stainless 
steel band clamp secures the mounting post assembly and orientation ring to the pipe. A junction 
box at the base of the pipe merge the electrical connections and signal cable to the signal 
conditioning, display, and recording devices. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 
• Upon installation or removal of the instrument at a field station 
 
• Whenever control limits are exceeded 
 
• Prior to any corrective action, service, or maintenance to any portion of the 

instrument that affects its operational principle 
 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 
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• Establish the calibration reporting protocol to satisfy client requirements. 
 

• Review calibration results. 
 

• Identify inconsistencies in calibration results and initiate corrective action as 
required. 

 
• Review and approve any changes to calibration procedures. 

 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are generally required to calibrate and maintain 
wind speed and wind direction sensor systems: 
 

• Topographic maps of the area 
 

• Protractor 
 

• Magnetic compass 
 

• Digital voltmeter (4-1/2 digit) 
 

• R.M. Young Model 18801 or 18802 anemometer drive motor 
 

• Torque disc and weights 
 

• Model 18112 vane angle bench stand 
 

• Laptop computer with Excel workbook (Calibrations.XLT) and CALCU program 
software 

 
• R.M. Young instrument manual 

 
• Tower climbing belt and safety equipment 

 
• Field service tools 

 
• Station log book 

 
• Wind Speed Calibration Forms 

 
• Wind Direction Calibration Forms 

 
• Pen or pencil 

 
• ARS calibration stickers 
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4.0 METHODS 
 
 The wind system must be dynamically checked (pre-maintenance calibration) before any 
electrical adjustments are made to the programmable translator or before servicing the 
meteorological sensors. Throughout the calibration and maintenance period, the datalogger, 
calibration forms, and strip chart (if used) must be annotated to indicate that data taken during 
the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. The 
pre- and post-maintenance calibration techniques are identical. Do not adjust the signal conditioning 
cards or perform any maintenance to the sensors until all pre-calibration checks are completed. 
 
 The procedures described in this TI are specific to R.M. Young model 05305 Wind 
Monitor-AQ wind speed and direction sensors. Calibration and maintenance include tasks that 
are detailed in the following four (4) major subsections: 
 
 4.1  Calibration Checks 
 4.2  Wind Direction Sensor 
 4.3  Wind Speed Sensor 
 4.4  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks. Refer to Figures 4-1 and 4-2, Example Wind Speed and 
Example Wind Direction Calibration Form, when performing calibration checks. Be sure to 
indicate on the form whether the calibration is pre- or post-maintenance and note all maintenance 
activities or replaced components in the “Comments” field. The form is available as an Excel 
spreadsheet and should be used for both pre- and post- maintenance checks. Results of each 
calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and time 
(beginning and ending) of the calibration and maintenance 
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 

Complete the following fields on the Wind Speed and Wind 
Direction Calibration Forms: network and station name; current 
date; name of technician performing the calibration; 
manufacturer, model, and serial number of the instrument; and 
date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance DVM and DAS of the 
sensor to be calibrated. 
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Figure 4-1.  Example Wind Speed Calibration Form. 
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Figure 4-2.  Example Wind Direction Calibration Form. 
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4.2 WIND DIRECTION SENSOR 
 

4.2.1 Sensor Checks 
 
ORIENTATION CHECK The wind direction sensor orientation check includes the 

following procedures: 
 
• Use a compass, protractor, and topographic map to 

familiarize yourself with the surrounding terrain. 
 
• Identify two outstanding features on the topographic map. 
 
• Determine the azimuth (to the nearest degree) of the selected 

feature from a topographic map and/or from a magnetic 
compass. 

 
• Record the selected features, azimuth measured (degrees 

true), and magnetic declination used (available from a 
topographic map) on the calibration form, using a laptop 
computer and Excel spreadsheet software. An example Wind 
Speed and Wind Direction Calibration Forms is presented in 
Figures 4-1 and 4-2. 

 
 NOTE: When using a compass, calculate degrees true 

 using magnetic declination carefully. If the 
 declination is easterly, increase the measured 
 magnetic azimuth by the amount of declination. If 
 westerly, decrease the reading. For example: Fort 
 Collins, CO, uses a declination of 14° east. If a 
 horizon landmark is measured by compass as 210°, 
 the landmark is 224° true. 

 
• Connect a digital voltmeter (DVM) to the output of the wind 

direction signal conditioning card. 
 
• Climb the tower and align the nose of the wind direction 

vane toward landmark 1. 
 
• Alert your assistant to record the data acquisition system 

wind direction value, DVM reading, and strip chart recorder 
value on the calibration form as “To Landmark 1.” 

 
• Align the tail of the wind direction vane toward landmark 1. 
 
• Alert your assistant to record the DAS, DVM, and strip chart 

output values as “From Landmark 1.” 
 
• Repeat this procedure for the remaining landmark. 
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LINEARITY CHECK The wind direction sensor linearity check includes the following 
procedures: 
 
• Attach the wind direction vane angle bench stand to the wind 

direction sensor. 
 
• Position the vane into 45° increments using the vane angle 

bench stands 0° - 360° scale. 
 
• Alert the assistant to record the DAS and DVM values at 

each increment. 
 

STARTING THRESHOLD 
CHECK 

The sensor bearing starting threshold check includes the 
following procedures: 
 
• Remove the sensor from the crossarm. Remove the cups. 
 
• Install the torque disc. 
 
• Note the weight required to overcome the shaft rotational 

threshold. 
 

4.2.2 Evaluation of Wind Direction Sensor Checks 
 
 Evaluate the results of the wind direction calibration checks to determine if the following 
specifications are met: 
 
ORIENTATION CHECK “To” and “From” values should not be more than 5° from any 

corresponding designated value. 
 

LINEARITY CHECK Results of the eight indexed positions should increase in 45° 
increments !3°. 
 

STARTING THRESHOLD Starting threshold of the sensors wind direction shaft should not 
be greater than 9 gm-cm. 
 

4.2.3 Sensor Adjustments 
 
 If checks are beyond the designated values, perform the following adjustments: 
 
ORIENTATION Re-orient the sensor if the alignment check indicated is greater 

than !5° difference at any point by: 
 
• Loosening the alignment collar on the crossarm. 
 
• Aligning the wind direction vane to known landmark. 
 
• Twisting the collar until the designated azimuth is achieved. 
 
• Tightening the alignment collar. 
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4.2.4 Sensor Maintenance 
 
LINEARITY Replace the potentiometer if the linearity check indicates greater 

than 3° deviation from the suggested values. Consult the 
manufacturer’s instruction manual for the proper procedure. 
 

STARTING THRESHOLD Replace the bearings if the starting threshold is greater than 6 
gm-cm. Consult the manufacturer’s instruction manual for the 
proper procedure. 
 

4.2.5 Post-Maintenance Calibration Checks 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.2.1, and record them as the post-maintenance values. 
 
4.3 WIND SPEED SENSOR 
 
4.3.1 Sensor Checks 
 
MOTOR RESPONSE 
CHECK(FOUR-POINT) 

The wind speed sensor speed response check includes the 
following procedures: 
 
• Connect the DVM to the wind speed signal conditioning card 

output. 
 
• Remove the anemometer propeller and attach the R. M. 

Young anemometer drive motor to the sensor input shaft. 
 
• Adjust the calibrator for 600 rpm and allow the sensor to 

stabilize. 
 
• Alert the assistant to record the DAS, DVM, and strip chart 

recorder output on the calibration form. 
 
• Repeat the procedure for 1800, 4000, and 7000 rpm. 
 

STARTING THRESHOLD 
CHECK 

The sensor starting threshold check includes the following 
procedures: 
 
• Remove the sensor. 
 
• Attach the torque disc to the anemometer shaft. 
 
• Note the weight and position when the shaft first starts to 
 turn. 
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4.3.2 Evaluation of Wind Speed Sensor Checks 
 
 Evaluate the results of the wind speed sensor tests to determine if the following 
specifications are met: 
 
SENSOR RESPONSE Measured instrument response must be within !5% of the 

designated value: 
  

R.M. YOUNG WIND MONITOR-AQ 
RPM Designated Value 

(0-50 m/s range) 
(m/s=0.00512 x rpm) 

Designated Value 
(0-100 mph range) 

(mph=0.01145 x rpm) 
600 

1800 
4000 
7000 

3.1  
9.2  

20.5  
35.8  

6.9  
20.6  
45.8  
80.1  

STARTING THRESHOLD Starting threshold of the sensor’s anemometer shaft should not be 
greater than 0.25 m/s or 0.5 mph. 
 

4.3.3 Sensor Adjustments 
 
 To calibrate the wind system electronics using a signal from the instrument, temporarily 
remove the propeller and connect the Model 18801 or 18802 Anemometer Drive to the propeller 
shaft. Apply the appropriate calibration formula to the calibrating motor RPM and adjust the 
electronics for the proper value. For example, with the propeller shaft turning at 3600 RPM, 
adjust an indicator to display 18.4 meters per second (3600 rpm x 0.00512 m/s/rpm = 18.4 m/s). 
 
4.3.4 Sensor Maintenance 
 
If checks are beyond the designated values, perform the following maintenance: 
 
SENSOR RESPONSE Inspect the sensor chopper disc and clean if necessary. Replace 

the sensor if response remains beyond tolerance. 
 

STARTING THRESHOLD Replace the sensor bearings if the starting threshold is greater 
than 0.3 gm-cm. 
 

4.3.5 Post-Maintenance Calibration Checks 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.3.1 and record them as post-maintenance values. 
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4.4 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained.  Review and sign all calibration forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the sensor, marking the 
date the instrument was calibrated and the name of the technician 
who calibrated it. 
 
 
 
 
 
 
 
 

Figure 4-3.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
 

5.0 DEFINITIONS 
 
 Dynamic Check:  A dynamic check implies subjecting a sensor to known conditions 

similar to those conditions under normal sampling. A dynamic check of a wind direction 
sensor would be to point the vane to a known landmark and comparing the sensor output 
with the measured landmark azimuth. 

 
 Power Supply:  The modular component that supplies positive and negative operating 

voltages to the signal conditioning cards. 
 
 Signal Conditioning Card:  An electronic circuit card that provides operational voltages to 

the meteorological sensor and converts the raw sensor signal to a linear analog output 
suitable for recording.  Signal conditioning cards are also referred to as “translator cards.” 

 
6.0 REFERENCES 
 
R.M. Young Company, 1995, Meteorological Instruments Model 05305 Wind Monitor - AQ 

Instructions, July.  Traverse City, MI. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details to dynamically calibrate: 
 

• A Climatronics P/N 100087 temperature card with P/N 100093-2 temperature probes 
and a P/N 100829-1 delta temperature card. 

 
• A Qualimetrics M/N 1410 temperature signal conditioning card with a M/N 4480-A 

temperature probe. 
 
 The two temperature systems described above have nearly identical components. Both 
systems include a power supply and mainframe, signal conditioning card, forced aspiration 
housing, and temperature probe. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are generally required to calibrate and maintain 
temperature/delta temperature systems: 
 

• Calibrated thermometers: -20° to +10°C, 0° to +30°C, and +20° to +50°C 
 

• Thermos bottles 
 

• One gallon of distilled water 
 

• Crushed ice 
 

• Portable water heater or hot water 
 

• Digital voltmeter (4-1/2 digit) 
 

• Field service tools 
 

• Station log book 
 

• Calibration forms 
 

• Pen or pencil 
 

• Laptop computer with Excel workbook (NPS.XLT) and CALCU program software 
 

• ARS calibration stickers 
 
4.0 METHODS 
 
 The temperature/delta temperature system must be dynamically checked (pre-maintenance 
calibration) before any electrical adjustments are made to the signal conditioning cards or before 
servicing the meteorological sensors. Throughout the calibration and maintenance period, the 
datalogger, calibration forms, and strip chart (if used) must be annotated to indicate that data taken 
during the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre- and post-maintenance calibration techniques are identical. Do not adjust the signal 
conditioning cards or perform any maintenance to the sensors until all pre-calibration checks are 
completed. 
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 The procedures described in this TI are specific to Climatronics or Qualimetrics 
temperature/delta temperature systems. Calibration and maintenance include tasks that are 
detailed in the following five (5) major subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks. Refer to Figure 4-1, Example Temperature, Delta 
Temperature, and Relative Humidity Calibration Form, when performing calibration checks. Be 
sure to indicate on the form whether the calibration is pre- or post-maintenance and note all 
maintenance activities or replaced components in the “Comments” field. The form is available as 
an Excel spreadsheet and should be used for both pre- and post- maintenance checks. Results of 
each calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and 
time (beginning and ending) of the calibration and maintenance 
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on the calibration form: network 
and station name; current date; name of technician performing 
the calibration; manufacturer, model, and serial number of the 
instrument; and date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance DVM and DAS 
readings of the sensor to be calibrated. Connect a DVM to the
output of the temperature signal conditioning card. 
 

PREPARE WATER BATHS Three water baths need to be prepared: one bath with ambient 
water near 20°C, one bath with water and crushed ice, and one 
bath with 40°-50°C water. Make arrangements to hang or 
support the baths in the vicinity of the temperature probes. 
 

CALIBRATION CHECK 
PROCEDURES 

A temperature calibration check is performed as follows: 
 
• Remove the temperature probe(s) from the aspirator(s) and 

fully immerse the probe(s) into the ambient water bath. Insert 
a calibrated thermometer of the appropriate range into the 
water bath. 
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 Figure 4-1.  Example Temperature, Delta Temperature, and Relative Humidity 

        Calibration Form. 
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CALIBRATION CHECK 
PROCEDURES (continued) 

• Agitate the bath for two to five minutes or until both the 
temperature value indicated on the data acquisition system 
(DAS) and the observed value on the thermometer stabilize, 
and the delta temperature is zero. 

 
• Record the observed value of the thermometer as the 

designated value on the calibration form. Record the DAS, 
DVM, and chart recorder values for temperature and delta 
temperature on the calibration form. 

 
• Repeat the above procedures for the ice bath and the warm 

bath. 
 

SIGNAL CONDITIONING 
CARD CHECKS 

Check the signal conditioning card(s) for proper electronic 
balance as follows: 
 
• Select “ZERO” (LOW) on the card mode switch(s) and 

record the DAS, DVM, and chart recorder values for 
temperature and delta temperature on the calibration sheet. 

 
• Select “SPAN” (HIGH) on each card mode switch(s) and 

record the DAS, DVM, and chart recorder values for 
temperature and delta temperature on the calibration sheet. 

 
4.1.1 Evaluation of Temperature/Delta Temperature Sensor Checks 
 
 Evaluate the results of the temperature/delta temperature calibration checks to determine 
if the following specifications are met: 
 
WATER BATH CHECK The temperature indicated value from the DAS should not differ 

by more than !0.2°C from the designated value at any bath 
temperature. 
 

SIGNAL CONDITIOINING 
CARD(S) BALANCE 

ZERO (LOW), SPAN (HIGH) position values should be within 
!0.1°C of the following designated values: 
 

Card Position DAS 
(°C) 

0-5.000 
VDC 

System 
(!0.005) 

0-1.000 
VDC 

System 
(!0.001) 

0-10.00 
VDC System

(!0.01) 

Temperature Zero (low)
Span (high)

-50.0 
+50.0

0.000 
5.000 

0.000 
1.000 

0.00 
10.00 

 
Delta 

Temperature
Zero (low)
Span (high)

+5.0 
-5.0 

0.000 
5.000 

0.000 
1.000 

0.00 
10.00 

 
 

4.2 SENSOR ADJUSTMENTS 
 
 No adjustments can be made to the sensors. 
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4.3 SENSOR MAINTENANCE 
 
 If checks are beyond the designated values, perform the following maintenance: 
 
INSPECT TEMPERATURE 
PROBE(S) 

Inspect the temperature probe(s) and electrical connections for 
cleanliness and electrical continuity. Correct if necessary. 
 

INSPECT ASPIRATOR 
HOUSING(S) 

Inspect the aspirator housing(s) and clean if any dirt or cobwebs 
have accumulated. Inspect the aspirator motor(s) and replace if 
necessary. 
 

SIGNAL CONDITIONNG 
CARD 

Adjust the signal conditioning card to the following designated 
values: 
 

CLIMATRONICS QUALIMETRICS 
Card Position Adjust 

Potentiometer 
Position Adjust 

Potentiometer 
Temperature ZERO 

SPAN 
R-8 

R-15 
LOW 
HIGH 

VR-302 
VR-302 

 
Delta 

Temperature 
ZERO 
SPAN 

R-1 
R-2 

LOW 
HIGH 

Not available 
Not available  

4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as post-maintenance values. 
 
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely.  Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration aremaintained. Review and sign all calibration forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in 
sensor or calibration operation that could affect the quality of 
data. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the sensor, marking the 
date the instrument was calibrated and the name of the 
technician 
who calibrated it. 
 
 
 
 
 
 
 
                          Figure 4-2.  ARS Calibration Sticker. 
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TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and minimize 
data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details to dynamically calibrate an 
R.M. Young Model 26700 programmable translator unit with two Model 41342 temperature 
probes. 
 
 The R.M. Young temperature/delta temperature system includes a power supply, 
programmable translator, two forced aspiration housings, and two temperature probes. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all defined 
specifications. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 
• Upon installation or removal of the instrument at a field station 
 
• Whenever control limits are exceeded 
 
• Prior to any corrective action, service, or maintenance to any portion of the instrument 

that affects its operational principle 
 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are generally required to calibrate and maintain 
temperature/delta temperature systems: 
 

• NIST certified digital thermometer 
 

• Thermos bottles 
 

• One gallon of distilled water 
 

• Crushed ice 
 

• Portable water heater or hot water 
 

• Digital voltmeter (4-1/2 digit) 
 

• Field service tools 
 

• Station log book 
 

• Temperature, delta temperature and relative humidity calibration form 
 

• Pen or pencil 
 

• Laptop computer with Excel workbook (Calibrations.XLT) and CALCU program 
software 

 
• ARS calibration stickers 

 
4.0 METHODS 
 
 The temperature/delta temperature system must be dynamically checked (pre-maintenance 
calibration) before any electrical adjustments are made to the signal conditioning cards or before 
servicing the meteorological sensors. Throughout the calibration and maintenance period, the 
datalogger, calibration forms, and strip chart (if used) must be annotated to indicate that data 
taken during the calibration period should not be included as standard observations. 
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 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre- and post-maintenance calibration techniques are identical. Do not adjust the signal 
conditioning cards or perform any maintenance to the sensors until all pre-calibration checks are 
completed. 
 
 The procedures described in this TI are specific to R.M. Young temperature/delta 
temperature systems. Calibration and maintenance include tasks that are detailed in the following 
five (5) major subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks. Refer to Figure 4-1 Example temperature, delta temperature 
and relative humidity calibration form, when performing calibration checks. Be sure to indicate on 
the form whether the calibration is pre- or post-maintenance and note all maintenance activities or 
replaced components in the “Comments” field. The form is available as an Excel spreadsheet and 
should be used for both pre- and post- maintenance checks. Results of each calibration should be 
in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and time 
(beginning and ending) of the calibration and maintenance 
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on the Temperature, Delta 
Temperature and Relative Humidity Calibration Form: network and 
station name; current date; name of technician performing the 
calibration; manufacturer, model, and serial number of the 
instrument; and date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance DVM and DAS 
readings of the sensor to be calibrated. Connect a DVM to the 
output of the temperature signal conditioning card. 
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Figure 4-1.  Example Temperature, Delta Temperature and Relative Humidity Calibration Form. 
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PREPARE WATER 
BATHS 

Three water baths need to be prepared: one bath with ambient 
water near 20°C, one bath with water and crushed ice at 0°C, and 
one bath with 40°-50°C water. Make arrangements to hang or 
support the baths in the vicinity of the temperature probes. 
 

CALIBRATION CHECK 
PROCEDURES 

A temperature calibration check is performed as follows: 
 
• Remove the temperature probes from the aspirators, tape them 

together so that the probe ends are close or touching, and fully 
immerse them into the ambient water bath. Insert a calibrated 
thermometer of the appropriate range into the water bath. 

 
• Agitate the bath for two to five minutes or until both the 

temperature value indicated on the data acquisition system 
(DAS) and the observed value on the thermometer stabilize, and 
the delta temperature is stable (it should be zero or near zero). 

 
• Record the observed value of the thermometer as the 

designated value on the calibration form. Record the DAS, 
DVM, and chart recorder values for temperature and delta 
temperature on the calibration form. 

 
• Repeat the above procedures for the ice bath and the warm 

bath. 
 

4.1.1 Evaluation of Temperature/Delta Temperature Sensor Checks 
 
 Evaluate the results of the temperature/delta temperature calibration checks to determine 
if the following specifications are met: 
 
WATER BATH CHECK The temperature indicated value from the DAS should not differ 

by more than 0.5°C from the designated value at any bath 
temperature. 
 
 The delta temperature indicated value from the DAS should not 
differ by more than 0.2°C from 0.0°C at any temperature. 
 

4.2 SENSOR ADJUSTMENTS 
 
 If checks are beyond the designated values, perform the following adjustments: 
 
INSPECT ASPIRATOR 
HOUSINGS 

Inspect the aspirator housings for level, adjust if necessary. 



            Number 3150-2113 
            Revision 0.3 
            Date JUN 2002 
            Page 6 of 6 
 

4.3 SENSOR MAINTENANCE 

4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as post-maintenance values. 
 
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet should 

be completed entirely. Where possible, use the Excel spreadsheet 
so that both a hard copy and digital record of the calibration are 
maintained. Review and sign all calibration forms. 
 

LOG NOTES A summary of results and maintenance performed must be included 
in the station log notes. Note any abnormalities in sensor or 
calibration operation that could affect the quality of data. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the sensor, marking the 
date the instrument was calibrated and the name of the technician 
who calibrated it. 
 
 
 
 
 
 
 

Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 

 

INSPECT 
TEMPERATURE 
PROBES 
 

Inspect the temperature probes and electrical connections for 
cleanliness and wire continuity. Correct if necessary. 

INSPECT ASPIRATOR 
HOUSINGS 

Inspect the aspirator housings and clean if any dirt or cobwebs have 
accumulated. Inspect the aspirator motor and fan blades, they 
should be moving. Replace if necessary. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for laboratory calibration 
and repair of Rotronics MP-101A ambient temperature/relative humidity (AT/RH) sensors,  
Rotronics MP-601A relative humidity sensors, or Vaisala 45AC AT/RH sensors. The purpose of 
the calibration is to ensure that the sensor accuracy under normal operating conditions is within 
specified manufacturer's or project accuracy limits. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new sensor 
 
• Upon installation or removal of the sensor at a field station 
 
• Whenever control limits are exceeded 
 
• Prior to any corrective action, service, or maintenance 
 
• At a maximum interval of 12 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and repair schedule and coordinate with the 
client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 
• Review and approve any changes to calibration procedures. 
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2.2 INSTRUMENT TECHNICIAN 
 
 The instrument technician shall: 
 

• Perform all laboratory calibrations and repair as described in this TI. 
 
• Document all calibration results and repair procedures performed using the forms 

described in this TI. 
 
• Maintain a file of all calibration and repair records. 

 
2.3 TECHNICAL ASSISTANT 
 
 The technical assistant shall: 
 

• Verify that the Instrument Service Order Form is complete. 
 
• Forward the Form and sensor to the instrument technician. 

 
• Update the equipment inventory and sensor maintenance cards. 

 
• File a duplicate of all calibration information. 

 
2.4 DATA TECHNICIAN 
 
 The data technician shall enter the calibration results into the calibration cost accounting 
database. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for laboratory AT/RH sensor 
calibration: 
 

• Vaportron H-100L calibrator, CR10 
 

• TESTO hygrometer 
 

• TESTO probe 
 

• Personal computer with two I/O ports 
 

• Vaportron 2.1 application software: 
- RHprecal.RAS 
- RHpstcal.RAS 

 
• Campbell Scientific CR10 datalogger 

 
• Campbell Scientific serial data interface (SC32A) 

 
• PC208W software (Campbell Scientific datalogger-to-PC interface program) 
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• Instrument Service Order Form 
 

• Sensor maintenance card 
 

• AT/RH Sensor Calibration Form 
 

• ARS calibration stickers 
 

• Pen or pencil 
 

• TI 3150-2114, Laboratory Calibration and Repair of Rotronics MP-101A AT/RH 
Sensors, Rotronics MP-601A Relative Humidity Sensors, or Vaisala 45AC AT/RH 
Sensors 

 
• Miscellaneous adapters 

 
• Microsoft Access database software 

 
• Rotronics MP-101A Instruction Manual 

 
• Rotronics MP-601A Instruction Manual 
 
• Vaisala HMP45A & HMP45D Humidity and Temperature Probes Operating Manual 

 
4.0 METHODS 
 
 The procedures described in this TI are specific to Rotronics MP-101A AT/RH sensors, 
Rotronics MP-601A RH sensors, and Vaisala 45AC AT/RH sensors. Laboratory calibration 
includes tasks that are detailed in the following five (5) major subsections: 
 
 4.1  Sensor Tracking and Calibration Order  
 4.2  Pre-Maintenance Calibration 
 4.3  Sensor Adjustments and Repair 
 4.4  Post-Calibration Checks 
 4.5  Documentation 
 
 Routine field procedures are not discussed herein. Refer to TI 3150-2115, Field 
Calibration and Routine Maintenance of Rotronics MP-101A AT/RH Sensors or Rotronics 
MP-601A Relative Humidity Sensors, or TI  3150-2116, Field Calibration and Routine 
Maintenance of Vaisala HMP 45AC AT/RH Sensors, for routine maintenance procedures. 
 
 A sensor received from the field should have an Instrument Service Order Form 
accompanying it. The field technician or person turning the sensor into the laboratory for 
maintenance should complete the following information on the form: 
 

• Instrument name • Date return required 
• Model number • Responsible ARS employee 
• Serial number • Shipping address 
• Project • Service type 
• Date arrived • Comments/problems of sensor 
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4.1 SENSOR TRACKING AND CALIBRATION ORDER 
 
 Rotronics and Vaisala sensors will be submitted for ARS calibration immediately upon 
return from the field. The field specialists will complete the sensor maintenance card and 
Instrument Service Order Form (Figure 4-1) and give the form, sensor, and field audit results to 
the technical assistant. 
 
 It is important that the field specialist be as thorough as possible when completing page 1 
of the Instrument Service Order Form. The technical assistant will verify that the form and 
supplemental information are complete. The technical assistant will also verify and/or update the 
equipment inventory, and will transfer the sensor and supporting documentation to the 
instrument technician within one day of receiving all complete information and the sensor from 
the field specialist. 
 
4.2 PRE-MAINTENANCE CALIBRATION 
 
 A pre-maintenance calibration must be performed prior to any maintenance activity.  
Refer to Figure 4-2, Example AT/RH Sensor Calibration Form, when performing 
pre-maintenance calibrations, and perform the following procedures: 
 
TURN ON 
INSTRUMENTATION 
 

Power up the Vaportron, personal computer, and monitor. 
 

INITIATE SOFTWARE Open the Vaportron 2.1 program on the personal computer and 
start the PC208W program to setup hardware connections as 
follows: 
      
• On the PC208W toolbar, click the connect button. The CR10 
     window will appear. 
 
• Click the tools tab at the bottom of the CR10 window. 

 
• Click the send button. 
 
• Click ok in the Change to Datalogger Program May Result in 
     Irrevocable Data Loss window. 

 
• To calibrate only Rotronics sensors, select the program 
 O:\Vaprtron\vapor\autoatrh.dld. To calibrate only Vaisala 
 sensors, or both Vaisala and Rotronics sensors, select 
 O:\vaprtron\vapor\hmp45c.dld. 
 
• Click ok after the Successful Transfer window appears. 
 
• Click the numeric display tab at the bottom of the CR10   
 window. 
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Figure 4-1.  Instrument Service Order Form. 
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Figure 4-1 (continued).  Instrument Service Order Form. 
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Figure 4-2.  Example AT/RH Sensor Calibration Form. 
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Figure 4-2 (Continued).  Example AT/RH Sensor Calibration Form. 
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INITIATE SOFTWARE 
(continued) 

• On the PC208W toolbar, click the setup button.  The Setup 
     Connections window will appear on screen. 
 
• Click the data collection tab at the bottom of the Setup 
 Connections window. 
 
• Click the browse button. 

 
• Name the file O:\vaprtron\yyTSTjd.dat, where yy is the year, 
 TST is either PRE or PST, and jd is the Julian date. PRE is 
 for pre-calibration and PST is for post-calibration. 
 
• Click the save edits button. 
 
• Close the Setup Connections window. 
 

PREPARE SENSOR FOR 
CALIBRATION 

Rotronics 
Remove the foam filter from the sensor to be calibrated and 
replace it with a plastic cage cap. Slide an O-ring over the body. 
 
Slide the sensor approximately 1/3 of its length into a port of the 
Vaportron, making sure the O-ring makes a good seal. 
 
Attach the sensor connector to a numbered CR10 connector, ports 
1-4 (if a Vaisala sensor is being calibrated, do not use port 3).  
 
Repeat for each sensor; up to four sensors can be calibrated 
simultaneously. 
 
Vaisala 
Remove the filter cap from the probe head. Remove the inner 
membrane filter from the cap, and replace the outer plastic cage 
back on the probe head. 
 
Attach the probe head to the probe handle. Slide the O-ring over 
the probe head. 
 
Push the small diameter port adapter into port #3 of the vaportron. 
 
Slide the probe head ½ of its length into the port adapter. 
 
Attach the probe handle’s 8-position connector to its mating 
CR10 connector. 
 
Since the Vaisala sensors can only be placed in port #3, only one 
sensor may be calibrated at any one time.  
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TEST AND RECORD 
RELATIVE HUMIDITY 
AND TEMPERATURE 
VALUES 

In the Vaportron window, select open from the Ramp&Soak 
menu. Select RHprecal.ras or RHpstcal.ras. 
 
Click run from the Ramp&Soak menu. 
 
Click start in the Ramp & Soak Run Control window. 
 
The ramp and soak should take approximately 3 hours for a 
pre-calibration and 10 hours for a post-calibration. 

 
The ramp and soak function will run through the eight relative 
humidity and three temperature test values listed on the 
calibration form automatically, leaving the sensors soaking at all 
the points for the nominal time required on the calibration form.  
 

SAVE THE FILE After the ramp and soak program is completed, perform the 
following steps: 

 
• On the PC208W toolbar, click the setup button. The Setup 

Connections window will appear. 

• Click the data collection tab at the bottom of the Setup 
Connections window. 

• Click the browse button. 

• Name the file C:\vaprtron\data\trash.dat. 

• Click the save edits button. 

• Close the Setup Connections window. 
 

REDUCE 
PRE-CALIBRATION 
DATA 
 
 
 
 
 
 
 
 
 
 
 

Open the AT/RH Sensor Calibration Form found at 
O:\VAPRTRON\Database\AT RH Sensor Calibration Form.mdb 
(see Figure 4-3). 
 
On the Main menu, select Calibrations. 
 
On the AT/RH Sensor Calibration screen, click the Add Record 
button. 
 
Complete the fields for serial number, model number, calibration 
date, service technician, Cal Equipment, Owner, Begin date of 
last operation, End date of last operation, Last operational site, 
Service type, and any Comments. 
 



             
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-3.  Example Access Calibration Data Entry Screen.
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REDUCE 
PRE-CALIBRATION 
DATA (continued) 
 
 
 
 
 
 
 
 
 
 
 
 

Click the Data File button and click on the file that was used to 
capture the data. 
 
If the calibrated sensor was an MP601, deselect Temperature. 
 
In the Sensor # field, enter the CR10 position number. 
 
Click the Process PRE Calibration Data button. 
 
Click the Preview Report button. 
 
Click File and then Print and print page one. 
 
Close the preview screen. 
 
To reduce data for another sensor, click the Add Record button 
and complete as instructed above. 
 
When finished adding sensors, close the AT/RH Sensor 
Calibration Form. 
 

4.3 SENSOR ADJUSTMENTS AND REPAIR 
 
 The following corrective actions are appropriate if the above checks reveal that the test 
AT/RH sensor’s response is beyond the manufacturer’s specifications. 
 
ADJUSTMENTS Adjust out of tolerance probes or replace sensors that cannot be 

adjusted to specifications.  Indicate what adjustments were made 
on the calibration form and at what set points. Appropriate 
specifications for sensors are listed on the calibration form and 
in Tables 4-1 and 4-2, Rotronics and Vaisala, respectively. Refer 
to the manufacturer’s instruction manual (appropriate to the 
sensor model) for adjustment procedures. 
 

WIRING INSPECTION 
AND REPAIR 

Inspect all AT/RH wiring for abrasions, cuts, or loose 
connections. Inspect all connector pins for possible corrosion, 
and repair as required. Table 4-3 presents the wiring diagram for 
Rotronics sensors. There is no wiring diagram for Vaisala 
sensors. 
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Table 4-1 
 

Specifications of Rotronics AT/RH Sensor 
 
SPECIFICATIONS 
Humidity Sensor     ROTRONICS HYGROMERTM C94 
Temperature Sensor     Pt100 RTD 
Humidity Measuring Range    0..100% RH 
Temperature Measuring Range    See Temperature Limits 
Temperature Limits     -40..+60°C 
Humidity Output Signal (linear)    0..1.0 VDC = 0..100% RH 
Temperature Output Signal (linear)   Standard: -0.4..0.6 VDC = -40..+60°C 
       Optional:  0.0..1.0 VDC = -40..+60°C 
       Optional:  0.0..1.0 VDC = -30..+70°C 
Minimum Load per Output    1000 Ω 
Accuracy (at 20..25°C)     !1% RH from 0 to 100% RH* 
       !0.3°C 
Repeatability      !0.3% RH and !0.1°C 
Humidity Sensor Stability    better than 1% RH over a year 
Response Time (without filter)    10 seconds (% RH and temperature) 
Calibration Potentiometers    35, 80% RH and RH min. 
       Tmin and Tmax 
Supply Voltage      4.8 to 26.5 VDC (MP-101A) 
       4.8 to 30.0 VDC (MP-601A) 
Max. Current Consumption    10 mA (MP-101A) 
       2.5 mA when powered with 
            12 VDC or less (MP-601A) 
Connector      MP 101A-C4: 4-pin CANNON 
       MP 101A-C5: 5-pin CANNON 
       MP 101A-T7: 7-pin TUCHEL 
Cable Length      MP 101A-C4 or C5: 6.5 ft (2 m) 
       MP 101A-T7: connector is on the probe 
Sensor Protection     Standard (MP-101A): foam filter MF25C  
       Optional (MP-101A): wire mesh filter SP-W25 
       Standard (MP-601A): D25 wire mesh filter 
       Optional (MP-601A): MF25-MP foam filter 
Weight       70..700g (0.15..1.50 lb) 
 
* When calibrated against highest quality reference standards.  Both factory calibration and field 

calibration with ROTRONIC standards result in !1.5%RH accuracy or better. 
 
Accessories (order separately) 
 
Natural Aspiration Shield    SMP-41002 
Motor Aspirated Shield     MAS-41003 (12 VDC, 75 mA) 
Calibration Device     EM25 
 
                  MP 101A - 03/18/94 
                        MP 601A- 07/24/95 
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Table 4-2 

 
Specifications of Vaisala AT/RH Sensor 

 
SPECIFICATIONS 
Humidity Sensor     Vaisala HMP 45A & HMP45D 
Measurement Range     0.8...100 %RH 
Output Scale      0...100 %RH equals 0-1 VDC 
Accuracy at +20°C (including non-linearity and hysteresis): 
 Against factory references   !1 %RH 
 Field calibration against references  !2 %RH (0...90 %RH) 
       !3 %RH (90...100 %RH) 
Typical Long-Term Stability    Better than 1 %RH per year 
Temperature Dependence    ! 0.05 % RH/°C 
Response time (90%) at +20°C    15 s with membrane filter 
Humidity Sensor     HUMICAP® 180 
 
Temperature Sensor     Vaisala HMP45A 
Measurement Range     -39.2... +60°C  
Output Scale      -40...+60°C equals 0...1 VDC 
Accuracy at 20°C     !0.2°C 
 
General: 
Operating Temperature Range    -40...+60°C 
Storage Temperature Range    -40...+80°C 
Supply Voltage      7...35 VDC 
Settling Time      500 ms 
 
Power Consumption     < 4 mA 
Output Load      > 10 kohm (to ground) 
Weight       350 g (including package) 
Cable Length      3.5 m 
Housing Material     ABS plastic 
Housing Classification (electronics)   IP 65 (NEMA 4) 
Sensor Protection (standard)    Membrane filter, part # 2787HM 
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Table 4-3 
 

Rotronics AT/RH Sensor Wiring 
 

Function Color Pin# 
Cable connector – 4-pin AMP male reverse sex plug 
12V 
Ground 
Relative Humidity 
Temperature 

Red 
Black 
Green 
White 

1 
2 
3 
4 

Sensor connector – 4-socket AMP female reverse sex receptacle 
12V 
Ground 
Relative Humidity 
Temperature 

Red 
Black and Shield 
Green 
White 

1 
2 
3 
4 

 
 
4.4 POST-CALIBRATION CHECKS 
 
 The post-maintenance calibration procedures are essentially the same as pre-calibration 
procedures described in Section 4.1. After completing all repair and adjustment activities, initiate 
a post-calibration and record as the post-calibration values. Use RHpstcal.ras when performing a 
post-calibration. 
 
REDUCE POST-
CALIBRATION DATA 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open the AT/RH Sensor Calibration Form found at 
O:\VAPRTRON\Database\AT RH Sensor Calibration Form.mdb 
(see Figure 4-3). 
 
On the Main menu select Calibrations. 
 
Use the record navigation buttons to find the record of the sensor 
you want to reduce data for. 
 
Click the Data File button and click on the file that was used to 
capture the data. 
 
If the calibrated sensor was an MP601, deselect Temperature. 
 
In the Sensor # field, enter the CR10 position number. 
 
Check all adjustments that were made. 
 
Make any comments necessary in the Repairs Made field. 
 
Click the Process POST Calibration Data button and the 
Preview Report screen will pop up. 
 
Click File and then Print and print page two. 
 
Close the preview screen. 
 
Use the navigation buttons to find another record to reduce data 
for or if you are done close the AT/RH Sensor Calibration Form. 
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4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION STICKER An ARS calibration sticker is placed on the sensor, marking the 

date the instrument was calibrated and the name of the 
technician  
who calibrated it (Figure 4-4). 
 
 
 
 
 
 
 

Figure 4-4.  ARS Calibration Sticker. 
 

CALIBRATION FORMS Calibration forms will be completed, reviewed, and signed by 
the instrument technician. The instrument technician shall also 
maintain the forms and the Excel data files in the instrument 
laboratory, and provide copies of both the calibration form and 
Instrument Service Order Form to the data technician for entry 
into the cost accounting database, and to the technical assistant 
along with the calibrated sensor. 
 

MAINTENANCE CARDS Upon receipt of the completed forms and the calibrated sensor 
from the instrument technician, the technical assistant will file 
both forms with the sensor’s maintenance card, update the card, 
and place each sensor in the calibrated bin for deployment by the 
field specialists. 
 

5.0 REFERENCES 
 
Rotronics, Inc., 1995, MP-601A Instruction Manual, July. 
 
Rotronics, Inc., 1994, MP-101A Instruction Manual.  March. 
 
Vaisala Oy, 1997, HMP45A & HMP45D Humidity and Temperature Probes Operating Manual, 
 September. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of Rotronics MP-101A ambient temperature/relative humidity (AT/RH) sensors and 
Rotronics MP-601A relative humidity sensors. The purpose of the calibration is to ensure that 
the sensor accuracy under normal operating conditions is within specified manufacturer’s or 
project accuracy limits. Both the Rotronics AT/RH system and the RH system include a DC 
power supply, sensor, and radiation shield. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 This TI is intended for use by field specialists who understand general instrument 
operational concepts and have their own National Institute of Standards and Technology (NIST) 
certified equipment. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 

• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for AT/RH sensor calibration: 
 

• A calibrated reference AT/RH sensor 
 

• A replacement sensor 
 

• A portable datalogger (Campbell 21XL or similar) 
 

• Appropriate audit parositic aspirator 
 
• Digital voltmeter (4-1/2 digit) 

 
• Sensor maintenance cards 
 
• Field service tools 
 
• Station log book or DataView 
 
• Temperature, Delta Temperature, and Relative Humidity Calibration Forms 
 
• Pen or pencil 
 
• Laptop computer loaded with Excel workbook (NPS.XLT) and CALCU program 

software 
 
• ARS calibration stickers 

 
4.0 METHODS 
 
 The AT/RH or RH system must be checked (pre-maintenance calibration) before 
servicing any system components. Throughout the calibration and maintenance period, the 
datalogger, calibration forms, DataView, and strip chart (if used) must be annotated to indicate 
that data taken during the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors  
The pre-and post-maintenance calibration techniques are identical. Do not perform any 
maintenance to the sensors until all pre-calibration checks are completed. 
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 The procedures described in this TI are specific to Rotronics 100 or 101 series AT/RH 
sensors and Rotronics MP-601 series RH sensors. Calibration and maintenance include tasks that 
are detailed in the following five (5) major subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks. Refer to Figure 4-1, Example Temperature, Delta 
Temperature, and Relative Humidity Calibration Form, when performing calibration checks. Be 
sure to indicate on the form whether the calibration is pre- or post-maintenance and note all 
maintenance activities or replaced components in the “Comments” field. The form is available as 
an Excel spreadsheet and should be used for both pre- and post- maintenance checks. Results of 
each calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and 
time (beginning and ending) of the calibration and maintenance
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on the Temperature, Delta 
Temperature, and Relative Humidity Calibration Form: network 
and station name; current date; name of technician performing 
the calibration; manufacturer, model, and serial number of the 
instrument; and date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance DVM and DAS of 
the sensor to be calibrated. Install the parositic aspirator onto the 
existing station aspirator 
 
The accuracy of the AT/RH or RH sensor response should be 
evaluated by comparing the ambient AT/RH or RH measured 
from the station sensor against a reference AT/RH sensor. 
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 Figure 4-1.  Example Temperature, Delta Temperature, and Relative Humidity   
                                Calibration Form. 
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CALIBRATE SENSOR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Calibrate the sensor as follows: 
 
• Install the reference sensor (Rotronics MP101A sensor used 

in example below) and attach leads to the portable 
datalogger. Use the following program for the 21XL. Allow 
the reference sensor to record for as long as practical (3 to 12 
hours recommended). Retrieve the data and compare to 
hourly averages of the existing sensor. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Air Temperature/Relative Humidity/Solar Radiation Audit Program
 
*Table 1 Program 
 01: 60  Execution Interval (seconds) 
 
1:  Volts (SE)  (P1) 
 1:  1  Reps 
 2:  1  1000 mV Slow Range 
 3:  1  SE Channel 
 4:  1  Loc REF AT 
 5:  .10000 Multi 
 6:  __30 Offset 
 
2:  Volts (SE)  (P1) 
 1:  1  Reps 
 2:  5  5000 mV Slow Range 
 3:  2  SE Channel 
 4:  2  Loc REF RH 
 5:  .10000 Mult 
 6:  0.0  Offset 
 
3:  Volt (Diff)  (P2) 
 1:  1  Reps 
 2:  2  15 mV Slow Range 
 3:  2  DIFF Channel 
 4:  3  Loc REF SOLAR 
 5:  x.xxx Mult  
 6:  0.0  Offset 
 Note: x.xxx = calibration constant for reference radiometer. 
 
4:  If time is  (P92) 
 1:  0000 Minutes into a 
 2:  0060 Minute Interval 
 3:  10  Set Output Flag High 
 
5:  Real Time  (P77) 
 1:  0110 Day, Hour/Minute (midnight = 0000) 
 
6:  Average  (P71) 
 1:  3  Reps 
 2:  1  Loc REF RH AND SOLAR 
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CALIBRATE SENSOR 
(continued) 

 
 
 
 
 
 
 
 
 
 
 
• Record the AT and RH values as the reference values listed 

on the calibration form, then record the corresponding 
datalogger and DVM values. 

 
4.1.1 Evaluation of Air Temperature and Relative Humidity Checks 
 
 Evaluate the results of the air temperature and relative humidity calibration check, and 
verify that the air temperature sensor is within 1°C and the relative humidity value is within !5% 
of the reference values. 
 
4.2 SENSOR REPLACEMENT 
 
 Any sensor that has operated in the field for 5 or more months should be replaced with a 
laboratory-calibrated sensor. The replacement sensor operation should be verified by a post-
maintenance calibration check (see Section 4.4). The replaced sensor should be submitted for 
ARS calibration immediately upon return from the field. 
 
4.3 SYSTEM MAINTENANCE 
 
 The following corrective actions are appropriate if the above checks reveal that the 
AT/RH response is beyond the tolerance discussed in Section 4.1.1: 
 
WIRING INSPECTION 
AND REPAIR 

Inspect all AT/RH wiring for abrasions, cuts, or loose 
connections. Measure  the supply voltage  between pins 1 and 2 
of  the 5-pin Rotronics connector, verifying that the sensor has a 
supply voltage between 5 and 26 DC volts (MP-101A) or 5 and 
30 DC volts (MP-601A). Inspect all connector pins for possible 
corrosion, and repair as required. Figure 4-2 presents the wiring 
diagram. 
 

AT/RH OR RH SENSOR Field adjustment or repair of the Rotronics MP-101A AT/RH 
sensor or MP-601A RH sensor is not recommended. If the sensor 
response is outside of specification, or if the sensor has been on-
site for 5 or more months, replace it with a laboratory-calibrated 
unit, then continue with the post-maintenance calibration 
procedures. Appropriate specifications are listed in Table 4-1. 

WIRING AT/RH CABLE TO 21XL DATALOGGER 
 
RED   +12 VOLTS 
WHITE   1 HIGH 
GREEN  1 LOW 
BLACK  GROUND 
SHIELD  GROUND 
 
WIRING SOLAR RADIATION TO 21XL DATALOGGER 
 
RED   2H 
BLACK  2L 
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Figure 4-2.  Rotronics AT/RH Sensor Wiring Diagram. 
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Table 4-1 

  
Specifications of Rotronics AT/RH Sensor 

 
SPECIFICATIONS 
 
Humidity Sensor     ROTRONIC HYGROMERTM C94 
Temperature Sensor     Pt100 RTD 
Humidity Measuring Range    0..100% RH 
Temperature Measuring Range    See Temperature Limits 
Temperature Limits     -40..+60°C 
Humidity Output Signal (linear)    0..1.0 VDC = 0..100% RH 
Temperature Output Signal (linear)   Standard: -0.4..0.6 VDC = -40..+60°C 
       Optional:  0.0..1.0 VDC = -40..+60°C 
       Optional:  0.0..1.0 VDC = -30..+70°C 
Minimum Load per Output    1000 Ω 
Accuracy (at 20..25°C)     !1% RH from 0 to 100% RH* 
       !0.3°C 
Repeatability      !0.3% RH and !0.1°C 
Humidity Sensor Stability    better than 1% RH over a year 
Response Time (without filter)    10 seconds (% RH and temperature) 
Calibration Potentiometers    35, 80% RH and RH min. 
       Tmin and Tmax 
Supply Voltage      4.8 to 26.5 VDC (MP-101A) 
       4.8 to 30.0 VDC (MP-601A) 
Max. Current Consumption    10 mA (MP-101A) 
       2.5 mA when powered with 
           12 VDC or less (MP-601A) 
Connector      MP 101A-C4: 4-pin CANNON 
       MP 101A-C5: 5-pin CANNON 
       MP 101A-T7: 7-pin TUCHEL 
Cable Length      MP 101A-C4 or C5: 6.5 ft (2 m) 
       MP 101A-T7: connector is on the probe 
Sensor Protection     Standard (MP-101A): foam filter MF25C  
       Optional (MP-101A): wire mesh filter SP-W25 
       Standard (MP-601A): D25 wire mesh filter 
       Optional (MP-601A): MF25-MP foam filter 
Weight       70..700g (0.15..1.50 lb) 
 
* When calibrated against highest quality reference standards.  Both factory calibration and field 

calibration with ROTRONIC standards result in !1.5%RH accuracy or better. 
 
Accessories (order separately) 
 
Natural Aspiration Shield    SMP-41002 
Motor Aspirated Shield     MAS-41003 (12 VDC, 75 mA) 
Calibration Device     EM25 
 
                 MP 101A - 03/18/94 
                    MP 601A- 07/24/95 
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4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as the post-maintenance values. 
 
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION FORMS Field calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely. Where possible, use the 
Excel spreadsheet so that both a hard copy and digital record of 
the calibration are maintained. Review and sign all calibration 
forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in 
sensor or calibration operation that could affect the quality of 
data. 
 

SENSOR MAINTENANCE 
CARD 

The sensor maintenance cards for both the existing and 
replacement sensors must be completed by the field specialist. 
 

CALIBRATION STICKER An ARS laboratory calibration sticker should exist on the   
replacement sensor, marking the date the instrument was 
calibrated and the name of the technician who calibrated it. 
 
 
 
 
 
 
 

Figure 4-3.  ARS Calibration Sticker. 
 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
 

5.0 REFERENCES 
 
Rotronics, Inc., 1995, MP-601A Instruction Manual, July. 
 
Rotronics, Inc., 1994, MP-101A Instruction Manual.  March. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of Vaisala HMP 45AC ambient temperature/relative humidity (AT/RH) sensors. 
The purpose of the calibration is to ensure that the sensor accuracy under normal operating 
conditions is within specified manufacturer's or project accuracy limits. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer’s instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 This TI is intended for use by field specialists who understand general instrument 
operational concepts and have their own National Institute of Standards and Technology (NIST) 
certified equipment. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 

• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for AT/RH sensor calibration: 
 

• A calibrated reference AT/RH sensor 
 

• A replacement sensor 
 

• A portable datalogger (Campbell 21XL or similar) 
 

• Appropriate audit parositic aspirator 
 

• Digital voltmeter (4-1/2 digit) 
 

• Sensor maintenance cards 
 

• Field service tools 
 

• Station log book or DataView 
 

• Temperature, delta temperature, and relative humidity calibration form 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel workbook (Calibrations.XLT) and CALCU 
program software 

 
• ARS calibration stickers 

 
4.0 METHODS 
 
 The AT/RH or RH system must be checked (pre-maintenance calibration) before 
servicing any system components. Throughout the calibration and maintenance period, the 
datalogger, calibration forms, DataView, and strip chart (if used) must be annotated to indicate 
that data taken during the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre-and post-maintenance calibration techniques are identical. Do not perform any 
maintenance to the sensors until all pre-calibration checks are completed. 
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 The procedures described in this TI are specific to Vaisala HMP 45AC AT/RH sensors. 
Calibration and maintenance include tasks that are detailed in the following five (5) major 
subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity.  The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks.  Refer to Figure 4-1, Temperature, Delta Temperature, and 
Relative Humidity Calibration Form (or similar), when performing calibration checks.  Be sure 
to indicate on the form whether the calibration is pre- or post-maintenance and note all 
maintenance activities or replaced components in the "Comments" field.  The form is available 
as an Excel spreadsheet and should be used for both pre- and post- maintenance checks.  Results 
of each calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually.  Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made.  The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and time 
(beginning and ending) of the calibration and maintenance
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on the calibration form: network 
and station name; current date; name of technician performing the 
calibration, manufacturer, model, and serial number of the 
instrument, and date of the last calibration. 
 

RECORD READINGS Simultaneously record the pre-maintenance DVM and DAS of the 
sensor to be calibrated. Install the parositic aspirator onto the 
existing station aspirator. 
 
The accuracy of the AT/RH or RH sensor response should be 
evaluated by comparing the ambient AT/RH or RH measured from 
the station against a reference AT/RH sensor. 
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Figure 4-1. Temperature, Delta Temperature, and Relative Humidity Calibration Form. 
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CALIBRATE 
SENSOR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Calibrate the sensor as follows: 
 
• Install the reference sensor and attach leads to the portable 

datalogger. Use the following program for the 21XL. Allow the 
reference sensor to record for as long as practical (3 to 12 
hours recommended). Retrieve the data and compare to hourly 
averages of the existing sensor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Air Temperature/Relative Humidity/Solar Radiation Audit Program
 
*Table 1 Program 
 01: 60  Execution Interval (seconds) 
 
1:  Volts (SE)  (P1) 
 1:  1  Reps 
 2:  1  1000 mV Slow Range 
 3:  1  SE Channel 
 4:  1  Loc REF AT 
 5:  .10000 Multi 
 6:  __30 Offset 
 
2:  Volts (SE)  (P1) 
 1:  1  Reps 
 2:  5  5000 mV Slow Range 
 3:  2  SE Channel 
 4:  2  Loc REF RH 
 5:  .10000 Mult 
 6:  0.0  Offset 
 
3:  Volt (Diff)  (P2) 
 1:  1  Reps 
 2:  2  15 mV Slow Range 
 3:  2  DIFF Channel 
 4:  3  Loc REF SOLAR 
 5:  x.xxx Mult  
 6:  0.0  Offset 
 Note: x.xxx = calibration constant for reference radiometer. 
 
4:  If time is  (P92) 
 1:  0000 Minutes into a 
 2:  0060 Minute Interval 
 3:  10  Set Output Flag High 
 
5:  Real Time  (P77) 
 1:  0110 Day, Hour/Minute (midnight = 0000) 
 
6:  Average  (P71) 
 1:  3  Reps 
 2:  1  Loc REF RH AND SOLAR 
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CALIBRATE SENSOR 
(continued) 

 
 
 
 
 
 
 
 
 
 
 
• Record the calculated AT and RH values as the reference 

values listed on the calibration form, then record the 
corresponding datalogger and DVM values. 

 
4.1.1 Evaluation of Air Temperature and Relative Humidity Checks 
 
 Evaluate the results of the air temperature and relative humidity calibration check, and 
verify that the air temperature sensor is within 1°C and the relative humidity value is within !5% 
of the reference values. 
 
4.2 SENSOR REPLACEMENT 
 
 Any sensor that has operated in the field for 5 or more months should be replaced with a 
laboratory-calibrated sensor. The replacement sensor operation should be verified by a post-
maintenance calibration check (see Section 4.4). The replaced sensor should be submitted for 
ARS calibration immediately upon return from the field. 
 
4.3 SYSTEM MAINTENANCE 
 
 The following corrective actions are appropriate if the above checks reveal that the 
station AT/RH response is beyond the tolerance discussed in Section 4.1.1: 
 
WIRING INSPECTION 
AND REPAIR 

Inspect all AT/RH wiring for abrasions, cuts, or loose 
connections. Inspect all connector pins for possible corrosion, and 
repair as required. 
 

AT/RH OR RH SENSOR Field adjustment or repair of the Vaisala HMP 45AC sensor is not 
recommended. If the sensor response is outside of specification, 
or if the sensor has been on-site for 5 or more months, replace it 
with a laboratory-calibrated unit, then continue with the post-
maintenance calibration procedures. 
 

4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as the post-maintenance values. 

WIRING AT/RH CABLE TO 21XL DATALOGGER 
 
RED   +12 VOLTS 
WHITE   1 HIGH 
GREEN  1 LOW 
BLACK  GROUND 
SHIELD  GROUND 
 
WIRING SOLAR RADIATION TO 21XL DATALOGGER 
 
RED   2H 
BLACK  2L 
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4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION 
FORMS 

Field calibration forms or the computer laptop Excel spreadsheet 
should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration forms. 
 
 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

SENSOR 
MAINTENANCE CARD 

The sensor maintenance cards for both the existing and 
replacement sensors must be completed by the field specialist. 
 

CALIBRATION 
STICKER 

An ARS laboratory calibration sticker should exist on the 
replacement sensor, marking the date the instrument was 
calibrated and the name of the technician who calibrated it. 
 
 
 
 
 
 
 

Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and minimize 
data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of R.M. Young Solar Radiation Systems 70201. The purpose of the calibration is to 
ensure that the sensor accuracy under normal operating conditions is within specified 
manufacturer's or project accuracy limits. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer's instrument manual should be able to adjust the equipment to fully meet all defined 
specifications. 
 
 This TI is intended for use by field specialists who understand general instrument 
operational concepts and have their own National Institute of Standards and Technology (NIST) 
certified equipment. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the instrument 
that affects its operational principle 

 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for AT/RH sensor calibration: 
 

• A calibrated reference solar sensor 
 

• A replacement sensor 
 

• A portable datalogger (Campbell 21X or similar) 
 

• Digital voltmeter (4-1/2 digit) 
 

• Sensor maintenance cards 
 

• Field service tools 
 

• Station log book or DataView 
 

• Solar Radiation and CASTNet Flow Calibration Form 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel workbook (Calibrations.XLT) and CALCU 
program software 

 
• ARS calibration stickers 

 
4.0 METHODS 
 
 The solar system must be checked (pre-maintenance calibration) before servicing any 
system components. Throughout the calibration and maintenance period, the datalogger, 
calibration forms, DataView, and strip chart (if used) must be annotated to indicate that data 
taken during the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre-and post-maintenance calibration techniques are identical. Do not perform any 
maintenance to the sensors until all pre-calibration checks are completed. 
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 The procedures described in this TI are specific to R.M. Young Solar Radiation System 
(70201). Calibration and maintenance include tasks that are detailed in the following five (5) 
major subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks.  Refer to Figure 4-1, Wetness, Precipitation, and Barometric 
Pressure Calibration Form (or similar), when performing calibration checks. Be sure to indicate on 
the form whether the calibration is pre- or post-maintenance and note all maintenance activities or 
replaced components in the “Comments” field. The form is available as an Excel spreadsheet and 
should be used for both pre- and post- maintenance checks. Results of each calibration should be 
in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made.  The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book or DataView indicating the 
date and time (beginning and ending) of the calibration and 
maintenance procedures. “Down” the appropriate channels on the 
DAS or set the calibration flag as appropriate for the DAS being 
used. 
 
Complete the following fields on the calibration form: network and 
station name; current date; name of technician performing the 
calibration, manufacturer, model, and serial number of the 
instrument, and date of the last calibration. 
 

RECORD READINGS The accuracy of the solar sensor response should be evaluated by 
comparing the ambient solar measured from the station against a 
reference solar sensor. 
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Figure 4-1.  Solar Radiation and CASTNet Flow Calibration Form. 
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CALIBRATE SENSOR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Calibrate the sensor as follows: 
 
• Install the reference sensor and attach leads to the portable 

datalogger. Use the following program for the 21XL. Allow the 
reference sensor to record for as long as practical (3 to 12 
hours recommended).  Retrieve the data and compare to hourly 
averages of the existing sensor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Relative Humidity/Solar Radiation Audit Program 
 
*Table 1 Program 
 01: 60  Execution Interval (seconds) 
 
1:  Volts (SE)  (P1) 
 1:  1  Reps 
 2:  5  5000 mV Slow Range 
 3:  1  SE Channel 
 4:  1  Loc REF RH 
 5:  .10000 Mult 
 6:  0.0  Offset 
 
2:  Volt (Diff)  (P2) 
 1:  1  Reps 
 2:  2  15 mV Slow Range 
 3:  2  DIFF Channel 
 4:  2  Loc REF SOLAR 
 5:  1.0  Mult 
 6:  0.0  Offset 
 
3:  If time is  (P92) 
 1:  0000 Minutes into a 
 2:  0060 Minute Interval 
 3:  10  Set Output Flag High 
 
4:  Real Time  (P77) 
 1:  0110 Day, Hour/Minute (midnight = 0000) 
 
5:  Average  (P71) 
 1:  2  Reps 
 2:  1  Loc REF RH AND SOLAR 
 
WIRING RH CABLE TO 21XL DATALOGGER 
 
RED   +12 VOLTS 
GREEN  1 HIGH 
BLACK  GROUND 
SHIELD  GROUND 
 
WIRING SOLAR RADIATION TO 21XL DATALOGGER 
 
RED   2H 
BLACK  2L 
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CALIBRATE SENSOR 
(continued) 

• Record the calculated solar values as the reference value listed 
on the calibration form. 

 
4.1.1 Evaluation of Solar Radiation Checks 
 
 Evaluate the results of the solar radiation calibration check, and verify that the station 
solar value is within 5% of the calculated reference value. 
 
4.2 SENSOR REPLACEMENT 
 
 Any sensor that has operated in the field for 12 or more months should be replaced with a 
laboratory-calibrated sensor. The replacement sensor operation should be verified by a post-
maintenance calibration check (see Section 4.4). The replaced sensor should be submitted for 
ARS calibration immediately upon return from the field. 
 
4.3 SYSTEM MAINTENANCE 
 
 The following corrective actions are appropriate if the above checks reveal that the station 
solar response is beyond the tolerance discussed in Section 4.1.1: 
 
WIRING INSPECTION 
AND REPAIR 

Inspect all solar wiring for abrasions, cuts, or loose connections. 
Inspect all connector pins for possible corrosion, and repair as 
required. 
 

SOLAR SENSOR Field adjustment or repair of the R M Young Solar Radiation 
System sensor is not recommended. If the sensor response is 
outside of specification, or if the sensor has been on-site for 12 or 
more months, replace it with a laboratory-calibrated unit, then 
continue with the post-maintenance calibration procedures. 

 
4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as the post-maintenance values. 
  
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION 
FORMS 

Field calibration forms or the computer laptop Excel spreadsheet 
should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration forms. 
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LOG NOTES A summary of results and maintenance performed must be 

included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

SENSOR 
MAINTENANCE CARD 

The sensor maintenance cards for both the existing and 
replacement sensors must be completed by the field specialist. 
 

CALIBRATION 
STICKER 

An ARS laboratory calibration sticker should exist on the 
replacement sensor, marking the date the instrument was 
calibrated and the name of the technician who calibrated it. 
 
 
 
 
 
 
 
  Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of a LI-COR model LI-200 pyranometer. The purpose of the calibration is to ensure 
that the sensor accuracy under normal operating conditions is within specified manufacturer's or 
project accuracy limits. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer's instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 This TI is intended for use by field specialists who understand general instrument 
operational concepts and have their own National Institute of Standards and Technology (NIST) 
certified equipment. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of six months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for AT/RH sensor calibration: 
 

• A calibrated reference solar sensor 
 

• A replacement sensor 
 

• A portable datalogger (Campbell 21X or similar) 
 

• Digital voltmeter (4-1/2 digit) 
 

• Sensor maintenance cards 
 

• Field service tools 
 

• Station log book or DataView 
 

• Calibration forms 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel calibration forms 
 

• ARS calibration stickers 
 
4.0 METHODS 
 
 The solar system must be checked (pre-maintenance calibration) before servicing any 
system components. Throughout the calibration and maintenance period, the datalogger, 
calibration forms, DataView, and strip chart (if used) must be annotated to indicate that data 
taken during the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre-and post-maintenance calibration techniques are identical. Do not perform any 
maintenance to the sensors until all pre-calibration checks are completed. 
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 The procedures described in this TI are specific to LI-COR model LI-200 pyranometer. 
Calibration and maintenance include tasks that are detailed in the following five (5) major 
subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks.  Refer to Figure 4-1, Solar Radiation and Net Radiation 
Calibration Form (or similar), when performing calibration checks. Be sure to indicate on the 
form whether the calibration is pre- or post-maintenance and note all maintenance activities or 
replaced components in the “Comments” field. The form is available as an Excel spreadsheet and 
should be used for both pre- and post- maintenance checks. Results of each calibration should be 
in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made.  The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book or DataView indicating the 
date and time (beginning and ending) of the calibration and 
maintenance procedures. “Down” the appropriate channels on the 
data acquisition system (DAS) or set the calibration flag as 
appropriate for the DAS being used. 
 
Complete the following fields on the calibration form: network 
and station name; current date; name of technician performing the 
calibration, manufacturer, model, and serial number of the 
instrument, and date of the last calibration. 
 

RECORD READINGS The accuracy of the solar sensor response should be evaluated by 
comparing the ambient solar measured from the station against a 
reference solar sensor. 
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Figure 4-1.  Solar Radiation and Net Radiation Calibration Form. 
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CALIBRATE SENSOR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Calibrate the sensor as follows: 
 
• Install the reference sensor and attach leads to the portable 

datalogger. Use the following program for the 21XL. Allow the 
reference sensor to record for as long as practical (3 to 12 
hours recommended).  Retrieve the data and compare to hourly 
averages of the existing sensor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Relative Humidity/Solar Radiation Audit Program 
 
*Table 1 Program 
 01: 60  Execution Interval (seconds) 
 
1:  Volts (SE)  (P1) 
 1:  1  Reps 
 2:  5  5000 mV Slow Range 
 3:  1  SE Channel 
 4:  1  Loc REF RH 
 5:  .10000 Mult 
 6:  0.0  Offset 
 
2:  Volt (Diff)  (P2) 
 1:  1  Reps 
 2:  2  15 mV Slow Range 
 3:  2  DIFF Channel 
 4:  2  Loc REF SOLAR 
 5:  1.0  Mult 
 6:  0.0  Offset 
 
3:  If time is  (P92) 
 1:  0000 Minutes into a 
 2:  0060 Minute Interval 
 3:  10  Set Output Flag High 
 
4:  Real Time  (P77) 
 1:  0110 Day, Hour/Minute (midnight = 0000) 
 
5:  Average  (P71) 
 1:  2  Reps 
 2:  1  Loc REF RH AND SOLAR 
 
WIRING RH CABLE TO 21XL DATALOGGER 
 
RED   +12 VOLTS 
GREEN  1 HIGH 
BLACK  GROUND 
SHIELD  GROUND 
 
WIRING SOLAR RADIATION TO 21XL DATALOGGER 
 
RED   2H 
BLACK  2L 
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CALIBRATE SENSOR 
(continued) 

• Record the calculated solar values as the reference value 
listed on the calibration form. 

 
4.1.1 Evaluation of Solar Radiation Checks 
 
 Evaluate the results of the solar radiation calibration check, and verify that the station 
solar value is within !5% of the calculated reference value. 
 
4.2 SENSOR REPLACEMENT 
 
 Any sensor that has operated in the field for 12 or more months should be replaced with a 
laboratory-calibrated sensor. The replacement sensor operation should be verified by a post-
maintenance calibration check (see Section 4.4). The replaced sensor should be submitted for 
ARS calibration immediately upon return from the field. 
 
4.3 SYSTEM MAINTENANCE 
 
 The following corrective actions are appropriate if the above checks reveal that the 
station solar response is beyond the tolerance discussed in Section 4.1.1: 
 
WIRING INSPECTION 
AND REPAIR 

Inspect all solar wiring for abrasions, cuts, or loose connections. 
Inspect all connector pins for possible corrosion, and repair as 
required. 
 

SOLAR SENSOR Field adjustment or repair of the LI-COR model LI-200 
pyranometer is not recommended. If the sensor response is 
outside of specification, or if the sensor has been on-site for 12 or 
more months, replace it with a laboratory-calibrated unit, then 
continue with the post-maintenance calibration procedures. 

 
4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as the post-maintenance values. 
  
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION 
FORMS 

Field calibration forms or the computer laptop Excel spreadsheet 
should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration forms. 
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LOG NOTES A summary of results and maintenance performed must be 

included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

SENSOR 
MAINTENANCE CARD 

The sensor maintenance cards for both the existing and 
replacement sensors must be completed by the field specialist. 
 

CALIBRATION 
STICKER 

An ARS laboratory calibration sticker should exist on the 
replacement sensor, marking the date the instrument was 
calibrated and the name of the technician who calibrated it. 
 
 
 
 
 
 
 
  Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of any tipping bucket-type precipitation gauge. The purpose of the calibration is to 
ensure that the gauge accuracy under normal operating conditions is within specified 
manufacturer's or project accuracy limits. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer's instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 This TI is intended for use by field specialists who understand general instrument 
operational concepts and have their own National Institute of Standards and Technology (NIST) 
certified equipment. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of 6 months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for a tipping bucket rain gauge: 
 

• Drip bottle 
 

• Digital voltmeter (4-1/2 digit) 
 

• Sensor maintenance cards 
 

• Field service tools 
 

• Station log book or DataView 
 

• Wetness, Precipitation, and Barometric Pressure Calibration Form 
 

• Pen or pencil 
 

• Laptop computer loaded with Excel workbook (Calibrations.XLT) 
 

• ARS calibration stickers 
 
4.0 METHODS 
 
 The tipping bucket precipitation gauge system must be checked (pre-maintenance 
calibration) before servicing any system components. Throughout the calibration and 
maintenance period, the datalogger, calibration forms, DataView, and strip chart (if used) must 
be annotated to indicate that data taken during the calibration period should not be included as 
standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre-and post-maintenance calibration techniques are identical. Do not perform any 
maintenance to the sensors until all pre-calibration checks are completed. 
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 The procedures described in this TI are applicable to any tipping bucket precipitation 
gauge. Calibration and maintenance include tasks that are detailed in the following five (5) major 
subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks. Refer to Figure 4-1, Wetness, Precipitation, and Barometric 
Pressure Calibration Form (or similar), when performing calibration checks.  Be sure to indicate 
on the form whether the calibration is pre- or post-maintenance and note all maintenance 
activities or replaced components in the “Comments” field. The form is available as an Excel 
spreadsheet and should be used for both pre- and post- maintenance checks. Results of each 
calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made. The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book indicating the date and time 
(beginning and ending) of the calibration and maintenance
procedures. “Down” the appropriate channels on the DAS or set 
the calibration flag as appropriate for the DAS being used. 
 
Complete the following fields on Wetness, Precipitation, and 
Barometric Pressure Calibration Form: network and station name; 
current date; name of technician performing the calibration, 
manufacturer, model, and serial number of the instrument, and 
date of the last calibration. 
 

RECORD READINGS Record the pre-maintenance DAS value of the sensor to be 
calibrated. Install the drip bottle calibrator onto the gauge. 
 
The accuracy of the precipitation gauge response should be 
evaluated by comparing the response to the expected value as 
indicated in Table 4-1. 
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Figure 4-1. Wetness, Precipitation, and Barometric Pressure Calibration Form. 
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Table 4-1 
 

Tipping Bucket-Type Rain Gauges 
Manufacturer Calibration Values 

 

Gauge 
Inlet 

Diameter / 
Model # 

mm/Tip Tips/900cc mm/900cc Tips/936cc mm/936cc 

Texas 
Electronics 
 

6.06” 4.73 483 48.3 503 50.3 

Texas 
Electronics 
 

8.00” 8.23 278 27.8 289 28.9 

Texas 
Electronics 
 

9.66” 4.73 190 19.0 198 19.8 

NovaLynx 
 

260-2500 8.24 278 27.8 289 28.9 

R.M. Young 52202 
52203 

2.0 450 45.0 468 46.8 

 
4.1.1 Evaluation of Precipitation Gauge Checks 
 
 Evaluate the results of the precipitation gauge calibration check, and verify that the gauge 
is within !5% of the calculated reference value. 
 
4.2 SYSTEM MAINTENANCE 
 
 The following corrective actions are appropriate if the above checks reveal that the 
station precipitation gauge response is beyond the tolerance discussed in Section 4.1.1: 
 
WIRING INSPECTION 
AND REPAIR 

Inspect all precipitation gauge wiring for abrasions, cuts, or loose 
connections. Inspect all connector pins for possible corrosion, and 
repair as required. 
 

PRECIPITATION GAUGE 
 
 
 
 
 
 
 
 
 
 
 
 
 

Field adjustment of the tipping bucket rain gauge is recommended 
if the gauge response is outside of specification. To check the 
calibration of the gauge or to recalibrate, the following procedure 
should be used: Using a pipet, allow the value of water indicated 
in Table 4-1 to pass through the inner funnel to the tipping 
bucket. The bucket should tip. Check the alternate bucket in the 
same manner. If both buckets tip when filled with indicated 
values of water, the gauge is in proper calibration (Note: before 
starting the calibration, the buckets should be wet).  If the buckets 
do not tip, recalibrate as follows: 
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PRECIPITATION GAUGE 
(continued) 

1. Release the lock nuts on the cup adjustments. 
2. Move the adjustment screws down to a position that would 

place the bucket far out of calibration. 
3. Introduce the tip value of water as indicated in Table 4-1. 
4. Turn the cup adjustment screw up until the bucket assembly 

tips. Tighten the lock nut. 
5. Repeat this procedure for the opposite bucket. 
6. Repeat the process several times to insure proper calibration. 
 
After installation and calibration (if necessary) replace the cover 
on the gauge. 

 
4.3 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as the post-maintenance values. 
  
4.4 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION 
FORMS 

Field calibration forms or the computer laptop Excel spreadsheet 
should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

CALIBRATION 
STICKER 

An ARS laboratory calibration sticker should exist on the gauge, 
marking the date the instrument was calibrated and the name of 
the technician who calibrated it. 
 
 
 
 
 
 
 
  Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip 
report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 The purpose of calibration and maintenance is to assure quality data capture and 
minimize data loss by performing and documenting scheduled operational checks and preventive 
maintenance. This technical instruction (TI) provides specific details for routine calibration and 
maintenance of an R.M. Young model 58101 wetness sensor. The purpose of the calibration is to 
ensure that the sensor accuracy under normal operating conditions is within specified 
manufacturer's or project accuracy limits. 
 
 Experienced technicians using this TI, Standard Operating Procedure (SOP) 3150, 
Calibration and Routine Maintenance of Meteorological Monitoring Systems, and the 
manufacturer's instrument manual should be able to adjust the equipment to fully meet all 
defined specifications. 
 
 This TI is intended for use by field specialists who understand general instrument 
operational concepts and have their own National Institute of Standards and Technology (NIST) 
certified equipment. 
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of six months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration and maintenance schedule and coordinate 
with the client as necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
• Review and approve any changes to calibration procedures. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for AT/RH sensor calibration: 
 

• A resistance decade box 
 

• A replacement wetness sensor 
 

• Digital voltmeter (4-1/2 digit) 
 

• Sensor maintenance cards 
 

• Field service tools 
 
• Station log book or DataView 
 
• Pen or pencil 

 
• Laptop computer loaded with Excel calibration forms 

 
• ARS calibration stickers 
 
• Water (small amount) 
 
• Kimwipe 

 
4.0 METHODS 
 
 The R.M. Young model 58101 wetness sensor is designed to monitor dew or rain that 
would collect upon the native vegetation. When the sensor’s artificial “leaf” gets wet, the sensor 
output changes from 0.00 VDC to 1.00 VDC. Adjustments to the sensor include the sensitivity 
adjustment, which defines how much moisture is required to indicate wet, and the voltage 
adjustment, which adjusts the instrument’s 1.00 VDC output.  
 
 The wetness system must be checked (pre-maintenance calibration) before servicing any 
system components. Throughout the calibration and maintenance period, the datalogger, 
calibration forms, DataView, and strip chart (if used) must be annotated to indicate that data 
taken during the calibration period should not be included as standard observations. 
 
 After performing system adjustments and maintenance, the system again needs to be 
dynamically checked (post-maintenance calibration) to ensure proper operation of the sensors. 
The pre-and post-maintenance calibration techniques are identical. Do not perform any 
maintenance to the sensors until all pre-calibration checks are completed. 
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 The procedures described in this TI are specific to R.M. Young model 58101 wetness 
sensors. Calibration and maintenance include tasks that are detailed in the following five (5) 
major subsections: 
 
 4.1  Calibration Checks 
 4.2  Sensor Adjustments/Replacement 
 4.3  Sensor Maintenance 
 4.4  Post-Maintenance Calibration Checks 
 4.5  Documentation 
 
4.1 CALIBRATION CHECKS 
 
 A complete calibration check must be performed prior to (pre) and following (post) any 
maintenance activity. The calibration check procedures described below apply to both pre- or 
post-maintenance calibration checks.  Refer to Figure 4-1, Wetness, Precipitation, and 
Barometric Pressure Calibration Form (or similar), when performing calibration checks. Be sure 
to indicate on the form whether the calibration is pre- or post-maintenance and note all 
maintenance activities or replaced components in the “Comments” field. The form is available as 
an Excel spreadsheet and should be used for both pre- and post- maintenance checks. Results of 
each calibration should be in both hardcopy and digital form. 
 
 Calibration checks are performed semiannually. Should any operational check be out of 
suggested tolerance, complete the calibration check before any maintenance or adjustments are 
made.  The following operational checks should be performed: 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book or DataView indicating the 
date and time (beginning and ending) of the calibration and 
maintenance procedures. “Down” the appropriate channels on the 
data acquisition system (DAS) or set the calibration flag as 
appropriate for the DAS being used. 
 
Complete the following fields on the calibration form: network 
and station name; current date; name of technician performing the 
calibration, manufacturer, model, and serial number of the 
instrument, and date of the last calibration. 
 

RECORD  
PRE-MAINTENANCE  
READINGS 

The accuracy of the wetness sensor response should be evaluated 
by observing the wetness sensor output when dry (0.00 VDC) and 
when wet (1.00 VDC). Wet the sensor using a damp Kimwipe; the 
red LED sensor should be on and the voltage should be 1.00 VDC. 

 
4.2 SENSOR ADJUSTMENTS/REPLACEMENT 
 
 Any sensor that is not able to be adjusted as described or exhibits other problems should 
be replaced. 
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Figure 4-1.  Wetness, Precipitation, and Barometric Pressure Calibration Form. 
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4.3 SENSOR MAINTENANCE 
 
 The following actions should be taken during each sensor check. 
 
CALIBRATE SENSOR Remove the cover from the sensor and insert leads from the decade 

box into the calibration jack. Adjust the decade box to 240 Kohms 
and adjust the sensitivity potentiometer until the LED illuminates.  
 
Check the sensor’s voltage output and adjust to 1.00 VDC. 
Remove the decade box and replace the sensor cover. 
 

RECORD  
POST-MAINTENANCE 
READINGS 

Record the sensor’s response on the calibration worksheet for dry 
and wet conditions, similar to the pre-maintenance checks. 

 
4.4 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing all maintenance and adjustment activities, initiate a post-maintenance 
calibration check as described in Section 4.1 and record them as the post-maintenance values. 
  
4.5 DOCUMENTATION 
 
 Sensor calibrations require several levels of documentation: 
 
CALIBRATION 
FORMS 

Field calibration forms or the computer laptop Excel spreadsheet 
should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration forms. 
 

LOG NOTES A summary of results and maintenance performed must be 
included in the station log notes. Note any abnormalities in sensor 
or calibration operation that could affect the quality of data. 
 

SENSOR 
MAINTENANCE CARD 

The sensor maintenance cards for both the existing and 
replacement sensors must be completed by the field specialist. 
 

CALIBRATION 
STICKER 

An ARS laboratory calibration sticker should exist on the 
replacement sensor, marking the date the instrument was 
calibrated and the name of the technician who calibrated it. 
 
 
 
 
 
 
 
  Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip report. 
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1.0 PURPOSE AND APPLICABILITY 
 

This standard operating procedure (SOP) is a guide to document the relationship between 
the analog inputs to a data acquisition system (DAS) and the values recorded and outputted by 
the DAS. This SOP applies to modern microprocessor-based datalogging systems. Detailed 
manufacturer’s specific DAS procedures are not included in this SOP. Separate technical 
instructions (TIs) are developed for each specific DAS. 
 
 A data acquisition system is generally referred to the measurement and recording devices 
that monitor and/or control various instruments and sensors. The DAS log discrete readings, 
averaged values, or events from the sensing instrument. Examples of data acquisition 
components include: dataloggers, strip chart recorders, printers, magnetic storage devices, 
modems, terminals, and data collection platforms (DCPs). 
 
 DAS calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• Upon installation or removal of the instrument at a field station 
 

• Whenever control limits are exceeded 
 

• Prior to any corrective action, service, or maintenance to any portion of the 
instrument that affects its operational principle 

 
• At a maximum interval of six months 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration schedule and coordinate with the client as 
necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations as described in this SOP. 
 
• Verify that the calibration standards are in good working order and are in current 

calibration. 
 
• Document all calibration results and maintenance procedures performed. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment is required for DAS calibration: 
 

• Voltage source calibrator (capable of outputting a range of values the covers the input 
range of the DAS) 

 
• Digital voltmeter (4 ½ digit) 

 
• Interconnect cabling 

 
• Manufacturer’s instrument manual 

 
• Instrument-specific technical instruction regarding calibrating the DAS 

 
• DAS calibration form (required only if the DAS is not connected to a printer) 

 
• Pen or pencil 

 
• Field service tools 

 
• Station log book 

 
4.0 METHODS 
 
 Calibration tasks are detailed in the following four (4) subsections: 
 
 4.1  Preparation for Calibration 
 4.2  Calibration Checks 
 4.3  Post-Maintenance Calibration Checks 
 4.4  Documentation 
 
4.1 PREPARATION FOR CALIBRATION 
 
 Before performing a calibration check, ensure adequate preparation of the operation 
environment, calibration device, and the DAS by determining the following: 
 

• The station is at the proper temperature. 
 

• Instruments are adequately warmed up. 
 

• Calibration documentation is current, complete, and available. 
 

• All required support tools, diagnostic equipment, supplies, and calibration forms are 
available. 

 
4.2 CALIBRATION CHECKS 
 
 It is important that all analog input channels of the datalogger be calibrated during the 
same procedure. The most complete calibration of a DAS would document how the input 
voltages are handled through the scaling, conversion, and recording functions of the DAS. The 
input voltages will be compared to the results logged on the storage media used for data 
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reporting. All functions of the system should be tested (if practical) as they are applied in 
operational logging at the site. 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book and annotate the strip chart 
recorder and data acquisition system (DAS) indicating the date 
and time (beginning and ending) of the calibration procedure.   
 

 It is standard to test the calibration of a DAS at 10 voltage values equally spaced over the 
range of the instrument.  The following steps describe the 10-point calibration procedure. 
 
CONNECT VOLTAGE 
SOURCE 

For efficiency, arrange a wiring harness so that all datalogger 
analog inputs can be subjected simultaneously to the same 
voltage source. Connect a calibrated voltmeter to the voltage 
source to verify the reference voltage. 
 

SHORT INPUTS Short all analog inputs to signal ground and scan all channels.  
This value is the zero (0.000) voltage input. 
 

SELECT VOLTAGES Select nine additional upscale voltage values that evenly 
challenge the entire measurement range of the datalogger analog 
input channels. Select each voltage sequentially, noting the 
individual channel response to each voltage. Verify the 
designated input voltage with the voltmeter. 
 

COMPARE VOLTAGES Compare the voltages recorded on each DAS channel to the 
voltmeter verified input voltage. If the difference between DAS 
response and voltmeter measured input is greater than 0.1% 
VDC, the DAS analog to digital converter will require service 
and/or adjustment. See Table 4-1 for acceptable DAS response. 
Refer to Figure 4-1 for an example of an annotated printer output 
that documents a DAS calibration. 
 

Table 4-1 
 

Acceptable Datalogger Accuracy Values 
 

Channel High Input 
(VDC) 

0.1% Tolerance 
(VDC) 

               0.100          0.0001 
               1.000          0.001 
               5.000          0.005 
             10.00          0.01 

 
 
4.3 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing any adjustment or maintenance, initiate a post-maintenance calibration 
check as described in Section 4.2. 
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Figure 4-1.  Annotated Printer Output Documenting a DAS Calibration. 
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4.4 DOCUMENTATION 
 
 DAS calibrations require several levels of documentation: 
 
CALIBRATION FORMS Record all channel voltage responses on a DAS calibration form. 

Record the voltmeter measured values as the designated input 
voltages. 
 
As an alternative to transcribing the data on  a separate form, an  
on-site printer connected to the DAS can be used to record the 
channel voltage responses. The digital voltmeter measured input 
voltage values can be written adjacent to the printed DAS values 
for comparison. This technique will reduce the possibility of 
transcription errors. 
 

LOG NOTES An entry is made in the station log book to document the 
calibration. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the DAS, marking the 
date the instrument was certified and the name of the technician 
who calibrated it. 
 
 
 
 
 

 
 

Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT Complete all summary documentation, attach to the calibration 
form or printed record, and submit with the site trip report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 This technical instruction (TI) describes the specific procedures for calibrating an ESC 
8816/8832 analog voltage input card. Calibration of current input, digital input, or other interface 
cards are discussed in other TIs.  
 
 Calibrations are required under any of the following circumstances: 
 

• Upon acceptance testing of a new instrument 
 
• Upon installation or removal of the instrument at a field station 
 
• Whenever control limits are exceeded 
 
• Prior to any corrective action, service, or maintenance to any portion of the 

instrument that affects its operational principle 
 
• At a maximum interval of six months 
 

2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the project-specific calibration schedule and coordinate with the client as 
necessary. 

 
• Establish the calibration reporting protocol to satisfy client requirements. 

 
• Review calibration results. 

 
• Identify inconsistencies in calibration results and initiate corrective action as 

required. 
 

• Review and approve any changes to calibration procedures. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
 

• Document all calibration results and maintenance procedures performed. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment and materials are required for ESC analog input card 
calibration: 
 

• Voltage source calibrator (capable of outputting a range of values that covers the 
input range of the DAS) 

 
• Digital voltmeter (4 ½ digit) 
 
• Calibration harness 
 
• Interconnect cabling 
 
• Manufacturer’s instrument manual 
 
• Technical Instruction 3160-2100 
 
• Calibration Form 
 
• Pen or pencil 
 
• Field service tools 
 
• Station logbook or DataView 
 
• ARS calibration stickers 

 
4.0 METHODS 
 
 Calibration (adjustment) of the analog voltage input card is not possible. Only 
verification (calibration check) of the card is possible. Cards found out of tolerance must be 
returned to ESC for repair. 
 

Calibration checks are detailed in the following four (4) subsections: 
 
 4.1  Preparation for Calibration 
 4.2  Calibration Checks 
 4.3  Post-Maintenance Calibration Checks 
 4.4  Documentation 
 
4.1 PREPARATION FOR CALIBRATION 
 
 Before performing a calibration check, ensure adequate preparation of the operation 
environment, calibration device, and the input card by determining the following: 
 

• The station is at the proper temperature. 
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• Instruments are adequately warmed up. 
 

• Calibration documentation is current, complete, and available. 
 

• All required support tools, diagnostic equipment, supplies, and calibration forms are 
available. 

 
4.2 CALIBRATION CHECKS 
 
 It is important that all analog input channels of the datalogger be calibrated during the 
same procedure. The input voltages will be compared to the results logged on the storage media 
used for data reporting. 
 
ANNOTATE DATA 
RECORDS 

Make an entry in the station log book and annotate the strip chart 
recorder and data acquisition system (DAS) indicating the date 
and time (beginning and ending) of the calibration procedure.   
 

 It is standard to test the calibration of a DAS at 10 voltage values equally spaced over the 
range of the instrument.  The following steps describe the 10-point calibration procedure. 
 
BUILD CALIBRATION 
HARNESS 

Build a calibration harness to allow input of known voltages to all 
eight analog inputs of each card under test at one time. Common all 
input lows and connect to the negative voltage supply. Common all 
input highs and connect to the positive voltage supply. Program the 
datalogger so each analog input full scale is 100 mv. 
 

APPLY VOLTAGE 
 

Apply 10% of the full scale value (10 mv) to the calibration 
harness and record the datalogger voltage response for each 
channel. An example calibration form is presented as Figure 4-1. 
 

SELECT ADDITIONAL 
VOLTAGES 

Repeat this procedures for 20% through 90% of the full scale 
selected.  If needed, reprogram the datalogger for other full scale 
ranges and apply known voltages and record as before. 
 

COMPARE VOLTAGES A successful calibration is when all values for a channel are 
within 0.1% of the full scale of the range under test. Channels 
that do not pass may either be indicated as so on the calibration 
sticker and not used, or returned to ESC for repair. 

 
4.3 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing any adjustment or maintenance, initiate a post-maintenance calibration 
check as described in Section 4.2. 
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ESC Voltage Analog Input Card 

Calibration Check Form 
 
 
  Date _________________________ 
 
  Technician ____________________ 
 
ESC Datalogger S/N ______________     DVM Model _____________     S/N ___________________  
 
Last Calibration Date ____________________ 
 
Voltage (circle one)     100 mv          1.000 v          5.000 v          10.00 v 
 
 

Channel 10% 20% 30% 40% 50% 60% 70% 80% 90% Full 
Scale 

1           

2           

3           

4           

5           

6           

7           

8           

 
 

Acceptable Accuracy Values 
 

Channel Input Tolerance 
100 mv ± 0.1 mv 
1.000 v ± 0.001 v 
5.000 v ± 0.005 v 
10.00 v ± 0.010 v 

N:\project\ars\forms\NPSAIR\ESC Calibration Check Form.doc (03/06) 

 
 

Figure 4-1.  ESC Voltage Analog Input Card Calibration Check Form. 
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4.4 DOCUMENTATION 
 
 Datalogger calibrations require several levels of documentation: 
 
CALIBRATION FORMS Record all channel voltage responses on a calibration form. 

Record the voltmeter measured values as the designated input 
voltages. 
 

LOG NOTES An entry is made in the station log book to document the 
calibration. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the datalogger, marking 
the date the instrument was certified and the name of the 
technician who calibrated it. Also indicate the channels and 
ranges calibrated. 
 
 
 
 
 

 
 

Figure 4-2.  ARS Calibration Sticker. 
 

TRIP REPORT Complete all summary documentation, attach to the calibration 
form or printed record, and submit with the site trip report. 
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1.0 PURPOSE AND APPLICABILITY 
 
 This standard operating procedure (SOP) describes the steps of routine site operator 
maintenance visits to meteorological monitoring sites that may monitor any or all of the 
following parameters: 
 

• Wind speed (horizontal and/or vertical) 

• Wind direction (horizontal and/or vertical) 

• Temperature (including delta temperature) 

• Relative humidity 

• Solar radiation 

• Wetness 

• Precipitation 
 
 The primary purpose of routine site operator maintenance is to assure quality data capture 
and minimize data loss by performing weekly operational checks and system integrity checks of 
meteorological sensors, the data acquisition system, and support equipment. 
 
 This SOP serves as a guideline for the site operator to verify the: 
 

• Integrity of tower and support structures 

• Alignment and stability of sensors and mounts 

• Integrity of power, telephone, and/or radio link 

• Operational integrity of the datalogger 

• Operational integrity of sensors, as compared to observed meteorological conditions 
 
 The operator must thoroughly document the results of each site visit by annotating the 
digital station log in the DataView system. Because monitoring sites have different 
configurations, specific Checklist Instructions (CIs) are commonly prepared for individual sites 
or monitoring networks. The following CIs provide detailed information regarding specific 
operator procedures (this list is subject to change with the addition or change of site 
configurations): 
 

• CI 3176-3100 Weekly Station Visit Wind Speed / Wind Direction Sensor   
   (Climatronics) 

• CI 3176-3101 Weekly Station Visit Wind Speed / Wind Direction Sensor 
   (R.M. Young) 

• CI 3176-3102 Weekly Station Visit Wind Speed / Wind Direction Sensor 
   (R.M. Young cups) 

• CI 3176-3103 Weekly Station Visit Wind Speed / Wind Direction Sensor 
   (Climatronics – No Translator) 



             Number 3176 
             Revision 1.0 
             Date JAN 2007 
             Page 2 of 5 
 

• CI 3176-3105 Weekly Station Visit Temperature (Climatronics) 

• CI 3176-3110 Weekly Station Visit Temperature /  Delta Temperature Sensor  
   (Climatronics) 

• CI 3176-3111 Weekly Station Visit Temperature / Delta Temperature Sensor 
   (R.M. Young) 

• CI 3176-3115 Weekly Station Visit Air Temperature and Relative Humidity Sensor  
   (Rotronics) 

• CI 3176-3116 Weekly Station Visit Air Temperature and Relative Humidity Sensor  
   (Vaisala) 

• CI 3176-3120 Weekly Station Visit Relative Humidity Sensor (Rotronics) 

• CI 3176-3121 Weekly Station Visit Relative Humidity Sensor (Vaisala) 

• CI 3176-3130 Weekly Station Visit Solar Radiation Sensor (Climatronics) 

• CI 3176-3131 Weekly  Station Visit Solar Radiation Sensor (R.M. Young) 

• CI 3176-3132 Weekly Station Visit Solar Radiation Sensor (Licor) 

• CI 3176-3140 Weekly Station Visit Wetness Sensor (R.M. Young) 

• CI 3176-3150 Weekly Station Visit Precipitation Sensor (Climatronics) 

• CI 3176-3151 Weekly Station Visit Precipitation Sensor (Texas Electronics) 

• CI 3176-3153 Weekly Station Visit Precipitation Sensor (R.M. Young) 

• CI 3176-3160 Weekly Station Visit Barometric Pressure Sensor (Various) 
 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall coordinate with the station operator, his/her supervisor, and ARS 
field specialist, concerning the schedule and requirements for routine and emergency maintenance. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Coordinate with the station operator, his/her supervisor, and project manager 
concerning the schedule and requirements for routine and emergency maintenance. 

 
• Train the station operator in all phases of the routine and emergency maintenance visit. 
 
• Provide technical support to the station operator via telephone to identify instrument 

problems and initiate instrument repairs. 
 

• Document all technical support given to the station operator. 
 
• Load revisions to the DataView system as they are released. 
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2.3 STATION OPERATOR 
 
 The station operator shall: 
 

• Coordinate with his/her supervisor, project manager, and ARS field specialist 
concerning the schedule and requirements for routine and emergency maintenance. 

 
• Perform all procedures described in site- or network-specific CIs. 
 
• Thoroughly document all procedures performed during each site visit. 
 
• Report any noted inconsistencies immediately to the field specialist. 
 

3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Site visits are generally performed weekly. Equipment needed for a weekly visit includes: 
 

• Keys for the shelter or support system internal lock and padlocks 
 
• A Site Operator’s Manual that includes site- or network-specific CIs, and other site- 

or network-specific documentation 
 
4.0 METHODS 
 
 The station operator will perform weekly site visits. The observations recorded during 
these visits verify the operation of the monitoring system. The station operator may also be 
called upon to perform troubleshooting, simple maintenance, and sensor replacements in 
consultation with the field specialist. 
 
 This section includes three (3) major subsections: 
 
 4.1  Weekly Visits 
 4.2  Troubleshooting, Maintenance, and Instrument Replacement 
 4.3  Documentation 
 
4.1 WEEKLY VISITS 
 
 The station operator will make weekly observations at the site. Sites may have different 
configurations and DataView is customized for each site’s instrumentation. While completing 
the DataView CIs, the operator will make some or all of the following observations: 
 
WIND SPEED AND 
DIRECTION 

Inspect the wind sensor for damage. Compare current wind speed 
and direction measurements to observed ambient conditions. 
 

TEMPERATURE/ 
DELTA TEMPERATURE 

Verify that the temperature sensor housing aspirator fan is 
operational. Compare current temperature and delta temperature 
measurements to observed ambient conditions. 
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RELATIVE HUMIDITY Compare the current relative humidity measurement to observed 
ambient conditions. 
 

SOLAR RADIATION Inspect the solar radiation sensor for dirt or snow and clean if 
necessary. Compare the current solar radiation measurement to 
observed ambient conditions. 
 

WETNESS Wet test the sensor with water (except during precipitation events 
or if the sensor is wet). 
 

PRECIPITATION Inspect the precipitation gauge collection funnel for snow or 
debris. Tip the mechanism 10 times. 
 

BAROMETRIC 
PRESSURE 

Compare the current barometric pressure to trends from recent 
weather activity. Inspect the sensor and tubing for abrasions, 
cracks, or other defects. 

 
The station operator should promptly report any noted inconsistencies to the field specialist. 
 
4.2 TROUBLESHOOTING, MAINTENANCE, AND INSTRUMENT REPLACEMENT 
 
 If a malfunction of any monitoring component occurs, or if any of the readings do not make 
sense, the station operator should call the Operation Support Center (1-800-344-5423) to report any 
discrepancy. A field technician will instruct the station operator on troubleshooting procedures. 
 
TROUBLESHOOTING If a potential malfunction or other inconsistency is noted, the station 

operator will be directed to perform a series of troubleshooting 
procedures. The use of certain tools or diagnostic equipment (most 
frequently a digital voltmeter) will be required. The field specialist 
will step the station operator through the proper procedures by 
telephone, fax, or electronic mail. Typical procedures may include 
continuity checks, supply voltage checks, bearing observations, 
datalogger interrogation, or specific instrument performance 
observations. The operator will be asked to thoroughly record his/her 
findings and relate them to the field specialist for further action. 
 

MAINTENANCE The station operator may be asked to perform certain mechanical, 
electrical, electronic, or datalogger program maintenance as 
directed by the field specialist. Typical maintenance tasks could 
include tightening tower guy wires, replacing backup batteries, 
resetting a power line breaker, or restarting system components. All 
maintenance must be thoroughly documented and the results related 
to the field specialist. 
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SENSOR 
REPLACEMENT 
 
 
 

Under the field specialist’s direction, the station operator may be 
asked to replace a malfunctioning sensor with a pre-calibrated unit. 
The unit would be calibrated on-site at a later date by the field 
specialist. All replacement steps will be reviewed by telephone with 
the station operator. Instrument-specific manuals or other diagrams 
or descriptions will be referenced as appropriate. All sensor 
replacement procedures including the sensor type, make, serial 
number, and date and time of replacement must be documented. 

 
4.3 DOCUMENTATION 
 
 Weekly operator checks entered in the Checklist Instructions are automatically 
documented in the DataView station log. Any additional troubleshooting, maintenance, or sensor 
replacement actions must be documented in the station log using DataView. 
 
 In the event of a DataView computer malfunction, the operator must manually complete a 
hard copy version of each Checklist Instruction. These paper hard copies exist in the Site 
Operator’s Manual. Upon completion, the site operator must mail or fax the completed forms to: 
 

Air Resource Specialists, Inc. 
Attn: IMC 

1901 Sharp Point Drive   Suite E 
Fort Collins, CO   80525 

Fax: 970/484-3423 



Checklist Instruction: 3176-3100                                    January 2011                                                        Page 1 of 6 

Checklist Instruction - Weekly Station Visit 
 
  •   Wind Speed/Wind Direction Sensor (Climatronics) 
 
Checklist Instruction Number: 3176-3100 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
Objective: Weekly checks of the wind speed and wind direction are performed to verify the 

operational integrity of the sensors and sampling system and to verify that 
collected data appear reasonable. 

 
 
1. Inspect the wind sensors for damage. Report any damage to the OSC. 
 
 From the ground, inspect the Climatronics wind vane and anemometer. Look for damage 

to the aluminum cups or direction vane and make certain that the sensors turn smoothly. 
Report any damage to the Operation Support Center. 

 
2.  Note the current wind speed and wind direction measurements and compare them 

to your observations of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <R> for Display Readings w/units. 

ESC 88xx v5.31  ID:BL    Real Time Engineering Units     08/06/97  14:59:27 
 
 O3   = 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8  = 38.23 (PPB ) 
 VWD  = 46.61 (DEG ) 
 SIG  = 46.61 (DEG ) 
 VWS  = 0.6261 (M/S ) 
 SWS  = 0.6261 (M/S ) 
 PWS  = 2.036 (M/S ) 
 TMP  = 3.399 (DGC ) 
 DTP  = 0.06188 (DGC ) 
 SOL  = 100.3 (WMS ) 
 RNF  = 0 (MM ) 
 RH   = 66.83 (% ) 
 WET  = 100.4 (+/- ) 
 FLW  = 3.008 (SLPM ) 
 STP  = 21.48 (DGC ) 
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 Watch the VWD (vector wind direction) and SWS (scalar wind speed) for several 
updates to identify any current trends. Then observe the conditions outside the shelter. 
Compare what you see with the readings on the datalogger. Does it make sense?  If not, 
call the Operation Support Center to report the discrepancy. 

 
 Remember: The VWD is reported as the direction the wind is blowing from. 
 
 Note:  With experience you will develop an “eye” for judging whether the wind readings 

are representative of ambient conditions. The following figure and table may help in your 
effort. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Report conditions that affect data validity (e.g., ice or damage to the sensor) in the 

logbook. 
 
3. Take the VWD, VWS, and SWS offline in preparation to check the translator 

calibration responses. 
 
 To ensure that only ambient winds are recorded, it is necessary to mark the VWD, VWS, 

and SWS channels offline. Wind data marked in this manner are automatically excluded 
from the hourly average. 

 
 Begin at the Home Menu as shown below. Remember, pressing <Esc> several times 

returns to the Home Menu. 
 
 
 
 
 
 
 

Wind Speed 
m/s mph 
1.0 2.2 
5.0 11.2 
10.0 22.4 
15.0 33.6 
20.0 44.7 

North 
   0º 
 360º 

East 
 90º West 

 270º 

 180º 
 South 
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ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <M> for Disable/Mark Channel Offline: 
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ESC 88xx v5.31  ID:BL   Choose(Space Toggle/Enter Select)  08/06/97  14:59:27
 
 O3   [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD  [04] 
 SIG   [05] 
 VWS  [06] 
 SWS  [07] 
 PWS  [08] 
 TMP   [09] 
 DTP   [10] 
 SOL   [11] 
 RNF    [12] 
 RH   [13] 
 WET    [14] 
 FLW    [15] 
 STP    [16] 
 

  
 Use the ↑ and ↓ keys to navigate and the spacebar to select the VWD, VWS, and SWS 

channels for offline status. The VWD, VWS, and SWS channels should be marked with a 
">" indicating imminent offline status. Press <Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)  08/06/97  14:59:27 
 
  O3      [01]  
 O3CAL   [02] 
 O3R8    [03] 
 > VWD    [04] 
 SIG     [05] 
 > VWS     [06] 
 > SWS     [07] 
 PWS   [08] 
 TMP     [09] 
 DTP     [10] 
 SOL     [11] 
 RNF     [12] 
 RH    [13] 
 WET     [14] 
 FLW     [15] 
 STP     [16] 
 

 
 Check the status of the VWD, VWS, and SWS channels by pressing <Esc> several times 

until the Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. 
Press <F> to display the data channels with flags (or, press <F6> in any menu to display 
flags). VWD, VWS, and SWS should be flagged with a D to the right to indicate offline 
status. The offline time is automatically recorded in the logbook when this step is 
completed. 

 
4. Set the mode switch on the F-460 wind translator from OPER. to ZERO. Verify that 

the VWD zero response is between –2º and +2º and the SWS zero response is 
between 0.2 and 0.3 m/s. 

 
 The mode selector switch on the F-460 translator is normally in the OPER. position. The 

translator can be verified by setting the mode switch to ZERO and SPAN and comparing 
the responses to the limits above. 
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 Set the F-460 mode selector switch to ZERO. Observe the VWD and SWS until both 
have stabilized. Compare the observation to the limits. VWD must be between -2º and 
+2º. SWS must be between 0.2 and 0.3 m/s. Call the Operation Support Center if the 
response is out of tolerance. 

 
5. Set the mode switch on the F-460 wind translator from ZERO to SPAN. Verify that 

the VWD span response is between 358º and 362º and the SWS span response is 
between 24 and 26 m/s. 

 
 Set the F-460 mode selector switch to SPAN. Observe the VWD and SWS until both 

have stabilized. Compare the observation to the limits. VWD must be between 358º and 
362º. SWS must be between 24 and 26 m/s. Call the Operation Support Center if the 
response is out of tolerance. 

 
6. Set the mode switch to OPER. 
 
7. Bring the VWD, VWS, and SWS channels back online. 
 
 Bring the VWD, VWS, and SWS channels online by beginning at the Home Menu of the 

ESC datalogger. Remember that pressing <Esc> several times will return you eventually 
to the Home Menu. 

 
ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL        Configuration Menu         08/06/97    14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97     14:59:27
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for  Enable/Mark Channel Online. VWD, VWS, and SWS should be the only 

channels displayed. 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
  > VWD     [04]  
    VWS     [06] 
 SWS     [07] 
 
 
 

 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Repeat the process 
until all channels are marked as shown below. Press <Enter> to put the selected channels 
online. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 
   > VWD     [04]  
   > VWS     [06] 
 > SWS     [07] 
 
 
 
 
 

 
 Check the status of the VWD, VWS, and SWS channels by pressing <Esc> several times 

until the Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. 
Press <F> once to display the data channels with flags (or, press <F6> in any menu to 
display flags). VWD, VWS, and SWS will no longer by marked with flags indicating 
online status; a P may be in the flag column for each channel indicating a purge period 
programmed to allow for the time it takes for ambient conditions to prevail. The P flag 
should clear within one minute. The online time is automatically recorded in the logbook 
when this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Wind Speed/Wind Direction Sensor (R.M. Young Wind Monitor) 
     
Checklist Instruction Number: 3176-3101 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the wind speed and wind direction are performed to verify the 

operational integrity of the sensors and sampling system and to verify that collected 
data appear reasonable. 

 
 
1.  Inspect the wind sensor for physical damage. Report any damage to the OSC. 
 
 From the ground, inspect the R.M. Young wind sensor propeller/vane assembly. Look for 

damage to the plastic propeller and make certain that the propeller is turning smoothly. 
Look for other circumstances that could affect data validity such as an accumulation of 
ice. Report any damage to the Operation Support Center and enter your observations in 
the logbook. 

 
2.  Compare the current wind speed and wind direction measurements to your 

observations of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97    14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
 Press <R> for Display Readings w/units. 
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ESC 88xx v5.31  ID:BL    Real Time Engineering Units        08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the VWD (vector wind direction) and SWS (scalar wind speed) for several 

updates to identify any current trends. Then observe the conditions outside the shelter. 
Compare what you see with the readings on the datalogger. Does it make sense?  If not, 
call the Operation Support Center to report the discrepancy. 

 
 Remember:  The VWD is reported as the direction wind is blowing from. 
 
 Note:  With experience you will develop an “eye” for judging whether the wind readings 

are representative of the ambient conditions. The following table and figure may help in 
your effort. 

 
 
 
 

Wind Speed 
m/s mph 
1.0 2.2 
5.0 11.2 
10.0 22.4 
15.0 33.6 
20.0 44.7 

 

    North 
 0º or 360º 

180º 
South 

West
270º

East 
90º 
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Checklist Instruction - Weekly Station Visit 
 
  •   Wind Speed/Wind Direction Sensor (Climatronics-No Translator) 
 
Checklist Instruction Number: 3176-3103 
 
Revision Number / Date:   0 / April 2006                  (last reviewed Apr. 2011)
 
 
Objective: Weekly checks of the wind speed and wind direction are performed to verify the 

operational integrity of the sensors and sampling system and to verify that 
collected data appear reasonable. 

 
 
1. Inspect the wind sensors for damage.  Report any damage to the OSC. 
 
 From the ground, inspect the Climatronics wind vane and anemometer.  Look for damage 

to the aluminum cups or direction vane and make certain that the sensors turn smoothly.  
Report any damage to the Operation Support Center (OSC). 

 
2.  Note the current wind speed and wind direction measurements and compare them 

to your observations of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <R> for Display Readings w/units. 
 

ESC 88xx v5.31  ID:BL    Real Time Engineering Units     08/06/97  14:59:27 
 
 O3   = 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8  = 38.23 (PPB ) 
 VWD  = 46.61 (DEG ) 
 SIG  = 46.61 (DEG ) 
 VWS  = 0.6261 (M/S ) 
 SWS  = 0.6261 (M/S ) 
 PWS  = 2.036 (M/S ) 
 TMP  = 3.399 (DGC ) 
 DTP  = 0.06188 (DGC ) 
 SOL  = 100.3 (WMS ) 
 RNF  = 0 (MM ) 
 RH   = 66.83 (% ) 
 WET  = 100.4 (+/- ) 
 FLW  = 3.008 (SLPM ) 
 STP  = 21.48 (DGC ) 
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 Watch the VWD (vector wind direction) and SWS (scalar wind speed) for several 
updates to identify any current trends.  Then observe the conditions outside the shelter.  
Compare what you see with the readings on the datalogger.  Does it make sense?  If not, 
call the OSC to report the discrepancy. 

 
 Remember: The VWD is reported as the direction the wind is blowing from. 
 
 Note:  With experience you will develop an “eye” for judging whether the wind readings 

are representative of ambient conditions.  The following figure and table may help in 
your effort. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Report conditions that affect data validity (e.g., ice or damage to the sensor) in the 

logbook. 
 
 

Wind Speed 
m/s mph 
1.0 2.2 
5.0 11.2 
10.0 22.4 
15.0 33.6 
20.0 44.7 

North 
   0º 
 360º 

East 
 90º West 

 270º 

 180º 
 South 
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Checklist Instruction - Weekly Station Visit 
 
  •   Temperature/Delta Temperature Sensor (Climatronics) 
 
Checklist Instruction Number:   3176-3110 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
Objective: Weekly checks of the temperature and delta temperature system are performed to 

verify the operational integrity of the temperature sensors and aspirators, and to 
verify that collected data appear reasonable. 

 
 
1.  Verify that the lower temperature sensor housing aspirator fan is operational. 
 
 Two ambient air temperature sensor housings are on the meteorological tower. The first 

is positioned at 10 meters above ground level and houses the primary temperature sensor 
represented by the channel name TMP in the datalogger. The second housing contains the 
sensor that measures air temperature at 2 meters above ground level. The delta 
temperature, or DTP as labeled in the datalogger, is derived from subtracting 2-meter 
temperature from 10-meter temperature (top minus bottom). 

 
 Both temperature sensors have a fan aspirated housing. The 2-meter housing is close 

enough to the ground that the fan can be heard. Listen for the sound of the fan. If it has 
failed, call the Operation Support Center. 

  
2.  Note the current temperature and delta temperature measurements and compare to 

your observation of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Uints     08/06/97  14:59:27    
 
 O3= 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8= 38.23 (PPB ) 
 VWD= 46.61 (DEG ) 
 SIG= 46.61 (DEG ) 
 VWS= 0.6261 (M/S ) 
 SWS= 0.6261 (M/S ) 
 PWS= 2.036 (M/S ) 
 TMP= 3.399 (DGC ) 
 DTP= 0.06188 (DGC ) 
 SOL= 100.3 (WMS ) 
 RNF= 0  (MM ) 
 RH= 66.83 (% ) 
 WET= 100.4 (+/- ) 
 FLW= 3.008 (SLPM ) 
 STP= 21.48 (DGC ) 
 

 
 Watch the TMP and DTP reading for several updates to identify the current values. Delta 

temperature should be between -5º C and +5º C or beyond at some sites. Negative values 
are typical on bright sunny days, closer to zero on cloudy days, and positive numbers at 
night. Snow cover, complex terrain, and high winds will affect typical values. 

 
 Observe the conditions outside the shelter. Compare what you see with the reading on the 

datalogger. Does it make sense?  If not, call the Operation Support Center to report the 
discrepancy. 

 
 Note:  With experience you will develop a feel for judging whether the TMP reading is 

representative of the ambient observation. Remember that the sun can make it seem 
warmer and wind can make it seem cooler. Use the conversion chart below for help. 

 
Temperature 

ºC  ºF 
-30  -22 
-20  -4 
-10  14 
0  32 
10  50 
20  68 
30  86 
40  104 

 
 Report conditions that affect validity (e.g., aspirator fan failure) in the logbook. 
 



Checklist Instruction: 3176-3110                                     January 2011                                                      Page 3 of 7 

3.  Take the TMP and DTP offline in preparation to check the translator calibration 
responses. 

 
 To ensure that only ambient temperatures are recorded in the hourly average, it is 

necessary to mark the TMP and DTP channels offline. Temperature data marked in this 
manner are automatically excluded from the hourly average. 

 
 Begin at the Home Menu as shown below. Remember, pressing <Esc> several times 

returns to the Home Menu. 
 

ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97 14:59:27 
 
 O3  [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD [04] 
 SIG   [05] 
 VWS [06] 
 SWS [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select the TMP and DTP channels 

for offline status. The TMP and DTP channels should be marked with a ">" indicating 
imminent offline status. Press <Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
  O3      [01]  
 O3CAL   [02] 
 O3R8    [03] 
   VWD   [04] 
 SIG     [05] 
   VWS     [06] 
   SWS     [07] 
  >  TMP     [08] 
  >  DTP     [09] 
 SOL     [10] 
 RNF     [11] 
 WET     [12] 
 FLW     [13] 
 STP     [14] 
 

 
 Check the status of the TMP and DTP channels by pressing <Esc> several times until the 

Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press 
<F> to display the data channels with flags (or, press <F6> in any menu to display flags). 
TMP and DTP should be marked with a D flag to the right to indicate offline status. The 
offline time is automatically recorded in the logbook when this step is completed. 

 
4.  Set the mode switch on the TEMP/DELTA TEMP translator from OPER. to ZERO. 

Verify that the TMP and DTP zero responses are within the ranges indicated on the 
sticker affixed to the translator. 

 
 The mode selector switch on the temp/Δtemp translator is normally in the OPERATE 

position. The calibration of the translator can be verified by setting the mode switch to 
ZERO and SPAN and comparing the responses to the limits below. 
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OPERATE
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CLIMATRONICS

OPERATE
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OPERATE
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Z
E
R
O

S
P
A
N

CLIMATRONICS

TEMP/DELTA TRADIATION

 
 

 Set the temp/Δtemp mode selector switch to ZERO. Observe the TMP and DTP until 
both have stabilized. Compare the values to those indicated on the sticker affixed to the 
translator card. Call the Operation Support Center if the response is out of tolerance. 

 
5.  Set the mode switch on the TEMP/DELTA TEMP translator from ZERO to SPAN. 

Verify that the TMP and DTP span responses are within the ranges indicated on the 
calibration sticker affixed to the front of the translator. 

 
 Set the temp/delta temp mode selector switch to SPAN. Observe the TMP and DTP until 

both have stabilized. Compare the observation to the limits. The ranges are indicated on 
the sticker affixed to the front of the translator. Call the Operation Support Center if the 
response is out of tolerance. 

 
6.  Set the mode switch to OPER. 
 
7.  Bring the TMP and DTP channels back online. 
 
 Bring the TMP and DTP channels online by beginning at the Home Menu of the ESC 

datalogger. Remember that pressing <Esc> several times you will eventually return to the 
Home Menu. 
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ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 
 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 
 
 

 
 Press <E> for  Enable/Mark Channel Online. TMP and DTP should be the only channels 

displayed. 
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ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
  > TMP     [04]  
    DTP     [06] 
  
 
 
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Press the 

<Spacebar> to select both for online status. Press <Enter> to put the selected channels 
online. 

 
 
 
 
 
 
 
 
  
 
 
 Check the status of the TMP and DTP channels by pressing <Esc> several times until the 

Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press  
<F> once to display the data channels with flags (or, press <F6> in any menu to display 
flags). TMP and DTP will no longer by marked with a flag indicating online status, or a P 
will be in the flag column for each indicating a purge period programmed to allow for the 
time it takes for ambient conditions to prevail. The P flag should clear within one minute. 
The online time will automatically recorded in the logbook when this step is completed. 

 
 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
   > TMP     [04]  
   > DTP     [06] 
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Checklist Instruction - Weekly Station Visit 
 
  •   Temperature/Delta Temperature Sensor (R.M. Young) 
 
Checklist Instruction Number: 3176-3111 
 
Revision Number / Date:   2 /January 2006  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the temperature/delta temperature system are performed to verify 

the operational integrity of the temperature sensors and aspirators, and to verify that 
collected data appear reasonable. 

 
1.  Verify that the lower temperature sensor housing aspirator fan is operational. 
 
 Two ambient air temperature sensor housings are mounted to the meteorological tower.  

The first is positioned at 10 meters above ground level and houses the primary 
temperature sensor represented by the channel name TMP in the datalogger.  The second 
housing contains the sensor that measures air temperature at 2 meters above ground level.  
The delta temperature is derived by subtracting 2-meter temperature from 10-meter 
temperature (top minus bottom) and is represented by the channel name DTP in the 
datalogger. 

 
 Both temperature sensors have a fan aspirated housing.  The 2-meter housing is close 

enough to the ground that the fan can be heard.  Listen for the sound of the fan.  If it has 
failed, call the Operation Support Center and enter your observations in the logbook. 

  
2.  Compare current TMP and DTP measurements to your observation of ambient 

conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
  

 



Checklist Instruction: 3176-3111                                 January 2006                                                           Page 2 of 2 

 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Uints     08/06/97  14:59:27   
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the TMP and DTP reading for several updates to identify the current values.  Delta 

temperature should be between -5º C and +5º C.  Negative values are typical on bright 
sunny days, closer to zero on cloudy days, and positive values at night.  Snow cover, 
complex terrain, and high winds will affect typical values. 

 
 Observe the conditions outside the shelter.  Compare what you see with the reading on 

the datalogger.  Does it make sense?  If not, call the OSC to report the discrepancy and 
enter your observations in the logbook. 

 
 Note: With experience you will develop a feel for judging whether the TMP reading is 

representative of the ambient observation.  Remember that the sun can make it seem 
warmer and wind can make it seem cooler.  Use the conversion chart below for 
assistance. 

 
Temperature 

ºC  ºF 
-30  -22 
-20  -4 
-10  14 
0  32 
10  50 
20  68 
30  86 
40  104 

 
 
 Report any conditions that affect validity (e.g., aspirator fan failure) in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Air Temperature and Relative Humidity Sensor (Rotronics) 
 
Checklist Instruction Number: 3176-3115 
 
Revision Number / Date:   1 / January 2006  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the air temperature and relative humidity system are performed to 

verify the operational integrity of the relative humidity sensor and aspirator, and to 
verify that collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower.  In most cases this aspirator is forced-aspirated by a fan.  If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition.  Call 

the Operation Support Center if problems are detected. 
 
2.  Compare the current air temperature and relative humidity measurement to your 

observation of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Units     08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the TMP (air temperature) and RH (relative humidity) reading for several updates 

to identify any current trends.  Observe the conditions outside the shelter.  Compare what 
you see with the reading on the datalogger.  Does it make sense?  If not, call the 
Operation Support Center to report any discrepancy and enter your observations in the 
logbook.  Also note any other conditions that could affect validity of the air temperature 
or relative humidity data and enter your observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Air Temperature and Relative Humidity Sensor (Vaisala) 
 
Checklist Instruction Number: 3176-3116 
 
Revision Number / Date:   1 / January 2006  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the air temperature and relative humidity system are performed to 

verify the operational integrity of the relative humidity sensor and aspirator, and to  
verify that collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower.  In most cases this aspirator is forced-aspirated by a fan.  If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition.  Call 

the Operation Support Center if problems are detected. 
 
2.  Compare the current air temperature and relative humidity measurement to your 

observation of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Units     08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 

 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the TMP (air temperature) and RH (relative humidity) reading for several updates 

to identify any current trends.  Observe the conditions outside the shelter.  Compare what 
you see with the reading on the datalogger.  Does it make sense?  If not, call the 
Operation Support Center to report any discrepancy and enter your observations in the 
logbook.  Also note any other conditions that could affect validity of the air temperature 
or relative humidity data and enter your observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Relative Humidity Sensor (Rotronics) 
 
Checklist Instruction Number: 3176-3120 
 
Revision Number / Date:   2 / January 2011                         (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the relative humidity system are performed to verify the 

operational integrity of the relative humidity sensor and aspirator, and to verify that 
collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower. In most cases this aspirator is forced-aspirated by a fan. If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition. Call the 

Operation Support Center if problems are detected. 
 
2.  Compare the current relative humidity measurement to your observation of 

ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Uints     08/06/97  14:59:27  
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 
 Watch the RH (relative humidity) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center  
to report any discrepancy and enter your observations in the logbook. Also note any other 
conditions that could affect validity of the relative humidity data and enter your 
observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Relative Humidity Sensor (Vaisala) 
 
Checklist Instruction Number: 3176-3121 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the relative humidity system are performed to verify the 

operational integrity of the relative humidity senso and aspirator, and to verify that 
collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower. In most cases this aspirator is forced-aspirated by a fan. If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition. Call the 

Operation Support Center if problems are detected. 
 
 
2.  Compare the current relative humidity measurement to your observation of 

ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
  

  
 
 
 
 
 
 
 
 
  



Checklist Instruction: 3176-3121                                January 2011                                                               Page 2 of 2 

 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Units     08/06/97  14:59:27
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 
 Watch the RH (relative humidity) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report any discrepancy and enter your observations in the logbook. Also note any other 
conditions that could affect validity of the relative humidity data and enter your 
observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Solar Radiation Sensor (Climatronics) 
 
Checklist Instruction Number: 3176-3130 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the solar radiation system are performed to verify the 

operational integrity of the solar radiation system, to clean the sensor, and to verify 
that collected data appear reasonable. 

 
1.  Inspect the solar radiation sensor for dirt or snow if your sensor is at a height to 

reach. Clean the sensor if required. 
 
 Locate your solar radiation sensor; most air quality station sensors are on the tower. 

Inspect the sensor for dirt, snow, etc. The sensor can be cleaned with a broom to remove 
snow or a Kimwipe with water to remove dirt. 

 
2.  Note the current solar radiation measurement and compare it to your observations 

of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
  

  
 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Display Last Base Avg.    08/06/97     14:59:27     
 
 O3= 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8= 38.23 (PPB ) 
 VWD= 46.61 (DEG ) 
 SIG= 46.61 (DEG ) 
 VWS= 0.6261 (M/S ) 
 SWS= 0.6261 (M/S ) 
 PWS= 2.036 (M/S ) 
 TMP= 3.399 (DGC ) 
 DTP= 0.06188 (DGC ) 
 SOL= 100.3 (WMS ) 
 RNF= 0  (MM ) 
 RH= 66.83 (% ) 
 WET= 100.4 (+/- ) 
 FLW= 3.008 (SLPM ) 
 STP= 21.48 (DGC ) 
 



Checklist Instruction: 3176-3130                                      January 2011                                                       Page 2 of 5 

 Watch the SOL (solar radiation) reading for several updates to identify any current 
trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report the discrepancy.  

 
 Note:  With experience you will develop and “eye” for judging whether the SOL reading 

is representative of the ambient observation. Remember that the solar radiation varies 
with time of day, sky conditions, and season. 

 
 Report conditions that affect data validity (e.g., snow found on the sensor) in the logbook. 
 
3. Take the SOL offline in preparation to check the translator responses.  
 
 To ensure that only ambient solar conditions are included in the hourly average, it is 

necessary to mark the SOL channel offline. Solar radiation data marked in this manner 
are automatically excluded from the hourly averages. 

 
 Begin at the Home Menu as shown below. Remember, pressing <Esc> several times 

returns to the Home Menu. 
 

ESC 88xx v5.31  ID:BL         Home Menu          08/06/97     14:59:27     
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27          
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D>, for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27      
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3   [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD  [04] 
 SIG   [05] 
 VWS  [06] 
 SWS  [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select the SOL channel for offline 

status. The channel should be marked with a ">" indicating imminent offline status. Press 
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
   O3      [01]  
 O3CAL   [02] 
 O3R8    [03] 
    VWD    [04] 
 SIG     [05] 
  VWS     [06] 
  SWS     [07] 
 TMP     [08] 
 DTP     [09] 
  > SOL     [10] 
 RNF     [11] 
 WET     [12] 
 FLW     [13] 
 STP     [14] 
 

 
 Check the status of the SOL channel by pressing <Esc> several times until the Home 

Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). SOL 
should be marked with a D flag to the right to indicate offline status. The offline time will 
be recorded in the logbook automatically when this step is complete. 

 
4.  Set the mode selector switch on the RADIATION translator from OPER. to ZERO. 

Verify that the SOL zero response is between –5 and +5.  
  
 The mode selector switch on the radiation translator is normally in the OPER. position. 

The calibration of the translator can be verified by setting the mode selector switch to 
ZERO and SPAN and comparing the responses to the limits below. 

 
 Set the mode selector switch to ZERO. Observe the SOL until stabilized. Compare the 

observation to the limits. SOL must be between -5 and +5. 
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5.  Set the mode switch on the RADIATION translator from ZERO to SPAN. Verify 
that the SOL span response is between 1391 and 1401. 

 
 Set the mode selector switch to SPAN. Observe until stabilized. Compare the observation 

to the limits. SOL must be within 1391 and 1401. Call the Operation Support Center if 
the response is out of tolerance. 

 

OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

OPERATE

Z
E
R
O

S
P
A
N

OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

RADIATIONTEMPERATURE

 
6.  Set the mode switch to OPER. 
 
7.  Bring the SOL channel back online. 
 
 Bring the SOL channel online by beginning at the Home Menu of the ESC datalogger. 

Remember that pressing <Esc> several times you will return eventually to the Home Menu. 
 

ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27       
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
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Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27          
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27      
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 
 
 

  
 Press <E> for Enable/Mark Channel Online. SOL should be the only channel displayed. 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
  > SOL    [04]  
     
 
 
 
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Press <Enter> to 

put the selected channel online. 
 
 Check the status of the SOL channel by pressing <Esc> several times until the Home 

Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> 
once to display the data channels with flags (or, press <F6> in any menu to display 
flags). SOL will no longer by marked with a flag indicating online status; a P may be in 
the flag column indicating a purge period programmed to allow for the time it takes for 
ambient conditions to prevail. The P flag should clear within one minute. The online time 
will automatically recorded in the logbook when this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Solar Radiation Sensor (R.M. Young) 
 
Checklist Instruction Number: 3176-3131 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the solar radiation system are performed to verify the operational 

integrity of the solar radiation system, to clean the sensor, and to verify that 
collected data appear reasonable. 

 
1.  Inspect the solar radiation sensor for dirt or snow if your sensor is at a height to 

reach. Clean the sensor if required. Also check the leveling bubble. 
 
 Locate your solar radiation sensor; most air quality station sensors are on a tower. Inspect 

the sensor for dirt, snow, etc. If the sensor can be reached, carefully remove snow from 
the sensor and clean the sensor with a water-dampened Kimwipe to remove dust and dirt. 
Also check the leveling bubble to verify it is level. 

 
2. Compare the current solar radiation measurement to your observations of ambient 

conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

  
 Press <R> for Display Readings w/units: 
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ESC 88xx v5.31  ID:BL    Display Last Base Avg.    08/06/97  14:59:27           
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the SOL (solar radiation) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report the discrepancy and enter your observations in the logbook.  

 
 Note:  With experience you will develop and “eye” for judging whether the SOL reading 

is representative of the ambient observation. Remember that the solar radiation varies 
with time of day, sky conditions, and season. 

 
 Report any conditions that affect data validity (e.g., snow found on the sensor) in the 

logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Solar Radiation Sensor (Licor) 
 
Checklist Instruction Number: 3176-3132 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the solar radiation system are performed to verify the operational 

integrity of the solar radiation system, to clean the sensor, and to verify that 
collected data appear reasonable. 

 
1.  Inspect the solar radiation sensor for dirt or snow if your sensor is at a height to 

reach. Clean the sensor if required. Also check leveling bubble. 
 
 Locate your solar radiation sensor; most air quality station sensors are on a tower. Inspect 

the sensor for dirt, snow, etc. If the sensor can be reached, carefully remove snow from 
the sensor and clean the sensor with a water-dampened Kimwipe to remove dust and dirt. 
Also check the leveling bubble to verify it is level. 

 
2. Compare the current solar radiation measurement to your observations of ambient 

conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
  

  
 Press <R> for Display Readings w/units: 
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ESC 88xx v5.31  ID:BL    Display Last Base Avg.    08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the SOL (solar radiation) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report the discrepancy and enter your observations in the logbook.  

 
 Note:  With experience you will develop and “eye” for judging whether the SOL reading 

is representative of the ambient observation. Remember that the solar radiation varies 
with time of day, sky conditions, and season. 

 
 Report any conditions that affect data validity (e.g., snow found on the sensor) in the 

logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Precipitation Sensor (Climatronics) 
 
Checklist Instruction Number: 3176-3150 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system, inspect and clean the 
funnel if necessary, verify the operation of the tipping mechanism and heater, and to 
verify that collected data appear reasonable. 

 
1.  Take the RNF (rainfall or precipitation) channel offline for operational checks. 
 
 The checks required to assure proper precipitation gauge operation will generate false 

RNF readings; therefore, the RNF channel must be taken offline.  
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status. The 

RNF channel should be marked with a ">" indicating imminent offline status. Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status. The offline time will 
automatically be recorded in the logbook when this step is completed. 

 
2.  Inspect the precipitation gauge collection funnel for snow or debris.  

 
Inspect the collection funnel and remove any foreign objects (e.g., leaves, bugs, etc.) call 
the Operation Support Center if there is unmelted snow in the funnel. This indicates a 
failure of the heating system. Record significant findings in the logbook. 
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3.  Once a month perform a calibration check. 
 

Verify the channel is still down and start the check just after the top of the hour. Fill the 
graduated cylinder with water. Place the black calibration funnel into the sensor and pour 
water from the graduated cylinder into the black funnel. At the completion of the check 
and in the next hour, log into the datalogger and check the RNF total. The value/result 
should be between 9.1 and 11.1. Remove the funnel after the check has completed. 

 
4.  Bring the RNF back online and record the value. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 RNF    [11] 
  
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s). Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 

 
 Check the status of the RNF channel by pressing <Esc> several times until the Home 

Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags. RNF should be marked with a D flag to the right to 
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indicate offline status that will clear after one minute. The online time will automatically 
be recorded in the logbook when this task is completed. Enter the total value of the 10-tip 
check onto the checklist. The value will automatically be entered into the logbook when 
this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Precipitation Sensor (Texas Electronics) 
 
Checklist Instruction Number: 3176-3151 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system, inspect and clean the 
funnel if necessary, verify the operation of the tipping mechanism and heater, and to 
verify that collected data appear reasonable. 

 
1.  Take the RNF (rainfall or precipitation) channel offline for operational checks. 
 
 The checks required to assure proper precipitation gauge operation will generate false 

RNF readings; therefore, the RNF channel must be taken offline.  
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88x v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status. The 

RNF channel should be marked with a ">" indicating imminent offline status. Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status. The offline time will 
automatically be recorded in the logbook when this step is completed. 

 
2.  Inspect the precipitation gauge collection funnel for snow or debris.  

 
Inspect the collection funnel and remove any foreign objects (e.g., leaves, bugs, etc.) call 
the Operation Support Center if there is unmelted snow in the funnel. This indicates a 
failure of the heating system. Record significant findings in the logbook. 
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3.  Once a month perform a calibration check. 
 

Verify the channel is still down and start the check just after the top of the hour. Fill the 
graduated cylinder with water. Place the black calibration funnel into the sensor and pour 
water from the graduated cylinder into the black funnel. At the completion of the check 
and in the next hour, log into the datalogger and check the RNF total. The value/result 
should be between 9.1 and 11.1. Remove the funnel after the check has completed. 

 
4.  Bring the RNF back online and record the value. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 RNF    [11] 
  
 
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s). Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 
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 Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags. RNF should be marked with a D flag to the right to 
indicate offline status that will clear after one minute. The online time will automatically 
be recorded in the logbook when this task is completed. Enter the total value of the 10-tip 
check onto the checklist. The value will automatically be entered into the logbook when 
this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Precipitation Sensor (RM Young) 
 
Checklist Instruction Number: 3176-3153 
 
Revision Number / Date:   1 / March 2011      (last reviewed Mar. 2011) 
 
 
Objective: Weekly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system, inspect and clean the 
funnel if necessary, and to verify that collected data appear reasonable. 

 
1.  Review RNF data since last visit and compare values with known precipitation 

events. 
 
 Verify actual precipitation events (rain or snow) that have occurred since your last visit 

were recorded by the ESC datalogger, and/or displayed on STKPLOT in DataView. 
 
 If the data appear reasonable, complete Step 2 of this checklist and bypass Steps 3 

through 5. If data appear to be missing, complete all steps of this checklist. 
 
2.  Inspect the precipitation gauge collection funnel for snow or debris.  

 
Inspect the collection funnel and remove any foreign objects (e.g., leaves, bugs, etc.) call 
the Operation Support Center if there is unmelted snow in the funnel. This indicates a 
failure of the heating system. Record significant findings in the logbook. 

 
3. Take the RNF channel offline for operational checks. 
 
 If data appear to be missing verify rain gauge operations, but first the RNF channel must 

be taken offline. 
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 
 
 
 

 
 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status. The 

RNF channel should be marked with a “>” indicating imminent offline status. Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status. The offline time will 
automatically be recorded in the logbook when this step is completed. 
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4.  Pour water into the precipitation gauge, observe results. 
 
 From the Home Menu select <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
 Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup       08/06/97  14:59:27
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
Enter a 1 and then m for the Average Interval if it has not defaulted to the 1m.  Use the ↑ 
and ↓ keys and the spacebar to select Show Channels. Type RNF if it is not already 
displayed. Navigate down to Start Continuous Report and press <Enter>. 

 
 
  
  
 TIME O3 O3CAL RNF 
 
 10/19 11:19 41. -1.  0.0 
 
 
 
  
 
 

 
The data line will update and append once per minute.  This screen allows the operator to 
leave the shelter, pour water into the rain gauge and return to the shelter to read the 
resulting “precipitation.” 

 
 Slowly pour a small volume of water (~20ml) into the rain gauge. Listen carefully for the 

buckeyes to tip. Attempt to count the number of tips. 20ml of water should result in 10 
tips (2 ml/tip). 
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 Back in the shelter, the ESC screen will have updated and will report the tips as 
precipitation. 

 
 
  
  
 TIME O3 O3CAL RNF 
 
 10/19 11:30 41. -1.  0.0 
 10/19 11:31 41. -1.  0.0 
   10/19 11:32 40. -1.  0.0 
   10/19 11:33 42. -1.  1.0 
   10/19 11:34 41. -1.  0.0 
 
 

 
 To be certain that all the tips were collected in the displayed one minute updates, wait 

long enough for an update of 0.0 to appear for RNF. The tips may have been recorded 
over one or two minutes. The total precipitation response is the sum of the one minute 
updates. The total should be 1.0mm (.1mm/tip) for 20ml of water. Call the OSC if the 
results are different than above. 

 
 
 
 
 
 
 
 
 
 
 
 
5.  Bring the RNF back online and record the results. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 

10 tips = 2.5 mm 10 tips = 1.0 mm
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 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 RNF    [11] 
  
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s). Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 

 
 Check the status of the RNF channel by pressing <Esc> several times until the Home 

Menu is displayed.  Press <D> once to enter the Real-Time Display Menu.  Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status that will clear after 
one minute. The online time will automatically be recorded in the logbook when this task 
is completed. Enter the results of the test in the logbook. 
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Checklist Instruction – Monthly Check 
 
  •   Precipitation Sensor (Various) 
 
Checklist Instruction Number: 3176-3155 
 
Revision Number / Date:   2 / August 2009  (last reviewed Aug. 2011) 
 
 
Objective: Monthly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system. Monthly checks should 
be performed under dry conditions (no precipitation) at temperatures above 
freezing. 

 
1.  Take the RNF (rainfall or precipitation) channel offline for operational checks. 
 
 The checks required to assure proper precipitation gauge operation will generate false 

RNF readings; therefore, the RNF channel must be taken offline.   
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status.  The 

RNF channel should be marked with a ">" indicating imminent offline status.  Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed.  Press <D> once to enter the Real-Time Display Menu.  Press <F> to 
display the data channels with flags. RNF should be marked with a D flag to the right to 
indicate offline status. The offline time will automatically be recorded in the logbook 
when this step is completed. 

 
2.  Inspect the precipitation gauge collection funnel for debris or snow.  

 
Inspect the leaf screen (if present) and collection funnel and remove any foreign objects 
(e.g., dirt, leaves, bugs, etc.). Call the Operation Support Center if there is unmelted snow 
in the funnel. This indicates a failure of the heating system. Record significant findings in 
the logbook. 
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3.  Fill graduated cylinder with water and pour into black calibration funnel. 
 
 The rain gauge calibration kit consists of a plastic graduated cylinder and a black 
calibration funnel. First inspect the black calibration funnel to ensure that it is clean and free 
from dust and particles that could clog the drip nozzle. If the nozzle is blocked, use the nozzle 
cleaning wire provided with the calibration kit. Place the cylinder on a level surface and fill it 
with clean water. The pre-drilled hole will allow the cylinder to fill to exactly 465mL. When the 
water has finished dripping from the hole, place your thumb over the hole to prevent spillage, 
and carry the graduated cylinder and the black calibration funnel to the rain gauge. Place the 
black calibration funnel in the gauge (remove leaf screen if present) and pour the entire contents 
of the cylinder into the calibration funnel. The black calibration funnel with the brass (#65) 
nozzle will drip the water into the rain gauge at a controlled rate. The funnel will empty in 
approximately 25 minutes. 
 
4.  Record the RNF value after the top of the hour. 
 
 The funnel will take approximately 25 minutes to empty. The results of the calibration 
check must be retrieved from the datalogger after the hour is completed. Note if the calibration 
crosses over the top of the hour, you must add the values recorded in both hours. 
 
 From the Home Menu press <R> for Report Generation Menu: 
 

ESC 88xx v5.31  ID:??             Report Menu                01/01/08  15:55:21
 
 A Report Averages 
 C Report Calibrations 
 L Summarize Last Cals 
 Q Autoprint Data Channel (s) 
 D Autoprint Daily Report 
 Z Autoprint Calibration (s) 
 R Daily Averages Report 
 T Daily Calibrations Report 
 

 
 Press <A> for Report Averages: 
 

ESC 88xx v5.31  ID:??        Report Averages Screen          01/01/08  15:56:27
 
 Average Interval  :  1h 
 Show Channels   :  RNF 
 Start Time   :  01/01/08 
 # of Flags to Report  :  02 
 Use Decimal Positioner? :  N 
 (Printer) Report Length :  22 
 (Printer) Page Length  :  22 
 View On Screen 
 Report to Printer 
 

 
 Arrow down to highlight the channels in “Show Channels” and enter RNF. Respond to 
the rest of the fields with the <Enter> key and the rainfall totals since midnight will display on 
the screen. 
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ESC 88xx v5.31  ID:??            Rainfall Totals             01/01/08  14:59:27
 
 01/01/08  00:00  0 
 01/01/08  01:00  0 
 01/01/08  02:00  0 
 01/01/08  03:00  0 
 01/01/08  04:00  0 
 01/01/08  05:00  0 
 01/01/08  06:00  0 
 01/01/08  07:00  0 
 01/01/08  08:00  0 
 01/01/08  09:00  9.8 
 01/01/08  10:00  -9999. <N 
 01/01/08  11:00  -9999. <N 
 ... 
 
 

 
 The most recent completed hour should display the volume measured in mm. Enter this 
value on the DataView checklist instruction. The value should be within the acceptable range of 
expected values displayed below for specific rain gauge types. If the value is outside of the 
expected range call the Operations Support Center. 
 

Instrument Funnel Diameter Diagram Expected Response  
to 480 ml of Water 

Climatronics 
Model 100508 

or 
Texas Electronics 

Model TR-525MM-L 

9.66” 
(24.5 cm) 

 
(catchment area 

471 cm2) 

 

in millimeters 
   10.1 mm ± 1 mm 
   (9.1 mm to 11.1 mm) 
 
in inches 
   0.4 inches ±.04 inches 
   (0.36 inches to .44 inches) 
 
 

Climatronics 
Model 100097 

or 
Novalynx 

Model 260-2500 

8” 
(20.3 cm) 

 
(catchment area 

324 cm2) 

 

in millimeters 
   14.8 mm ± 1.48 mm 
   (13.32 mm to 16.28 mm) 
 
in inches 
   .58 inches ± .06 inches 
   (.52 inches to .64 inches) 
 
 

R.M. Young 
Model 52202 

7” 
(18 cm) 

 
(catchment area 

200 cm2) 

 

in millimeters 
   24 mm ± 2.4 mm 
   (21.6 mm to 26.4 mm) 
 
in inches 
   0.94 inches ± 0.09 inches 
   (0.85 inches to 1.03 inches) 
 

-- continued -- 
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Instrument Funnel Diameter Diagram Expected Response  
to 480 ml of Water 

Met One 
Model 385 

12” 

 

in millimeters 
6.6 mm ± 0.6 mm 
(6.0 mm to 7.3 mm) 

Texas Electronics 
Model TR-525I-HT 

6.06” 
(154 mm) 

 

in millimeters 
25.8 mm ± 2.6 mm 
(23.2 to 28.3 mm) 

 
 
5.  Bring the RNF back online. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 RNF    [11] 
  
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s).  Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 

 
 Check the status of the RNF channel by pressing <Esc> several times until the Home 

Menu is displayed.  Press <D> once to enter the Real-Time Display Menu.  Press <F> to 
display the data channels with flags.  RNF should be marked with a D flag to the right to 
indicate offline status that will clear after one minute.  The online time will automatically 
be recorded in the logbook when this task is completed.  Enter the results of the test in the 
logbook. 
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1.0 PURPOSE AND APPLICABILITY 
 
 This standard operating procedure (SOP) describes the steps of routine site operator 
maintenance visits to gaseous monitoring sites that may monitor ozone (O3), sulfur dioxide 
(SO2), carbon monoxide (CO), or oxides of nitrogen (NOx). 
 
 The primary purpose of routine site operator maintenance is to assure quality data capture 
and minimize data loss by performing weekly operational checks and system integrity checks of 
gaseous analyzers, the data acquisition system, and support equipment. 
 
 This SOP serves as a guideline for the site operator to verify the: 
 

• Automated analyzer checks are within specifications 

• Analyzer routine maintenance is completed 

• Integrity of power, telephone, and/or radio link 

• Integrity of the datalogger 
 
 The operator must thoroughly document the results of each site visit by annotating the 
digital station log in the DataView system. Because monitoring sites have different 
configurations, specific Checklist Instructions (CIs) are commonly prepared for individual sites 
or monitoring networks. The following CIs provide detailed information regarding specific 
operator procedures (this list is subject to change with the addition or change of site 
configurations): 

 
• CI 3178-3114 Weekly Station Visit Oxides of Nitrogen Analyzer (TEI 42iTL,  

   Sulfur Dioxide Analyzer (TEI 43iTL), Carbon Monoxide Analyzer  
   (TEI 48iTLE), Ozone Analyzer (TEI 49i), Ozone Calibrator (TEI  
   49i), Gas Dilution Calibrator (TEI 146i)   

• CI 3178-3115 Weekly Station Visit Ozone Analyzer (TEI 49C) Ozone Calibrator  
   (TEI 49C) 

• CI 3178-3116 Weekly Station Visit Ozone Analyzer (TEI 49C) Ozone Calibrator  
   (TEI 49C) CASTNet Dry Deposition 

• CI 3178-3117 Weekly Station Visit Sulfur Dioxide Analyzer (TEI 43C),   
   Carbon Monoxide Analyzer (TEI 48C), Oxides of Nitrogen   
   Analyzer (TEI 42C)  Gas Dilution Calibrator (TEI 146C) 

• CI 3178-3118 Weekly Station Visit Oxides of Nitrogen Analyzer (TEI 42C), Sulfur 
   Dioxide Analyzer (TEI 43C), Carbon Monoxide Analyzer (TEI 48C), 
   Ozone Analyzer (TEI 49C), Ozone Calibrator (TEI 49C), and Gas  
   Dilution Calibrator (TEI 146C) 

• CI 3178-3119 Weekly Station Visit Oxides of Nitrogen Analyzer (TEI 42CTL),  
   Sulfur Dioxide Analyzer (TEI 43CTL), Carbon Monoxide Analyzer  
   (TEI 48CTLE), Carbon Dioxide Analyzer (TEI 41C), Ozone  
   Analyzer (TEI 49C), Ozone Calibrator (TEI 49C), and Gas   
   Dilution Calibrator (TEI 146C) 
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• CI 3178-3120 Weekly Station Visit Oxides of Nitrogen Analyzer (TEI 42C and  
   42i), Sulfur Dioxide Analyzer (TEI 43C and 43i), Ozone Analyzer  
   (TEI 49C and 49i), Ozone Calibrator (TEI 49C and 49i), and Gas  
   Dilution Calibrator (TEI 146C and 146i) 

• CI 3178-3123 Weekly Station Visit Ozone Analyzer (API 400E) Ozone Calibrator 
   (API 703E) 

• CI 3178-3125 Station Visit Ozone Analyzer (2B Technologies, Model 202) Gas  
   Dilution Calibrator (API M700E/M700EU)  

• CI 3178-3127 Weekly Station Visit Ozone Analyzer (2B Technologies), Meteorology 

• CI 3178-3128 Weekly Station Visit Ozone Analyzer (2B Technologies,   
   Simultaneous Ozone Analyzer (2B Technologies), Meteorology,  
   CASTNet Dry Deposition 

• CI 3178-3129 Weekly Station Visit Ozone Analyzer (2B Technologies),   
   Simultaneous Ozone Analyzer (2B Technologies), Meteorology 

• CI 3178-3130 Weekly Station Visit Carbon Monoxide Analyzer (TEI48C) and  
   Gas Dilution Calibrator (TEI 146C) 

• CI 3178-3140 Weekly Station Visit Ozone Analyzer (TEI 49C), Ozone Calibrator  
   (TEI 49C), Oxides of Nitrogen Analyzer (TEI 42C), Gas Dilution  
   Calibrator (TEI 146C) 

• CI 3178-3154 Weekly Station Visit Sulfur Dioxide Analyzer (TEI 43CTL), Gas  
   Dilution Calibrator (TEI 146) 

• CI 3178-3157 Weekly Station Visit Oxides of Nitrogen Analyzer (TEI 42C), Gas  
   Dilution Calibrator (TEI 146C) 

• CI 3178-3158  Station Visit Oxides of Nitrogen Analyzer (API M200E/M200EU)  
   Gas Dilution Calibrator (API M700E/M700EU) 

• CI 3178-3311 Multipoint Calibration Ozone Analyzer (TEI 49, 49C, 49i) Ozone  
   Calibrator (TEI 146C, 146i) 

• CI 3178-3315 Multipoint Calibration Ozone Analyzer (TEI 49C) Ozone   
   Calibrator (TEI 49C) 

• CI3178-3330 Multipoint Calibration Carbon Monoxide Analyzer (TEI 48C, 48i,  
   48iTL) and TEI 146C Calibrator 

• CI 3178-3340 Multipoint Calibration Oxides of Nitrogen Analyzer (TEI 42C)  
   Gas Calibrator (TEI 146C) 

• CI 3178-3350 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43C, 43i,  
   43TL) Dynamic Gas Calibrator (TEI 146C or 146i) Auto 3-point  
   Multipoint 

• CI 3178-3351 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43C)   
   (0-500 ppb Range) Dynamic Gas Calibrator (TEI 146C)  

• CI 3178-3352 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43C)   
   (0-500 ppb Range) Dynamic Gas Calibrator (TEI 146) 
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• CI 3178-3353 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43C) 
   (0-100 ppb Range) Dynamic Gas Calibrator (TEI 146) 

• CI 3178-3354 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43CTL)  
   (0-50 ppb Range) Dynamic Gas Calibrator (TEI 146) 

• CI 3178-3355 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43C)   
   Dynamic Gas Calibrator (TEI 146C) Auto 5-point Multipoint  

• CI 3178-3356 Multipoint Calibration Sulfur Dioxide Analyzer (TEI 43C)  
   (760-840 ppb Range) Dynamic Gas Calibrator (TEI 146) 

 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall coordinate with the station operator, his/her supervisor, and 
ARS field specialist concerning the schedule and requirements for routine and emergency 
maintenance. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Coordinate with the station operator, his/her supervisor, and project manager 
concerning the schedule and requirements for routine and emergency maintenance. 

• Train the station operator in all phases of the routine and emergency maintenance 
visit. 

• Provide technical support to the station operator via telephone to assure high quality 
site visits and identification and resolution of instrument problems. 

• Document all technical support given to the station operator. 

• Load revisions to the DataView system as they are released. 
 
2.3 STATION OPERATOR 
 
 The station operator shall: 
 

• Coordinate with his/her supervisor, project manager, and ARS field specialist 
concerning the schedule and requirements for routine and emergency maintenance. 

• Perform all procedures described in site- or network-specific CIs. 

• Thoroughly document all procedures performed during each site visit. 

• Report any noted inconsistencies immediately to the field specialist. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Site visits are generally performed weekly. Equipment needed for a weekly visit includes: 
 

• Keys for the shelter or support system internal lock and padlocks 

• A Site Operator’s Manual that includes site- or network-specific CIs, and other site- 
or network-specific documentation 

 
4.0 METHODS 
 
 The station operator will perform weekly site visits. The observations recorded during 
these visits verify the operation of the monitoring system. The station operator may also be called 
upon to perform troubleshooting, simple maintenance, and sensor replacements in consultation 
with the field specialist. 
 
 This section includes three (3) major subsections: 
 
 4.1  Weekly Visits 
 4.2  Troubleshooting, Maintenance, and Instrument Replacement 
 4.3  Documentation 
 
4.1 WEEKLY VISITS 
 
 The station operator will make weekly observations at the site. Sites may have different 
configurations and DataView is customized for each site’s instrumentation. While completing the 
DataView CIs, the operator will make some or all of the following observations: 
 
OZONE (O3) Verify that the ozone analyzer is functioning properly. Check the ozone 

particulate filter weekly and change if necessary (at least every two weeks).  
 
A monthly multipoint calibration is also performed as a more 
comprehensive check of the instrument’s condition. 
 

SULFUR DIOXIDE 
(SO2) 
 
 

Verify that the sulfur dioxide analyzer is functioning properly. Verify 
that the gas dilution calibrator is functioning properly. Change the sulfur 
dioxide filter every two weeks. 
 
A monthly multipoint calibration is also performed as a more 
comprehensive check of the instrument’s condition. 
 

CARBON 
MONOXIDE (CO) 

Verify that the carbon monoxide analyzer is functioning properly. Verify 
that the gas dilution calibrator is functioning properly. Change the 
carbon monoxide filter every two weeks. 
 
A monthly multipoint calibration is also performed as a more 
comprehensive check of the instrument’s condition. 
 



             Number 3178 
             Revision 0.4 
             Date JUL 2012 
             Page 5 of 6 
 

OXIDES OF 
NITROGEN (NOX) 

Verify that the oxides of nitrogen analyzer is functioning properly. 
Verify that the gas dilution calibrator is functioning properly. Change the 
oxides of nitrogen filter every two weeks. 
 
A monthly multipoint calibration is also performed as a more 
comprehensive check of the instrument’s condition. 

 
 The station operator should promptly report any noted inconsistencies to the field 
specialist. 
 
4.2 TROUBLESHOOTING, MAINTENANCE, AND INSTRUMENT REPLACEMENT 
 
 If a malfunction of any monitoring component occurs, or if any of the readings do not make 
sense, the station operator should call the Operation Support Center (1-970-484-7941) to report any 
discrepancy. A field technician will instruct the station operator on troubleshooting procedures. 
 
TROUBLESHOOTING If a potential malfunction or other inconsistency is noted, the station 

operator will be directed to perform a series of troubleshooting 
procedures. The use of certain tools or diagnostic equipment (most 
frequently a digital voltmeter) will be required. The field specialist 
will step the station operator through the proper procedures by 
telephone, fax, or electronic mail. Typical procedures may include 
continuity checks, supply voltage checks, bearing observations, 
datalogger interrogation, or specific instrument performance 
observations. The operator will be asked to thoroughly record his/her 
findings and relate them to the field specialist for further action. 
 

MAINTENANCE The station operator may be asked to perform certain mechanical, 
electrical, electronic, or datalogger program maintenance as directed 
by the field specialist. Typical maintenance tasks could include 
tightening tower guy wires, replacing backup batteries, resetting a 
power line breaker, or restarting system components. All maintenance 
must be thoroughly documented and the results related to the field 
specialist. 
 

ANALYZER 
REPLACEMENT 

Under the field specialist’s direction, the station operator may be asked 
to replace a malfunctioning sensor with a pre-calibrated unit. The unit 
would be subsequently calibrated on-site at a later date by the field 
specialist. All replacement steps will be reviewed by telephone with 
the station operator. Instrument-specific manuals or other diagrams or 
descriptions will be referenced as appropriate. All sensor replacement 
procedures including the sensor type, make, serial number, and date 
and time of replacement must be documented. 
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4.3 DOCUMENTATION 
 
 Weekly operator checks entered in the Checklist Instructions are automatically 
documented in the DataView station log. Any additional troubleshooting, maintenance, or sensor 
replacement actions must be documented in the station log using DataView. 
 
 In the event of a DataView computer malfunction, the operator must manually complete a 
hard copy version of each Checklist Instruction. These paper hard copies exist in the Site 
Operator’s Manual. Upon completion, the site operator must mail or fax the completed forms to: 
 

Air Resource Specialists, Inc. 
Attn: IMC 

1901 Sharp Point Drive   Suite E 
Fort Collins, CO   80525 

Fax: 970/484-3423 
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Checklist Instruction - Weekly Station Visit 
 
  •   Ozone Analyzer ( TEI 49i) 
  •   Ozone Calibrator (TEI 49i) 
  •   CASTNet Dry Deposition 
 
Checklist Instruction Number: 3178-3112 
 
Revision Number / Date:   0 / July 2012   
 
 
Objective:  Weekly checks of the ozone instrumentation and the CASTNet dry deposition filter 

pack are to: 
 
 • Verify that the ozone analyzer is functioning properly. 
 • Check the analyzer particulate filter in the orange holder and change if necessary. 

The filter must be changed no less than every two weeks. 
 • Perform a leak check on the ozone analyzer sample manifold. 
 • Change the CASTNet dry deposition filter pack, verify the operational integrity of 

the filter pack system, complete the SSRF, and return the exposed filter pack and 
SSRF to the CASTNet contractor. 

 
 
1. Check  for an  alarm condition on the front panel of the ozone analyzer. Report 

alarms to the OSC. 
 
 Alarm conditions are indicated on the TEI 49i ozone analyzer with a “bell symbol” in the 

front panel display,  as shown below: 
 

CONCENTRATION 
 

O3    62.7 PPB 
 

                               16:45                                
 
RANGE         AVG         DIAGS         ALARM 
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 To list specific alarms, press the Alarm softkey on the analyzer to access the Alarm 
screen: 

 
CONCENTRATION 

 
O3    67.0 PPB 

                               12:16                                
ALARMS: 
   ALARMS DETECTED 1 
 >O3 LAMP TEMP OK 
   LAMP TEMP OK 
   BENCH TEMP LOW 
   PRESSURE OK 
   FLOW A OK 
   FLOW B OK 
 
RANGE         AVG         DIAGS         ALARM 

 
 Call the Operation Support Center to report and resolve the alarms that have been flagged 

on the right side of the display. Record the significant actions related to the alarms in the 
site logbook. Press the Run () button once to return to the Run mode when diagnostics 
are completed. 

 
2. Take the ozone analyzer and flow offline and shut off the CASTNet flow pump and 

hour meter. 
 
 To ensure that only ambient and flow data are recorded in the hourly average, it is 

necessary to mark the O3, O3CAL, and FLW channels offline. Data marked in this 
manner are automatically excluded from the valid data set. 

 
 To access the Login Screen of the ESC datalogger press <Esc> on the keyboard a couple 

of times until the Home Menu is displayed: 
 

 ESC 88XX v5.31  ID:RM              Home Menu                04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 
 
 O Log Out/Exit 
 
 
 

 
 Press <L> for Login/Set User Level: 
 

 ESC 88XX v5.31  ID:RM            Login Screen               04/26/02  11:30:27 
 
 Enter Password             ************** 
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 Login by typing user name and password on the keyboard then press <Enter>. The 

datalogger display will look similar to: 
 

 ESC 88XX v5.31  ID:RM              Home Menu               04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

 ESC 88XX v5.31  ID:RM           Configuration Menu        04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

 ESC 88XX v5.31  ID:RM        Channel Configuration Menu    04/26/02   11:30:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <M> for Disable/Mark Channel Offline: 
 

 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27 
 
 O3  [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD [04] 
 SIG   [05] 
 VWS [06] 
 SWS [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
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 Use the ↑ and ↓ keys to navigate and the spacebar to select the O3, O3CAL, and FLW 
channels for offline status. The channels should be marked with a ">" indicating 
imminent offline status. Press <Enter> to take the marked channels offline. 

 
 Check the status of the channels by pressing <Esc> several times until the Home Menu is 

displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to display 
the data channels with flags. O3, O3CAL, FLW should be marked with a D flag to the 
right to indicate offline status. The offline time is automatically recorded in the logbook 
when this step is complete. 

 
 Switch off the pump and the hour meter for the CASTNet flow system. The labeled 

switches are located below the CASTNet flow box. 
 
3. Tip the dry deposition tower and replace the analyzer particulate filter in the 

orange holder every two weeks or as needed. 
 
 Lower the flow tower only during good weather (e.g., no electrical storms, high winds, 

heavy ice buildup, or obvious tower damage). First remove the locking pin to allow the 
tower to be lowered. Then gently control its descent with the attached rope. Secure the 
tower by tying the rope to the base. 

 
 The dry deposition filter and particulate filter resides in the "pothead" at the top of the 

tower. The particulate filter is in a Teflon housing with an orange tightening ring. Look 
through the “T” at the bottom for obvious fine debris or discoloration on the filter. If the 
filter is unfit for another week of service, it must be changed. Install a clean filter when it 
is visibly dirty or once every 2 weeks, whichever comes first. 

 
 The filter protects the sample inlet system from particulate that could contaminate and 

subsequently reduce the ambient ozone concentrations. Proper filter inspection and 
replacement is key in maintaining accurate readings of ambient ozone concentrations. 

 
 To open the particulate filter holder, loosen the orange tightening ring from the filter 

housing using the dark green filter wrenches supplied by the Operation Support Center.  
 
 Begin a filter change by removing and discarding the exposed filter. Using the provided 

tweezers remove a new 5µ Teflon filter from the envelope and install it into the filter 
housing. The 5µ filter envelope has an orange color code. Ensure that the filter remains 
clean during this process since contamination reduces the ozone concentrations in the 
sampling stream. Reassemble the filter holder and tighten the orange ring securely using 
the filter wrenches. 

 
4. If a new analyzer particulate filter (orange holder) was installed, perform leak 

check of the ozone intake manifold system.  
 
 It is important to know that the inlet system does not have any leaks which could impact 

the air sample presented to the ozone analyzer. This simple procedure should be 
performed after each filter change. Carefully thread a Teflon plug (cap) onto the open 
port of the Teflon “tee” that is situated directly below the orange filter holder. Make sure 
the plug is tight.  
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 Observe the pressure value on the 49i ozone analyzer. Do this by selecting <DIAGS>, 
<Pressure> from the analyzer front panel display. The pressure will be displayed in 
millimeters of mercury. The display should drop and come to rest at a value below 250 
mm which will indicate a leak-free inlet system. Record the pressure value on the 
DataView checklist. 

 
 Should the pressure not drop below 250 mm Hg, initiate the following corrective action: 
 
 A) Tighten the orange filter holder with the green filter wrenches. 
 
 B) Tighten the Teflon nuts of the “tee” and filter holder in the pothead. 
 
 C) Tighten all Teflon nuts on the back of the analyzer and calibrator. 
 
 If this still does not result in a satisfactory leak check, please contact the monitoring 

support contractor. 
 
 Note:  A pressure alarm may sound during this test. Disregard this alarm. 
 
5. If a new analyzer particulate filter (orange holder) was installed, condition it by 

starting a DIAGSZ. 
 
 Following a filter change, a DIAGSZ is required to verify the integrity of the sampling 

system and to condition the new filter. From the ESC datalogger Home Menu, press <C> 
for Configuration Menu: 

 
 ESC 88XX v5.31  ID:RM          Configuration Menu          04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <C> again for Configure Calibrations: 
 

 ESC 88XX v5.31  ID:RM         Cal Configuration Menu       04/26/02  11:30:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
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 Press <S> for Start a Calibration Program: 
 

 ESC 88XX v5.31  ID:RM      Choose List (Enter to Select)   04/26/02  11:30:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
 2    <ESC>    TAB      CTRL-K     CTRL-R     Arrows       
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSZ. This is an ozone 

calibration sequence that begins with a 15-minute span phase and concludes with a 5-
minute zero phase. The control of the calibration sequence is automatic. Press <Enter> 
and several things occur immediately. Pump noise in the shelter increases dramatically as 
the ozone calibrator (O3CAL) sample pump and the zero air pumps switch to on. 

 
 After 15 minutes the span phase will conclude and the zero phase will commence. 
 
 After 5 additional minutes, the zero will turn off and ambient collection will resume 

automatically. Before leaving the station, you will be asked to find and record the stored 
results. 

 
6.  Remove the exposed CASTNet dry deposition filter cartridge, perform a flow 

system leak check and complete last week’s SSRF. 
 
 To confirm that all systems are in good operational condition and that filters are handled 

correctly, the operator is required to check each component and change filters weekly. 
 
 A mailing tube is sent to your site weekly by MACTEC E&C, in Gainesville, Florida. 

Each tube contains a sample filter pack enclosed in a Ziplock bag and a Site Status 
Report Form (SSRF). Filters are generally changed each Tuesday. Call the Operation 
Support Center for exceptions. 

 
 Begin this week’s filter change by completing last weeks SSRF. In the FILTER OFF 

column on last week’s SSRF, record the dry deposition flow box rotameter reading 
observed at the middle of the ball. 

 
 Obtain the most recent Hourly Average for flow by starting at the Home Menu of the 

datalogger. Press <R> for Report Generation Menu. Then press <R> for Daily Averages 
Report. In the highlighted Show Channels field type “FLW” and press <Enter> four 
times to view the Daily Report to Screen.  

 
 ESC 88XX v5.31  ID:RM             Daily Report Screen      04/26/02  11:30:27 
 
 Show Channels             :       FLW 
 
 
 
    Start Time                :       04/26/02 00:00:00 
    # of Flags to Report      :       02 
    Daily Report to Screen    : 
    Daily Report to Printer   : 
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 Daily Average         04/26/02 11:30:27        JDay:  116    Logger ID: BL 
    Report                      ROCKY MOUNTAIN NATIONAL PARK 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
- - 
Name:                        FLW 
Channel Num:                 15 
Analog Input:                10 
Units:                       SLPM 
Full Scale:                     5 V 
High Output:                 5.89 
Low Output:                  0.00 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

- - 
04/26 02:00                   3.00 
04/26 03:00                   3.00 
04/26 04:00                   3.00 
04/26 05:00                   3.00 
04/26 06:00                   3.00 
04/26 07:00                   3.00 
04/26 08:00                   3.00 
04/26 09:00                   3.00 
04/26 10:00                   3.00 
04/26 11:00                 -9999.<N 
04/26 12:00                 -9999.<N 
04/26 13:00                 -9999.<N 
04/26 14:00                 -9999.<N 

 
 Obtain the most recent datalogger HOURLY AVERAGE for FLW and record it in the 

FILTER OFF DAS FLOW (LPM) entry cell on the SSRF. In this example the most 
recent hourly average occurs at 10:00 and is 3.00. 

 
 Remove the CASTNet dry deposition filter. 
 
 A) Wearing clean vinyl gloves (provided by the Operation Support Center), remove the 

dry deposition filter pack from the tower by pulling back on the locking ring of the 
quick-disconnect. Once the filter is removed the quick-disconnect provides an 
airtight seal. 

 
 B) Insert the plastic caps that were saved in the shipping container to avoid 

contamination to the filter. 
 
 C) Place the filter pack in its Ziplock bag.  
 
 D) Enter the date and time for FILTER OFF on last week’s SSRF. 
 
 E) Remove your gloves and discard them. 
 
 F) Observe the current reading of the Mass Flow Controller (MFC) display. It should be 

close to zero. Record this value as the MFC (pump off) under FILTER OFF on last 
week’s SSRF. 

 
G) Turn on the pump to leak check the sampling system. Let the MFC value stabilize 

and record the value in the MFC LEAK CHECK box on last week’s SSRF. The new 
value should also be close to zero. Call the OSC if the MFC (pump off) and the MFC 
LEAK CHECK are more than ± 0.03 different. Turn off the pump. 

 
H) Record the hour meter reading as the ELAPSED TIME (HRS). 
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I) Record the expected ship date, then sign and date the form on the PREPARED BY 

line. At this point, last week’s SSRF should be complete; the white, yellow, and gold 
copies and the filter you just removed can be packed in last week’s mailing tube for 
shipment to MACTEC E&C. The pink copy remains in your stations file cabinet. 

 
 Inspect the plumbing for signs of obvious deterioration or moisture. If either is 

discovered, report your finding to the OSC. 
  
7. Install new CASTNet dry deposition cartridge, raise the tower, and reset hour 

meter. Begin the new SSRF and turn on pump and hour meter. 
 
 Open the mailing tube containing this week’s filter and a new SSRF. Enter the codes for 

the site name and number. The codes are found on the side of the filter housing and on 
the Chain of Custody label.  Enter the date, followed by the day of the week in the VISIT 
DATE/DAY field. If the plumbing has not been disturbed you may enter your previous 
leak check results in the MFC LEAK CHECK cell in the FILTER ON column. Enter 
your name and the date on the SHIPMENT OPENED BY line. 

 
 Enter the filter pack number from the label on the filter pack housing. Back outside, 

release the vacuum at the filter quick-disconnect by pressing into the center of the 
connector until you hear a faint rush of air. Use a small clean screwdriver. 

 
 Put on clean vinyl gloves and remove the caps from the new filter pack. Seal the caps in 

the Ziplock bag and store the bag in the mailing tube until next week. 
 
 Install the filter pack by pressing it into the fitting until you hear a "snap," indicating a 

secure connection. Discard the gloves. 
 
 Raise the tower slowly and secure it by inserting the locking pin. 
 
 Reset the hour meter to zero. Turn on the flow pump and the hour meter. 
 
 Enter the FILTER ON date and time on the new SSRF, using the Local Standard Time 

(LST) displayed by the datalogger. Ensure that the readout box LED display reaches the 
set point recorded on the calibration label affixed to the case. 

 
8. Bring the O3, O3CAL, and FLW channels back online. 
 
 Bring the O3, O3CAL, and FLW channels online by beginning at the Home Menu of the 

ESC datalogger. Remember that pressing <Esc> several times will return you eventually 
to the Home Menu. 

 
 ESC 88XX v5.31  ID:RM              Home Menu               04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
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 Press <C> for Configuration Menu: 
 

 ESC 88XX v5.31  ID:RM           Configuration Menu         04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

 ESC 88XX v5.31  ID:RM        Channel Configuration Menu    04/26/02  11:30:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for  Enable/Mark Channel Online. O3 and FLW should be the only channels 

displayed. 
 

 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27 
 
  > O3     [01] 
    O3CAL  [02] 
    FLW    [15] 
  
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Press the 

<Spacebar> to select both channels for online status. Press <Enter> to put the selected 
channels online. 

 
 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27 
 
   > O3     [01] 
   > O3CAL  [02]  
   > FLW    [15] 
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 Check the status of the O3, O3CAL, and FLW channels by pressing <Esc> several times 
until the Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. 
Press <F> once to display the data channels with flags. O3, O3CAL, O3R8, and FLW 
will no longer be marked with a flag indicating online status; a P may be in the flag 
column for each indicating a purge period programmed to allow for the time it takes for 
ambient conditions to prevail. The P flag should clear within one minute. The online time 
will be recorded in the logbook when this step is complete. 

 
 Note:  If the calibration sequence, DIAGSZ, is still active, O3, O3CAL, and O3R8 will 

be flagged with a C. 
 
9-10. If a new analyzer particulate filter (orange holder) was installed and a DIAGSZ was 

activated enter the filter conditioning results for O3 and O3CAL. 
 
 From the Home Menu press <R> for Report Generation Menu: 
 

ESC 88XX v5.31  ID:BL         Report Menu          08/06/97  14:59:27 
 
 A Report Averages 
 C Report Calibrations 
 L Summarize Last Cals 
 Q Autoprint Data Channel(s) 
 D Autopring Daily Report 
 Z Autoprint Calibration(s) 
 R Daily Averages Report 
 T Daily Calibrations Report 
  

 
 Press <L> for Summarize Last Cals. Navigate through the Last Cals using the <D> 

(down) or <U> (up) keys to find the DIAGSZ: 
 

DIAGSZ 
 

O3 
 
 

O3 CAL 
 
 
 
 

08/14   08:00 
 

SPAN 
ZERO 

 
SPAN 
ZERO 

EXPECTED 
 

400 
0 
 

400 
0 

ACTUAL 
 

406.1 
-0.1956 

 
403.9 
1.0100 

ERROR 
 

6.1 
0 
 

3.9 
1.01 

UNITS 
 

PPB 
PPB 

 
PPB 
PPB 

FLAGS 
 

DC 
DC 

 
DC 
DC 

 
 Record the O3 and O3CAL from the ACTUAL column into the appropriate cells of the 

checklist. The result location has been highlighted in the graphic above. 
 
 O3ZERO Value between -5 and +5 ppb 
 O3SPAN Value within 10% of O3CAL SPAN 
 O3CAL ZERO Value between -5 and +5 ppb 
 O3CAL SPAN Value between 350 and 450 ppb 
 
 The checklist will prompt you to call the OSC if the results were not within tolerance. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Ozone Analyzer ( TEI 49C) 
  •   Ozone Calibrator (TEI 49C) 
  •   CASTNet Dry Deposition 
 
Checklist Instruction Number: 3178-3116 
 
Revision Number / Date:   4 / January 2006  (last reviewed Jan. 2012) 
 
 
Objective:  Weekly checks of the ozone instrumentation and the CASTNet dry deposition filter 

pack are to: 
 
 • Verify that the ozone analyzer is functioning properly. 
 • Check the analyzer particulate filter in the orange holder and change if necessary.  

The filter must be changed no less than every two weeks. 
 • Change the CASTNet dry deposition filter pack, verify the operational integrity of 

the filter pack system, complete the SSRF, and return the exposed filter pack and 
SSRF to the CASTNet contractor. 

 
 
1. Check  for an  alarm condition on the front panel of the ozone analyzer.  Report 

alarms to the OSC. 
 
 Alarm conditions are indicated on the TEI 49C ozone analyzer front panel display,  as 

shown below: 
 

 
O3 PPB  67.0 
 
   ALARM              REMOTE 

 
 To list specific alarms, press the MENU button on the analyzer once to access the Main 

Menu: 
 

MAIN MENU:  10:25 
> RANGE 
 AVERAGING TIME 
 CALIBRATION FACTORS 
 

 
   CALIBRATION 
   INSTRUMENT CONTROLS 
   DIAGNOSTICS 
   ALARM 
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 Use the ↑ and ↓ buttons to move the cursor and press <Enter> once to access the Alarm 
Menu: 

 
ALARMS DETECTED: 1 
> BENCH TEMP OK 
 BENCH LAMP TEMP LOW 
 PRESSURE OK 
 

 
 FLOW A OK 
 FLOW B OK 
 INTENSITY A OK  
 INTENSITY B OK 
 O3 CONC OK 

 
 Call the Operation Support Center to report and resolve the alarms that have been flagged 

on the right side of the display.  Record the significant actions related to the alarms in the 
site logbook.  Press the RUN button once to return to the Run mode when diagnostics are 
completed. 

 
2. Take the ozone analyzer and flow offline and shut off the CASTNet flow pump and 

hour meter. 
 
 To ensure that only ambient and flow data are recorded in the hourly average, it is 

necessary to mark the O3, O3CAL, and FLW channels offline.  Data marked in this 
manner are automatically excluded from the valid data set. 

 
 To access the Login Screen of the ESC datalogger press <Esc> on the keyboard a couple 

of times until the Home Menu is displayed: 
 

 ESC 88XX v5.31  ID:RM              Home Menu                04/26/02  11:30:27 
 
 H Help Screen 

L Login/Set User Level 
 
 
 
 O Log Out/Exit 
 
 
 

 
 Press <L> for Login/Set User Level: 
 

 ESC 88XX v5.31  ID:RM            Login Screen               04/26/02  11:30:27 
 
 Enter Password             ************** 
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 Login by typing user name and password on the keyboard then press <Enter>.  The 
datalogger display will look similar to: 

 
 ESC 88XX v5.31  ID:RM              Home Menu               04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

 ESC 88XX v5.31  ID:RM           Configuration Menu        04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

 ESC 88XX v5.31  ID:RM        Channel Configuration Menu    04/26/02   11:30:27
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <M> for Disable/Mark Channel Offline: 
 

 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27
 
 O3  [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD [04] 
 SIG   [05] 
 VWS [06] 
 SWS [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
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 Use the ↑ and ↓ keys to navigate and the spacebar to select the O3, O3CAL, and FLW 
channels for offline status.  The channels should be marked with a ">" indicating 
imminent offline status.  Press <Enter> to take the marked channels offline. 

 
 Check the status of the channels by pressing <Esc> several times until the Home Menu is 

displayed.  Press <D> once to enter the Real-Time Display Menu.  Press <F> to display 
the data channels with flags.  O3, O3CAL, FLW should be marked with a D flag to the 
right to indicate offline status.  The offline time is automatically recorded in the logbook 
when this step is complete. 

 
 Switch off the pump and the hour meter for the CASTNet flow system.  The labeled 

switches are located below the CASTNet flow box. 
 
3. Tip the dry deposition tower and replace the analyzer particulate filter in the 

orange holder every two weeks or as needed. 
 
 Lower the flow tower only during good weather (e.g., no electrical storms, high winds, 

heavy ice buildup, or obvious tower damage).  First remove the locking pin to allow the 
tower to be lowered.  Then gently control its descent with the attached rope.  Secure the 
tower by tying the rope to the base. 

 
 The dry deposition filter and particulate filter resides in the "pothead" at the top of the 

tower.  The particulate filter is in a Teflon housing with an orange tightening ring.  Look 
through the “T” at the bottom for obvious fine debris or discoloration on the filter.  If the 
filter is unfit for another week of service, it must be changed.  Install a clean filter when it 
is visibly dirty or once every 2 weeks, whichever comes first. 

 
 The filter protects the sample inlet system from particulate that could contaminate and 

subsequently reduce the ambient ozone concentrations.  Proper filter inspection and 
replacement is key in maintaining accurate readings of ambient ozone concentrations. 

 
 To open the particulate filter holder, loosen the orange tightening ring from the filter 

housing using the dark green filter wrenches supplied by the Operation Support Center.   
 
 Begin a filter change by removing and discarding the exposed filter.  Using the provided 

tweezers remove a new 5μ Teflon filter from the envelope and install it into the filter 
housing.  The 5μ filter envelope has an orange color code.  Ensure that the filter remains 
clean during this process since contamination reduces the ozone concentrations in the 
sampling stream.  Reassemble the filter holder and tighten the orange ring securely using 
the filter wrenches. 

 
4. If a new analyzer particulate filter (orange holder) was installed, condition it by 

starting a DIAGSZ. 
 
 Following a filter change, a DIAGSZ is required to verify the integrity of the sampling 

system and to condition the new filter. From the ESC datalogger Home Menu, press <C> 
for Configuration Menu: 
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 ESC 88XX v5.31  ID:RM          Configuration Menu          04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <C> again for Configure Calibrations: 
 

 ESC 88XX v5.31  ID:RM         Cal Configuration Menu       04/26/02  11:30:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <S> for Start a Calibration Program: 
 

 ESC 88XX v5.31  ID:RM      Choose List (Enter to Select)   04/26/02  11:30:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSZ.  This is an 

ozone calibration sequence that begins with a 15-minute span phase and concludes with a 
5-minute zero phase.  The control of the calibration sequence is automatic.  Press 
<Enter> and several things occur immediately.  Pump noise in the shelter increases 
dramatically as the ozone calibrator (O3CAL) sample pump and the zero air pumps 
switch to on. 

 
 After 15 minutes the span phase will conclude and the zero phase will commence. 
 
 After 5 additional minutes, the zero will turn off and ambient collection will resume 

automatically.  Before leaving the station, you will be asked to find and record the stored 
results. 
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5.  Remove the exposed CASTNet dry deposition filter cartridge, perform a flow 
system leak check and complete last week’s SSRF. 

 
 To confirm that all systems are in good operational condition and that filters are handled 

correctly, the operator is required to check each component and change filters weekly. 
 
 A mailing tube is sent to your site weekly by MACTEC E&C, in Gainesville, Florida.  

Each tube contains a sample filter pack enclosed in a Ziplock® bag and a Site Status 
Report Form (SSRF).  Filters are generally changed each Tuesday. Call the Operation 
Support Center for exceptions. 

 
 Begin this week’s filter change by completing last weeks SSRF.  In the FILTER OFF 

column on last week’s SSRF, record the dry deposition flow box rotameter reading 
observed at the middle of the ball. 

 
 Obtain the most recent Hourly Average for flow by starting at the Home Menu of the 

datalogger.  Press <R> for Report Generation Menu.  Then press <R> for Daily Averages 
Report.  In the highlighted Show Channels field type “FLW” and press <Enter> four 
times to view the Daily Report to Screen.   

 
 ESC 88XX v5.31  ID:RM             Daily Report Screen      04/26/02  11:30:27 
 
 Show Channels             :       FLW 
 
 
 
    Start Time                :       04/26/02 00:00:00 
    # of Flags to Report      :       02 
    Daily Report to Screen    : 
    Daily Report to Printer   : 
 
 

 
 Daily Average         04/26/02 11:30:27        JDay:  116    Logger ID: BL 
    Report                      ROCKY MOUNTAIN NATIONAL PARK 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
- - 
Name:                        FLW 
Channel Num:                 15 
Analog Input:                10 
Units:                       SLPM 
Full Scale:                     5 V 
High Output:                 5.89 
Low Output:                  0.00 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

- - 
04/26 00:00                   3.00 
04/26 01:00                   3.00 
04/26 02:00                   3.00 
04/26 03:00                   3.00 
04/26 04:00                   3.00 
04/26 05:00                   3.00 
04/26 06:00                   3.00 
04/26 07:00                   3.00 
04/26 08:00                   3.00 
04/26 09:00                   3.00 
04/26 10:00                   3.00 
04/26 11:00                 -9999.<N 
04/26 12:00                 -9999.<N 
04/26 13:00                 -9999.<N 
04/26 14:00                 -9999.<N 
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 Obtain the most recent datalogger HOURLY AVERAGE for FLW and record it in the 
FILTER OFF DAS FLOW (LPM) entry cell on the SSRF.  In this example the most 
recent hourly average occurs at 10:00 and is 3.00. 

 
 Remove the CASTNet dry deposition filter. 
 
 A) Wearing clean vinyl gloves (provided by the Operation Support Center), remove the 

dry deposition filter pack from the tower by pulling back on the locking ring of the 
quick-disconnect.  Once the filter is removed the quick-disconnect provides an 
airtight seal. 

 
 B) Insert the plastic caps that were saved in the shipping container to avoid 

contamination to the filter. 
 
 C) Place the filter pack in its Ziplock® bag.   
 
 D) Enter the date and time for FILTER OFF on last week’s SSRF. 
 
 E) Remove your gloves and discard them. 
 
 F) Observe the current reading of the Mass Flow Controller (MFC) display.  It should 

be close to zero.  Record this value as the MFC (pump off) under FILTER OFF on 
last week’s SSRF. 

 
G) Turn on the pump to leak check the sampling system.  Let the MFC value stabilize 

and record the value in the MFC LEAK CHECK box on last week’s SSRF.  The new 
value should also be close to zero.  Call the OSC if the MFC (pump off) and the 
MFC LEAK CHECK are more than ± 0.03 different.  Turn off the pump. 

 
H) Record the hour meter reading as the ELAPSED TIME (HRS). 

 
I) Record the expected ship date, then sign and date the form on the PREPARED BY 

line.  At this point, last week’s SSRF should be complete; the white, yellow, and 
gold copies and the filter you just removed can be packed in last week’s mailing tube 
for shipment to MACTEC E&C.  The pink copy remains in your stations file 
cabinet. 

 
 Inspect the plumbing for signs of obvious deterioration or moisture.  If either is 

discovered, report your finding to the OSC. 
  
6. Install new CASTNet dry deposition cartridge, raise the tower, and reset hour 

meter.  Begin the new SSRF and turn on pump and hour meter. 
 
 Open the mailing tube containing this week’s filter and a new SSRF.  Enter the codes for 

the site name and number.  The codes are found on the side of the filter housing and on 
the Chain of Custody label.   Enter the date, followed by the day of the week in the VISIT 
DATE/DAY field.  If the plumbing has not been disturbed you may enter your previous 
leak check results in the MFC LEAK CHECK cell in the FILTER ON column.  Enter 
your name and the date on the SHIPMENT OPENED BY line. 
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 Enter the filter pack number from the label on the filter pack housing.  Back outside, 

release the vacuum at the filter quick-disconnect by pressing into the center of the 
connector until you hear a faint rush of air.  Use a small clean screwdriver. 

 
 Put on clean vinyl gloves and remove the caps from the new filter pack.  Seal the caps in 

the Ziplock® bag and store the bag in the mailing tube until next week. 
 
 Install the filter pack by pressing it into the fitting until you hear a "snap," indicating a 

secure connection.  Discard the gloves. 
 
 Raise the tower slowly and secure it by inserting the locking pin. 
 
 Reset the hour meter to zero.  Turn on the flow pump and the hour meter. 
 
 Enter the FILTER ON date and time on the new SSRF, using the Local Standard Time 

(LST) displayed by the datalogger.  Ensure that the readout box LED display reaches the 
set point recorded on the calibration label affixed to the case. 

 
7. Bring the O3, O3CAL, and FLW channels back online. 
 
 Bring the O3, O3CAL, and FLW channels online by beginning at the Home Menu of the 

ESC datalogger.  Remember that pressing <Esc> several times will return you eventually 
to the Home Menu. 

 
 ESC 88XX v5.31  ID:RM              Home Menu               04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 
 

 
 Press <C> for Configuration Menu: 
 

 ESC 88XX v5.31  ID:RM           Configuration Menu         04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <D> for Configure (Data) Channels: 
 

 ESC 88XX v5.31  ID:RM        Channel Configuration Menu    04/26/02  11:30:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for  Enable/Mark Channel Online.  O3 and FLW should be the only channels 

displayed. 
 

 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27
 
  > O3     [01] 
    O3CAL  [02] 
    FLW    [15] 
  
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel.  Press the 

<Spacebar> to select both channels for online status.  Press <Enter> to put the selected 
channels online. 

 
 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27
 
   > O3     [01] 
   > O3CAL  [02]  
   > FLW    [15] 
  
 
 
 
 

 
 Check the status of the O3, O3CAL, and FLW channels by pressing <Esc> several times 

until the Home Menu is displayed.  Press <D> once to enter the Real-Time Display 
Menu.  Press <F> once to display the data channels with flags.  O3, O3CAL, O3R8, and 
FLW will no longer be marked with a flag indicating online status; a P may be in the flag 
column for each indicating a purge period programmed to allow for the time it takes for 
ambient conditions to prevail.  The P flag should clear within one minute.  The online 
time will be recorded in the logbook when this step is complete. 

 
 Note:  If the calibration sequence, DIAGSZ, is still active, O3, O3CAL, and O3R8 will 

be flagged with a C. 
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8-9. If a new analyzer particulate filter (orange holder) was installed and a DIAGSZ was 
activated enter the filter conditioning results for O3 and O3CAL. 

 
 From the Home Menu press <R> for Report Generation Menu: 
 

ESC 88XX v5.31  ID:BL         Report Menu          08/06/97  14:59:27 
 
 A Report Averages 
 C Report Calibrations 
 L Summarize Last Cals 
 Q Autoprint Data Channel(s) 
 D Autopring Daily Report 
 Z Autoprint Calibration(s) 
 R Daily Averages Report 
 T Daily Calibrations Report 
  

 
 Press <L> for Summarize Last Cals.  Navigate through the Last Cals using the <D> 

(down) or <U> (up) keys to find the DIAGSZ: 
 

DIAGSZ 
 

O3 
 
 

O3 CAL 
 
 
 
 
 
 

08/14   08:00 
 

SPAN 
ZERO 

 
SPAN 
ZERO 

EXPECTED 
 

400 
0 
 

400 
0 

ACTUAL 
 

406.1 
-0.1956 

 
403.9 

1.0100 

ERROR 
 

6.1 
0 
 

3.9 
1.01 

UNITS 
 

PPB 
PPB 

 
PPB 
PPB 

FLAGS 
 

DC 
DC 

 
DC 
DC 

 
 Record the O3 and O3CAL from the ACTUAL column into the appropriate cells of the 

checklist.  The result location has been highlighted in the graphic above. 
 
 O3ZERO Value between -5 and +5 ppb 
 O3SPAN Value within 10% of O3CAL SPAN 
 O3CAL ZERO Value between -5 and +5 ppb 
 O3CAL SPAN Value between 350 and 450 ppb 
 
 The checklist will prompt you to call the OSC if the results were not within tolerance. 
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Checklist Instruction - Multipoint Calibration 
 
 •   Ozone Analyzer (TEI 49C) 
 •   Ozone Calibrator (TEI 49C) 
 
Checklist Instruction Number: 3178-3315 
 
Revision Number / Date:   2 / July 2012   (last reviewed July 2012) 
 
Objective:  Monthly multipoint calibrations are performed to provide a more comprehensive 

check of the instrument’s condition and verify the ozone analyzer’s response to 
ozone free (zero) air and three (3) upscale ozone concentrations: 

 
 • 360 to 440 ppb 
 • 150 to 200 ppb 
 •   50 to 80 ppb 

 
1. Start a DIAGZERO sequence from the ESC datalogger. 
 
 From the ESC datalogger Home Menu, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
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 Press <S> for Start a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows     ** 
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGZERO. This is an 

ozone calibration sequence that initiates a 30-minute zero. The control of the calibration 
sequence is automatic. Press <Enter> and several things occur immediately. Pump noise 
in the shelter increases dramatically as the ozone calibrator (O3CAL) sample pump and 
the zero air pump switch on.  The alarm on the front panel of the ozone calibrator should 
go off within a few seconds. Inspect the front panel of the ozone analyzer and the ozone 
calibrator. If either panel is displaying an alarm, abort the multipoint calibration and call 
the Operation Support Center for diagnostic support. Restart the multipoint when the 
alarms have been resolved. 

 
 Press <Esc> several times to return to the datalogger Home Menu. 
 
 From the Home Menu, select <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup       08/06/97  14:59:27 
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
 Enter a <1> and then <m> for the Average Interval if it has not defaulted to the 1m. 

Arrow down to Show Channels. Type O3 and O3CAL if it is not already displayed. 
Arrow down to Start Continuous Report and press <Enter>. 
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 TIME  O3 O3CAL RNF 
 
 08/06 14:59 41.<C -1.<C  0.0 
 
 
 
 

 
2. Check  for an  alarm condition on the front panel of the ozone analyzer. Report 

alarms to the OSC before proceeding with the multipoint calibration. 
 
 Alarm conditions are indicated on the TEI 49C ozone analyzer front panel display,  as 

shown below: 
 

 
 
O3 PPB  0.0 
 
ZERO   ALARM              REMOTE 

 
3. Check  for an  alarm condition on the display of the ozone calibrator. The display 

should not show an alarm condition during the DIAGZERO. Report alarms to the 
OSC before proceeding with the multipoint calibration. 

 
 Previous to the initiation of the DIAGZERO sequence, the normal TEI 49C ozone 

calibrator front panel will display an alarm condition as shown below: 
 

 
 
O3 PPB  0.0 
 
   ALARM              REMOTE 

 
 When the DIAGZERO sequence has been initiated, the ozone calibrator sample pump 

will start and the alarm condition will no longer be visible. As the flow rate approaches 
its set point, the ALARM indicator will be replaced with and indication of the time of day 
as shown below: 

 
 
 
O3 PPB  0.0 
 
   10:25                 REMOTE 

 
 
 Note:  The time of day need not be correct for the calibrator to operate properly. 
 
 If the alarm condition persists after one minute into the DIAGZERO calibration 

sequence, call the Operation Support Center. 
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4.  Observe the continuous average report for several minutes. When five or more 

1-minute updates indicate a stable zero response, +5ppb to –5ppb, record the last 
1-minute averages for O3 and O3CAL.  

 
 After several minutes the Continuous Average Report will display the arrays of 1-minute 

updates for O3 and O3CAL. 
 

 
  
 TIME   O3 O3CAL RNF 
 
 10/19 11:30 41.<C -1.<C  0.0 
 10/19 11:31  4.<C -0.<C  0.0 
  10/19 11:32  0.<C -1.<C  0.0 
  10/19 11:33 -1.<C  1.<C  0.0 
  10/19 11:34  0.<C  1.<C  0.0 
 
  

 
 Once the following conditions have been met: 
 
  1. The last five 1-minute averages of O3 are in the range of +5ppb to –5ppb. 
  2. The last five 1-minute averages of O3CAL are in the range of +5ppb to –5ppb. 
 
 Record the last 1-minute average of O3 and O3CAL. If  the conditions are not met, even 

after several more minutes, do not proceed further with the multipoint calibration. Call 
the OSC for diagnostic support. 

 
 
 If the zero values were successful and recorded, abort the DIAGZERO. 
 
 Press <Esc> several times to return to the Home Menu. Press <C> for the Configuration 

Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <A> for Abort a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGZERO. 
 
 Press <Enter> and the zero air pump and ozone calibrator pump turn off. The alarm 

condition should reappear on the front panel of the ozone calibrator. 
 
5.  Start a DIAGSPAN.  
 
 From the ESC datalogger Home Menu, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <S> for Start a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSPAN. This is an 

ozone calibration sequence that initiates an ozone span. The control of the calibration 
sequence is automatic. Press <Enter>. 

 
 Note: Incase of MDI error message, wait 1 minute before starting DIAGSPAN. 
 
6.  Observe the Continuous Average Report for several minutes. When five or more 

1-minute updates indicate a stable span response, 360ppb to 440ppb, record the last 
1-minute averages for O3 and O3CAL. 

 
 From the Home Menu, press <D> for the Real-Time Display Menu: 
 
 Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup     08/06/97  14:59:27 
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
 Enter a <1> and then <m> for the Average Interval if it has not defaulted to the 1m. 

Arrow down to Show Channels. Type O3 and O3CAL if it is not already displayed. 
Arrow down to Start Continuous Report and press <Enter>. 
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 TIME  O3 O3CAL RNF 
 
 08/06/99 14:59:27 41.<C -1.<C  0.0 
 
 
  
 

 
 After several minutes the Continuous Average Report will display the arrays of 1-minute 

updates for O3 and O3CAL. 
 

 
  
  
 TIME   O3 O3CAL RNF 
 
 10/19 11:30 41.<C -1.<C  0.0 
 10/19 11:31 350.<C 361.<C  0.0 
  10/19 11:32 401.<C 400.<C  0.0 
  10/19 11:33 402.<C 400.<C  1.0 
  10/19 11:34 401.<C 401.<C  0.0 
 
  

 
 Once the following conditions have been met: 
 
 1. The last five 1-minute averages of O3 are within the range of 360ppb to 440ppb. 

 2. The difference between O3 and O3CAL for each of the last five averages is less than 
25ppb. 

 
 Record the last 1-minute average of O3 and O3CAL on the checklist. If the conditions are 

not met, even after several more minutes, call the Operation Support Center for 
assistance. 

 
7.  Adjust the O3 analyzer LEVEL2, downward to generate a concentration between 

150ppb and 200ppb. Record the results from the Continuous Average Reports after 
the event has stabilized.  

 
 From the front panel of the O3 analyzer, navigate through the menus to reduce the ozone 

concentration. Start from the Run screen. 
 

 
O3 PPB  401. 
 
   ALARM                 REMOTE 
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 Press the MENU button once. 
 

MAIN MENU: 10:25 
> RANGE 
 AVERAGING TIME 
 CALIBRATION FACTORS 
 

 
 CALIBRATION 
 INSTRUMENT CONTROLS 
 DIAGNOSTICS 
 ALARM 

 
 Use the ↑ and ↓ buttons to navigate and position the cursor next to INSTRUMENT 

CONTROLS. Press <Enter> once to enter the Instrument Controls Menu. 
 

INSTRUMENT CONTROLS: 
> TEMP CORRECTION 
 PRESSURE CORRECTION 
 OZONATOR SOLENOID 
 OZONATOR LEVEL 1 
 OZONATOR LEVEL2 
 

 
   SCREEN BRIGHTNESS 
   SERVICE MODE 
   TIME 
   DATE 
 
 Use the ↑ and ↓ buttons to navigate and position the cursor next to LEVEL2. Press 

<Enter> once to enter the LEVEL2 adjustment screen. 
 

 
 O3PPB 401. 
 LEVEL2  44.1% 
 
 ↑ ↓     INC/DEC 
 

 
 Use the ↑ and ↓ buttons to decrease the power to the ozone generator. The power is 

expressed as a percentage. Normal lag time between and adjustment and a stable ozone 
reading is about one minute. Wait for the ozone reading to stabilize. Further adjust the 
power up or down until the ozone concentration stabilizes between 150ppb and 200ppb. 

 
 Watch the Continuous Average Report on the datalogger for several minutes. When five 

or more 1-minute updates indicate a stable response, record the last 1-minute updates for 
O3 and O3CAL on the checklist. 
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8.  Adjust the O3 analyzer LEVEL2, downward to generate a concentration between 
50ppb and 80ppb. Record the results from the Continuous Average Reports after 
the event has stabilized. 

 
 Use the ↑ and ↓ buttons to decrease the power to the ozone generator. The power is 

expressed as a percentage. Normal lag time between and adjustment and a stable ozone 
reading is about one minute. Wait for the ozone reading to stabilize. Further adjust the 
power up or down until the ozone concentration stabilizes between 50ppb and 80ppb. 

 
 Watch the Continuous Average Report on the datalogger for several minutes. When fivee 

or more 1-minute updates indicate a stable response, record the last 1-minute updates for 
O3 and O3CAL on the checklist. 

 
 The multipoint is complete. 
 
9. Press the RUN button on the O3 analyzer to return to the RUN screen. Abort the 

DIAGSPAN on the datalogger. 
 
 Press the RUN button once on the O3 analyzer. This returns the analyzer to the Run 

screen and resets LEVEL2 to the previous set point percentage for normal spans. 
 
 Abort to DIAGSPAN and return the analyzer to ambient sampling by pressing <Esc> on 

the datalogger keyboard several times, to return to the Home Menu. From the ESC 
datalogger Home Menu, press <C> for Configuration Menu. 

 
ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
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 Press <A> for Abort a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSPAN. The 

DIAGSPAN ceases immediately. 
 
10. Review the results. Call the Operation Support Center to discuss the multipoint 

results. 
 
 Select View Results on the checklist. 
  
 The multipoint calibration summary, displays the zero and three upscale point results, an 

X-Y plot of the results, the linear regression results and a pass/fail indicator. Call the 
Operation Support Center to discuss the results of the multipoint check. 
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Checklist Instruction - Multipoint Calibration 
 
 •   Ozone Analyzer (TEI 49i) 
 •   Ozone Calibrator (TEI 49i) 
 
Checklist Instruction Number: 3178-3316 
 
Revision Number / Date:   0 / July 2012   (last reviewed July 2012) 
 
Objective:  Monthly multipoint calibrations are performed to provide a more comprehensive 

check of the instrument’s condition and verify the ozone analyzer’s response to 
ozone free (zero) air and three (3) upscale ozone concentrations: 

 
 • 360 to 440 ppb 
 • 150 to 200 ppb 
 •   50 to 80 ppb 

 
1. Start a DIAGZERO sequence from the ESC datalogger. 
 
 From the ESC datalogger Home Menu, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
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 Press <S> for Start a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows     ** 
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGZERO. This is an 

ozone calibration sequence that initiates a 30-minute zero. The control of the calibration 
sequence is automatic. Press <Enter> and several things occur immediately. Pump noise 
in the shelter increases dramatically as the ozone calibrator (O3CAL) sample pump and 
the zero air pump switch on.  The alarm on the front panel of the ozone calibrator should 
go off within a few seconds. Inspect the front panel of the ozone analyzer and the ozone 
calibrator. If either panel is displaying an alarm, abort the multipoint calibration and call 
the Operation Support Center for diagnostic support. Restart the multipoint when the 
alarms have been resolved. 

 
 Press <Esc> several times to return to the datalogger Home Menu. 
 
 From the Home Menu, select <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup       08/06/97  14:59:27 
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
 Enter a <1> and then <m> for the Average Interval if it has not defaulted to the 1m. 

Arrow down to Show Channels. Type O3 and O3CAL if it is not already displayed. 
Arrow down to Start Continuous Report and press <Enter>. 
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 TIME  O3 O3CAL RNF 
 
 08/06 14:59 41.<C -1.<C  0.0 
 
 

 
2. Check  for an  alarm condition on the front panel of the ozone analyzer. Report 

alarms to the OSC before proceeding with the multipoint calibration. 
 
 Alarm conditions are indicated on the TEI 49i ozone analyzer with a “bell symbol” in the 

front panel display,  as shown below: 
 

CONCENTRATION 
 
O3    62.7 PPB 
 

                               16:45                                
 
RANGE         AVG         DIAGS         ALARM 

 
3. Check  for an  alarm condition on the display of the ozone calibrator. The display 

should not show an alarm condition during the DIAGZERO. Report alarms to the 
OSC before proceeding with the multipoint calibration. 

 
 Previous to the initiation of the DIAGZERO sequence, the normal TEI 49i ozone 

calibrator front panel will display an alarm condition as shown below: 
 

CONCENTRATION 
 
O3    62.7 PPB 
 

                               16:45                                
 
RANGE         AVG         DIAGS         ALARM 

 
 When the DIAGZERO sequence has been initiated, the ozone calibrator sample pump 

will start and the alarm condition will no longer be met. As the flow rate approaches its 
set point, the ALARM indicator will disappear. 

 
CONCENTRATION 
 
O3    62.7 PPB 
 
                               16:45                                
 
RANGE         AVG         DIAGS         ALARM 

  
 If the alarm condition persists after one minute into the DIAGZERO calibration 

sequence, call the Operation Support Center. 
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4.  Observe the continuous average report for several minutes. When five or more 

1-minute updates indicate a stable zero response, +5ppb to –5ppb, record the last 
1-minute averages for O3 and O3CAL.  

 
 After several minutes the Continuous Average Report will display the arrays of 1-minute 

updates for O3 and O3CAL. 
 

 
  
 TIME   O3 O3CAL RNF 
 
 10/19 11:30 41.<C -1.<C  0.0 
 10/19 11:31  4.<C -0.<C  0.0 
  10/19 11:32  0.<C -1.<C  0.0 
  10/19 11:33 -1.<C  1.<C  0.0 
  10/19 11:34  0.<C  1.<C  0.0 
 
  

 
 Once the following conditions have been met: 
 
  1. The last five 1-minute averages of O3 are in the range of +5ppb to –5ppb. 
  2. The last five 1-minute averages of O3CAL are in the range of +5ppb to –5ppb. 
 
 Record the last 1-minute average of O3 and O3CAL. If  the conditions are not met, even 

after several more minutes, do not proceed further with the multipoint calibration. Call 
the OSC for diagnostic support. 

 
 
 If the zero values were successful and recorded, abort the DIAGZERO. 
 
 Press <Esc> several times to return to the Home Menu. Press <C> for the Configuration 

Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <A> for Abort a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGZERO. 
 
 Press <Enter> and the zero air pump and ozone calibrator pump turn off. The alarm 

condition should reappear on the front panel of the ozone calibrator. 
 
5.  Start a DIAGSPAN.  
 
 From the ESC datalogger Home Menu, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <S> for Start a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSPAN. This is an 

ozone calibration sequence that initiates an ozone span. The control of the calibration 
sequence is automatic. Press <Enter>. 

 
 Note: In case of MDI error message, wait 1 minute before starting DIAGSPAN. 
 
6.  Observe the Continuous Average Report for several minutes. When five or more 

1-minute updates indicate a stable span response, 360ppb to 440ppb, record the last 
1-minute averages for O3 and O3CAL. 

 
 From the Home Menu, press <D> for the Real-Time Display Menu: 
 
 Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup     08/06/97  14:59:27 
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
 Enter a <1> and then <m> for the Average Interval if it has not defaulted to the 1m. 

Arrow down to Show Channels. Type O3 and O3CAL if it is not already displayed. 
Arrow down to Start Continuous Report and press <Enter>. 
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 TIME  O3 O3CAL RNF 
 
 08/06/99 14:59:27 41.<C -1.<C  0.0 
 
 
  
 

 
 After several minutes the Continuous Average Report will display the arrays of 1-minute 

updates for O3 and O3CAL. 
 

 
  
  
 TIME   O3 O3CAL RNF 
 
 10/19 11:30 41.<C -1.<C  0.0 
 10/19 11:31 350.<C 361.<C  0.0 
  10/19 11:32 401.<C 400.<C  0.0 
  10/19 11:33 402.<C 400.<C  1.0 
  10/19 11:34 401.<C 401.<C  0.0 
 
  

 
 Once the following conditions have been met: 
 
 1.  The last five 1-minute averages of O3 are within the range of 360ppb to 440ppb. 

 2.  The difference between O3 and O3CAL for each of the last five averages is less than 
25ppb. 

 
 Record the last 1-minute average of O3 and O3CAL on the checklist. If the conditions are 

not met, even after several more minutes, call the Operation Support Center for 
assistance. 

 
7.  Select the O3 analyzer CUSTOM LEVEL3 to generate a concentration between 

150ppb and 200ppb. Record the results from the Continuous Average Reports after 
the event has stabilized.  

 
 From the front panel of the O3 analyzer, navigate through the menus to reduce the ozone 

concentration. Start from the Run screen. 
 

CONCENTRATION 
 
O3    62.7 PPB 
 
                               16:45                                
 
RANGE         AVG         DIAGS         ALARM 
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 Press the MENU (    )  button once. 
 

CONCENTRATION 
O3      67.0PPB 
 
SAMPLE  10:16 
MAIN MENU: 
>RANGE 
  AVERAGING TIME 
  CALIBRATION FACTORS 
  CALIBRATION 
  INSTRUMENT CONTROLS 
  DIAGNOSTICS 
  ALARMS      
 

 
 Use the ↑ and ↓ buttons to navigate and position the cursor next to INSTRUMENT 

CONTROLS. Press <Enter> once to enter the Instrument Controls Menu. 
 
 

CONCENTRATION 
O3      67.0PPB 
 
SAMPLE  10:16 
INSTRUMENT CONTROLS: 
>CUSTOM LEVELS 
  OZONATOR SOLENOID 
  CYCLE TIME 
  TEMPERATURE COMPENSATION 
  PRESSURE COMPENSATION 
  DATALOGGING SETTINGS 
  COMMUNICATION SETTINGS   
 

 
 Use the ↑ and ↓ buttons to navigate and position the cursor next to CUSTOM LEVELS.  

Press <Enter> once. 
 

CONCENTRATION 
O3      67.0PPB 
 
CUSTOM O3 LEVELS: 
>LEVEL 1     17.5% 
  LEVEL 2     35.9% 
  LEVEL 3     22.4% 
  LEVEL 4     16.0% 
  LEVEL 5     18.2% 
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 Use the ↑ and ↓ buttons to select different percentages of power to the ozone generator. 
The power is expressed as a percentage. Normal lag time between and adjustment and a 
stable ozone reading is about one minute. Wait for the ozone reading to stabilize. Further 
adjust the power up or down until the ozone concentration stabilizes between 150ppb and 
200ppb. 

 
 Watch the Continuous Average Report on the datalogger for several minutes. When five 

or more 1-minute updates indicate a stable response, record the last 1-minute updates for 
O3 and O3CAL on the checklist. 

 
8.  Adjust the O3 analyzer CUSTOM LEVEL 3 downward to generate a concentration 

between 50ppb and 80ppb. Record the results from the Continuous Average 
Reports after the event has stabilized. 

 
 Use the ↑ and ↓ buttons to decrease the power to the ozone generator. The power is 

expressed as a percentage. Normal lag time between and adjustment and a stable ozone 
reading is about one minute. Wait for the ozone reading to stabilize. Further adjust the 
power up or down until the ozone concentration stabilizes between 50ppb and 80ppb. 

 
 Watch the Continuous Average Report on the datalogger for several minutes. When five 

or more 1-minute updates indicate a stable response, record the last 1-minute updates for 
O3 and O3CAL on the checklist. 

 
 The multipoint is complete. 
 
9. Press the RUN button on the O3 analyzer to return to the RUN screen. Abort the 

DIAGSPAN on the datalogger. 
 
 Press the RUN button once on the O3 analyzer. This returns the analyzer to the Run 

screen and resets LEVEL2 to the previous set point percentage for normal spans. 
 
 Abort to DIAGSPAN and return the analyzer to ambient sampling by pressing <Esc> on 

the datalogger keyboard several times, to return to the Home Menu. From the ESC 
datalogger Home Menu, press <C> for Configuration Menu. 

 
ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 
 

 
 Press <A> for Abort a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSPAN.  The 

DIAGSPAN ceases immediately. 
 
10. Review the results. Call the Operation Support Center to discuss the multipoint 

results. 
 
 Select View Results on the checklist. 
  
 The multipoint calibration summary, displays the zero and three upscale point results, an 

X-Y plot of the results, the linear regression results and a pass/fail indicator. Call the 
Operation Support Center to discuss the results of the multipoint check. 
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1.0 PURPOSE AND APPLICABILITY 
 

This standard operating procedure (SOP) is a guide to calibration of mass flowmeters and 
controllers. The mass flowmeters/controllers are most commonly associated with gas dilution 
calibrators. Accurate calibration of mass flowmeters/controllers is essential for the correct 
determination of designated gas concentrations. 

 
Mass flowmeters/controllers may be located in portable “reference” gas dilution systems, 

within on-site calibrators, or independent systems. This SOP is not manufacturer-specific, and 
will apply to any common mass flowmeter/controller. Mass flowmeters/controllers must be 
calibrated quarterly. 
 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Establish the calibration reporting protocol to satisfy client requirements. 
 

• Review calibration results. 
 

• Identify inconsistencies in calibration results and initiate corrective action as required. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations as described in this SOP. 
 

• Verify that the calibration standards are in good working order and are in current 
calibration. 

 
• Document all calibration results and maintenance procedures performed. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 The following equipment may be required for mass flowmeter/controller calibration: 
 

• Primary flow standard: 
-  Bubble tube flowmeter (Hastings HBM-1), or  
-  Mini-Buck calibrator Model M-5, or 
-  BIOS International DC-2 DryCal calibrator, or 
-  BIOS International DryCal DC-Lite and DryCal Nexus NS DC-Lite accessory module, or  
 

• Calibrated mass flowmeter transfer standard 
 
• Zero air supply 
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• Thermometer 
 
• Stop watch 
 
• Laboratory barometer 
 
• Vapor pressure of water chart 
 
• Mass flowmeter/controller calibration forms 
 
• Calculator capable of linear regression analysis 
 
• Laptop computer loaded with Excel spreadsheet (NPS.XLT) and CALCU program 

software 
 
• Manufacturer’s instrument manual 
 
• Pen or pencil 
 
• Field service tools 
 
• Station log book 

 
4.0 METHODS 
 
 Calibration tasks are detailed in the following four (4) subsections: 
 
 4.1  Preparation for Calibration 
 4.2  Calibration Checks 
 4.3  Post-Maintenance Calibration Checks 
 4.4  Documentation 
 
4.1 PREPARATION FOR CALIBRATION 
 
 Before performing a calibration check, ensure adequate preparation of the operation 
environment by determining the following: 
 

• Calibration documentation is current, complete, and available. 
 

• All required support tools, diagnostic equipment, supplies, and calibration forms are 
available. 

 
4.2 CALIBRATION CHECKS 
 
 Mass flowmeters/controllers may be calibrated with either a primary flow standard 
(Hastings HBM-1, mini-Buck M-5, BIOS International DryCal DC-2, or BIOS International 
DryCal Lite) or by comparison to a transfer standard (calibrated mass flowmeter/controller). The 
use of each device requires slightly different techniques. All results will be corrected to standard 
temperature and pressure (298 °K and 760 mmHg). 
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ANNOTATE DATA 
RECORDS 

Make an entry in the station log book and annotate the strip chart 
recorder and data acquisition system (DAS) indicating the date 
and time (beginning and ending) of the calibration procedure.   
 

 If a mass flow controller is calibrated with its controlling set point set to maximum flow, 
the controller will operate precisely like a mass flowmeter. Therefore, the following text will 
refer only to mass flowmeters, but will apply directly to the calibration of a mass flow controller 
with its set point at maximum flow. 
 
4.2.1 Calibration by Hastings HBM-1 Bubble Tube Set 
 
 This flow calibration device requires the use of a stop watch to calculate the rate of air 
flow through the bubble tube.  The procedures are: 
 
DETERMINE 
CORRECTION FACTOR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Determine the factor for correcting flows to standard temperature 
and pressure by: 
 
• Measuring and recording the ambient temperature in °C. 
 
• Measuring and recording the uncorrected barometric pressure 

(station pressure). 
 
• Determining the vapor pressure of water by using Table 4-1. 
 

Table 4-1 
 

Vapor Pressure of Water Over a 
Common Range of Temperature 

 

Degrees C Degrees K mmHg 

15 288 13 

16 289 14 

17 290 15 

18 291 16 

19 292 17 

20 293 18 

21 294 19 

22 295 20 

23 296 21 

24 297 22 

25 298 24 

26 299 25 

27 300 27 

28 301 28 

29 302 30 

30 303 32 

31 304 34 

32 
 

305 36 

Source:  Handbook of Chemistry and Physics,  68th 
Edition, 1987-88, p. D-189. 
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DETERMINE 
CORRECTION FACTOR 
(continued) 

• Completing the formula: 
 
 
 
 
 where: 
 
 CF = correction factor 
 Pamb = uncorrected barometric pressure in mmHg 
 PH2O = vapor pressure of water in mmHg 
 Pstd = standard pressure of 760 mmHg 
 Tstd = standard temperature of 298°K 
 Tamb = ambient temperature in °K (°C + 273) 
 

RECORD CORRECTION 
FACTOR 

Record the correction factor on the flowmeter calibration by 
bubble tube calibration form (Figure 4-1). 
 

ESTABLISH AIR FLOW Establish a steady air flow through the mass flowmeter with a 
zero air supply and into the bubble tube. 
 

INITIATE BUBBLE Initiate a soap bubble, and time its travel between the graduated 
lines on the bubble tube with a stop watch. 
 

RECORD TIME Record the time in minutes (decimal representation), the volume 
of the bubble tube (in cc’s), and the mass flowmeter digital value 
on the flowmeter calibration by bubble form. 
 

REPEAT Repeat each point three times and average the results. 
 

ADJUST AIR FLOW Adjust the air flow for at least five different points equally 
spaced throughout the range of the flowmeter and repeat  the 
above three steps, beginning with initiating a bubble. 
 

CALCULATE FLOW RATE Calculate the flow rate by: 
 
• Dividing the ∆ volume by the time in minutes to determine 

Qamb (flow rate at ambient conditions). 
 
• Multiplying Qamb by CF to determine Qstp (flow rate in 

cc/min corrected to 298°K and 760 mmHg). 
 
• Repeat for each flow point. 
 

DETERMINE 
CORRELATION 

Determine the slope, intercept, and correlation factor for Qstp 
versus the mass flowmeter digital value. Accept no calibration 
with a correlation of less than .999. 

 

Tamb

Tstd

Pstd

OPHPamb
CF ×

−
=

2  
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Figure 4-1.  Example Mass Flowmeter Calibration by Bubble Tube Calibration Form. 
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RECORD VALUES Record the slope and intercept as: 

 
InterceptSlopeQstpDisplayFlowmeterMass +×= )(  

 
SlopeInterceptDisplayFlowmeterMassQstp /)( −=  

 
4.2.2 Calibration by Mini-Buck Calibrator (Model M-5) 
 
 This calibration procedure does not require the use of a stop watch because Qamb (flow 
rate at ambient conditions) is calculated by the device. The procedures are: 
 
DETERMINE 
CORRECTION FACTOR 

Determine the correction factor as in Section 4.2.1, and record n 
the flowmeter calibration by mini-Buck calibrator calibration 
form (Figure 4-2). 
 

ESTABLISH AIR FLOW Establish a steady air flow through the mass flowmeter with a 
zero air supply and into the mini-Buck calibrator. 
 

INITIATE BUBBLE Initiate a bubble and record the mini-Buck calibrator output and 
the mass flowmeter digital value on the calibration form. 
 

REPEAT Repeat each point three times and average Qamb. 
 

ADJUST AIR FLOW Adjust the air flow for at least five different points equally 
spaced throughout the range of the flowmeter and repeat the 
above two steps beginning with initiating a bubble. 
 

CALCULATE Calculate Qstp as in Section 4.2.1, “Calculate Flow Rate,” 
“Determine Correlation,” and “Record Values.” 
 

4.2.3 Calibration by Transfer Standard (Calibrated Mass Flow Controller) 
 
 The procedures to calibrate a mass flowmeter/controller using a transfer standard are: 
 
ESTABLISH AIR FLOW Establish a steady air flow through the mass flowmeter with a 

zero air supply and into the transfer standard. 
 

DETERMINE FLOW RATE Determine and  record Qstp from the  transfer standard linear 
regression and record the mass flowmeter digital display. 
 

ADJUST AIR FLOW Adjust the air flow for at least five different points equally 
spaced throughout the range of the flowmeter and repeat the 
above step. 
 

COMPLETE FORM Complete the calibration by transfer standard calibration form 
(Figure 4-3) by following Section 4.2.1, steps “Determine 
Correlation” and “Record Values.”  
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Figure 4-2.  Example Mass Flowmeter Calibration by Mini-Buck Calibrator Calibration Form. 
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Figure 4-3.  Example Mass Flowmeter Calibration by Transfer Standard Calibration Form. 
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4.2.4 Calibration by BIOS International DryCal DC-2 
 
 This calibration procedure utilizes the internal temperature and pressure sensors inside 
the DC-2 calibrator to calculate standard flow rates. The procedures are: 
 
SELECT FLOW CELL Select the appropriate flow cell and install upon the DC-2 base. 

 
ESTABLISH AIR FLOW Establish a steady air flow through the mass flowmeter and into 

the DC-2 calibrator. 
 

INITIATE SAMPLES Turn the DC-2 on, select RUN, and push ENTER.  Push 
BURST to initiate 10 flow rate samples.  Record the resulting 
standard flow rate average (“SAvg”) on the calibration by BIOS 
International calibrator calibration form (Figure 4-4). 

ADJUST AIR FLOW Adjust the air flow for at least five different points equally 
spaced throughout the range of the flowmeter and repeat the 
above two steps. 

 
4.2.5 Calibration by BIOS International DryCal DC-Lite and DryCal Nexus NS DC-Lite 

Accessory Module 
 
 The DryCal DC-Lite is a similar instrument as the DryCal DC-2, however, it only 
measures and displays volumetric (actual) flows. The DryCal Nexus is required to convert 
volumetric flow rates to standard conditions. These components must be connected and turned 
on in a specific sequence, or they may not operate. To calibrate: 
 
MAKE CONNECTIONS 
 
 
 
 
 
 
 
 

Connect the DryCal DC-Lite flowmeter to the DryCal Nexus as 
described below and illustrated in Figure 4-5. 
 
Using the supplied DB25 cable, connect the DryCal DC-Lite to 
the DryCal Nexus connector labeled “DryCal.” Using the 
appropriate tubing, connect the output of the flowmeter to be 
calibrated to the DryCal Nexus (either side), then connect the 
DryCal Nexus to the inlet port of the DryCal DC-Lite. 
 

TURN ON Turn on the combination using the ON button of the DryCal 
DC-Lite. The display on the DC-Lite should indicate “:Nexus 
Control”. Press the READ button on the Nexus to initiate flow 
measurements. 
 

ESTABLISH AIR FLOW Establish a steady air flow through the mass flowmeter and into 
the DC-Lite calibrator. 
 

INITIATE AUTO  MODE Hold the READ button down during a measurement to initiate 
AUTO mode. In Auto Mode, 10 measurements will be averaged 
and displayed. Record the results on Figure 4-4. 
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ADJUST AIR FLOW Adjust the air flow for at least five different points equally 

spaced throughout the range of the flowmeter and repeat the 
above two steps. 
 

TURN OFF The DryCal DC-Lite has no OFF button. It powers down in 5 
minutes of no action or 60 minutes when connected to the Nexus 
control unit. 

 

 
Figure 4-4.  Example Mass Flowmeter Calibration by BIOS International Calibrator 

        Calibration Form. 
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Figure 4-5.  DryCal DC-Lite and Nexus Connection Diagram. 
 
4.3 POST-MAINTENANCE CALIBRATION CHECKS 
 
 After completing any adjustment or maintenance, initiate a post-maintenance calibration 
check as described in Section 4.2. 
 
4.4 DOCUMENTATION 
 
 Mass flowmeter/controller calibrations require several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely. Where possible, use the Excel 
spreadsheet so that both a hard copy and digital record of the 
calibration are maintained. Review and sign all calibration 
forms. 
 

LOG NOTES An entry is made in the station log book to document the 
calibration. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the mass flowmeter or 
controller, marking the date the instrument was certified and the  
name of the technician who calibrated it. 
 
 
 
 
 
 

Figure 4-6.  ARS Calibration Sticker. 
 

 

ON 

NEXUS CONTROL 

DryCal 
DC-Lite 

INLET 
 
 
OUTLET READ 

DryCal 
 
NEXUS 

DryCal Connector 

From unit  
under test  
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TRIP REPORT Complete all summary documentation, attach to the calibration 

form or printed record, and submit with the site trip report. 
 

5.0 DEFINITIONS 
 

Correction Factor (CF):  A value used to convert Qamb to Qstp. 
 

Mass Flowmeter:  A flow measuring device that determines flow rate by means of 
measuring the mass (molecular weight0 of a gas flowing past a point. The mass 
flowmeter’s measured output is self-correcting for changing temperature and pressure. 

 
Mass Flow Controller:  A mass flowmeter that incorporates a metering valve to control the 
flow of gas. 

 
Qstp:  A flow rate referenced to standard conditions of 298°K and 760 mmHg. 

 
Qamb:  A flow rate referenced to ambient temperature and pressure. 

 
Transfer Standard:  A mass flowmeter that is under current calibration. 
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1.0 PURPOSE AND APPLICABILITY 
 
 This technical instruction (TI) describes the steps for maintaining sampling equipment, 
verifying flow rate, and adjusting the flow rate of instrumentation operated for the Clean Air 
Status and Trends Network (CASTNet). It is referenced from SOP 3180, Calibration of Mass 
Flowmeters and Mass Flow Controllers. The primary purpose of performing routine instrument 
servicing checks is to assure quality data capture and minimize data loss. The U.S. 
Environmental Protection Agency (EPA) CASTNet program directs for twice-annual flow 
calibrations of the filter pack monitoring system. 
 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 

The project manager shall: 
 
• Establish the project-specific calibration schedule and coordinate with the client as 

necessary. 
• Establish the calibration reporting protocol to satisfy client requirements. 
• Review calibration results. 
• Identify inconsistencies in calibration results and initiate corrective action as required. 

 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Perform required calibrations and maintenance as described in this TI. 
• Verify that the calibration standards are in good working order and are in current 

calibration. 
• Document all calibration results and maintenance procedures performed. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Equipment and materials required for  calibration include: 
 

• An authoritative flow standard (BIOS Definer 220 or equivalent) 
• A quick-disconnect interface connector for pot-head 
• A pump rebuild kit 
• Electronic flow check and flow calibration forms  
• Keys for the monitoring shelter or support system internal lock and padlocks 
• A copy of this TI 
• A complete field tool kit 
• Latex or similar-type gloves 
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4.0 METHODS 
 

The procedures described in this TI are specific to CASTNet filter pack systems. This 
section includes three major subsections: 
 
 4.1 System Calibration 

4.2 System Maintenance 
 4.3 Documentation 
 
4.1 SYSTEM CALIBRATION 
 
PREPARE FOR 
CALIBRATION 
AND DOCUMENT 
EXISTING 
CONDITIONS 

Mark the flow channel off-line and wear clean gloves when handling 
the filter packs. 
 
Enter the identifying information on the electronic CASTNet Flow 
Check Form (see Figure 4-1), and record the data acquisition system 
(DAS) flow, mass flow controller (MFC) readout value, and rotameter 
value. 
 

ANNOTATE DATA 
RECORDS 

Without adjusting any components of the flow system, record the DAS 
flow value and MFC flow display value. Turn off the flow pump and 
record the local time and the time displayed on the elapsed time meter 
on the Flow Check Form.  
 

REMOVE FILTER 
AND PERFORM 
LEAK CHECK 

Lower the flow tower, remove the filter pack (using clean gloves), and 
store the filter pack in a clean, plastic bag. 
 
Removal of the filter will cause the quick release fitting to cap (or seal) 
the inlet line. Then: 
 

• Record the Zero Values (pump off) from all displays and the 
rotameter (center of ball) on the check form. 

• Perform a Leak Check by turning pump on, allow the readings 
to stabilize, and record values from all displays on the check 
form. 

 
An unacceptable leak check (a leak is present) is if the difference 
between the measured Zero Value on the MFC display and the Leak 
Check Value is greater than 0.10 slpm. If a leak in the system is 
indicated, maintenance must be performed to find and eliminate the 
leak. 
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Figure 4-1. Example CASTNet Flow Check Form. 

CASTNET FLOW CHECK FORM

Network:  NPS Location:  Big Bend Site:  BIBE-KB Date: 02/01/12 Date of Last Site Visit:  07/06/11

Field Specialist:  Valvur, Martin

High Flow Standard (BIOS) Reference S/N:  120798 Cell #: Calibration Date:  11/09/10

MFC SENSOR IDENTIFICATION

Mfg.

Model #

Serial #

PUMP IDENTIFICATION Standard Temp. and Pressure (STP)

PRE-MAINTENANCE POST MAINTENANCE

Mfg.

Model #

Serial #

FLOW CHECK

ITEM PRE MAINTENANCE POST MAINTENANCE ITEM AS FOUND AS LEFT

Vacuum DAS Full Scale

DAS Flow (Operating) DAS Zero

Flow Target

PRE-MAINTENANCE SENSOR RESPONSE

1.5 SLPM 3.0 SLPM SLPM %

Zero (pump off) 0.000 -0.01 0.00 0.094 0.023 N/A N/A

Leak Test 0.000 0.02 0.00 0.100 0.029 N/A N/A 0.0056 PASS

Point 1 (low) 2.108 2.15 2.18 2.134 1.947 0.75 to 1.00
lpm

2.00 to 2.25
lpm 0.0257 1.2% PASS

Point 2 (target) 2.961 3.04 3.05 2.990 2.755 1.50 lpm 3.00 lpm 0.0294 1.0% PASS

Point 3 (high) 3.868 3.97 4.10 3.888 3.602 2.00 to 2.25
lpm

3.75 to 4.00
lpm 0.0196 0.5% PASS

Max Flow Test 4.001 4.13 4.20 4.035 3.741 2.50 lpm 4.00 lpm 0.0338 0.8% PASS

Calibration Required?

1.2% MFC Zero/Leak Test Diff: 0.03

1.0% Leak Present? NO

0.5%

POST MAINTENANCE SENSOR RESPONSE

1.5 SLPM 3.0 SLPM SLPM %

Zero (pump off) 0.000 -0.01 0.00 0.096 0.025 N/A N/A

Leak Test 0.000 0.02 0.00 0.102 0.031 N/A N/A 0.00534 PASS

Point 1 (low) 2.224 2.25 2.30 2.234 2.042 0.75 to 1.00
lpm

2.00 to 2.25
lpm 0.0102 0.5% PASS

Point 2 (target) 2.983 3.04 3.05 2.990 2.755 1.50 lpm 3.00 lpm 0.007 0.2% PASS

Point 3 (high) 3.881 3.97 4.10 3.887 3.601 2.00 to 2.25
lpm

3.75 to 4.00
lpm 0.006 0.2% PASS

Max Flow Test 4.054 4.15 4.20 4.063 3.767 2.50 lpm 4.00 lpm 0.0086 0.2% PASS

Pre-Maint CASTNet Flow Comments:

Post Maint CASTNet Flow Comments:

*Note:  A leak is present if the difference 
between the zero and leak test value is 
greater than 0.10 lpm

2.96 2.98BIOS SLPM

Point 2 (target)
% Difference NOT REQUIRED

ACTION BIOS (SLPM) MFC Display Rotometer
Flow

Point 3 (high)
% Difference NOT REQUIRED

Point 1 (low)
% Difference NOT REQUIRED

ACTION BIOS (SLPM) MFC Display Rotometer
Flow

*Note:  A calibration is required if the difference between the transfer 
standard and the DAS value is greater than +/- 2.0%
at the target setting or greater than +/- 2.5% at either the low
or high point.

MFC
VOLTS DC

Target Flow PointsDAS Flow
Value 

(SLPM)

PRE-MAINTENANCE POST MAINTENANCE Date

MFC Disp la y  Se t Po intTylan Tylan

FC280SAV-45 Slo p e

Intercept

TEMP (º C)

2.99

Thomas

AW9403018

Rebuilt pump between pre and post flow check.

3.04

5.37

0.07

107CAB18

N/A

3.0

PRESSURE (mmHg)

PASS/FAIL
DAS Flow

Value 
(SLPM)

MFC
VOLTS DC

Target Flow Points Difference

FC280SAV-45

AW9403018

3.04

107CAB18

N/A

Thomas

MFC Flow Value
(Operating)

20" hg

3

1.08748

-0.23501

1.08748

-0.23501

Difference
PASS/FAIL

25 760

5.37

0.07

3.0

PREVIOUS DAS
LINEAR REGRESSION

FLOW CALIBRATION
LINEAR REGRESSION

02/01/12

3.04

07/06/11

3.04
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CHECK AS-FOUND 
FLOW 

Connect the primary standard (BIOS) to the inlet line. Turn on the 
pump and allow all readings to stabilize. 
 
Record the following data on the electronic spreadsheet (record all 
flows in standard temperature and pressure): 
 

• BIOS SAVG flow 
• MFC display flow 
• Datalogger flow and voltage 
• Rotameter flow (center of ball) 

 
Note that the target flowrates are either 1.50 slpm or 3.00 slpm 
depending on the station configuration. 
 
With the BIOS in place, adjust the site MFC to within the following 
flow ranges as indicated on the datalogger display. The max flow point 
tests the pump capacity. 
 
 Point Category For a 1.5 lpm 

Nominal Flow 
For a 3.0 lpm 
Nominal Flow 

 

 1 
2 
3 

Max Flow 

Low 
Nominal 

High 
Max 

0.75 to 1.00 slpm 
            1.50 slpm 
2.00 to 2.25 slpm 
        >2.5 slpm 

2.00 to 2.25 slpm 
            3.00 slpm 
3.75 to 4.00 slpm 

     >4 slpm 

 

 
At each point, record the data on the Flow Check Form. 

 
EVALUATE 
AS-FOUND 
RESULTS 
 

If the flow as displayed on the datalogger is off by more than ±2.0% 
from the BIOS standard SAVG flow at the nominal setting, or off by 
more than ±2.5% at either the high or low points, a complete 
calibration is required. The flow check form will indicate if a flow 
calibration is required. 
 

PERFORM AND 
DOCUMENT 
CALIBRATION 

If the flow check determines that a calibration of the flow system is 
required, perform the calibration: 
 

• Complete five flow rates (ranges suggested on the form).  

• The form will calculate new full-scale and zero-scale values for 
the datalogger.  

• Enter and save these values on the datalogger. 
 
Document all findings on the CASTNet Flow Calibration Form (see 
Figure 4-2). 
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Figure 4-2. Example CASTNet Flow Calibration Form. 

CASTNET FLOW CALIBRATION FORM

Network:  NPS Location:  Big Bend Site:  BIBE-KB Date: 02/01/12 Date of Last Site Visit:  07/06/11

Field Specialist:  Valvur, Martin

High Flow Standard (BIOS) Reference S/N:  120798 Cell #: Calibration Date:  11/09/10

MFC SENSOR IDENTIFICATION

Mfg.

Model #

Serial #

PUMP IDENTIFICATION Standard Temp. and Pressure (STP)

PRE-MAINTENANCE POST MAINTENANCE

Mfg.

Model #

Serial #

CASTNET FLOW CALIBRATION RESULTS

Linear Regression

1.5 SLPM 3.0 SLPM Parameter MFC DAS MFC
VOLTS DC

Zero (pump off) 0 lpm 0 lpm Slope

Leak Test 0 lpm 0 lpm Y
Intercept

Point 1 1.00 lpm 2.00 lpm Correlation
Coefficient

Point 2 1.25 lpm 2.50 lpm

Point 3 1.50 lpm 3.00 lpm MFC Set Point Zero/FS Set Point

Point 4 1.75 lpm 3.50 lpm 1.5 slpm 3.0 slpm Zero Full Scale

Point 5 2.00 lpm 4.00 lpm

Pre-Maint CASTNet Flow Comments:

Post Maint CASTNet Flow Comments:

760Thomas

AW9403018 AW9403018

Tylan

Thomas

107CAB18 107CAB18

FC280SAV-45

Tylan

FC280SAV-45

TEMP (º C) PRESSURE (mmHg)

25

BIOS (SLPM) MFC Display
DAS Flow

Value 
(SLPM)

N/A N/A

ACTION
Target Flow Points

MFC
VOLTS DC

PRE-MAINTENANCE POST MAINTENANCE

0.000

0.500

1.000

0.000 0.500 1.000

M
FC

 V
ol

ts
 D

C

BIOS SLPM
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4.2 SYSTEM MAINTENANCE 
 
SYSTEM 
MAINTENANCE  

Scheduled system maintenance includes: 
• Each station visit 

- Check the condition of the tubing to the inlet filter. Replace if 
interior damage or contamination exists. 

- Check that all quick releases function properly. 
• Twice each year 

- Change or rebuild the flow pump. 
• Annually 

- Replace the Balston filter on the pump. 
- Replace the rotameter (the first visit of each year). 

 
RECALIBRATE 
SYSTEM 
 

If, after performing initial calibration, the calibration form indicates the 
system must be re-calibrated, proceed to the Flow Calibration form and 
document all findings on the form. 
 

POST-
MAINTENANCE 
CHECKS 

Return to the original Flow Calibration Form and complete the post-
maintenance checks on the bottom of the form. 
 
Review the results, and if satisfactory, the calibration is complete. 
 
Replace the filter pack, set the proper flow rate, raise the flow tower, 
and bring the datalogger channel back on-line. 

 
4.3 DOCUMENTATION 
 

Flow calibrations require the following levels of documentation: 
 
CALIBRATION 
FORMS 
 

Calibration forms or the computer laptop Excel spreadsheet should be 
completed. Where possible, use the Excel spreadsheet so that both a 
hard copy and digital record of the calibration are maintained. Review 
and sign all flow check and flow calibration forms. 
 

CALIBRATION 
STICKER 

An ARS calibration sticker (see Figure 4-3) is placed on the analyzer, 
marking the date the instrument was certified and the name of the 
technician that calibrated it. 
 
 
 
 
 

Figure 4-3. Example ARS Calibration Sticker. 
 

TRIP REPORT The calibration is thoroughly documented in a written site trip report.  
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1.0 PURPOSE AND APPLICABILITY 
 
 This standard operating procedure (SOP) serves as a guide for transferring the certificate 
of authority from a verified ozone UV photometer (primary standard) or certified ozone transfer 
standard to a candidate ozone transfer standard. This SOP also serves as a guide to re-certify a 
previously certified ozone transfer standard. This procedure is for photometer-based ozone 
analyzers only, not stand-alone ozone generating sources. 
 
 Because ozone (O3) cannot be reliably stored, O3 concentrations for analyzer calibration 
purposes must be generated and carefully assayed on-site. Transfer standards are used to assay 
generated O3 concentrations used for calibrations. 
 
 Ozone transfer standards are required to be certified or re-certified under any of the 
following circumstances: 
 

• Upon acceptance testing of a new instrument 
 

• After any corrective action, service, or maintenance to any portion of the instrument 
that affects its operational principle 

 
• Once per calendar quarter 

 
 All standards will be traceable to the National Institute of Standards and Technology 
(NIST). Transfer standards will be maintained according to Transfer Standards for the 
Calibration of Ambient Air Monitoring Analyzers for Ozone (EPA-600/4-79-056). 
 
2.0 RESPONSIBILITIES 
 
2.1 PROJECT MANAGER 
 
 The project manager shall: 
 

• Oversee and ensure certification is performed according to the required schedule. 
 

• Review certification results. 
 

• Review and approve any changes to certification procedures. 
 

• Identify inconsistencies in certification results and initiate corrective action. 
 
2.2 LABORATORY TECHNICIAN 
 
 The laboratory technician shall: 
 

• Perform required certifications as described in this SOP and manufacturer’s 
instrument manuals. 

 
• Document all certification results and procedures performed. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Certifications should be conducted in a properly equipped laboratory where external, 
potentially influencing variables can be minimized. Required equipment includes: 
 

• A UV photometer (primary standard) under current verification 
 
 or 

 
• An ozone transfer standard under current certification 

 
• Strip chart recorder 

 
• Digital voltmeter (4-1/2 digit) 

 
• A candidate ozone transfer standard 

 
• Pen or pencil 

 
• Instrument-specific manufacturer’s manual 

 
• Ozone Transfer Standard Certification Worksheets 

 
• Laptop computer loaded with Excel spreadsheet form (O3cert.xls) and CALCU 

program software 
 

• ARS calibration stickers 
 
4.0 METHODS 
 
 Certification of candidate ozone transfer standards requires a six-point calibration check 
performed on six different days (six-by-six calibration). The days need not be consecutive.  
Success of the certification process is determined by statistical analysis of the calibration check 
results. Ozone transfer standard certifications are valid for 90 days and require re-certification 
quarterly. 
 
 Re-certification involves one six-point calibration check. Data from the most recent six-
point calibration checks are subjected to analysis to determine the success of the re-certification. 
A moving (rolling) average of results is calculated and maintained each quarter. Should an ozone 
transfer standard fail re-certification, or should its certification lapse, the entire certification 
process must be repeated, starting with a new six-by-six calibration check procedure. 
 
 This section is presented in the following four (4) major subsections: 
 
 4.1  Preparation for Ozone Transfer Standard Certification 
 4.2  Certification (six-by-six) of an Ozone Transfer Standard 
 4.3  Re-certification of an Ozone Transfer Standard 
 4.4  Documentation 
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4.1 PREPARATION FOR OZONE TRANSFER STANDARD CERTIFICATION 
 
 Transfer standard certifications are critical, lengthy (six day) operations that require 
careful attention to detail and record keeping. Certification should be performed in a properly 
equipped laboratory where external variables can be kept to a minimum. Personnel performing 
the certifications need to be experienced technicians familiar with the operation of UV 
photometric-based ozone analyzers. 
 
 Preparation for transfer standard certification involves the following procedures: 
 
CONFIGURE 
STANDARDS 

Configure the primary (or certified transfer) standard and 
candidate transfer standard(s) for operation. 
 

CONFIGURE TEFLON 
TUBING 

Configure clean Teflon tubing so the candidate transfer standard 
is assaying ozone concentrations generated from the primary (or 
certified transfer) standard. Be certain flows generated by the 
primary (or certified transfer) standard satisfy the demands of the 
photometers. 
 

CONNECT STRIP CHART 
RECORDER 

Connect a strip chart recorder to the candidate transfer standard 
to document the standard’s response. 
 

WARM UP 
INSTRUMENTS 
 

Warm up the instruments for an adequate amount of time. 
 

VERIFY 
DOCUMENTATION 

Confirm that calibration documentation is current, complete, and 
available. 

 
4.2 CERTIFICATION (SIX-BY-SIX) OF AN OZONE TRANSFER STANDARD 
 
 The following procedures detail the necessary steps to complete the six-by-six 
certification process. Re-certification procedures are identical to certification, but just one 
calibration check is required rather than six. The procedures assume that an ozone primary 
standard (UV photometer) is being used to transfer authority to a candidate transfer standard.  
The procedures are identical if a certified transfer standard is used in place of the ozone primary 
standard. An example Ozone Transfer Standard Certification Worksheet, used to record daily 
six-point checks, is presented as Figure 4-1. 
 
4.2.1 Introduce Known Ozone Concentrations and Record Instrument Responses 
 
RECORD PARAMETERS Check all instrument-specific operational parameters for 

operation and record parameter values on a Ozone Transfer 
Standard Certification Worksheet. 
 

INTRODUCE ZERO AIR Direct a flow of zero air into the candidate transfer standard(s) 
and allow the value to stabilize (as indicated by the strip chart 
recording). Record the response on the calibration form. This 
point represents the zero response, the first of the six levels of 
known ozone concentration. 
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Figure 4-1.  Example Ozone Transfer Standard Certification Worksheet. 
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GENERATE OZONE Consecutively generate the following concentrations of ozone 

from the primary standard and direct the flow into the candidate 
transfer standard. Allow sufficient time for each point to 
stabilize (as indicated by the strip chart recording). 
Concentrations to be generated include: 
 
  0.400 to 0.450 ppm 
  0.300 to 0.350 ppm 
  0.200 to 0.250 ppm 
  0.100 to 0.150 ppm 
  0.050 to 0.100 ppm 
 

RECORD VALUES As each point stabilizes, note and average five consecutive 
updates of both the primary standard and candidate transfer 
standard(s). Record the primary standard value on the calibration 
form as the primary ozone concentration and the candidate 
transfer standard as the transfer response.  
 

REPEAT Repeat the above procedures once a day for a total of six days. 
 

4.2.2 Compile Certification Data 
 
 At the end of six days, information from each of the daily calibrations are compiled. 
 
COMPLETE WORKSHEET Complete the Ozone Transfer Standard Certification Worksheet. 

The worksheet calculates the following: 
 
• Calculates the slope and intercept. 
 
• Sums the slopes and intercepts and calculates the average. 
 
• Calculates the standard deviation of the slopes and intercepts. 
 
• Determines if the certification process was successful by 

comparing the results of the worksheet against the stated 
limits. 

 
 Slope must be between 0.95 and 1.05. 
 Intercept must be ≤ 3.0. 
 Standard deviation of slope must be ≤ 3.7% 
 Standard deviation of intercept must be ≤ 1.5. 
 

TROUBLESHOOT If certification is unsuccessful, troubleshoot the instrument, 
implement corrective action, and repeat the certification process. 
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4.3 RE-CERTIFICATION OF AN OZONE TRANSFER STANDARD 
 
 Re-certification of an ozone transfer standard requires only a single (one day) six-point 
check each quarter. All other re-certification procedures are identical to the certification 
procedures presented in Section 4.2. 
 
 Re-certification documentation procedures require using the most recent six calibration 
checks to determine certification success. Complete the Ozone Transfer Standard Certification 
Worksheet with the most recent calibration check first, followed by the five most recent 
calibration checks. 
 
 If the transfer standard does not pass the re-certification tests, the standard should be 
evaluated and serviced. At any time that a transfer standard fails the re-certification process, a 
new, complete six-by-six certification procedure must be initiated. 
 
4.4 DOCUMENTATION 
 
 Transfer standard certification requires several levels of documentation: 
 
CALIBRATION FORMS Calibration forms or the computer laptop Excel spreadsheet 

should be completed entirely for each of the initial six days and 
any re-certifications. Where possible, use the Excel spreadsheet 
so that both a hard copy and digital record of the calibration are 
maintained. Review and sign all calibration forms. 
 

STRIP CHARTS Strip chart records should be annotated to clearly document 
standard response. 
 

LOG NOTES A copy of all log notes summarizing work performed and results 
of the certification. Note any abnormalities in standard 
operation. 
 

CALIBRATION STICKER An ARS calibration sticker is placed on the standard, marking 
the date the instrument was certified and the name of the 
technician who calibrated it. 
 
 
 
 
 
 
 
 

Figure 4-2.  ARS Calibration Sticker. 
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5.0 DEFINITIONS 
 

CALIBRATOR - A device capable of generating concentrations of a pollutant (ozone).  
Calibrators may or may not be able to assay the concentration of pollutants produced. 

 
CERTIFICATION - The procedure and methodology of transferring the authority of 
measurement from one device to another. In ozone monitoring, this procedure is 
commonly known as a “six-by-six” calibration referring to subjecting a candidate transfer 
standard to a six-point calibration check on six different days. 

 
OZONE TRANSFER STANDARD - A device capable of accurately assaying 
concentrations of ozone. Ozone transfer standards are typically ozone analyzers that have 
been dedicated in their usage as transfer standards. Referring to a transfer standard implies 
that the device has already been “certified.” Without certification, the device would have 
status of “calibrator.” 

 
PRIMARY STANDARD - a device that due to its mechanical configuration, is inherently 
accurate and requires no periodic calibration. It is an authority unto itself. Primary 
standards, however, do require “verification.” Ozone primary standards must be UV 
photometer-based ozone analyzers that require no convertors, scrubbers, or consumable 
reagents. They have no provision for an electronic or mechanical adjustment of their 
measured output. An ozone primary standard is often referred to as a “UV photometer.” 

 
RE-CERTIFICATION - A single six-point calibration check of a previously-certified 
ozone transfer standard. Ozone transfer standards are required to be re-certified quarterly 
in order to maintain authority. 

 
VERIFICATION - A six-point calibration check of a candidate ozone primary standard 
by an ozone primary standard. This verification takes only one day, and is required on a 
yearly basis. 

 
6.0 REFERENCES 
 
Environmental Protection Agency (EPA), September 1979, Transfer Standards for the 

Calibration of Ambient Air Monitoring Analyzers for Ozone, Technical Assistance 
Document.  (EPA-600/4-79-056). 
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1.0 PURPOSE AND APPLICABILITY 
 
 The Gaseous Pollutant Monitoring Program (GPMP) is a major component of the 
National Park Service (NPS) air quality program and is coordinated by the NPS Air Resources 
Division (ARD). Network sites have traditionally monitored a combination of gaseous 
pollutants, particulates, and meteorological parameters. Dry deposition monitoring systems, 
operated under Clean Air Status and Trends Network (CASTNet) protocol, are located at most 
sites. Data collected from the network consist of over 95 million hourly averages collected from 
over 150 network sites. The Information Management Center (IMC) manages this data 
warehouse and current network data handling including data collection, validation,  reporting, 
and archive. This document provides an overview of the IMC configuration and concepts. Other 
documents including standard operating procedures (SOPs), technical instructions (TIs), and 
technical references provide details of each function of the IMC. Table 1-1 is a list of current 
documents in this set. 

 
Table 1-1 

 
IMC-Related Standard Operating Procedures (SOP), 

Technical Instructions (TI), and Reference Documents (REF) 
 

Type Number Title 

SOP 3340 Information Management Center (IMC) Concept and Configuration 
 

SOP 3345 Day to Day Network Operations Technical Support for the National Park Service Gaseous and 
Meteorological Monitoring Program 
 

SOP 3350 Collection of Ambient Air Quality and Meteorological Monitoring Data 
 

TI 3350-4000 Collection of Ambient Air Quality and Meteorological Monitoring Data via Telephone Modem 
 

TI 3350-4005 Collection of DataView Files via Telephone Modem 
 

SOP 3450 Ambient Air Quality and Meteorological Monitoring Data Validation 
 

TI 3450-5000 Ambient Air Quality and Meteorological Monitoring Data - Level 0 Validation 
 

TI 3450-5010 Ambient Air Quality and Meteorological Monitoring Data - Preliminary Validation 
 

TI 3450-5020 Ambient Air Quality and Meteorological Monitoring Data - Final Validation 
 

SOP 3550 Ambient Air Quality and Meteorological Monitoring Data Reporting 
 

TI 3550-5000 Ambient Air Quality and Meteorological Monitoring Data Monthly Reporting 
 

TI 3550-5100 Ambient Air Quality and Meteorological Monitoring Data Annual Reporting 
 

TI 3550-5200 Handling Requests for Ambient Air Quality and Meteorological Monitoring Data 
 

TI 3550-5300 Submitting Ambient Air Quality and Meteorological Monitoring Data to the EPA AQS Database 
 

SOP 3650 Maintenance Responsibilities for the Ambient Air Quality Data Base Management System (AQDBMS) 
 

REF ARS Air Quality Data Base Management System (AQDBMS) User’s Guide 
 

REF ARS Air Quality Data Base Management System (AQDBMS) Database Manager/Programmer’s Guide 
 

REF ARS STKWIN User Documentation 
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2.0 RESPONSIBILITIES 
 
 IMC technical staff ensure successful operation of the IMC and provide timely network 
data management that meets NPS performance requirements. This section lists the 
responsibilities of the IMC staff positions.  Figure 2-1 is an organizational chart of IMC staff.    
 

 
 

Figure 2-1.  IMC Staff Organization. 
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2.1 NPS ARD STAFF 
 
 NPS ARD staff shall: 
 

• Participate in monthly data and operational reviews with ARS personnel. 

• Review and comment on all data reports. 

• Evaluate and approve data requests. 

• Provide guidance and direction in all aspects of data handling and quality assurance. 

• Consult with IMC and field operations staff to resolve data related problems or questions. 
 

2.2 PROGRAM MANAGER 
 
 The program manger has the overall responsibility, accountability, and authority for the 
IMC.  The program manager shall: 
 

• Oversee that all project objectives are met on schedule, including data collection, 
validation, reporting, archive, and other products and technical requirements. 

• Assign duties to the information management section manager and IMC technical 
staff, and review the section manager’s performance. 

• Coordinate and review all quality assurance/quality control aspects of the program. 

• Participate in monthly data and operational reviews with the contracting officer’s 
technical representative (COTR), NPS ARD personnel, and ARS personnel. 

 

2.3 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager oversees the IMC and verifies that 
day-to-day tasks are completed to ensure timely, quality data collection, validation, reporting, 
and archiving.  The section manager shall: 
 

• Assign duties to the IMC data analysts and review the data analysts’ performance. 

• Coordinate the overall information management effort to ensure that all components of 
the IMC are fully functional. 

• Assign the database manager, programmers, or computer systems support staff to meet 
the needs of the IMC. This includes system hardware, software, and communications 
components. 

• Participate in and/or direct overall IMC planning and procedures formulation and 
documentation including SOPs and TIs. 

• Participate in monthly data and operational reviews with the program manager, IMC 
staff, and other project participants as appropriate.  

• Participate in monthly CASTNet conference calls. 
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• Oversee all aspects of the data validation process and perform a final data review each month. 

• Summarize IMC-related progress and forward items to the technical assistant for 
inclusion in project progress reports. 

 
2.4 IMC DATA ANALYSTS 
 
 The team of data analysts perform the following tasks to collect, validate, report, and 
archive all network data: 
 

• Ensure that the workstation used for automatic data collection is properly configured. 

• Review the status of automatic data collection each morning (including reviewing 
daily error and diagnostic printouts). 

• Inform the network operations staff of any observed, site-related data or 
communications inconsistencies. 

• Review collected data files. 

• Compile and document site specifications and configurations 

• Blank-fill missing data as necessary. 

• Review all trip report field documentation and maintain the master field 
documentation forms. 

• Collect, review, and log DataView and manual site documentation. 

• Document issues and review Electronic Status Board entries and inform field 
operations staff of noted inconsistencies. 

• Validate all data according to established protocols. 

• Review and annotate stackplots. 

• Cross-check annotated stackplots prepared by fellow data analysts. 

• Review annotated stackplots with the field specialist. 

• Enter validation codes in the AQDBMS based on stackplot annotations. 

• Update the Data Validation Log in the AQDBMS. 

• Hand enter or enter reduced data from other sources (strip charts, printouts, or digital 
data) as required. 

• Update information in the AQDBMS site configuration tables and stackplot 
configuration files. 

• Post a combination of validated plots and raw, annotated stackplots for the plot reviews. 

• Prepare national gaseous and meteorological summaries for plot reviews. 

• Participate in weekly program reviews and monthly plot reviews. Respond to 
questions posed during the plot review. 
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• Prepare all data reports. 

• Respond to site operator or COTR comments on data reports. 

• Compile all independent audit information performed by state agencies or other 
entities on GPMP sites. 

• Fulfill all data requests as assigned. 

• Submit all validated data to the EPA AQS database. 

• Submit validated data from CASTNet sites to the EPA CASTNet contractor. 

• Update database files to account for system configuration or site changes. 

• Provide telephone support to site operators to resolve data communications and 
documentation problems. 

• File hardcopy documentation and maintain hard copy site files. 

• Prepare and distribute all hardcopy and digital archives. 

• Create and update IMC-related SOPs and TIs. 

• Manage and archive site photographs and site specification documentation. 
 
2.5 DATABASE MANAGER AND SYSTEMS SUPPORT STAFF 
 
 The database manager is responsible for maintaining the IMC database and supervising 
ongoing development and maintenance of database applications by the systems support staff.  In 
addition to the database manager, the systems support staff includes applications programmers, 
data communications specialists, and network administrators.  The systems support staff shall: 
 

• Design, develop, implement, test, and maintain database, data acquisition, data 
communications, site documentation (DataView), trip report forms, and applications 
software to meet evolving program needs. 

• Ensure that all software licenses and updates are current. 

• Perform database system maintenance as required. 

• Train all ARS personnel on the use of database applications. 

• Produce database archive and export records to ensure that contingency plans can be 
carried out if required. 

• Coordinate with cooperating agencies such as states and with special study 
participants to regularly retrieve and process data files as appropriate. 

• Research new and enhanced database and applications systems. 

• Maintain and upgrade project and request Web site hardware configurations and software. 
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2.6 FIELD SPECIALISTS 
 
 The field specialists shall: 
 

• Document field operations problems in the Site Status Log. 

• Inform IMC staff of any changes in site configurations resulting from maintenance visits. 

• Inform IMC staff of any equipment, data acquisition system or DataView malfunction, 
replacements, additions, or inconsistencies. 

• Inform IMC staff of any data acquisition system or DataView program changes. 

• Inform IMC staff of any inconsistencies or needed program changes on trip report 
documentation forms. 

• Review stackplots and troubleshoot inconsistencies observed on the stackplots or 
identified by IMC staff. 

• Provide assistance to the IMC for troubleshooting data collection problems. 

• Provide assistance in troubleshooting on-site instrument problems. 

• Meet weekly with IMC staff to discuss network issues. 

• Review annotated stackplots with IMC staff. 

• Participate in the monthly plot review. 
 
2.7 SITE OPERATORS 
 
 The site operators shall: 
 

• Enter all required site documentation in DataView. 

• Telephone the IMC or field specialist if data collection or calibration problems are 
noted on site. 

• Perform regular site maintenance and troubleshooting as required or directed by the 
field operations staff. 

 
2.8 TECHNICAL ASSISTANT 
 
 The technical assistant shall: 
 

• Enter appropriate information in the Site Status Log. 

• Review and print trip reports, file copies in the IMC, and post .pdf files on the project 
Web Site. 

• Compile and distribute weekly and quarterly progress reports. 

• Assist with IMC correspondence. 
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2.9 QUALITY ASSURANCE MANAGER 
 
 The quality assurance manager shall: 
 

• Coordinate with the IMC section manager and technical personnel for appropriate 
quality assurance document content. 

• Coordinate annually, or as needed, review and updates of IMC-related SOPs and TIs. 

• Review final documents and revisions for completeness and accuracy before approval. 
 

3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Dataloggers at each monitoring site automatically collect and store data from on-site 
instruments. Laptop computers installed at each site are used by the site operators to document 
weekly site calibration and maintenance visits using DataView software. IMC programs retrieve 
datalogger data daily and DataView station logs weekly via telephone or satellite modem and 
create ASCII files on the IMC computer network file server. The data and station logs are 
promptly loaded into an Oracle database, the primary data management tool for the centralized 
IMC. An Oracle database is maintained on a database server that allows multiple connections 
from client workstations. The workstations run commercial and custom software applications 
consisting primarily of MS-Windows object-oriented, graphical user interfaces, and efficient 
programs to validate, report, and archive data. The IMC also contains working files and archives 
of site documentation, hardcopy reports, and IMC-related correspondence. This section describes 
specific computer hardware, software, and other equipment requirements of the IMC. 
 
3.1 MONITORING SITE DATA COLLECTION HARDWARE 
 
 Each monitoring site in the current network must be equipped with sufficient hardware to 
ensure accurate and timely data collection. Typically, the hardware configuration includes a 
datalogger connected to a telephone or satellite modem and a laptop computer with an internal 
modem. The datalogger stores data via analog or serial inputs from multiple gaseous pollutant 
analyzers, meteorological sensors, or other monitoring instrumentation. The laptop computer 
runs DataView software that is used by the operator to document the actions and results of 
weekly site visits. This information is consolidated by DataView into the station log. IMC 
software and modems are used to call the modems at each site, send specific commands to the 
datalogger and laptop computer, and transfer the data and station log to the IMC. IMC software 
and modems can also download data from other media such as FTP sites, centralized computers, 
e-mail files, or other services. Monitoring site hardware currently used in the network is 
presented in Table 3-1. 
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Table 3-1 
 

Current IMC Computer Hardware Configuration 
 
Monitoring Site Data Collection Hardware 

Communications Settings Number of Inputs 
Component Manufacturer  Model 

Serial (Baud Rate) / IP Error Checking Analog Serial 

Datalogger 
 

ESC 
Campbell Scientific 

8816 / 8832 
23X 

Varies 
Varies 

Yes 
Yes 

16 
12 

2 
4 

 
Datalogger telephone  
modem 
 

Various N/A Varies Yes - - 

DataView laptop Various Varies Varies Yes - - 
 

Hardware Specifications for IMC Servers 

Name Manufacturer Model Processor(s) RAM 
Disk 
Space 

Ethernet 
Speed Services 

Netware Server 
Oracle Server 
Firewall 

IBM 
HP Proliant 
McAfee 

xSeries 250 
DL380 G5 
Firewall 
Enterprise 2009 

Xeon 700 
Xeon 3.00 gHz 
 

4GB 
460GB 
   - 

72.8GB 
91GB 
     - 

1000mbs 
100mbs 
100mbs 

File, Print 
File, Database 
Firewall 

 
Hardware Specifications for Workstations 

User Processor(s) RAM Disk 
Space Network Card 

Modem 
Baud Rate 

Floppy 
Drive 

CD Drive 
Speed 

Database 
manager 

Pentium IV 3.6 1.0GB 40GB 3Com Ethernet 
100MB 
 

56K  3.25 52x 

IMC data 
processing staff 

Pentium IV 2.8 gHz 512MB 40GB 3Com Ethernet 
100MB 

56K 3.25 52x 

 
IMC Computer Support Hardware 

Component Manufacturer  Model Function 

High-quality 
laserjet printer  
 

Hewlett-Packard LaserJet 4300tn Report tables and plots 
 

Color laserjet printer Xerox Solid Ink Phaser 8550 Color report tables and plots 
 

Write capable CD Drive Sony 52x32x52 Data distribution and archive 
 

T-1 Internet data 
connection 
 

AT&T  Internet access 

Data Backup 
 

Arkeia Network Backup Appliance Database and flat file nighly 
backup 
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3.2 IMC COMPUTER HARDWARE 
 
 The IMC is built on client/server architecture in a local area network (LAN). The 
hardware consists primarily of servers and client workstations. Supporting hardware includes 
computer peripherals, such as printers, required by the IMC.  Table 3-1 lists the current hardware 
and Figure 3-1 is a diagram of the current IMC computer hardware configuration. A brief 
description of each hardware category is provided below. 
  
3.2.1 Servers 
 
 The IMC primarily requires the following three network servers: 
  
 1)  File server for storing and retrieving program executables, ASCII data files, word 
                  processing documents, etc. (Netware Server) 
 
 2)  Database server for managing a relational database management system (RDBMS) 
                  such as Oracle. (Oracle Server) 
 
 3)  Internet communications server for transferring data to and from the EPA AQS 
                  database and other sources. (McAfee Firewall Enterprise 2009) 
  
One or more servers in the network may handle these services. The servers have sufficient 
processing power, hard drive storage, random access memory (RAM), and network throughput 
to allow for efficient and secure data processing and warehousing and all other computer-related 
tasks of the IMC. 
 
3.2.2 Workstations 
 
 The servers are accessed by networked workstations.  Each workstation has sufficient 
processing power to efficiently run the software applications required to collect, validate, report, 
and archive the data. 
 
3.2.3 Computer Support Hardware 
 
 A variety of computer peripherals are required to support IMC operations including 
printers, write-capable compact disc (CD) drives, modems, and other communications devices. 
 
3.3 IMC COMPUTER SOFTWARE 
 
 The Air Quality Data Base Management System (AQDBMS) is a collection of 
commercial and custom software designed to run on client/server architecture in a local area 
network (LAN).  Three categories of software exist in the AQDBMS: 
 
 1) The Oracle relational database management system. 
 
 2) Custom software for performing the day-to-day tasks of the IMC. 
 
 3) Support software for the computer operating systems, network communications, 
               printing, and all other supporting tasks. 
 
 Table 3-2 lists the current IMC software by category.  A brief description of each category is 
provided in the following subsections. 



 

 

 

Figure 3-1.  IMC Computer Hardware Configuration. 
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Table 3-2 
 

Current IMC AQDBMS Software 
 
Oracle Database System 
Program Manufacturer Version Installed on Function 
Oracle Database 11g Standard 
One Edition for Linux 
 

Oracle Corporation 11.1 Database 
 server 

Relational Database  
Management System 

SQL Net TCP/IP 
 

Oracle Corporation 11.1 Database server Database networking 

SQL*Net Listener Oracle Corporation 11.1 Database server 
 

Database networking  

SQL*Net Client 
 

Oracle Corporation 11.1 Client Database networking 

Oracle Enterprise Manager Oracle Corporation 11.1 Client Database administration                   
and special processing 

AQDBMS Commercial Software 
Program Manufacturer Version Installed on Function 
DATA COLLECTION 
     Crosstalk Mk.4 DCA 3.3 Client Data logger support                  

and data collection 
     HyperAccess Hillgraeve 8.4 Client Data logger support                 

and data collection 
     PC208W Campbell Scientific 3.3 Client Data logger support                 

and data collection 
     Loggernet Campbell Scientific 3.1.1.0 Client Data logger support                 

and data collection 
     PcAnywhere Symantec 10.5+ Client Data collection and  

DataView support 
AQDBMS Custom Software 

Program Manufacturer 
Source Code 
Language and 
Version 

Installed on Function 

DATA COLLECTION 
     Orbcomm ARS Visual Basic 6.6 Client Acquire Orbcomm satellite data 
     TECO BAM ARS Visual Basic 6.6 Client Acquire TECO BAM data 
DATA VALIDATION AND REPORTING 

     Datacoll ARS Visual Basic 6.6 Client Acquire and prepare data for 
database import 

     FTM8816 ARS Visual Basic 6.6 Client Reformat ESC88xx data file 

     StackPlot --- --- --- --- 

     Diurnal Plot --- --- --- Prepare diurnal data plot 

     Three-Year Summary Plot --- --- --- Prepare three-year summary plot 

     Roseplot --- --- --- Prepare wind and pollutant rose 
plots 

     Barchart ARS Visual Basic 6.6 Client Prepare annual barcharts 

     AIRNow DataColl ARS Visual Basic 6.6 Client 
Acquire, prepare, and upload 
hourly data to AIRNow and FTP 
sites 

     ARS utility programs ARS Visual Basic 6.6 and 
PowerBuilder 10 Client 

Perform a variety of data 
acquisition, preparation, and 
uploading 

 
-- continued -- 
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Table 3-2  (continued) 
 

Current IMC AQDBMS Software 
 
Network Operating Systems and Support Software 
Component Manufacturer Version Installed on Function 
Novell SUSE Linux Server Novell SLES 10 Database 

server 
Network operating system 

Novell Netware Server Novell 6.5 File and e-mail 
servers 

Network operating system 

Novell Netware Client Novell 4.91 Clients Network operating system 

Arkeia Backup Appliance Arkeia 8.1.4 Database 
server 

Server backup  
 

HP LaserJet 4300 PCL 5e Hewlett-Packard   Clients Printer communications 

HP LaserJet 4000 PCL 6 Hewlett-Packard  Clients Printer communications 

MS-Windows XP Microsoft  Clients PC operating system 

MS-Word XP Microsoft XP (2002/2003) Clients Word processing reports 

MapViewer Golden Software 5 Clients Report map production 

WS-FTP PRO Ipswitch 12 Clients Data transmission 

Scheduled Tasks Microsoft XP Clients Automatic data collection 
& startup 

WINZIP WinZip Computing 9 Clients Data archive 

UltraEdit IDM Computer Solutions 9.2 Clients Multiple functions 

WARFTP Server Open Source 1.7 AIRNow 
servers 

Host FTP services 

 
3.3.1 Oracle Relational Database Management System 
 
 The core of the IMC AQDBMS is the Oracle database.  Oracle is a comprehensive 
relational database management system operating in a client/server environment. The Oracle 
database and Oracle networking programs reside on the database server.  The database is 
accessed by network drivers installed on client workstations. The Oracle system also includes 
database administration utilities. 
 
3.3.2 AQDBMS Custom Software 
 
 Because of the unique nature of NPS air quality data, custom software has been 
developed to perform the day-to-day tasks of collecting, validating, reporting, and archiving the 
data.  The software has been developed primarily using Powersoft PowerBuilder and Microsoft 
Visual Basic development tools. Commercial utility programs are also used for certain functions.  
 
3.3.3 Network Operating System and Support Software 
 
 The IMC AQDBMS operates in a client/server environment that handles system 
peripherals, network file management and sharing, word processing, e-mail, Internet access, 
system backup, data archive, and a variety of other computer services. 
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3.4 ADDITIONAL SUPPORT EQUIPMENT 
 
 In addition to computer hardware and software, the IMC maintains working hardcopy 
files for each site currently in the monitoring network.  Paper documents stored in the IMC 
include site documentation, site-related correspondence, diagnostic plots, plots annotated with 
validation comments, monthly and annual reports, and other hardcopies related to current and 
recent past data.  Adequate storage space is required for this information.  The IMC is currently 
housed in an 800 square foot office with additional off-site storage.  Active paper documents are 
filed in standard 4-drawer file cabinets.  Archive paper documents, extending back five years, are 
stored in file cabinets in an ARS warehouse. 
 
4.0 METHODS 
 
 This section presents an overview of the IMC, NPS Gaseous Pollutant Monitoring 
Program data quantity and quality objectives, and the methods used in the IMC to meet the data 
objectives. This section includes seven (7) major subsections: 
 
 4.1 IMC Concept and Overview 
 4.2 Data Quantity and Quality Objectives 
 4.3 AQDBMS Design Concept 
 4.4 Data Collection 
 4.5 Data Validation 
 4.6 Data Reporting 
 4.7 Data Archiving 
 
4.1 IMC CONCEPT AND OVERVIEW 
 
 The IMC is a centralized data management center that includes the computer hardware, 
software, database, communications, facilities, and support systems required to efficiently and 
effectively manage all data for the NPS Gaseous Pollutant Monitoring Program. It has been 
designed to fully meet or exceed all of the requirements of the monitoring program.  
 
 The primary component of the IMC is the Air Quality Data Base Management System 
(AQDBMS).  The AQDBMS consists of an Oracle database and custom software designed to 
process and report air quality data.  Gaseous air pollution, meteorological, and supporting data 
are collected from dataloggers and DataView laptop computers by telephone modem, processed 
through three levels of validation, and reported via a variety of output products. Data and 
supporting field documentation are archived at all stages of the process.  A flow diagram that 
illustrates the details of the process is provided as Figure 4-1. Further details of each stage in the 
process are briefly presented in the following subsections and in function-specific standard 
operating procedures and technical instructions (see Table 1-1). 
 
4.2 DATA QUANTITY AND QUALITY OBJECTIVES 
 
 Performance criteria ensure uninterrupted, reliable, and quality assured operation of the 
NPS Gaseous Pollutant Monitoring Program.  Table 4-1 summarizes the performance measures 
and goals for the network.  The technical approach of the IMC recognizes the importance of 
these criteria and fully meets or exceeds the criteria within IMC control.  
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4.3 AQDBMS DESIGN CONCEPT 
 
 The AQDBMS is specifically designed to manage and report hourly network data and 
related site information data, validated data, diagnostic data, and parameter data that 
accommodate the many temporal, spatial, and functional variations found in the NPS network.  
The core of the AQDBMS is the Oracle database.  Oracle is a comprehensive relational database 
management system (RDBMS).  A table is the basic unit of data storage in an Oracle database.  
Table data are stored in rows (records) and columns (fields).  Each table is related to one or more 
other tables by linking common columns.  Relationships and other rules defined within the 
RDBMS are used to enforce data integrity.  The AQDBMS database interface incorporates user-
friendly site/date selection and editing screens for data maintenance, validation, and reporting.  
Table 4-2 presents a summary of current AQDBMS design specifications. 
 
4.4 DATA COLLECTION 
 
 As shown in Figure 4-1, the data management flow begins with data collection. The 
AQDBMS maintains an integrated, comprehensive data collection module that performs daily 
automatic data polling of network sites via telephone.  The data collection module also includes 
programs providing auxiliary data polling, data transmission error screening, and data transmission 
error recovery. Complete and accurate site configuration details are required for successful data 
collection. 
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Figure 4-1.  NPS Gaseous Pollutant Monitoring Program Data Collection, Validation, and  

    Reporting Flow Diagram. 
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Table 4-1 
 

Performance Measures and Goals for the NPS Gaseous Pollutant Monitoring Program 
 
Performance Measure  Performance Goal 

1.   Performance of  
      Monthly Calibrations    
      for Pollutant Analyzers 

 Number of Calibrations: 
Ozone:                   80% of sites conduct a minimum of 6 calibrations during Apr-Oct 
                             100% of sites conduct a minimum of 3 calibrations during Nov-Mar 
Sulfur Dioxide:     100% of sites conduct a minimum of 8 calibrations per year 
 
Calibration Results: 
Absolute percent difference for 80% of all calibrations at each site are within 5%, 95% of all 
calibrations are within 10%, and 100% of all calibrations are within 15%. 
 
Note: Absolute percent difference is defined as the absolute value of difference between the 
calibration’s slope estimate and 1, expressed as a percent. 

2.   Data Documentation by 
      Site Operators 

 • DataView station logs that include all required site documentation are downloaded weekly 
from all sites. If an on-site DataView system fails, site operators are required to submit 
completed manual checklists by the 15th of each month. 

• 100% of all site documentation complete by the 15th of each month. 

3.   Instrument Problems  Initial response to all problems within 48 hours (or by the close of business Tuesday for 
problems occurring on weekends). 
Analyzers/Calibrators:      Maximum instrument downtime [ 10 days. 
Status Board Entries:        100% entered within 1 working day. 
Site Visits:                         All problems identified during semiannual visits are resolved     
                                          within 10 days. 

4.   Data         
      Communications 
      Problems 

 100% of problems corrected within 6 calendar days. 
100% of sites polled at least weekly. 

5.   Precision Checks  97% of sites, at least once every 14 days.  

6.   Zero/Span Checks  97% of sites, at least once every 7 days. 

7.   Semiannual Site Visit 
      Reports (also emergency 
      site visits) 

 100% of reports for trips concluded during the proceeding month are included in progress 
reports and uploaded to the project Web site. 

8.   Data Capture  Quarterly Criteria: 
100% of sites, m 95% data capture. 

9.   Valid Data  Quarterly Criteria: 
100% of sites, m 90% of available hours considered valid. 

10.   Data Requests  75 of all requests handled satisfactorily within 3 days. 
All requests completed within 10 days. 

11.   Quality Assurance 
        Performance 
        Checks 

 80% of all audits (on a site-parameter basis) will have an average absolute percent difference  
of [ 5%. 
95% of all audits (on a site-parameter basis) will have an average absolute percent difference  
of [ 10%. 
100% of all audits will have an absolute percent difference of [ 15%. 
 
Note: Average absolute percent difference is defined as the average of absolute difference 
(expressed as a  percent based on the known value) for each audit point. 

12.  AQS/PARS 
       Submittals 

 Data from 100% of sites submitted within 90 days. 

13.  Preliminary Data        
        Reports 

 All preliminary data reports submitted within 35 days of receipt of complete field documentation 
for the month. 



 Number 3340 
 Revision 4.2 
 Date FEB 2010 
  Page 17 of  20 
 

 

Table 4-2 
 

Current AQDBMS Design Specifications Summary 
 

The database manages: 

1.   Hourly average network data: 
• Raw values as collected 
• Validated values in the same measurement units as collected 
• Validation codes 
• Data source codes 
• Validation progress log 
• Datalogger and screening flags 

 

2.   DataView station logs: 
• Manual log entries 
• Results of checklist procedures 

 

3.   Daily and weekly calibration network data: 
• Raw values as collected 

 

4.   Current and historical site information: 
• Name, abbreviation, AQS codes, location information 
• Datalogger configuration for current sites 
• Site Status Log 

 

5.   Parameter information: 
• Name, abbreviation, AQS codes, measurement units 
• Anomaly screening rules 

 

The user interface provides: 
1.   Site and parameter information data entry/modification. 
2.   Site Status Log information data entry/modification. 
3.   Data loading from ASCII files and manual data entry, raw data review, and anomaly  
      screening before moving to permanent database. 
4.   Data validation in a spreadsheet-like editing screen. 
5.   Batch printing of report tables and plots for selected sites/periods/parameters. 
6.   Creation of AQS transaction files. 
7.   Export of data to ASCII files. 
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4.5 DATA VALIDATION 
 
 Timely validation of network data using procedures that meet EPA standards is a primary 
goal of the IMC.  The data validation process applies both automated and manual procedures to 
evaluate collected data against defined acceptance criteria. Site documentation (DataView station 
logs) and other pertinent network documentation are essential to the validation of the data. Each 
step of the validation process is carefully logged into electronic and manual validation log 
systems. Three levels of data validation are performed: 
 
 1)  Level 0 
 2)  Preliminary 
 3)  Final 
 
 The following subsections summarize the activities performed at each progressive level 
of data validation.  Only Final validation level data will meet all NPS and EPA validation 
requirements and be acceptable for submission to the NPS-validated data archives and the EPA 
AQS national database.  
 
4.5.1 Level 0 Validation 
 
 Data are appended daily to the database and are subjected to an automatic anomaly 
screening routine.  Weekly plots of hourly data are printed and reviewed by IMC staff and 
network operations staff.  Once these steps have been taken for all data in a site/month and site 
station logs have been received by the IMC, Level 0 validation is complete.   
 
4.5.2 Preliminary Validation 
 
 Preliminary validation is performed monthly by site.  The following steps are taken 
during Preliminary validation: 
 

• Support documents including station logs, Site Status Log entries, trip reports, daily 
summaries, SSRF forms, calibration results, and independent audit results are 
reviewed. Stripcharts of gaseous data are reviewed on-line by the IMC using 
DataView for all sites where interactive access is possible. 

 
• Comments are written on the weekly plots from the support documentation review and 

validation codes are determined by the IMC staff.  
 

• Data validation codes are entered interactively in the database. 
 

• IMC, network operations, and NPS ARD personnel simultaneously review pollutant 
plots and a random sample of commented weekly plots and associated information in 
monthly plot review meetings. 

 
• Data validation codes are modified based upon revisions or clarifications resulting 

from the plot review. 
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• Annotated plots and data validation codes are cross-checked by members of the IMC 
team. 

 
• Preliminary data reports are generated and delivered electronically to the NPS ARD 

and to each site operator. 
 
4.5.3 Final Validation 
 
 Final validation is considered complete on the date the preliminary reports are e-mailed. 
The following steps occur during the Final validation process: 
 

• Responses from the plot review, final data analyst cross-checks, site operators, ARD 
staff, and other related parties are reviewed. 

 
• Validation code changes are made if appropriate. 

 
• A Final validation date is entered in the Data Validation Log. 

 
 Upon completion of this final step, the data are considered final.  The validated data are 
ready to be formatted for submittal to the EPA AQS database and available for use by the NPS 
ARD or third-party users. 
 
4.6 DATA REPORTING 
 
 Data reporting tasks of the IMC include preparing and distributing hardcopy reports and 
digital data, submission of hourly and precision and accuracy data to the EPA AQS database, 
(submission of CASTNet-related data to the CASTNet contractor), and standard and ad hoc data 
retrieval to accommodate NPS ARD-authorized internal or external data requests or scientific 
investigations.  Table 4-3 lists the current standard IMC report products and tasks.  
 
4.7 DATA ARCHIVING 
 
 Data are archived in the AQDBMS each night as a backup. Data in the form of raw files 
for each site for each day are also stored on the network drive for one year, and are backed up 
each night. These files are also archived to CD-ROM on a quarterly basis. Data back-ups and 
CD-ROMs are kept in both on-site and off-site locations. Raw and validated data on CD-ROM 
are also delivered quarterly to the NPS ARD. 
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Table 4-3 
 

Current IMC Standard Report Products and Tasks 
 
  
Deliverable Product/Task Distribution List Schedule 

Weekly Progress Report NPS ARD Weekly by the second workday of 
each week. 
 

Ozone “hit list” NPS ARD Monthly during the ozone season 
(April-October), generated from raw 
data within 5 days of the end of each 
month. 
 

Monthly Data Reports 
(one for all sites in the program) 

NPS ARD, site operators Monthly, within 35 days of the end of 
the month of record. 
 

Annual Data Reports 
(one for all sites in the program) 

NPS ARD, site operators, ARFS, 
state, and regional air quality 
coordinators 
 

Yearly, by July 31st of the year 
following. 
 

Digital Data in ASCII files NPS ARD Quarterly, by 60 days following the 
end of the quarter. 
 

CASTNet-related data CASTNet contractor Monthly, within 75 days of final 
validation. 
 

EPA AQS data submittal EPA AQS Monthly, following final validation, 60 
days from period of record. 
 

Data requests To requesting party Within 3 days of request for validated 
data. Within 3 days of authorization 
by ARD if raw data. 
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1.0 PURPOSE AND APPLICABILITY 
 
 Maintaining the continuous operation of the National Park Service (NPS) Gaseous 
Pollutant Monitoring Program requires daily review of network data and operations and 
implementation of responsive, corrective actions when problems are noted.  The purpose of this 
standard operating procedure (SOP) is to describe the day-to-day technical support provided by 
Information Management Center (IMC) and network operations staff to: 
 

• Provide site operator telephone support. 

• Perform routine daily, weekly, and monthly data and operational system reviews. 

• Perform operational network documentation. 

• Perform corrective actions. 

• Inventory, distribute, and track network equipment and supplies. 
 
2.0 RESPONSIBILITIES 
 
2.1 IMC STAFF 
 
2.1.1 IMC Section Manager 
 

The IMC section manager’s responsibilities include: 
 

• Supervise the data analysts. 

• Coordinate with ARS programming staff, regarding upgrades and repair of problems 
with products used in data review. 

 
2.1.2 Data Analyst 
 
 The data analyst responsibilities include: 
 

• Participate in weekly and monthly data reviews. 

• Follow through from problems noted during monthly plot review and data validation. 

• Print and review the daily datalogger report file. 

• Review daily stackplots.  

• Review daily calibration plots.  

• Print, circulate, and file weekly stackplots. 

• Print weekly calibration plots for maintenance personnel to review and file. 

• Alert maintenance personnel of potential problems daily. 

• Follow through from daily problems. 

• Initiate weekly IMC/maintenance meetings. 
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• Maintain current site status log with any site problems. 
• Enter trip report pre-calibration results. 
• Enter any audit results. 
 

2.2 NETWORK OPERATIONS STAFF 
 
2.2.1 Network Operations Section Manger 
 

Within the context of this SOP, the network operations section manager has responsibility to: 
 
• Develop and revise technician-of-the-week (TOW) responsibilities as needed. 
• Assign the TOW. 
• Schedule TOW duties. 
• Support and oversee TOW duties. 
• Serve as TOW when scheduled. 

 
2.2.2 Field Specialists and Technician-of-the-Week (TOW) 
 
 The field specialists will serve as TOWs as scheduled by the network operations section 
manager.  TOW responsibilities are detailed in Section 4.0 and generally include: 
 

• Review network data daily. 
• Review results of automated calibrations daily. 
• Update electronic Site Status Log with site problems and actions for problem 

resolution. 
• Initiate contact with site operators when problems are recognized. 
• Consult with site operators when they telephone. 
• Document communication with site operators. 
• Regularly interact with the IMC staff. 
• Ship replacement systems or system components to a site, or malfunctioning 

instruments to an appropriate repair facility. 
 
2.2.3 Technical Assistant 
 
 The technical assistant shall: 
 

• Track status of shipped equipment. 
• Maintain expendable site supply inventory. 
• Print and file Daily Summary Reports. 
• Organize photographs from ARS site visits. 
• Maintain inventory of backup instrumentation and equipment. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC-related equipment and materials are fully described in SOP 3340, Information 
Management Center (IMC) Concept and Configuration.  The hardware and software used to 
perform specific data validation functions are referenced in the technical instructions (TIs) that 
support that SOP. 
 
4.0 METHODS 
 
 This section includes seven (7) major subsections: 
 
 4.1 Telephone Support – Scheduled and Unscheduled 
 4.2 Routine Data and Operational Systems Review 
 4.3 Operational Network Documentation 
 4.4 Corrective Actions 
 4.5 Coordination, Tracking, and Inventory Control of Government-Owned  

Equipment to and from Monitoring Sites or Other Repair Facilities 
 4.6 Maintenance and Distribution of Expendable Site Supplies 
 4.7 Maintenance and Distribution of Capital Equipment and Instrumentation 
 
4.1 TELEPHONE SUPPORT - SCHEDULED AND UNSCHEDULED 
 
 At least one member of ARS’ technical staff experienced with National Park Service 
network operations will be available during normal business hours (0800-1700 Mountain Time) 
to provide telephone assistance to site operators.  Extended hours will be arranged when 
necessary. A telephone answering/message system will be in place when no employees are 
present. ARS will maintain a toll-free telephone number (1-800-344-5423) for site operators to 
ensure ease of access and encourage open communications.  Operators are trained and 
encouraged to call if they have any questions or observe any problems or inconsistencies with 
data or site operations. 
  

Telephone support will include, but not be limited to, the following: 
 
• Assist operators in performing weekly preventive maintenance checks. 

• Record and discuss results from monthly multipoint calibration checks. 

• Assist operators in troubleshooting a system malfunction. 

• Assist operators with all site and data documentation. 

• Answer any DataView questions. 

• Answer any standard operating procedure (SOP) and site visit checklist questions. 

• Assist newly-assigned operators in understanding all technical requirements. 

• Assist site operators with data interpretation. 

• Coordinate semiannual site maintenance and training visits. 
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• Coordinate shipping and receiving of all consumable supplies, replacement parts, and 
equipment.  

• Confirm with the operator that all site documentation is properly maintained. 
 

 Every call that results in a maintenance action or affects data validation will be logged on a 
Site Status Report (see Section 4.3). Required action will immediately be initiated (see Section 
4.4). Quality site operators will be complimented, and positive constructive direction will be given 
to operators who encounter problems. The information on the Site Status Report will be entered 
daily on the Site Status Log by the technical assistant (see Section 4.3 for a description of the Site 
Status Log).  All original copies of Site Status Reports will be filed chronologically by site. 
 
4.2 ROUTINE DATA AND OPERATIONAL SYSTEMS REVIEW 
 
4.2.1 Data Products 
 
 Critical to maintaining high data capture throughout the network is timely identification 
of instrument malfunctions, operator errors, or other circumstances that affect data validity. A 
primary method for problem identification is the routine review of recently collected data. 
 
 The previous day’s data from each monitoring station is automatically polled daily by the 
IMC. (This procedure is described in SOP 3350, Collection of Ambient Air Quality and 
Meteorological Monitoring Data and Site Documentation). Important data troubleshooting 
products are automatically generated by the IMC. These products are used by the IMC and network 
operations staff to efficiently and expediently review the data and are briefly described below. 
 

• Daily Datalogger Report is automatically generated and printed at the conclusion of 
daily automated polling. This report lists whether each station was successfully 
polled, displays the datalogger time against National Institute of Standards and 
Technology (NIST) time, and highlights any keyboard-entered messages from site 
operators. Figure 4-1 is an example of this report. 

 
• Primary Data Stackplots for each site (displaying the previous seven days of primary 

data) are updated daily and available as computer displays or printouts. The data and 
control files used to produce these plots are maintained by the daily polling routines 
with each new day’s data appended automatically. Stackplots may be reviewed at any 
time from any ARS terminal for all monitoring stations or specifically-selected 
stations. This type of plot shows the temporal variations of individual parameters and 
data interrelationships on the same page. In addition, hardcopy stackplots are 
generated each week, and archived by site for convenient and immediate access by 
network operations and IMC staff. An example Primary Data Stackplot is provided as 
Figure 4-2. 

 
• Calibration Results Summary Stackplots of zero, span, and precision data for the 

previous 15 days are updated every morning. The support files for this product are 
also maintained by the daily polling routines. Application and use of these plots are 
similar to the Primary Data Stackplots above. An example 30-day Calibration Results 
Summary Stackplot is provided as Figure 4-3. 
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• Daily Summaries are available on-screen on-demand and are also printed for 
hardcopy archive. Each summary includes each hourly value for each parameter at a 
single site for a day. The magnitude and variations in hourly parameter values can be 
easily viewed using this product. The file also lists the calibrator results, power 
failure logs, and keyboard-entered messages entered by the site operator. An example 
Daily Summary is provided as Figure 4-4. 

 
 Daily and periodic data and support documentation reviews are performed by both IMC 
and network operations staff.  These reviews and resulting actions are noted below. 
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Figure 4-1.  Example Daily Datalogger Report. 

Summary of Datalogger Time Accuracy 
 
       Logger  Logger   Logger     IMC       IMC     Days   Time     
       Julian   Date     Time      Date      Time    Diff.  Diff.    
Site   Date   mm/dd/yy  hh:mm:ss  mm/dd/yy  hh:mm:ss  #    hh:mm:ss 
--------------------------------------------------------------------------- 
ACMH    221  08/08/00   05:33:26  08/08/00  04:35:17  000 -00:01:51 
BIBE    221  08/08/00   04:39:50  08/08/00  04:39:52  000 -00:00:02 
CANY    221  08/08/00   03:47:05  08/08/00  04:47:11  000 -00:00:06 
CHIR    221  08/08/00   03:51:30  08/08/00  04:52:34  000 -00:01:04 
CRMO    221  08/08/00   03:53:55  08/08/00  04:58:57  000 -00:05:02 
DENA    221  08/08/00   02:04:35  08/08/00  05:05:03  000 -00:00:28 
DEVA    221  08/08/00   03:12:53  08/08/00  05:10:41  000 +00:02:12 
EVER    221  08/08/00   06:17:08  08/08/00  05:16:54  000 +00:00:14 
GLAC    221  08/08/00   04:22:02  08/08/00  05:22:32  000 -00:00:30 
GRBA    221  08/08/00   03:26:28  08/08/00  05:27:58  000 -00:01:30 
GRCA    221  08/08/00   04:32:31  08/08/00  05:33:15  000 -00:00:44 
GSCC    221  08/08/00   06:38:59  08/08/00  05:38:41  000 +00:00:18 
GSCD    221  08/08/00   06:43:46  08/08/00  05:43:47  000 -00:00:01 
GSCM    221  08/08/00   06:48:52  08/08/00  05:48:50  000 +00:00:02 
GSLR    221  08/08/00   06:54:20  08/08/00  05:54:06  000 +00:00:14 
HATH    221  08/08/00   01:56:49  08/08/00  05:59:38  000 -00:02:49 
HAVO    221  08/08/00   02:05:58  08/08/00  06:05:07  000 +00:00:51 
JOYV    221  08/08/00   04:10:36  08/08/00  06:10:41  000 -00:00:05 
LAVO    221  08/08/00   04:17:14  08/08/00  06:16:38  000 +00:00:36 
MAHM    221  08/08/00   06:23:38  08/08/00  06:23:46  000 -00:00:08 
MEVE    221  08/08/00   05:29:12  08/08/00  06:29:15  000 -00:00:03 
MORA    221  08/08/00   04:36:20  08/08/00  06:34:56  000 +00:01:24 
NOCA    221  08/08/00   04:38:50  08/08/00  06:41:07  000 -00:02:17 
OLHR    221  08/08/00   04:46:45  08/08/00  06:47:28  000 -00:00:43 
OLYM    221  08/08/00   04:51:39  08/08/00  06:52:08  000 -00:00:29 
PINN    221  08/08/00   04:57:51  08/08/00  06:58:34  000 -00:00:43 
ROMO    221  08/08/00   07:35:08  08/08/00  08:35:55  000 -00:00:47 
SEAS    221  08/08/00   05:04:53  08/08/00  07:04:43  000 +00:00:10 
SELK    221  08/08/00   05:08:05  08/08/00  07:08:37  000 -00:00:32 
SELP    221  08/08/00   05:51:21  08/08/00  07:51:55  000 -00:00:34 
TRVC    221  08/08/00   07:06:36  08/08/00  08:06:33  000 +00:00:03 
VIIS 
VOYA    221  08/08/00   08:14:53  08/08/00  08:15:11  000 -00:00:18 
YELL    221  08/08/00   07:22:50  08/08/00  08:21:52  000 +00:00:58 
YOTD    221  08/08/00   06:30:04  08/08/00  08:30:28  000 -00:00:24 
 
Central Messages Report 
 
Site  Timestamp          Message 
--------------------------------------------------------------------------- 
DEVA  08/04/00 16:14:27  FLW FIXED, FILTER WAS NOT FULLY LOCKED INTO IT'S BASE, GOOD 
THING IT DIDN'T FALL 
EVER  08/02/00 12:04:30  CHANGED OFFSET FROM -13 TO -10. DDM-ARS. 
LAVO  08/01/00 10:44:41  PERFORMING LAVO STATION CHECK. M.MAGNUSON 
SEAS  08/01/00 09:32:50  WEEKLY STATION CHECK AND MULTIPOINT, DMM. 
YOTD  08/04/00 11:52:53  REPLACED WETNESS SENSOR-IT WORKS! KATY/NPS 
 
Operator Messages Report 
 
Site  Timestamp          Message 
--------------------------------------------------------------------------- 
HATH  07/31/00 10:14:16   
HATH  07/31/00 10:17:49  Messages complete 
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Figure 4-2.   Example Primary Data Stackplot. 
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Figure 4-3.   Example Calibration Results Summary Stackplot. 



             Number 3345 
             Revision 1.1 
             Date FEB 2010 
             Page 9 of 17 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

Figure 4-4.   Example Daily Summary. 
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4.2.2 Daily Data Review 
 
 Data are reviewed daily (Monday through Friday) by both IMC and network operations 
staff as described below: 
 

IMC 
 The IMC data analysts review data daily and inform the network operations staff 
immediately of any noted anomalies. Notification of network operations is initially performed 
verbally. The procedures applied to review data daily are: 
 

• Daily Datalogger Report - Stations not successfully polled automatically will be 
retried or manually polled by the IMC. This effort is the first priority of the IMC team 
every day. Stations that cannot be polled or require repeated manual polling will be 
reported to network operations for further investigation. Stations with datalogger 
times drifting beyond 2-minutes of NIST time will be reported to network operations 
for correction. 

 
• Primary Data Stackplot - The stackplot for each site is reviewed on screen. Any noted 

anomalies are reported to network operations. This review is performed to identify 
unusual variations in hourly data or logger data flags.  Specific types of data review 
that would indicate issues for further investigation by network operations are: 

 
− Solar Radiation - Nighttime values ≥ 14 W/m2 or ≤ -14 W/m2 

− RH - values >105 or <0 

− Ozone - values ≤ -5ppb 

− Instrument stuck at either zero or full scale 

− Instrument readings that do not vary for extended periods of time 
 

• Calibration Results Summary Stackplots - The data analysts review the plots for 
value consistency. Any noted anomalies are reported to network operations. 

 
Data analysts (or field specialists) enter site data issues into the electronic Site Status Log for 

documentation and evaluation. An entry will be made for each confirmed anomaly or inconsistency. 
 
Network Operations 

 An ARS field specialist is assigned to review data, recognize problems, and initiate 
corrective action. This technician-of-the-week (TOW) has primary troubleshooting and telephone 
assistance responsibility for the entire assigned period, typically one week. Rotating this 
responsibility allows all network operations personnel to keep current on network concerns, while 
having time to encounter and resolve a range of problems and maintain contact with the site 
operators. This builds a more dynamic staff and adds to the depth of the institutional memory of  
the network operations staff. The loss of a staff member is far less crippling to the program with 
this broad level of cross-training. The TOW, section manager, or other assigned field specialist will 
review the following data summaries and plots daily. Any inconsistencies or anomalies noted by 
network operations review or identified by the IMC will be investigated by network operations.  
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• Daily Datalogger Report - These daily printouts are reviewed each morning. The 

accuracy of the logger time is verified and any time drift beyond two minutes of 
NIST time is corrected by calling and resetting the datalogger. Keyboard-entered 
messages from the site operator requesting supplies or identifying problems are noted 
and corrective actions are initiated. 

 
• Primary Data Stackplot -  The stackplot for each site is reviewed on-screen for data 

completeness, tolerance, and reasonability. Any noted inconsistencies initiate 
corrective actions by network operations. 

 
• Calibration Results Summary Stackplots - These plots are reviewed for calibration 

timing and value consistency. Noted anomalies initiate corrective actions. 
 
• Daily Summary - Network operations will view selected hourly data to help identify 

and troubleshoot problems noted during the daily data review.  Network operations can 
also call any site with a DataView system to view detailed data plots and tables online. 

 
Field specialists or data analysts enter site data issues into the electronic Site Status Log 

for documentation and evaluation. An entry will be made for each confirmed anomaly or 
inconsistency. 

 
4.2.3 Weekly Review 
 
 Every week, IMC staff will meet with network operations staff (TOW and/or section 
manager) to review all network operations site by site. The discussion is led by going through 
the electronic Site Status Log to review resolved and unresolved problems. This discussion is 
supplemented by: 
 

• IMC 
 

− Daily lists of problems 

− Previous week’s unresolved issue list 

− Notes from site documentation reviews 

− Notes from validation procedures 

− Notes from monthly plot reviews 

− Stackplots 

− Calibration plots 

− Site documentation packets 

− Supplemental data summary plots and listings 

− National Performance Audit Program (NPAP) audit results or state audit results 
                  when available 
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• Network Operations 
 
− Electronic Site Status Log  

− Trip reports (calibration results are entered by the data analyst upon receipt) 

− Other notes and field specialist’s comments 

− Supplemental data summary plots and listings 
 
 The results of the meeting will include identified further action items by network 
operations or IMC staff and documentation of resolved and unresolved problems. All actions 
will be noted in site-specific Site Status Logs. 
 
4.2.4 Site Document Review 

 
 Site operators complete DataView checklists during their weekly station visits.  These 
checklists, and supporting DataView plots and tables, require notation of specific tolerance 
values of  instruments and support systems. The site operator should recognize out-of-tolerance 
conditions and call network operations for assistance. However, additional review of these 
entries by the IMC  staff can identify a required maintenance action or prevent unnecessary 
instrument failure. These checklists are retrieved electronically from DataView sites by the IMC. 
The IMC data analysts will review the newly received documents for: 

 
• Thoroughness of written lognotes. 

• Any out-of-tolerance condition requiring immediate action. 

• Any note or condition that should be addressed during a future semiannual 
maintenance visit. 

 
 Any noted inconsistencies will be documented in the Site Status Log and will prompt 
immediate corrective actions.   
 
4.2.5 Monthly Review 
 
 Monthly review actions are based on the information gathered during validation 
procedures described in the following SOPs and TIs: 
 
 SOP 3450 Ambient Air Quality and Meteorological Monitoring Data Validation 
 
 TI 3450-5000 Ambient Air Quality and Meteorological Monitoring Data – 

 Level 0 Validation 
 
 TI 3450-5010 Ambient Air Quality and Meteorological Monitoring Data – 

 Preliminary Validation 
 
 TI 3450-5020 Ambient Air Quality and Meteorological Monitoring Data – 

 Final Validation 
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 Monthly network review is focused on the monthly plot review, which is a joint review 
of the commented weekly stackplots by IMC, network operations, and National Park Service Air 
Resource Division (NPS ARD) staff. Any problems discovered during the plot review will be 
addressed and appropriate actions will be taken by the IMC or network operations. 
 
4.3 OPERATIONAL NETWORK DOCUMENTATION 
 
4.3.1 Site Status Log 
 
 The electronic Site Status Log is an electronic bulletin board that provides a convenient 
and permanent record of field instrumentation problems, solutions, and other conditions that 
affect data quality. The Site Status Log is a component of the IMC Air Quality Database 
Management System (AQDBMS), and problems are entered or updated daily by network 
operations or IMC staff. The Site Status Log is available at http://www.arssitestatuslog.com, via 
authorized username and password, to allow field specialists access to data entries while on-site 
at a monitoring location. 
 
 Any inconsistency in the data or any other information pertinent to data validity noted by 
the field specialists (or TOW), IMC, or site operator will be manually documented in the 
electronic Site Status Log. An example Site Status Log is provided as Figure 4-5. It is the 
TOW’s (or other field specialist’s) or IMC staff’s responsibility to complete a Site Status Log 
entry for every identified data anomaly or action that affects network operations and/or data 
validity. The entries should be clear, concise, and provide sufficient detail to accurately describe 
each problem or action.  
 

Entries and updates will: 
 
• Identify and document an ARS- or site operator-recognized problem. 

• Record the shipping of replacement parts or sensors. 

• Document and explain results of adjustments or repairs. 

• Provide an up-to-date record of actions leading to the rectification of a problem. 

• Provide a historical record of problems to assist in data validation. 
 

 Brief, informational trip reports will also be entered to highlight significant or unusual 
findings or to document instrument replacements or repairs after a semiannual or emergency site 
repair. An example Site Status Log display for Chiricahua National Monument is provided as 
Figure 4-5.  
 
 Copies of the Site Status Log unresolved problems by site are printed immediately 
following data entry and filed by site in the IMC. An option also exists in the logging system to 
have current entries e-mailed to appropriate staff for immediate notice. 
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Figure 4-5 .   Example Electronic Site Status Log Display. 

 
 
4.4 CORRECTIVE ACTIONS 
 
 Network operations has the responsibility to expediently address and resolve network 
operation issues that affect data quantity and quality. Upon identification of a problem network 
operations staff will employ their technical skills to clarify, troubleshoot, and resolve network 
problems. All actions will be summarized on Site Status Logs. The corrective actions that will be 
used may include the following approaches or combinations of approaches depending on specific 
problems: 
 

• Directly contact the datalogger by telephone modem to correct times, perform resets, 
change programs, adjust ranges, reschedule events, initiate events, or other logger 
control or communication functions. 

 
• Directly contact the DataView system on-site to view detailed data plots and tables 

by parameters to help identify, troubleshoot, and resolve problems. 
 
• Contact the site operator to perform troubleshooting sequences as directed by 

network operations to isolate a problem. 
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• Send repair or replacement parts or systems to a site operator for installation and 
provide written and verbal direction to ensure the repair or replacement is performed 
properly. 

 
• At sites where smart analyzers (i.e., TEI “C” series instruments) are connected to a 

telephone modem, directly connect to the analyzer to perform troubleshooting, 
change ranges, or other analyzer related functions. 

 
• Perform needed troubleshooting repairs, replacements, or additional operator training 

during the next scheduled site visit. 
 
• Conduct an emergency site visit with the Contracting Officer’s Technical 

Representative (COTR) approval to perform needed troubleshooting, repairs, or 
replacements. 

 
4.5 COORDINATION, TRACKING, AND INVENTORY CONTROL OF 

GOVERNMENT-OWNED  EQUIPMENT TO AND FROM MONITORING SITES 
OR OTHER REPAIR FACILITIES 

 
 When troubleshooting procedures indicate that a system or system component must be 
replaced, network operations staff will coordinate the overnight shipment of replacement parts to 
the site.  Network operations staff will also coordinate the shipment of the malfunctioning unit to 
the appropriate repair facility. All repair or replacement efforts will be performed expediently to 
minimize data loss. 
 
 Shipping and receiving of all instrumentation and support hardware to and from sites will 
be thoroughly documented. All equipment will be tracked by name, serial number, shipping date, 
shipping method, and bar-coded tracking label. Any delays or losses in shipping will be 
expediently tracked and documented. 
 
 Permanent shipping and receiving records will be kept as hardcopy documents.  Shipping 
documentation includes: 
 

• Equipment Shipped Form 

• Equipment Received Form 

• Packing Documentation 
 
 The status of shipped equipment will be tracked by the technical assistant. 
 
4.6 MAINTENANCE AND DISTRIBUTION OF EXPENDABLE SITE SUPPLIES 
 
 An inventory of expendable site supplies and common replacement parts will be 
maintained. Expendable supplies will be shipped periodically to the sites to ensure an adequate 
on-site inventory. All critical requests will be handled expediently. 
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 A list of in-stock quantities of supplies and common replacement parts will be 
maintained. Inventory control will be tracked by hardcopy forms and Equipment Inventory 
Database entries. A current inventory listing will be included semiannually in the Monthly 
Progress Report or as requested. When the inventory stock falls below the desired level, 
replacement orders will be initiated. 
 
 The NPS ARD has traditionally purchased supplies of routine consumable and 
replacement items directly. It is assumed that the NPS ARD will continue this practice. A list of 
items to be purchased and suppliers will be provided quarterly by ARS to the NPS ARD. An 
example of this list is presented as Figure 4-6.  
 
 When unanticipated supplies are needed immediately, ARS will directly procure the 
required supplies.  A funding contingency for emergency supplies will be included in the Cost 
Proposal. 
 
4.7 MAINTENANCE AND DISTRIBUTION OF CAPITAL EQUIPMENT AND 

INSTRUMENTATION 
 
 Major system malfunctions, such as the failure of an air quality analyzer, meteorological 
sensor, or data acquisition system component, can occur. When operator repair is not a viable 
option due to failure complexity or time constraints, a backup system will be sent to the site. 
ARS will maintain this inventory of backup instrumentation and equipment. The status of the 
backup equipment inventory will be periodically reviewed with the COTR.   
 
 When instrumentation fails, it may not be cost-effective to repair certain aging systems. 
Therefore, to maintain adequate backup, it may be necessary to procure additional backup 
equipment. ARS will work with the COTR to identify the priorities and most appropriate 
methods of maintaining the backup equipment inventory. As directed by the COTR, ARS will 
procure and/or coordinate direct NPS procurement of identified capital equipment and 
instrumentation. 
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SPARE PARTS INVENTORY 

   
 Item 

 
 Type 

Quantity 
In Stock/ 
On Order 

 
Quantity 
Needed 

Charcoal  6  
Gloves - Vinyl Phoenix Anti-Static 1600  
Lamps - Generator Dasibi 

Monitor Labs 
 8  
 9  

Lamps - Photometer Dasibi 
Monitor Labs 

  10  
 12  

10*

Met Gear - Climatronics Bearings (WS/WD) 
Cups 
Vanes 
Potentiometers 
Photo Chopper Assemblies 
Dew Point Sensors 

120  
 7  
  5  
10  
5  

13  
Met Gear - Qualimetrics Bearings (WS) 

Bearings (WD) 
Cups 
Vanes 
Potentiometers 
Photo Chopper Assemblies 
Dew Point Sensors 

16  
 20  

6  
5  
3  
7  
5  

Pumps Monitor Labs 
Dasibi - 5 liter 
Dasibi - 3 liter 
Thomas Pump & Mounts 
Dasibi Pump Feet (Sets of 4) 

3  
 4  
6  
 7  

   8  
Ribbons Panasonic KX-P150 

Panasonic KX-P115 
  

               2  
  6  

10 

Scrubbers Dasibi 
Monitor Labs 

  15  
 12  

Silica Gel   6  
Solenoid Valves Monitor Labs - 115 V 

Dasibi - 24 V 
Dasibi 115 V 

 7  
9  

  12  
Tubing/Fittings Tubing 1/8" 

Tubing 1/4" 
Assorted Fittings 

225'  
  75'  
~50  

200*

Teflon Filters (10 packs) 2 micron (47 mm)  
20 micron (50 mm) 

   25  
  0  

50*
   100* 

  
  * Please order ASAP. 

 
Figure 4-6.   Example Listing of Replacement and Consumable Parts. 
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1.0 PURPOSE AND APPLICABILITY 
 

This standard operating procedure (SOP) outlines the steps taken by Air Resource 
Specialists’, Inc. (ARS) Information Management Center (IMC) to collect ambient air quality 
and meteorological data and quality control documentation from network dataloggers, DataView 
computers, manual operational logs, and other data compilation systems. This information 
includes: 

 
• Criteria pollutant parameters 
 
• Meteorological parameters 
 
• Diagnostic parameters and calibration results 
 
• DataView or manual station logs 

 
 Successful data collection is the first step in the network data collection, validation, and 
reporting process illustrated in Figure 1-1.  This SOP outlines the data collection process.  For 
detailed instructions on data collection refer to the following technical instructions (TIs): 
 

• TI 3350-4000 Collection of Ambient Air Quality and Meteorological Monitoring 
    Data via Modem 

 
• TI 3350-4005 Collection of DataView Files via Telephone Modem 
 

2.0 RESPONSIBILITIES 
 
 Staff positions that have data collection responsibilities are: 
 

• IMC data analyst 
 

• Field specialist 
 

• Site operator 
 

Specific IMC staff data collection responsibilities are presented in the TIs that support 
this SOP (see previous Section 1.0). 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340, Information 
Management Center (IMC) Concept and Configuration for the National Park Service Gaseous 
Pollutant Monitoring Program, and SOP 3341, Air Resource Specialist’s, Inc. (ARS) Information 
Management Center (IMC) Concept and Configuration. The hardware and software used to 
perform specific data collection functions are referenced in the TIs that support this SOP (see 
previous Section 1.0). 
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Figure 1-1.   General Data Collection, Validation, and Reporting Flow Diagram. 
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4.0 METHODS 
 
 To assure complete, error-free data collection, data are usually logged on-site by a  
datalogger and collected daily via telephone modem or satellite modem (see the Data Collection 
section of Figure 1-1). DataView software runs on laptop computers and the information written 
by the software to the station log is collected weekly via telephone modem (see the Data 
Collection section of Figure 1-1). Occasionally, telephone lines to a site are not available or data 
cannot be directly collected by modem due to problems such as modem or telephone line 
malfunctions. If electronic data collection methods fail, the IMC will attempt to recover data 
from on-site DataView stripchart plots, printed data tables, DataView digital data files, or on-site 
data storage modules. Data text files can also be downloaded from an FTP site and reformatted 
for entry into the database. As a last resort, suitable data from third parties may be used. In the 
event of DataView failure or at sites where manual logs are most practical, station logs and other 
quality assurance documentation can be manually completed and mailed or faxed to the IMC. 
 
 To summarize, the IMC collects data by one of these methods: 
 

• From a datalogger via telephone or satellite modem 
 
• From an FTP site 
 
• Reduced from DataView stripchart plots, printed data tables, or DataView digital data 

files 
 
• On-site data storage devices (i.e., storage modules) 
 
• Digital transmission from a third-party source 

 
 For detailed instructions on each method of data collection, refer to the technical 
instruction listed previously in Section 1.0. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps taken by the Air Resource Specialists’, 
Inc. (ARS) Information Management Center (IMC) to collect ambient air quality and 
meteorological data via telephone or satellite modems. The primary purpose of daily collection is 
to assure quality data capture and minimize data loss by: 

 
• Calling the datalogger at each station via telephone or satellite modem and 

downloading the past day’s data into site-specific daily files. 

• Reformatting the site-specific daily files for loading into the Air Quality Data Base 
Management System (AQDBMS) Oracle database. 

• Reviewing the daily error and diagnostic printouts to verify complete data collection 
or to identify problems. 

 
 As referenced from Standard Operating Procedure (SOP) 3350, Collection of Ambient Air 
Quality and Meteorological Monitoring Data, this TI is a guide for using custom data collection 
software to assure complete, error-free data collection from network dataloggers via modems. 
 
2.0 RESPONSIBILITIES 
 
2.1 DATA ANALYST 
 

The data analyst shall on a daily basis: 
 
• Set up and maintain the automatic data collection programs and support information. 

• Ensure that the workstation used for automatic data collection is properly configured 
for daily data poll. 

• Review the status of the automatic data collection each morning (including reviewing 
daily error and diagnostic printouts) to verify complete, error-free data collection, 
assure the integrity of the monitoring systems, or to identify problems and initiate 
corrective actions. 

• Perform required daily retries. 

• Review collected ASCII data files. 

• Provide technical support to site operators via telephone. 

• Ensure proper archive and storage of final raw data files. 
 

2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Inform data analysts of any changes in site configurations resulting from maintenance 
visits. 

• Inform data analysts of any equipment or data acquisition systems malfunction, 
replacements, additions, or inconsistencies. 
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• Inform data analysts of any data acquisition system program changes. 

• Review stackplots and troubleshoot inconsistencies observed on the stackplots or 
identified by data analysts. 

• Provide assistance to the IMC for troubleshooting data collection problems. 

• Provide assistance in troubleshooting on-site instrument problems. 
 
2.3 SITE OPERATOR 
 
 The site operator shall: 
 

• Telephone the IMC or field specialist if data collection problems are noted on-site. 

• Provide on-site assistance for troubleshooting data collection problems. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Detailed descriptions of all IMC hardware and software and monitoring station hardware 
requirements are presented by category in SOP 3340, Information Management Center (IMC) 
Concept and Configuration for the National Park Service Gaseous Pollutant Monitoring 
Program and SOP 3341, Air Resource Specialists’, Inc. (ARS) Information Management Center 
(IMC) Concept and Configuration. The IMC requires the following hardware and software to 
collect data from dataloggers via modems: 
 

• Monitoring site data collection hardware 
 
• IMC hardware: 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− Support hardware: 

− High-quality laser printer 
− Write-capable CD drive 

 
• IMC computer support software: 

− AQDBMS custom software 
− Network operating system and support software 

 
4.0 METHODS 
 
 This section includes six (6) major subsections: 
 
 4.1 Automatic Data Collection 
 4.2 Retry of Failed Data Collection Sites 
 4.3 Data Files Generated by the AQDBMS 
 4.4 Manual Data Collection via Telephone Modem From Datalogger 
 4.5 Daily Review of Data Directory Contents 
 4.6 Monthly Archival of Final Raw Data Files 



          Number 3350-4000 
          Revision 2.2 
          Date FEB 2010 
     Page 3 of  14 
 

 

 
 A detailed flowchart of the entire data acquisition process is provided in Figure 4-1. Files 
generated by this process and their distribution are shown in Table 4-1. 
 
4.1 AUTOMATIC DATA COLLECTION 
 
 Several methods exist for placing data into the Oracle database. Usually, hourly data are 
loaded through a series of automated processes. Currently, a Windows operating system utility 
called System Agent is utilized to launch the application with a command line argument at a 
scheduled time every night. The AQDBMS application detects the command line argument, 
automatically connects to the IMC database, and enables the auto polling function. A system 
timer queries  the polling configuration tables continually to determine if it is time to poll any 
sites. When the query returns a result set of sites and polling configurations, the program loops 
through the list, calling the dataloggers and loading the data into the database. 
 
 Data can also be loaded for one site for one day at a time using the Manual command 
button in the polling window. Either way, the polling program issues a call to the site, captures 
data for the requested date and writes it to an ASCII file, reformats the ASCII file, and loads the 
data into the database. It also initiates error screening and writes error messages for data analyst 
review. The program retries calling sites up to two times if necessary. As data are being loaded 
for each site, the header columns of the ASCII file must match the datalogger column 
information stored in the Polling Line ID Table. Figure 4-2 shows the Polling interface. 
 
 Data collected from air quality stations without telephone or cellular phone access is 
accomplished via StarBand or ORBCOMM satellite. With StarBand systems, ARS connects 
directly to monitoring stations via the Internet using satellite modems. With ORBCOMM 
systems, ARS contracts with a service provider to recover files from the provider’s FTP site. The 
files are then reformatted into files similar to telephone-collected data and imported into the 
AQDBMS.  
 

Data can also be hand-entered or blank-filled in the Data Validation interface. Data entry 
forms for entering non-hourly aerosol data, precision check data, and data from audit reports are 
also available. To open the Polling window, select Polling from the Configuration frame. 
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Figure 4-1.  AQDBMS Data Acquisition and Processing Via Telephone Modem 

          Detailed Flowchart. 
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Table 4-1 

File Name and Directory Organization of Files Generated by AQDBMS Routines 
 

File Type File Description Source(s)1 File Name(s)2 Directory Location3 Destination 
Daily Site 
Information 
 

Data Collection 
Summary4 

 

AQDBMS 
 

yyyymmdd.MES ESC_sitecall\logs\ 
printed 

LaserJet 
 

Data Files Raw datalogger output 
 

AQDBMS ssssjjj.yyyyR ESC_SITECALL\ 
SUCCESS 

Archived and 
Printed  
 

Plot Files Daily raw stackplot  
configuration and data 
files 

AQDBMS site.STK 
site.DAT 

Stkplots\DailyReview 
Stkplots\DailyReview 

Stackplot 
Stackplot 

Notes: 
1 Refers to routines defined in Figure 4-1. 
2 File naming convention: mm = 2-digit month   ssss or site = 4-character site code 
   (based on MS-DOS dd = 2-digit day    RET = retry file 
   8.3 file name format) yyyy = 4-digit year   SPN = span file 
   jjj = Julian day    DAT = stackplot data file 

ERR = error report   D = hourly data import file 
   MES = detailed message report  L = calibration data import file 
   SUM = summary report    
3 Directory Location: The AQDBMS directory is currently located under N:\PROJECT\IMC\. 
4 Data Collection Summary, Logger Time Accuracy Summary, and Span File are used by the field specialist. 

 
Figure 4-2.  The Polling Interface Shows Last Successful Poll. 
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4.1.1 Starting the Auto Poll Process 
 
 Usually, Windows System Agent will launch the AQDBMS application and enable the 
auto load process. Sometimes the auto load process must be manually started. To run Auto Poll 
in the Polling window, click the Enable Auto Poll command button. The button text changes to 
read “Disable Auto Poll.” 
 
4.1.1.1  Polling Order 
 

The order in which the sites are polled is determined by the following: 
 
1. Polling time specified in each site’s configuration. 
 
2. Alphabetically by site name. 
 
Sites with identical polling times will be polled alphabetically. To change the polling 

order of a site, edit the polling configuration as described below. 
 
4.1.1.2  Manual Data Polling 
 
 Manual data polling provides functionality not included in the automatic data collection 
process. Manual data collection is used in the following situations: 
 

• When automatic data collection from a site has failed and the data are needed in the 
database. 

 
• When recent data are needed for immediate use. 
 
• When archived or edited raw data need to be written to the database without polling 

the site. 
 

 Manual data polling cannot be used at the same time as automatic data collection. It is 
necessary to disable automatic data collection. To run Manual Poll: 
 

• Select the sites to poll by clicking on them (use standard Windows keys for multi-
select). 

 
• Select the Process Only checkbox if the raw data file already exists (no polling of the 

site(s) will be performed). 
 
• Select the Get All Data checkbox to poll a 21X, 23X, or CR10 datalogger and 

attempt to retrieve all of the data contained therein. This may take a long time and 
may return many months of data. This option is recommended only in extreme 
situations. Note:  This option only applies to Campbell dataloggers.  

       -or 
 Select the Get Single Day checkbox to poll an ESC datalogger for one specific day. 
  -or 
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 Leave both the Get All Data and Get Single Day checkboxes unchecked. The dates 
polled will be from the date listed next to each site in the Select Sites list box to the 
current day. The date listed may also be changed by clicking in the field and entering 
a new date. 

 
• Click the Start button to begin processing the site(s) in the order they appear in the 

list. 
 
 The manual data collection process operates similarly to the automatic data collection 
process regarding log files, etc. 
 
4.1.1.3  Reviewing the Log and Err Files 
 
 The Auto Poll and Manual Poll programs write messages to files tracking the data polling 
and loading processes. The log files are called yyyymmdd.log where yyyy is the year, mm the 
month number and dd the day number. (For example, the file 20001128.log holds the log entries 
for November 28, 2000)  The error files are called yyyymmdd.err. Both files are stored in the 
N:\project\IMC\esc_sitecall\logs directory and can be viewed by either clicking the View 
Sitecall Logs button in the Polling window or by opening directly in any text editor. Figure 4-3 
is a sample log file and Figure 4-4 is a sample ERR file. 
 
4.1.1.4  Daily Output 

 
In addition to polling and loading data, the polling window performs several other 

functions: 
 
• Update of stackplot files (auto mode) 

• Auto printing of datalogger summary files (auto mode) 

• Generation of span files (auto and manual modes) 
 
 Results of the AQDBMS program run are shown on the AQDBMS polling screen. The 
data analysts should check the AQDBMS polling status each day by performing the following: 
 

• Launch AQDBMS and  open the polling section. 

• Check the date next to each site. This indicates date/time of the last successful poll. 

• Click the Daily Output button to update selected sites. 
 
 The database system manager initially installs AQDBMS. Instructions are provided in Air 
Quality Data Base Management System (AQDBMS) Database Manager/Programmer’s Guide 
(ARS, 2001).  
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Figure 4-3.  A Sample Data Collection Log. 

 
  
 
 
 

 
 

Figure 4-4.  A Sample Data Collection Error File. 
 

DATA_COLLECTION: Site No: Figure Error! No text of specified style in 
document.-1 SHBM 01-25-200105:38:29 ---------- Begin Site: SHBM ---------- 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 SHBM 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 540999369834 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 BM 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 2 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 ESC8816 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 36896 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM005a.2001r 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM.dat 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM.cal 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.LOG 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\sys\ars_soft\programs\campbell\ 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 NONE 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 Turning modem ON... 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:33 Turning modem ON... 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:37 HANGUP: Opening port #2 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:38 HANGUP: AT&FV1&W 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:45 HANGUP: ATH0 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:54 HANGUP: DTR toggle 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:09 HANGUP: Close port 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:09 Turning modem OFF... 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 Offline 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 GetDataESC8816() started 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 Getting ESC8816 data: 
F:\COM_SOFT\ATMAPPS\XTALK32\XTALK30.exe SHBM(NPSAIR BM 01/05/01 5 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM005a.2001r 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.LOG 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\200101 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 Executing: 
F:\COM_SOFT\ATMAPPS\XTALK32\XTALK30.exe SHBM(NPSAIR BM 01/05/01 5 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM005a.2001r 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.LOG 

XTALK - shbm 1/25/2001 5:42:33 AM-XTALK data collection failed - shbm 
(01/05/01) 
FMT8816: SHBM 038 01/25/2001 05:42:37 >> Bad filename and/or path 
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4.1.2 Daily Preparation for Automatic Execution of the AQDBMS 
 
 Software for automatically running the AQDBMS is installed on the data collection 
workstation. A data analyst prepares the workstation at the end of each day by shutting down and 
restarting the workstation. 
 
 When the data collection workstation is unattended for extended periods such as 
weekends and holidays, data collection is handled without data analyst intervention. Once the 
workstation is setup on the afternoon prior to the period, the AQDBMS will automatically run 
once per night throughout the period at the assigned time. 
 
4.1.3 IMC Daily AQDBMS Summary Report 
 
 Each run of the AQDBMS data collection routine generates two diagnostic reports (see 
Table 4-1). The Daily Site Information report is automatically printed at the conclusion of the 
AQDBMS run and is subsequently examined by the data analyst each working day, to determine 
the success or failure of the automatic data collection routines. An example of this report is  shown 
in Figure 4-5. This report is intended to summarize the diagnostic information only. Detailed 
troubleshooting must be performed by the data analyst by manually calling the problem site. 
 
4.1.4 Data Reformat 
 
 The data transmitted by the dataloggers are not readily imported into a database. Custom 
software was written to reformat the data into columns that are easier to import into a database. 
The AQDBMS performs this task. 
 
 Data errors occasionally prove difficult to troubleshoot during the reformat process. A 
data analyst or applications programmer may need to examine this file in a text editor for 
additional diagnostic information to find the problem. If the checkpoint fails, the program gives a 
brief statement of the cause and the recovery status of the data file. 
 
4.1.5 Data Error Checking 
 
 The data rarely have errors because all modems are error correcting. Manual error 
checking is not necessary. 
 
4.2 RETRY OF FAILED DATA COLLECTION SITES 
 
 Results of the daily data collection are automatically printed at the completion of the 
polling process. The data analyst examines the MES file to determine which sites failed to poll 
correctly. The AQDBMS tracks the last successful poll date for each site. The data analyst 
carefully examines the automatic collection results and verifies the contents. 
 
 To retry failed sites: 
 

• Launch AQDBMS and go to Polling. 

• Click the site to retry. 
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• Type in the date of data to be collected.  

• Click start. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4-5.  Example Daily Site Information File. 

Summary of Datalogger Time Accuracy 
 
       Logger  Logger   Logger     IMC       IMC     Days   Time     
       Julian   Date     Time      Date      Time    Diff.  Diff.    
Site   Date   mm/dd/yy  hh:mm:ss  mm/dd/yy  hh:mm:ss  #    hh:mm:ss 
--------------------------------------------------------------------------- 
ACMH    221  08/08/00   05:33:26  08/08/00  04:35:17  000 -00:01:51 
BIBE    221  08/08/00   04:39:50  08/08/00  04:39:52  000 -00:00:02 
CANY    221  08/08/00   03:47:05  08/08/00  04:47:11  000 -00:00:06 
CHIR    221  08/08/00   03:51:30  08/08/00  04:52:34  000 -00:01:04 
CRMO    221  08/08/00   03:53:55  08/08/00  04:58:57  000 -00:05:02 
DENA    221  08/08/00   02:04:35  08/08/00  05:05:03  000 -00:00:28 
DEVA    221  08/08/00   03:12:53  08/08/00  05:10:41  000 +00:02:12 
EVER    221  08/08/00   06:17:08  08/08/00  05:16:54  000 +00:00:14 
GLAC    221  08/08/00   04:22:02  08/08/00  05:22:32  000 -00:00:30 
GRBA    221  08/08/00   03:26:28  08/08/00  05:27:58  000 -00:01:30 
GRCA    221  08/08/00   04:32:31  08/08/00  05:33:15  000 -00:00:44 
GSCC    221  08/08/00   06:38:59  08/08/00  05:38:41  000 +00:00:18 
GSCD    221  08/08/00   06:43:46  08/08/00  05:43:47  000 -00:00:01 
GSCM    221  08/08/00   06:48:52  08/08/00  05:48:50  000 +00:00:02 
GSLR    221  08/08/00   06:54:20  08/08/00  05:54:06  000 +00:00:14 
HATH    221  08/08/00   01:56:49  08/08/00  05:59:38  000 -00:02:49 
HAVO    221  08/08/00   02:05:58  08/08/00  06:05:07  000 +00:00:51 
JOYV    221  08/08/00   04:10:36  08/08/00  06:10:41  000 -00:00:05 
LAVO    221  08/08/00   04:17:14  08/08/00  06:16:38  000 +00:00:36 
MAHM    221  08/08/00   06:23:38  08/08/00  06:23:46  000 -00:00:08 
MEVE    221  08/08/00   05:29:12  08/08/00  06:29:15  000 -00:00:03 
MORA    221  08/08/00   04:36:20  08/08/00  06:34:56  000 +00:01:24 
NOCA    221  08/08/00   04:38:50  08/08/00  06:41:07  000 -00:02:17 
OLHR    221  08/08/00   04:46:45  08/08/00  06:47:28  000 -00:00:43 
OLYM    221  08/08/00   04:51:39  08/08/00  06:52:08  000 -00:00:29 
PINN    221  08/08/00   04:57:51  08/08/00  06:58:34  000 -00:00:43 
ROMO    221  08/08/00   07:35:08  08/08/00  08:35:55  000 -00:00:47 
SEAS    221  08/08/00   05:04:53  08/08/00  07:04:43  000 +00:00:10 
SELK    221  08/08/00   05:08:05  08/08/00  07:08:37  000 -00:00:32 
SELP    221  08/08/00   05:51:21  08/08/00  07:51:55  000 -00:00:34 
TRVC    221  08/08/00   07:06:36  08/08/00  08:06:33  000 +00:00:03 
VIIS 
VOYA    221  08/08/00   08:14:53  08/08/00  08:15:11  000 -00:00:18 
YELL    221  08/08/00   07:22:50  08/08/00  08:21:52  000 +00:00:58 
YOTD    221  08/08/00   06:30:04  08/08/00  08:30:28  000 -00:00:24 
 
Central Messages Report 
 
Site  Timestamp          Message 
--------------------------------------------------------------------------- 
DEVA  08/04/00 16:14:27  FLW FIXED, FILTER WAS NOT FULLY LOCKED INTO IT'S BASE, GOOD 
THING IT DIDN'T FALL 
EVER  08/02/00 12:04:30  CHANGED OFFSET FROM -13 TO -10. DDM-ARS. 
LAVO  08/01/00 10:44:41  PERFORMING LAVO STATION CHECK. M.MAGNUSON 
SEAS  08/01/00 09:32:50  WEEKLY STATION CHECK AND MULTIPOINT, DMM. 
YOTD  08/04/00 11:52:53  REPLACED WETNESS SENSOR-IT WORKS! KATY/NPS 
 
Operator Messages Report 
 
Site  Timestamp          Message 
--------------------------------------------------------------------------- 
HATH  07/31/00 10:14:16   
HATH  07/31/00 10:17:49  Messages complete 
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4.3 DATA FILES GENERATED BY THE AQDBMS 
 
 Data from the daily data files are automatically saved and printed. Figure 4-6 shows the 
datalogger file. If data load is successful, the AQDBMS moves ASCII files to the \success 
directory. TI 3450-5000, Ambient Air Quality and Meteorological Monitoring Data – Level 0 
Validation, details the steps of loading these data. Moving and copying these files may be done 
by any file management tool that the data analyst is comfortable with.  
 
 

 
 

Figure 4-6.  Example ESC Datalogger Format Data File. 
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4.4 MANUAL DATA COLLECTION  
 
 If the AQDBMS automatic data collection system is unable to correctly retrieve error-
free data, the data analyst manually retrieves as much data as possible as soon as possible using 
one of the following methods: 
 

• Manual retrieval using AQDBMS software: 

− Select the site. 
− Select the date that is needed. 
− Click start. 
 

• Manual retrieval from DataView. 

• Data received via e-mail or diskette.  

• Third party data report. 
 
 Procedures for manual data retrieval using communications software and manual 
datalogger commands are outlined in the following subsection. Procedures for manual data 
retrieval from DataView are outlined in Section 4.4.2. TI 3450-5000, Ambient Air Quality and 
Meteorological Monitoring Data – Level 0 Validation, details the steps of manual entry of data 
from daily data printouts. 
 
4.4.1 Manual Data Retrieval Using AQDBMS Software 
 
 All monitoring sites have error-correcting modems hence data files are not edited for 
problems. To reprocess manually collected data files: 
 

• Launch the AQDBMS. 

• Choose  a site to be reprocessed. 

• Type in a date of data to be reprocessed. 

• Click process only. 

• Click start. 
 
4.4.2 Manual Data Retrieval from DataView 
 
 DataView communicates directly with the datalogger retrieving minute data every 
minute, hourly data every hour, and calibration data every day. These data are stored in a 
database on the DataView laptop. These data cannot be viewed outside of DataView unless they 
are exported to a comma-delimited ASCII file (.csv). This can be accomplished in two ways: 
 

• An IMC data analyst can configure DataView to automatically and continuously save 
minute, hourly, and/or calibration data to an ASCII file. This is normally done only in 
situations where continuous data availability from the datalogger is not available.  

 
• The DataView user can interactively export specific data to the ASCII files. 
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Either way, the user must manually copy the .csv files to diskette for retrieval. To retrieve data 
from the on-site DataView laptop: 
 

• Connect to the site’s laptop with pcAnywhere and log on to DataView. If DataView 
has been configured to automatically generate the .csv files, skip to “Transfer Files” 
below. 
 

• Manually export the data needed to .csv files. From dropdown boxes along the top of 
the screen, select Data Tables then Data Export. The Data Export form will appear. 
 

• Choose the export file destination. The default is C:\toucans\poll_data\. Change this 
setting only if creating files that will not be sent to  the IMC. If performing export on 
site, it is recommended that data be exported onto C:\drive and transferred to diskette 
instead of exporting directly to diskette. 
 

• Select the appropriate data type (Hourly/Minute/Cals) and a parameter list will 
appear. If fulfilling an IMC request to recover missing datalogger data, select Hourly 
and Cals (the IMC does not need minute data). Click the Select All button. 
 

• Select the appropriate dates. Click in the Start Date box and a calendar will appear. 
Select the start and end dates and click the button labeled Go. When the message 
Export Complete is displayed, click the Done button. Log off from DataView. 
 

• Transfer the files to the IMC using pcAnywhere. The following steps will transfer 
both the data files and the station log files to N:\project\IMC\DataView\poll_data. 
 
On an IMC computer setup to automatically collect station logs with pcAnywhere: 

 
- Click the File Transfer button at the top of the screen. (The button looks like a 

page with a lightning bolt). 
 
- Click the Auto Transfer button, then OK, then Yes. 
 
- This will transfer the files from the site’s laptop to the correct location on the 

server and then will disconnect from the site. To remain connected, uncheck the 
End session when finished button when the File Transfer Status window appears. 

 
On any other computer with pcAnywhere: 
 

 - Click on the File Transfer button at the top of the screen. (The button looks like a 
page with a lightning bolt). 

 
- On  your side of the file transfer screen, navigate to N:\project\IMC\ 

DataView\Poll_data|.  
 
- On the DataView laptop side of the file transfer screen, navigate to: 

C:\DataView2\poll_data\. 
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- Select the files to transfer. 
 
- Click the appropriate arrow. 
 
This will transfer the files from the site’s laptop to the correct location on our server 
to be loaded into the database (station logs) and afterwards, disconnect you from the 
site. If you wish to stay connected, uncheck the End session when finished button 
when the File Transfer Status window appears. 

 
4.5 DAILY REVIEW OF DATA DIRECTORY CONTENTS 
 
 Daily review of file sizes and locations is useful for error control and later archiving of 
data files. Following each daily data collection, the data analyst checks that the number of raw 
files (ssssjjja.yyyyr) is the same as the number of sites to be called. 
 
4.6 MONTHLY ARCHIVAL OF FINAL RAW DATA FILES 
 
 Data collected via telephone modem from monitoring sites using AQDBMS program 
routines must be archived for possible future reference. The previous sections in this document 
describe the process to collect and load the data. Each month, the data files are checked for 
completeness and organization. They are then written to CD and distributed. This process is 
accomplished in the following steps: 
 

• The data analyst ensures that a complete month of data has been collected and resides 
in the \success directory. 

 
• Select all daily ASCII files for all sites and create an archive. 
 
• Create three (3) copies of the CD and distribute to the network-specific program 

manager, on-site in the IMC, and to an off-site location other than the IMC. 
 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2001, Air Quality Data Base Management System 
          (AQDBMS) Database Manager/Programmer’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps taken by ARS’ Information 
Management Center (IMC) to collect DataView files (station logs) via telephone modems. The 
primary purpose of daily collection is to assure quality data capture and minimize data loss by: 

 
• Calling the DataView computer at each station via telephone modem and 

downloading any new station logs into site-specific daily files. 
 
• Reviewing the daily status report to verify complete information collection or to 

identify problems. 
 

 The station logs contain automatically or manually entered notes that describe results of 
weekly site visits and maintenance visits to the site. 
 
 As referenced from Standard Operating Procedure (SOP) 3350, Collection of Ambient Air 
Quality and Meteorological Monitoring Data and Site Documentation, this TI is a guide for 
using custom data collection software to assure complete, error-free data collection from network 
dataloggers via telephone modems. 
 
2.0 RESPONSIBILITIES 
 
2.1 DATA ANALYST 
 

The data analyst shall: 
 
• Set up and maintain the automatic station log collection programs and support 

information daily. 
 
• Ensure that the workstation used for automatic station log collection is properly 

configured for daily polling. 
 
• Review the status of the automatic station log collection each Wednesday to verify 

complete, error-free information collection, assure the integrity of the DataView 
systems, or to identify problems and initiate corrective actions. 

 
• Perform required daily retries. 
 
• Review collected station log files. 
 
• Provide technical support to the site operator via telephone. 
 
• Ensure proper archive and storage of station log data files. 
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2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Inform data analysts of any changes in site configurations resulting from maintenance 
visits. 

 
• Inform data analysts of any equipment or DataView system malfunction, 

replacements, additions, or inconsistencies. 
 
• Inform data analysts of any DataView system program changes. 
 
• Provide assistance to the IMC for troubleshooting DataView problems. 

 
2.3 SITE OPERATOR 
 
 The site operator shall: 
 

• Telephone the IMC or field specialist if DataView problems are noted on-site. 
 
• Provide on-site assistance for troubleshooting DataView problems. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Detailed descriptions of all IMC hardware and software and monitoring station hardware 
requirements are presented by category in SOP 3340, Information Management Center (IMC) 
Concept and Configuration. The IMC requires the following hardware and software to collect 
information from DataView via telephone modems: 
 

• DataView on-site system including a laptop computer, modem, and printer. 
 
• IMC hardware: 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− Support hardware 

 
• IMC computer support software: 

− AQDBMS custom software 
− Network operating system and support software 
− DataView station log collection software 
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4.0 METHODS 
 
 This section includes four (4) major subsections: 
 
 4.1 Automatic Station Log Collection 
 4.2 Manual Station Log Collection 
 4.3 Automatic Import of Station Logs to the AQDBMS 
 4.4 Monthly Archive of Raw Station Log Files 
 
 A flowchart of the station log process is provided in Figure 4-1. Files generated by this 
process and their distribution are shown in Table 4-1. 
 
4.1 AUTOMATIC STATION LOG COLLECTION 
 
 The station logs are collected by several methods. At sites with reliable land-line 
telephone service, the station logs are automatically acquired by the station log collection 
software and stored in comma-delimited ASCII files. If the automatic collection fails, the data 
analyst may also run the software manually. Station logs at sites that do not have reliable 
telephone service are collected by the site operator onto a 3.5” diskette using a DataView utility 
and then transmitted to the IMC by e-mail or regular mail/shipping. Logs may also be hand-
entered from printed copies of the logs. 
 
4.1.1 Starting the Automatic Station Log Software 
 
 The automatic station log collection software is loaded onto a computer with a telephone 
modem. The software uses a continuous clock/timer function and is configured to begin 
execution at 2:30 a.m. each Wednesday. This program calls each DataView site and downloads 
the most recent station log files to the IMC as comma-delimited ASCII files. 
 
4.1.2 Polling Order 
 
 The order in which the sites are polled is determined by the time specified in the 
automatic station log collection software setup, and generally polls according to time zone. The 
sites are polled in 15-minute intervals with four (4) automatic retries built in to each polling 
session. To change the polling time of a site, the polling configuration can be directly edited. 
 
4.1.3 Reviewing the Station Log Acquisition Status 
 
 The current availability of station logs may be reviewed at any time by running the 
DataView Status Summary program. A sample of the status summary output is provided as 
Figure 4-2. This program lists by site, the date of the last station log acquired and the age of the 
file. Station log files older than 7 days are highlighted. Several columns of information are 
presented in this table for troubleshooting purposes. The data analyst should review the last three 
columns of the report daily and take action to recover station logs older than 7 days. 
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Figure 4-1.  AQDBMS Station Log Acquisition and Processing via Telephone Modem Flowchart. 
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Table 4-1 
 

File Name and Directory Organization of Files Generated by Station Log Collection Routines 
 

File Type File Description Source(s)1 File Name(s)2 Directory Location3 Destination 
Station 
Logs 

Comma-delimited 
ASCII text files 

Station log 
collection 
software 

sitemmddyyyylog
.csv 

DATAVIEW\POLL_
DATA 
 

Archived and 
imported to 
AQDBMS 

Notes: 
1 Refers to routines defined in Figure 4-1. 
 
2 File naming convention: mm = 2-digit month   site = 4-character site code 
   (based on MS-DOS dd = 2-digit day    RET = retry file 
   8.3 file name format) yyyy = 4-digit year   SPN = span file 
   ERR = error report   DAT = stackplot data file 
   MES = detailed message report  D = hourly data import file 
   SUM = summary report   L = calibration data import file 
   CSV = Excel import format file 
 
3 Directory Location: The AQDBMS directory is currently located under N:\PROJECT\IMC\. 
 
 
 

 
 

Figure 4-2.  Example DataView Status Report. 
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4.2 MANUAL STATION LOG COLLECTION 
 
4.2.1 Manually Retrieving Digital Station Logs 
 
 If automatic acquisition of the digital station logs fails, the data analyst should attempt to 
manually retrieve the file by running the station log collection software. After the program 
begins, the analyst should select the site that has failed and choose the Run button. If several 
manual attempts fail, the problem must be reported to network operations for troubleshooting. 
 
4.2.2 Manually Retrieving Hardcopy Station Logs 
  
 If, after all attempts at acquiring the digital station logs fail, including on-site remedies, 
the data analyst must contact the site operator and request that a copy of the missing pages be 
printed and/or copied from the DataView computer and mailed to the IMC. 
 
4.3 AUTOMATIC IMPORT OF STATION LOGS TO THE AQDBMS 
 
 The station log files are automatically imported into the AQDBMS daily during the 
automatic data collection process. 
 
4.4 MONTHLY ARCHIVE OF RAW STATION LOG FILES 
 
 All collected raw station log files are archived monthly with the other raw data files. Each 
quarter, the station log files are checked for completeness and organization. They are then 
written to CD once year year and distributed as described in TI 3350-4000, Collection of 
Ambient Air Quality and Meteorological Monitoring Data Via Telephone Modem. This process 
is accomplished in the following steps: 
 

• The data analyst ensures that a complete month of station logs have been collected 
and resides in the \poll_data directory. 

 
• Create three (3) copies of the CD and distribute to the client, on-site in the IMC, and 

to an off-site location other than the IMC. 
 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2001, Air Quality Data Base Management System 
          (AQDBMS) Database Manager/Programmer’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This standard operating procedure (SOP) outlines the steps of ambient air quality and 
meteorological data validation, to assure quality data and to ensure that data are validated to meet 
Environmental Protection Agency (EPA) guidelines for successful submission to the EPA AQS 
(Air Quality System) database. The steps outlined apply to all ambient air quality and 
meteorological parameters that are monitored and loaded into the Information Management 
Center (IMC) database, regardless of whether the data for a specific parameter are uploaded to 
the EPA AQS database. 

 
The validation process consists of the following major steps: 
 
• Review of raw data visually on a daily basis for data acquisition errors, and for details 

on instrument performance. 

• Process data through Level 0 validation to ensure that all possible data have been 
collected and are correctly loaded into the permanent table of the database. 

• Process data through Preliminary validation to identify values that do not meet 
acceptance criteria. 

• Process data through Final validation that includes input from air quality specialists, 
field specialists, and site operators to resolve all questionable validation issues. 

• Accommodate post-final validation changes when necessary. 
 
 Successful validation at each level requires completion of a set of automatic (computer 
program) and manual checkpoints as shown in the data collection, validation, and reporting flow 
diagram (Figure 1-1). 
 
 This SOP outlines the data validation process. For detailed data validation procedures 
refer to the following technical instructions (TIs): 
 

• TI 3450-5000 Ambient Air Quality and Meteorological Monitoring Data –  
    Level 0 Validation 

• TI 3450-5010 Ambient Air Quality and Meteorological Monitoring Data – 
   Preliminary Validation 

• TI 3450-5020 Ambient Air Quality and Meteorological Monitoring Data – 
   Final Validation 
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Figure 1-1.  General Data Collection, Validation, and Reporting Flow Diagram. 

            (Specific processes may vary by monitoring network). 
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2.0 RESPONSIBILITIES 
 
 Staff positions that have data validation responsibilities are: 
 

• Information Management Section Manager 

• Data analyst 

• Field specialist 

• Site operator 

• Technical Assistant 

• Sponsoring organization staff 
 

Specific Information Management Center (IMC) staff data collection responsibilities are 
presented in the TIs that support this SOP (see previous Section 1.0). 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340, Information Management 
Center (IMC) Concept and Configuration for the National Park Service Gaseous Pollutant 
Monitoring Program, and SOP 3341, Air Resource Specialist’s, Inc. (ARS) Information Management 
Center (IMC) Concept and Configuration. The hardware and software used to perform specific data 
validation functions are referenced in the TIs that support this SOP (see previous Section 1.0). 
 
4.0 METHODS 
 
 This section discusses the levels of data validation and the methods used to complete each 
level of air quality and meteorological data validation. Throughout the data validation process, the 
programs within the Air Quality Data Base Management System (AQDBMS) are used extensively. 
Details on operating the system are found in the TIs that support this SOP (see previous Section 1.0). 
 
 This section includes four (4) major subsections: 
 
 4.1  Level 0 Validation Procedures 
 4.2  Preliminary Validation Procedures 
 4.3  Final Validation Procedures 
 4.4  Post-Final Validation Procedures 
 
4.1 LEVEL 0 VALIDATION PROCEDURES 
 
 Level 0 validation is accomplished by: 
 

• Collecting data via modem or other collection method. 

• Initially screening the daily data for anomalies. 

• Visually reviewing graphed raw data on stackplots on a weekly basis. 

• Verifying the receipt of DataView station logs or manual station logs. 
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4.1.1 Daily Data Review and Anomaly Screening 
 
 Data are collected via modem or other communications and stored in computer files (see 
SOP 3350, Collection of Ambient Air Quality and Meteorological Monitoring Data). Flags 
applied to the data by the dataloggers are also stored. The data and flags are then loaded into the 
AQDBMS database and are visually reviewed by the data analyst. Data for one site, all 
parameters, are displayed on a stackplot displayed on a computer screen one at a time. The data 
analyst reviews the data and verifies the following: 

 
• All sites and parameters that should be collected were collected. 

• The data set for each site is complete. 

• The data are reasonable for the site, season, and conditions. 
 

If data for a site have not been properly loaded, the data for the site/day must be deleted, 
corrected, and loaded again. It may be necessary to compare the data on screen with the raw 
computer file for verification. If data are missing and unrecoverable, the missing data is 
“blank-filled” by using the AQDBMS manual data entry screen and program. If raw data values 
are to be recovered by other than digital means, for example, reduced from a stripchart, the 
AQDBMS validation screen raw data/source view is used to enter the data. 
 
 After data for a site/day is verified, it is screened for anomalies by an AQDBMS 
program. This program applies anomaly flags (Level 0 validation codes). These flags are added 
to any datalogger flags that were loaded with the raw data from the datalogger. 
 
 Specific values for the screening program are maintained in the AQDBMS Screening 
Ranges Table for each site/parameter combination. If a site/parameter is not defined, a message is 
displayed. The Screening Ranges Table must be immediately updated and the data screened again. 
 
 After screening, the data analyst notifies the field specialist if any of the following are true: 
 

• Data for any parameter are at a full scale or zero scale values for an uncommonly 
long time. This indicates an instrument may have been left in zero or span mode 
inadvertently. 

 
• Daily calibration data (zero and span values from the analyzer) are not within the 

expected range. Zero values should be within  2% of full scale (ozone and carbon 
monoxide) or  3% (oxides of nitrogen and sulfur dioxide) of the instrument and span 
values within  7% (ozone) or ± 10% (all other gases) of the calibrator’s 
corresponding values. In this case, the field specialist must be notified as soon as 
possible so the analyzer can be calibrated in the field. 

 
• Any unusual and noteworthy anomalies with the data that would call attention to 

either a needed repair of an instrument or correction of a condition by the site 
operator (such as datalogger flags, anomaly screening flags, or anomalies resulting 
from visual data review). 
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Corrective action is initiated to resolve any noted inconsistencies and the problem and 
actions are entered in the Site Status Log. 

 
4.1.2 Review of Raw Data Stackplots 
 

A stackplot may include single or multiple user-selected parameters on line or bar graphs 
plotted against time on the X-axis. Up to 20 parameters may be plotted on up to 10 separate 
graphs (1 or 2 parameters per graph) in a stack. Temporal data variations are then easy to 
compare. Stackplots are used throughout the validation process. Raw data are graphed on 
stackplots on a weekly basis for each site for the following time periods each month: 

 
• Days 1 – 7 

• Days 8 – 15 

• Days 16 – 23 

• Days 24 – end of month 
 

One copy of each plot is generated and is promptly forwarded to all data analysts and the 
field specialist assigned as technician-of-the-week for examination. Problems not detected up to 
this point in the validation process are entered into the Site Status Log and a field specialist is 
notified for resolution of the problem.  
 
4.1.3 Site Documentation 
 
 Site operators are required to complete station checklists in DataView or on manual log 
sheets during every station visit. The DataView station checklists are downloaded and stored in 
the AQDBMS. 
 
 Level 0 validation is complete for a site/month on the date all possible data for the month 
have been collected and loaded into the AQDBMS database and all site documentation has been 
received. This date is entered in the AQDBMS Data Validation Log. In the event of DataView 
failure or for specific instrument types, the operator will complete manual checklists or logsheets 
and fax a copy of the logsheet to the IMC. All manual logsheets will be reviewed and checked 
upon arrival at the IMC. Data will be manually entered into the AQDBMS and the logsheets will 
be stored with the hardcopy stackplots from the site. 
 
4.2 PRELIMINARY VALIDATION PROCEDURES 
 
 Data for a site/month must be at Level 0 validation before beginning Preliminary 
validation. The Monthly Validation Checklist, shown in Figure 4-1, is used as a guide for the 
Preliminary validation procedure. The checklist identifies the major steps taken during 
Preliminary validation and provides a record of the date each step was completed and the initials 
of the analyst completing it. Preliminary data validation is accomplished by the following: 
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Figure 4-1.  The Monthly Validation Checklist. 
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• Determining if each data value meets validation acceptance criteria by: 
 

-  Reviewing site documentation. 
-  Reviewing the AQDBMS Site Status Log. 
-  Recording and reviewing comments on the raw data stackplots. 
-  Entering calibration data into the AQDBMS database. 
-  Reviewing daily summaries. 
-  Reviewing trip reports. 
-  Reviewing calibration plots. 
-  Entering and reviewing any audit report data received for the site/month into the  
   AQDBMS database. 

 
• Using the Auto Validation tool in the AQDBMS to automatically apply validation codes. 

• If necessary, adjusting validation codes or values in the AQDBMS database. 

• Updating the AQDBMS Data Validation Log. 

• Reviewing validated data stackplots. 
 
4.2.1 Validation Acceptance Criteria 
 
 Validation acceptance criteria and the methods for determining if a data value meets the 
criteria are usually related to one of the following events or limitations: 
 

• Data are out of instrument specifications (instrument-specific, see anomaly screening 
in TI 3450-5000, Ambient Air Quality and Meteorological Monitoring Data – Level 0 
Validation). 

• Data exceed minimum or maximum expected value (site-specific, see anomaly 
screening in TI 3450-5000). 

• Data exceed minimum or maximum expected rate-of-change (site-specific, see 
anomaly screening in TI 3450-5000). 

• Station temperature is out of specified limits. 
• Zero and span check data are within specified limits (instrument- and instrument 

range-specific, see anomaly screening in TI 3450-5000). 
• Data are affected by calibration check. 
• Less than 45 minutes of data are available (hourly averaging period). 
• Instrument or datalogger was affected by acts of nature. 
• Instrument or datalogger was affected by power failure. 
• Data capture was affected by a datalogger failure. 
• Data were affected by operator maintenance or calibration check. 

• Data were affected by site operator error. 

• Data were affected by instrument malfunction or failure. 

• Data were below lower detectable limit. 
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 To determine if the data meet or do not meet validation acceptance criteria, the data 
analyst first reviews the site documentation and weekly stackplots for the site/month being 
validated, uses Auto Validate to apply codes, reviews the codes, and then writes any comments 
on the plots that affect validation. Comments on plots are based on information from the site 
documentation, communication with field personnel and site operators, and anomaly and Auto 
Validation screening results. A commented plot is shown in Figure 4-2. The following guidelines 
are used when commenting plots: 
 

• Comments are written within the outline of the day of the affected data and in close 
proximity to the data point affected. 

• Comments include the hours affected, the reason(s) for invalidating the data, and the 
corresponding invalid code. The invalid code gives the reason for invalidating the data. 

• Explanations of valid but unusual data are also included. 

• Data points flagged by the anomaly-screening program are noted on the plot when 
appropriate. 

• Site visits are identified at the top of the plot above the corresponding date with date, 
time, and duration of the visit. 

• Normal actions that occur during a site visit and do not invalidate data are also 
identified on the plot (for example, meteorological instrument checks that last less 
than 15 minutes). This indicates that a required maintenance check was completed 
and further establishes validity of the data. 

 
 Precision check, calibration, and audit data are reviewed and entered if necessary during 
this step in the Preliminary validation process.  
 

A group plot review is held that includes input from air quality specialists, field 
specialists, and site operators, to resolve all questionable validation issues. After the plot review, 
necessary validation code changes are made in the AQDBMS database based on the group plot 
review discussion. 
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Figure 4-2.  Example of a Commented Stackplot.  
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4.2.2 Entering Validation Codes and Other Values into the AQDBMS Database 
 
 During the Preliminary validation process, each data record is assigned a data validation 
code. These codes identify which records are valid and which are not. To apply these validation 
codes, the Auto Validation process in the database is initiated. The database then automatically 
assigns a validation code to each record based on datalogger flags and anomaly screening. The data 
analyst reviews the codes and makes changes where necessary. Screening flags, datalogger flags, 
and validation codes are all stored in separate fields within the database so they can always be 
referred to if necessary. All flags are tracked by date and source. 
 
 At times, raw data may need to be adjusted in order to get a correct, validated value. A 
situation may occur where a data point is valid, but the datalogger was scaled or initialized 
incorrectly. In cases when the data can be appropriately adjusted, a control value is entered in the 
control value field that operates on the raw value to provide an adjusted validated value. For 
example, if the data analyst determines the datalogger was programmed with incorrect units for a 
parameter, the data is not invalid but it is incorrect. A multiplier placed in the control value field 
is used to properly convert the data.  
 

Additional tools for verifying complete and accurate entry of validation codes are 
available within the AQDBMS. The data analyst completes the following checks: 
 

• Reviews the Data Collection Statistics Table for a site/month, to quickly detect if a 
code was missed for parameters that must be validated identically, and to look for 
indications of missed power failures or recorder failures. 

• Reviews the High Values Tables for individual pollutant parameters, to detect 
calibration points inadvertently left in as valid. 

• Reviews validated data stackplots to further verify that no points were missed.  
 
 All of these products can be reviewed either on screen or as printed copy (see SOP 3550, 
Ambient Air Quality and Meteorological Monitoring Data Reporting ). 
 
 Preliminary data validation is complete after reviewing the validated data graphically.. 
 
4.2.3 Third-level Validation Procedures 
 
 Third-level validation procedures involve verifying that plots were annotated correctly 
and cross-checking of all codes applied in the AQDBMS. The AQDBMS Data Validation Log is 
then updated by entering the date completed and the analyst’s initials into the log record for the 
site/month. 
 
4.3 FINAL VALIDATION PROCEDURES 
 
 Data for a site/month must be at Preliminary validation before beginning Final validation. 
Final validation is accomplished by generating and reviewing raw data plots and comparing them  
to validated data. During this final review, suspect data are investigated and validation codes are 
changed where deemed necessary. Once Final validation is complete, monthly reports are 
generated and e-mailed to specified project personnel. The data are considered final and the 
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AQDBMS Data Validation Log is updated by entering the date completed and the analyst’s 
initials into the log record for the site/month. The monthly data reports are then filed. At the 
Final validation level, the data can be uploaded to AQS (see TI 3550-5300, Submitting Ambient 
Air Quality and Meteorological Data to the EPA AQS Database) and can be included in data 
requests (see TI 3550-5200, Handling Requests for Ambient Air Quality and Meteorological 
Monitoring Data). 
 
4.4 POST-FINAL VALIDATION PROCEDURES 
 
 If a validation error is found after the data are labeled as final, the following steps are 
taken:  
 

• The necessary changes are made in the AQDBMS database. 

• Changes made are logged in N:\\project\IMC\data corrections\revalidated_yyyy.xls. 
• If the affected data have been submitted to the EPA AQS database, they must be 

resubmitted. 

• If the affected data have been submitted to other data depositories (e.g., CASTNet or 
other project-specific databases or Web sites), they must be resubmitted. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps taken by the Air Resource Specialists’, 
Inc. (ARS) Information Management Center (IMC) for completing Level 0 validation of ambient 
air quality and meteorological data. These steps apply to all ambient air quality and 
meteorological parameters that are monitored and loaded into the Air Quality Data Base 
Management System (AQDBMS). This TI is referenced from SOP 3350, Collection of Ambient 
Air Quality and Meteorological Monitoring Data, and SOP 3450, Ambient Air Quality and 
Meteorological Monitoring Data Validation. 

 
The steps taken to complete Level 0 data validation are: 
 
• Load or enter data into the AQDBMS. 
 
• Review raw data visually on a near daily basis for data collection errors and for 

details on instrument performance. 
 
• Screen the data for anomalies. 
 
• Collect and log site documentation. 

 
2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager shall oversee validation procedures to 
ensure timely and proper validation. 
 
2.2 DATA ANALYST 
 
 The data analyst shall: 
 

• Update information in the Site Configuration Table of the AQDBMS and stackplot 
configuration files as needed. 

 
• Review stackplots of raw data. 
 
• Verify Data Validation Log updates. 

 
• Update the Data Validation Log in the AQDBMS with the Level 0 validation date. 

 
• Collect digital data and load it into the database. 
 
• Blank-fill missing data as necessary. 
 
• Collect and log field documentation. 
 
• File all hardcopy documentation and maintain hardcopy site files. 
 
• Identify collection or monitoring system problems and initiate corrective actions. 
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2.3 FIELD SPECIALIST 
 
 The field specialist shall review stackplots and troubleshoot inconsistencies observed on 
the stackplots or identified by IMC staff. 
 
2.4 TECHNICAL ASSISTANT 
 
 The technical assistant shall: 

 
• Enter appropriate information into the Site Status Log. 
 
• Print out trip reports and give them to the IMC. 
 
• Print daily digital data files. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340, Information 
Management Center (IMC) Concept and Configuration for the National Park Service Gaseous 
Pollutant Monitoring Program, and SOP 3341, Air Resource Specialist’s, Inc. (ARS) Information 
Management Center (IMC) Concept and Configuration. The IMC requires the following 
hardware and software for Level 0 validation of ambient air quality and meteorological data: 
 

• IMC hardware: 
− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
 
• IMC AQDBMS software: 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 

 
4.0 METHODS 
 
 This section discusses the methods used to complete Level 0 validation of air quality and 
meteorological data (see Figure 4-1). This section contains the following eight (8) major subsections: 
 
 4.1   The Data Validation Log 
 4.2   The Site Status Log 
 4.3   Loading and Entering Data into the AQDBMS Database 
 4.4   Data Review 
 4.5   Anomaly Screening 
 4.6   Review of Raw Data Stackplots 
 4.7   Site Documentation 
 4.8   Loading Data From Other Sources 
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Figure 4-1.  General Data Collection, Validation, and Reporting Flow Diagram. 

(Specific processes may vary by monitoring network). 
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4.1 THE DATA VALIDATION LOG 
 
 The Data Validation Log is used to track the completion of each major step of the 
validation process. The master record logs the initials of the data analyst completing each 
validation step and when it occurred. The Detail Table logs the receipt of the various supporting 
documents received from the field specialist and/or site operator. See Section 4.0, Using the Data 
Validation Log, in the Air Quality Data Base Management System (AQDBMS) User’s Guide 
(ARS, 2001) for detailed instructions. 
 
4.2 THE SITE STATUS LOG 
 
 The Site Status Log is a diary of site-related events such as instrument malfunctions and 
repairs, data adjustments, calibrations, special site visits, weather episodes, etc., that may be 
relevant to data validation. A basic description of each event is entered as a record in the Master 
Table. The master record contains the site number and name, a reference number assigned by the 
program, date started and stopped fields to define the time period involved, and an affected 
parameters field to indicate which data parameters may be affected by the event.  Another field 
indicates if the event is considered to be a problem resulting in data loss or not. This field is used 
to quickly create a list of current problems found in the log. The Detail Table holds as many 
records as needed to record notes about each event. Normally, a master record will have at least 
one detail record. Entries can be added, modified, or deleted in both the Master Table and the 
Detail Table. See Section 5.0, Using the Site Status Log in the Air Quality Data Base 
Management System (AQDBMS) User’s Guide (ARS, 2001) for detailed instructions. 
 
4.3 LOADING AND ENTERING DATA INTO THE AQDBMS DATABASE 
 
 Data are collected daily via modem and stored in computer files as explained in TI 
3350-4000, Collection of Ambient Air Quality and Meteorological Monitoring Data via Modem. 
Flags applied to the data by the dataloggers are also stored. The data and flags are then loaded 
into the AQDBMS. To correctly load data, each site currently being monitored must be properly 
defined in the AQDBMS Site Configuration Table. 
 
 Several methods exist for placing data into the Oracle database. Usually, hourly data are 
loaded in the Oracle database for all sites for one day at a time using the “ProcessOnly” 
command. Sometimes, data cannot be acquired electronically and must be hand-entered from 
daily printouts or stripcharts. As a last resort, data collected by another agency collocated at a 
site can be entered into the Oracle database. If data cannot be acquired by any means, the 
missing data are “blank-filled.” All of these methods are accomplished through commands found 
in the AQDBMS application. 
 
4.3.1 Polling Configuration 
 
 Figure 4-2 is an example polling configuration. The information in the polling 
configuration is critical for data collection and must be accurate. Errors in the polling 
information may cause the data to not be retrieved, be written to the database incorrectly, or not 
be written at all. Follow these guidelines when adding or modifying polling configurations: 
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Figure 4-2. Example Polling Configuration. 
 
 
 

• Configure new sites in the Site Specifications configuration window before 
attempting to add a new polling configuration record. 

 
• Sites can have multiple polling configurations for multiple dataloggers. 
 
• The raw data configuration and data parameter configuration must be up-to-date 

before adding or modifying a site. Attempting to configure the polling information 
with an undefined raw data format will cause an error. 

 
• If the On box is checked, a complete and accurate polling configuration is expected. 

Fill in all boxes. Check the DataView box if DataView is operating at the site. Do not 
check Retry. Check the days of the week to poll (usually all days are checked). The 
polling minutes are used to define the polling order of the sites within each hour. 
Using lower polling minutes will cause a site to be polled before other sites with 
higher polling minutes. Entering any minute value (including zero) into any hourly 
field will cause the data to be polled for that hour. 

 
• Add or delete linked raw data configurations to a site’s polling configuration from the 

Configured Data Format IDs data window. 
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4.3.2 Raw Data Formats Configuration 
 
 A raw data format configuration defines what type of data are collected by each channel 
in the datalogger and is used to relate the incoming raw data to information stored in the 
database. Figure 4-3 is an example of a raw data format for hourly data. Figure 4-4 is an example 
of a raw data format for ESC calibration sequence. 
 
 To access the raw data formats configuration, select Configuration -> Raw Data 
Formats from the Configuration frame. Then select an abbreviation from the Select Site 
drop-down list box or add a new record. 

 
Figure 4-3.  Example Raw Data Format for Hourly Data. 

 

 
Figure 4-4.  Example Raw Data Format for ESC Calibration Sequence. 
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 When configuring raw data formats, follow these guidelines: 
 

• For hourly data collected on dataloggers, the Data Field and Data Label columns must 
reflect what the datalogger is providing in the raw data. (The Data Field column maps 
to the channel number). 

 
• The collected data type must already exist in the data parameter configuration. If it 

does not exist, it will not be available in the Par Code drop-down list box and cannot 
be used. In this case, a new data parameter is being defined and must be added to the 
Data Parameters configuration before continuing. 

 
• For calibration data collected on dataloggers: 
 

− The Data Field column should contain 0. 
 
− The Data Label column must contain an appropriate label for the calibration data 

type (SPAN, PREC, or ZERO). 
 
− The Par Code column must contain the appropriate primary parameter name code 

rather than a specific parameter code (i.e., “O3” not “O3-10”). The data loading 
program assigns the correct par code by querying the hourly data. 

 
− The Code Field, Code Exp, Cal Type, and Cal Val Type columns tell the data 

loading program where in the reformatted cal file to look for the data. 
 
− Calibration configurations are not straightforward. Seek the help of the database 

administrator if a new configuration is required. 
 

• To add a new format ID, click the New Format button to show a blank configuration 
interface. 

 
4.3.3 Using Process Only 
 
 The “Process Only” command loads hourly data for a given day for currently monitored 
sites from ASCII files (such as BIBE0601A.2000R for Big Bend National Park June 2000) into 
the database. Zero, span, and precision check data are also extracted from ASCII files. The 
ASCII files must reside in the \\ARSNW1\vol4\project\IMC\ESC_sitecall directory. The program 
also writes to a message file in this directory that can be viewed in any text editor. 
 
 To run Process Only: 
 

• Copy the ASCII files to the \\ARSNW1\vol4\project\IMC\ESC_sitecall directory. 
 
• From the Polling menu, click Process Only. 
 
• Type in the date in m/d/yy format (that is 6/1/97 or 06/01/97 for June 1, 1997) and 

then press <Enter> or click OK. 
 
• Review the message file when the program finishes. 

 
 



          Number 3450-5000 
          Revision 1.6 
          Date FEB 2010 
     Page 8 of  14 
 

 

4.3.4 Correcting Data Loading Errors 
 
 The AQDBMS program writes messages to a folder indicating reasons for loading 
successes or failures of the processes. This folder is located in the \\ARSNW1\vol4\project\ 
IMC\ESC_sitecall\logs directory and can be viewed in any text editor. The folder contains error 
(.err) and message logs (.logs) files. Examples of possible messages and actions are: 
 
 Message: Data for BIBE 06/01/97 loaded into database. 
 Action: None. 
 

Message: Full scale in datalogger column 8 does not match full scale column 8 in 
site configuration. 

Action: Modify the site’s site configuration record to match the full scale value of 
column 8 to the column 8 full scale header in the ASCII file. (Refer to 
Section 4.3.1, Polling Configuration). 

 
4.3.5 Blank-Filling Data 
 
 To blank-fill data: 
 

• Select the site to validate. 
 
• Enter the Start Date/Time of the data set to work on. 
 
• Enter the End Date/Time of the data set to work on. 
 
• Click the Get ParCodes button. The program queries the database and returns all the 

parameter codes found for the selected site and period in the list box. 
 
• Check the blank fill box. 
 
• Check the All box and click Get ParCodes to retrieve a list of all parameter codes. 

Select the parameter codes to be blank-filled for the selected site and time period. 
-or- 

Check the pattern date and enter a date that contains the parameter codes that need to 
be blank-filled for the selected period. 

 -or- 
Enter an end date just beyond the period of time to be blank-filled that contains all 
parameter codes that need to be blank-filled. Click the Get Par Codes button and 
highlight all parameters listed. 

 
• Select a code from the Validation Code drop-down list box. 
 
• Click the Apply Code button. Data will be blank-filled with a value of “-999” in the 

raw value and validated value fields, the selected code in the validation code field, 
and a “B” in the source code field. NOTE: The program will not overwrite existing 
data. When the process is complete, the number of blank-filled rows will be indicated 
in the process box. 
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To display the data grid: 
 
• Select the site to validate. 
 
• Enter the Start Date/Time of the data set to work on. 
 
• Enter the End Date/Time of the data set to work on. 
 
• Click the Get ParCodes button. The program queries the database and returns all the 

parameter codes found for the selected site and period in the list box. 
 
• Select the parameter code to display. NOTE: If more than one parameter code is 

selected, only data for the first code will be displayed. 
 
• Click the 24x31 button. The data will be displayed in a grid of 24 hours across by 

days down (optimally one month). For each data point, if any code other than a “V”, 
“VA”, or “VZ” exists in the validation code field, the code will be displayed in red. 
Otherwise, the value found in the validated value field is displayed. 

 
• Click the X button to close the window and return to the validation window. 
 

4.4 DATA REVIEW 
 
 Data are typically collected via modem and stored in ASCII files (see TI 3350-4000, 
Collection of Ambient Air Quality and Meteorological Monitoring Data via Modem). Data flags 
generated by the dataloggers are also stored. Table 4-1 is a list of datalogger flags. The data and 
flags are then loaded into the AQDBMS database and visually reviewed by the data analyst. Data 
for one site, one day, and all parameters, are displayed on the computer screen. The data in this 
window can also be sorted and filtered but cannot be edited in any way. Figure 4-5 is an example 
View Tables Monthly Data window. Datalogger data flags are automatically placed in the 
datalogger flag field. As the data proceed through the data validation process, however, all 
original datalogger flags are replaced by permanent validation codes. 
 

Table 4-1  
 

   ESC 8816 Datalogger Data Flags1 

 
Flag          Description 
P Power failure 
D Channel Disabled/Off-line 
B Bad status 
C Calibration 
M Maintenance 
+ Maximum exceeded 
- Minimum exceeded 
> Some missing data, but meets requirement for valid average 
< Does not meet requirement for valid average 
H High-high alarm threshold exceeded 

     1  These flags are replaced by permanent validation 
         codes later in the validation process. 
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Figure 4-5.  Example View Tables Monthly Data Window. 
 
 
 To view the Monthly Data window onscreen: 
 

• Select View Data Tables from the Data Collection and Configuration frame. 
 
• Select a site from the Site drop-down box. 
 
• Select a month and year to view from the Month and Year drop-down boxes. 
 
• Select the table type (AQMet or AQCal) from the Table Type drop-down box. 
 
• Click the Retrieve button. 

 
To sort or filter data in the Monthly Data window: 
 
• Select View Data Tables from the Data Collection and Configuration frame. 
 
• Select a site from the Site drop-down box. 
 
• Select a month and year to view from the Month and Year drop-down boxes. 
 
• Select the table type (AQMet or AQCal) from the Table Type drop-down box. 
 
• Click the Retrieve button. 
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• Right-click anywhere within the data window. 
 
• Select Filter or Sort from the pop-up menu. A dialog box is displayed. Follow the 

dialog box instructions to apply filter or sorting options. Click the Help button to 
access specific help on the dialog boxes. 

 
4.5 ANOMALY SCREENING 
 
 After data for a site/day are verified, they are automatically screened for anomalies by an 
AQDBMS program. This program applies anomaly flags (Level 0 validation codes). These flags 
are added to any datalogger flags that were loaded with the raw data from the datalogger. The 
screening program uses values stored in the AQDBMS Screening Ranges Table. Figure 4-6 
shows example records from this table. It contains the screening ranges for each current site and 
parameter code, which allows each screening element to be defined independently from the 
other. Each record contains the following information fields: 
 

• Minimum expected value 
 
• Maximum expected value 
 
• Minimum rate of change 
 
• Minimum rate of change hours 
 
• Maximum rate of change 
 
• Maximum rate of change hours 
 
• Zero adjust value (does not apply to all parameters) 
 
• Maximum adjust value (does not apply to all parameters) 

 
 To manually screen the data for anomalies, click the Screen button. The program looks 
up acceptable ranges of values in the Screening Ranges Table and flags anomalies. The program 
also compares the values of certain parameters and applies flags as needed. Table 4-2 is a list of 
anomaly flags. The program stops and a message is displayed if screening ranges have not been 
defined for a site/parameter combination. In this case, request that the data analyst make 
appropriate changes to the Screening Ranges Table, as described in SOP 3650, Maintenance 
Responsibilities for the Ambient Air Quality Data Base Management System (AQDBMS). After 
the data analyst makes the changes, run the screening program again. 
 
 After screening, the data analyst notifies the field specialist if any of the following are true: 
 

• Data for any parameter are at a full scale or zero scale values for an uncommonly 
long time. This indicates an instrument may have been left in zero or span mode 
inadvertently. 
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Figure 4-6.  Example Records in the Screening Ranges Table.  
 

 
Table 4-2 

 
Anomaly Screening Flags 

 
Flag Description 
XV > the maximum value in the Screening Ranges Table. 
DT Dewpoint value is >  2.5)C above the temperature. 
NR Rate-of-change < minimum value in the Screening Ranges Table. 
NV < minimum value in the Screening Ranges Table. 
WS Scalar wind speed > Vector wind speed - generated by the screening program 
IM Set in VWS, VWD, and SDWD when SWS < minimum expected (NV) 
XR Rate-of-change > the maximum value in the Screening Ranges Table. 
TH Data invalid for ozone when station temp is > 30.5)C. 
TL Data invalid for ozone when station temperature < 19.5)C. 
VM Valid but the validated value has been adjusted for the max value by the 

screening program based on the max_adj, max_adj_to, and max_val fields of 
the Screening Ranges Table. 

VZ Valid but the validated value has been adjusted for zero by the screening 
program based on the zero adjustment value in the Screening Ranges Table.  
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• Daily calibration data (zero and span values from the analyzer) are not within the 
expected range. Zero values should be within ± 1% of full scale of the instrument and 
span values within ± 10% of the calibrator’s corresponding values. In this case, the 
field specialist must be notified as soon as possible so the analyzer can be calibrated 
in the field. 

 
• Other unusual and noteworthy data flags that would call attention to either a needed 

repair of an instrument or correction of a condition by the site operator. 
 

 Once the data have been verified, screened, and all problems reported, the data are moved 
to the permanent database. Corrective action is initiated to resolve any noted inconsistencies and 
the problem and actions are entered in the AQDBMS Site Status Log.  
 
4.6 REVIEW OF RAW DATA STACKPLOTS 
 

A stackplot may include single or multiple user-selected parameters on line or bar graphs 
plotted against time on the X-axis. Up to 18 parameters may be plotted on up to 9 separate 
graphs (1 or 2 parameters per graph) in a stack. Temporal data variations are then easy to 
compare. Stackplots are used throughout the validation process. Raw data are graphed on 
stackplots on a weekly basis for each site for the following time periods each month: 

 
• Days 1 – 7 
 
• Days 8 – 15 
 
• Days 16 – 23 
 
• Days 24 – end of month 

 
One copy of each plot is generated and is promptly forwarded to all data analysts and 

field specialists for examination. Problems not detected up to this point in the validation process 
are entered into the Site Status Log and a field specialist is notified for resolution of the problem. 
Comments regarding the data are handwritten on the plots. This copy is then filed in a temporary 
file box in order to receive further comments later in the validation process. For instructions on 
running the stackplot graphics program, see the Air Quality Data Base Management System 
(AQDBMS) User’s Guide (ARS, 2001). 
 
4.7 SITE DOCUMENTATION 
 
 Site operators are required to complete station checklists in DataView during every 
station visit. The station checklists are downloaded and stored in the AQDBMS. At times, 
manual checklists must be completed by the site operators and faxed to the IMC. When this is 
necessary, the manually collected information is filed with other site documentation in the IMC. 
 
 The documentation received is logged in the AQDBMS Data Validation Log. A log 
record is created for each site/month and documentation items added to the detail log noting the 
date received any comments. Level 0 validation is complete for a site/month on the date all 
possible data for the month has been collected and loaded into the AQDBMS database and all 
site documentation has been received. This date is entered in the AQDBMS Data Validation Log. 
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4.8 LOADING DATA FROM OTHER SOURCES   
 
 As discussed in SOP 3350, Collection of Ambient Air Quality and Meteorological 
Monitoring Data, if data cannot be collected electronically, they are hand-entered from daily 
summaries received from the site. Typically, if a valid daily summary is available and the time 
on it is correct and distinguishable, the data are reduced onto a missing data form and then 
manually entered into the database as raw data. To manually enter data from a daily summary: 
 

• Open the Data Validation data window. 
 
• Click on the Source Code field of the raw needing a hand-entered raw value. 
 
• Enter the source code that will allow a hand-entered value (D). 
 
• Click on the Raw Val field and enter the new value. Note: Only raw values of –999 

should be replaced in this manner. Use the value adjust method for other raw values. 
 
 If data are unavailable from all other sources, data collected by another agency collocated 
at a site can be entered into the Oracle database. This “third-party” data should only be used if 
similar instruments at similar heights were used to collect it. In this case, the data analyst verifies 
the suitability of the data, acquires digital data from the third-party, then notifies the database 
administrator who writes a custom data loading program and loads the data. As the data are 
loaded, an appropriate source code is assigned to define its source. Since each case is unique, 
there are no additional standard steps for loading the data. 
 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2001, Air Quality Data Base Management System 
          (AQDBMS) User’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps taken by Air Resource Specialists’, Inc. 
(ARS) Information Management Center (IMC) to complete Preliminary validation of ambient air 
quality and meteorological data. These steps apply to all ambient air quality and meteorological 
parameters that are monitored and loaded into the Air Quality Data Base Management System 
(AQDBMS). This TI is referenced from SOP 3350, Collection of Ambient Air Quality and 
Meteorological Monitoring Data, and SOP 3450, Ambient Air Quality and Meteorological 
Monitoring Data Validation. 

 
This TI presents the detailed steps used to ensure high quality Preliminary data validation 

of ambient air quality and meteorological data. Data for a site/month must be at Level 0 validation 
before beginning Preliminary validation. The Monthly Validation Checklist is used as a guide for 
the Preliminary validation procedure. The checklist identifies the major steps taken during 
Preliminary validation and provides a record of the date each step was completed and the initials of 
the analyst completing it. Preliminary data validation is accomplished by the following: 

 
• Determining if each data value meets validation acceptance criteria by: 

 
- Reviewing site documentation including daily summaries, field station logs,  
 trend-graphs, and edit logs. 
- Reviewing datalogger and anomaly screening flags. 
- Reviewing the AQDBMS Site Status Log. 
- Recording and reviewing comments on the raw data stackplots. 
- Reviewing precision check and calibration data. 
- Reviewing any recent maintenance trip reports to verify that all instrumentation is 
 operating within specifications. 
- Entering and reviewing any audit report data received for the site/month into the 
    AQDBMS database. 
- Reviewing SSRF forms to check for flow leaks. 

 
• Using the Auto Validation tool in the AQDBMS to automatically apply validation 

codes. 

• Reviewing validation codes and, if necessary, adjusting values in the AQDBMS 
database. 

• Reviewing plots of the validated data compared to the raw data. 

• A group plot review that includes input from the sponsoring organization, air quality 
specialists, and field specialists to resolve all questionable validation issues. 

• Making necessary validation code changes in the AQDBMS based on the group plot 
review discussion. 

• Updating the AQDBMS Data Validation Log. 

• Reviewing validated data stackplots and other output. 
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2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager shall oversee validation procedures to 
ensure timely and proper validation. 
 
2.2 SPONSORING ORGANIZATION 
 
 Staff from the sponsoring organization, at their discretion, shall participate in the monthly 
plot review and respond to questions posed during the plot review. 
 
2.3 DATA ANALYST 
 
 The data analyst shall: 
 

• Update the Data Validation Log in the AQDBMS with the Preliminary validation date. 
• Review validation codes applied by the Auto Validation tool. 
• Review and annotate stackplots using field documentation and Auto Validation codes. 
• Review plots of the validated data to check for errors. 
• Review annotated stackplots with the field specialist. 
• Participate in the monthly plot review and respond to questions posed during the plot 

review. 
 
2.4 FIELD SPECIALIST 
 
 The field specialist shall review data issues with the IMC staff before the plot review. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340, Information 
Management Center (IMC) Concept and Configuration for the National Park Service Gaseous 
Pollutant Monitoring Program, and SOP 3341, Air Resource Specialist’s, Inc. (ARS) Information 
Management Center (IMC) Concept and Configuration. The IMC requires the following 
hardware and software for Preliminary validation of ambient air quality and meteorological data: 
 

• IMC hardware: 
− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
• IMC AQDBMS software: 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 
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4.0 METHODS 
 
 Data for a site/month must be at Level 0 validation before beginning Preliminary 
validation (see Figure 4-1). The Monthly Validation Checklist, shown in Figure 4-2, is used as a 
guide for the Preliminary validation procedure. The checklist identifies the major steps taken 
during Preliminary validation and provides a record of the date each step was completed and the 
initials of the analyst completing it. This section discusses the methods used to complete 
Preliminary data validation of air quality and meteorological data. This section contains the 
following six major subsections: 
 
 4.1  The Data Validation Log 
 4.2  The Site Status Log 
 4.3  Validation Acceptance Criteria 
 4.4  Applying Validation Codes and Other Values into the AQDBMS Database 
 4.5  Group Plot Review 
 4.6  Reviewing Validated Data Stackplots and Other Output 
 
4.1 THE DATA VALIDATION LOG 
 
 The Data Validation Log is used to track the completion of each major step of the 
validation process. The master record logs the initials of the data analyst completing each 
validation step and when it occurred. The log entry for a particular site/month must exist before 
data can be edited in the Data Validation window. The validation log also provides a summary of 
the decision-making process that went into validating the data. The data analyst provides 
justification for the validation codes that were applied to the data. See Section 4.0, Using the 
Data Validation Log, in the Air Quality Data Base Management System (AQDBMS) User’s 
Guide (ARS, 2012) for detailed instructions. 
 
4.2 THE SITE STATUS LOG 
 
 The Site Status Log is a diary of site-related events such as instrument malfunctions and 
repairs, data adjustments, calibrations, special site visits, weather episodes, etc., that may be 
relevant to data validation. A basic description of each event is entered as a record in the Master 
Table. The master record contains the site number and name, a reference number assigned by the 
program, date started and stopped fields to define the period of time involved, and an affected 
parameters field to indicate which data parameters may be affected by the event. Another field 
indicates if the event is considered to be a problem or not. This field is used to quickly create a 
list of current problems found in the log. The Detail Table holds as many records as needed to 
record notes about each event. Normally, a master record will have at least one detail record. 
Entries can be added, modified, or deleted in both the Master Table and the Detail Table. See 
Section 5.0, Using the Site Status Log, in the Air Quality Data Base Management System 
(AQDBMS) User’s Guide (ARS, 2012) for detailed instructions. 
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Figure 4-1. General Data Collection, Validation, and Reporting Flow Diagram.  

(Specific processes may vary by monitoring network). 
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Figure 4-2. The Monthly Validation Checklist. 
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4.3 VALIDATION ACCEPTANCE CRITERIA 
 
 Validation acceptance criteria and the methods for determining if a data value meets the 
criteria are usually related to one of the following events or limitations (specific criteria for each 
parameter is presented in Table 4-1) : 
 

• Data are out of instrument specifications. 

• Data exceed minimum or maximum expected value. 

• Data exceed minimum or maximum expected rate-of-change. 
• Station temperature is out of specified limits. 

• Data are affected by calibration check. 

• Zero and span check data are within specified limits. 

• Less than 45 minutes of data are available (hourly averaging period). 

• Instrument or datalogger was affected by acts of nature. 

• Instrument or datalogger was affected by power failure. 

• Data capture  was affected by a datalogger failure. 

• Data were affected by operator maintenance or calibration check. 

• Data were affected by site operator error. 

• Data were affected by instrument malfunction or failure. 

• Data were below lower detectable limit. 
 

 For all gas parameters the monthly calibration plot is reviewed. This plot displays the 
results of the daily automated zero, precision, and span. Zero values should be within  2% of 
full scale (ozone and carbon monoxide) or  3% (oxides of nitrogen and sulfur dioxide) of the 
instrument and span values within  7% (ozone) or ± 10% (all other gases) of the calibrator’s 
corresponding values. Data can be zero-adjusted when zeros are outside ± 2% of full scale, but 
are invalidated when beyond ± 3% of full scale. 
 
 To determine if a data value meets validation acceptance criteria, the data analyst reviews 
the site documentation and weekly stackplots for the site/month being validated, then writes any 
comments on the plots that affect validation. Comments on plots are based on information from 
the site documentation, communication with field personnel and site operators, datalogger flags, 
and anomaly screening flags and reflect the codes in the AQDBMS as applied using the Auto 
Validation tool. A commented plot is shown in Figure 4-3. The following guidelines are used 
when commenting plots: 
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Table 4-1 
 

Validation Acceptance Criteria for the Gaseous and Meteorological Parameters 
 

Parameter Calibration Method Criteria Validation Criteria 
(Data Reasonableness) 

Temperature 
(Climatronics or RM Young) 

Three water baths and certified 
thermometer 
(0ºC, 20 to 30ºC, 30 to 50ºC) 
 

Max error ≤ ±0.5°C from actual 

Temperature (Rotronics) 
 

Temperature transfer standard Max error ≤ ±1.5°C 

Temperature and 
Temperature Difference 
(Climatronics or RM Young) 
 

Three water baths 
(0ºC, 20 to 30ºC, 30 to 50ºC) 
 

Max error ≤ ±0.5°C 

Shelter Temperature 
 

Temperature transfer standard Max error ±1.5°C 

Relative Humidity RH sensor transfer standard 
 

Max error ≤ ±10.0% 

Wind Speed Selectable speed rpm motor Max error ≤ ±0.5 m/s for values <5.0 m/s 
≤ ±5.0% for values >5.0 m/s 
 

Wind Speed Starting Threshold Weighted torque disk Max error ≤ 0.4 g-cm (Climatronics) 
≤ 0.5 g-cm (RM Young) 
 

Wind Direction Alignment Solar Azimuth, Precision 
compass, USGS map 
 

Max error ≤ ±5° from true degrees 

Wind Direction Linearity 
 

45º increment inputs Max error ≤ ±5° 

Wind Direction Starting 
Threshold 
 

Weighted torque disk Max error ≤ 8 g-cm (Climatronics) 
≤ 11 (RM Young) 

Precipitation (Tipping Bucket) Addition of known water volume 
 

Max error ≤ ±10.0% 

Precipitation (Weighting Gauge) 
 

Addition of certified weights, 
 or known water volume 
 

Max error ≤ ±10% or ≤ ±0.10 inches 

Wetness Sensor Mist with distilled water; and 
apply test resistance (230-240 
Ohms) 

Response Confirmed sensor response as 
necessary to correct readings to full 
scale of 100 (equivalent to 1.0VDC) 
 

Solar Radiation Collocated transfer standard 
 

Average error 
 

≤ ±10% 

Barometric Pressure 
 

Collocated transfer standard Max error ≤ ±3.0 mmHg or ±4.0 mb 

Gas Max difference Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Max error ≤ ±10.0% of actual 

Gas Average difference Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Average error ≤ ±10.0% 

Gas Slope (m) Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Actual 0.900 ≤ slope ≤ 1.100 

Gas Intercept (b) Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Actual ≤ ±5.0 ppb from actual for O3 and SO2 
≤ ±5.0 ppm for CO 

Gas Correlation (r) Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Actual >0.9900 

Data Acquisition System Time 
 

Compare with NIST time Max error ≤ ±2 minutes 

Data Acquisition System Voltage 
 

Known voltage inputs Max error ≤ ±0.003 VDC 

Meteorological Translator Cards Compare with calibrated 
voltmeter 

Max error ≤ ±0.005 VDC of designated zero 
value; and ≤ ±0.1% of span 
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Figure 4-3. Example of a Commented Stackplot.  



          Number 3450-5010 
          Revision 2.0 
          Date MAR 2012 
     Page 9 of  18 
 

 

• Comments are written within the outline of the day of the affected data and in close 
proximity to the data point affected. 

• Comments include the hours affected, the parameters affected, and the corresponding 
invalid code which provides the reason for invalidating the data. 

• Explanations of valid but unusual data are also included. 

• Data points invalidated by the Auto Validation tool are noted on the stackplot when 
appropriate. 

• Site visits are identified at the top of the plot above the corresponding date with date, 
time, and duration of the visit. 

• Normal actions that occur during a site visit and do not invalidate data are also 
identified on the plot (for example, meteorological instrument checks that last less 
than 15 minutes). This indicates that a required maintenance check was completed 
and further establishes validity of the data. 

 
 Precision check, calibration, and audit data are reviewed during this step in the 
Preliminary validation process.  
 
 After commenting the weekly stackplots for a site/month, the AQDBMS Data Validation 
Log is updated by entering the date stackplot comments are completed with the analyst’s initials 
into the log record for the site/month. Validation notes are also entered into this log. 
  
4.4 APPLYING VALIDATION CODES AND OTHER VALUES INTO THE 

AQDBMS DATABASE 
 
 During the Preliminary validation process, validation codes are applied in the database. 
The codes entered are guided by the datalogger and anomaly flags that are already in the 
database. A validation code is entered for each data point in a field separate from the datalogger 
and anomaly screening flags. Table 4-2 is a list of datalogger and anomaly screening flags and 
most common analyst actions taken based on the flags. Table 4-3 is a list of validation codes and 
conditions. 
 
 The Data Validation interface of the AQDBMS is used to apply validation codes to the 
data via two windows. The initial window provides a way to apply codes to all data points,  list 
missing data, and blank-fill data within a selected set of data. The second window displays a 
tabular data window of the selected data and provides a way to apply validation codes to selected 
data points within a window. It provides an interface for sorting and applying specific filters to 
the data and for hand entering data.  
 
 To open the Data Validation window, select Validate from the AQ and Met Processing 
frame. 
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Table 4-2 
 

Analyst’s Actions Based on Datalogger and Anomaly Screening Flags 
 

Flag Type Description Action 
- Datalogger Low alarm Investigate 

# Datalogger Insufficient data Investigate 

* Datalogger Out of calibration Investigate 

/ Datalogger Rate-of-change alarm  Investigate 

\ Datalogger Rate-of-change alarm Investigate 

^ Datalogger High alarm Investigate 

_ Datalogger Low alarm Investigate 

< Datalogger Missing data Invalidate with PF or RF 

B Datalogger Bad status Investigate 

C Datalogger Calibration Invalidate with ZS, PC, CA, SC, PA,   or MT 

D Datalogger Channel disabled/off-line Investigate; can be valid or invalid 

P Datalogger Power failure Investigate; may be erroneous or true 
power failure 

Z Datalogger Zero/span Investigate 

DT Screening  Dewpoint more than 2.5C greater than 
temperature 

Invalidate either TMP or DDT with IM 

IM Screening  Set in VWS, VWD, and SDWD when SWS           
< min. expected (NV) 

Invalidate keeping IM 

NR Screening  Rate-of-change less than minimum value in the 
Screening Ranges Table 

Investigate 

NV Screening  Less than minimum value in the Screening  
Ranges Table 

Investigate 

TH Screening  Ozone data suspect  when station temp is  > 32C Investigate 

TL Screening Ozone data suspect when station temp is  < 18C Investigate 

VM Screening Valid but the validated value has been adjusted 
for the max value by the screening program 
based on the max adj, max adj to, and max val 
fields of the Screening Ranges Table 

None 

VZ Screening Valid but the validated value has been adjusted 
for zero by the screening program based on the 
zero adjustment value in the Screening Ranges 
Table 

None 

WS Screening  Vector wind speed greater than Scalar wind 
speed – generated by the screening program 

Invalidate VWS, VWD, SDWD with IM 

XR Screening 
program 

Rate-of-change greater than the maximum value 
in the Screening Ranges Table 

Investigate 

XV Screening 
program 

Greater than the maximum value in the Screening 
Ranges Table 

Investigate 

 



          Number 3450-5010 
          Revision 2.0 
          Date MAR 2012 
     Page 11 of  18 
 

 

Table 4-3 
 

Validation Codes 
 

 Code Description 
BM Begin monitoring. For a new site or instrument, place in only one hour before valid data. 

CA Multipoint calibration of an AQ instrument, > 15 min/hour. 

EM End monitoring. When a site or instrument is discontinued, place in only one hour after valid data. 

IM Instrument malfunction. Problem was not discovered until after data had been collected, instrument failure or 
other problem was not identified until the data validation occurred, may or may not be related to a problem 
listed on the status board. 

IN Acts of nature. 

IW Instrument warm-up. After the instrument was off or a power failure long enough to cause the instrument to go 
through a warm-up cycle. Some indicators:  dpt > temp, noisy signal or drift shown on chart. Usually only used 
for 1 – 2 hours. 

LI Local interference. Human interference directly or indirectly that was local and not under the control of the 
operator. Examples: dust, particulates, construction. 

MT Maintenance. Someone on-site actively attempting repairs or doing preventive maintenance (changing chart 
paper, replacing instrument parts). Can be the site operator or repair person or remote activation or 
programming of the datalogger. 

NA Monitoring out for the month, before or after an analyzer is placed at a site, no intent of collecting data, unable 
to calculate value. 

OE Mistake by operator or anybody else at the station that leads to a loss in data. Example.: switches left in 
incorrect positions after repairs or calibrations, lines not returned to the manifold after an audit, open manifold 
ports, etc. 

OR Instrument in process of being repaired, often off-site. Incapable of getting good values, more than 1-hour of 
data, problem identified on site & status log or log book record would normally be present. MT must follow. 
Often a cal must follow. 

OS Signal is off the top of the chart, data is presumed good. 

PA Calibration on-site by an external agency person. May be several hours. (Gaseous parameters only.) 

PC Precision Check. Normally once per week. 

PF Power failure  15 minutes/hour, instrument warm-up and data loss at the top of the hour may also be an 
issue (RF). 

RF Datalogger system fails and chart record is unavailable. 

SA External agency person on-site which leads to data loss (Met parameters only.) 

SC Use when both a precision check and a zero/span check are done within the same hour.  

TH Data invalid for ozone when station temp is > 32 C. 

TL Data invalid for ozone when station temperature < 18 C. 

TO When time is off by more than 5 minutes. 

V Valid Value. 

VA Valid value, but the validated value has been adjusted from the raw value by the data analyst. The control 
value field must contain the offset. 

VM Valid but the validated value has been adjusted for the max value by the analyst based on the parameter 
criteria. 

VZ Valid but the validated value has been adjusted for zero. 

ZS Invalid data for the hour if zero/span takes longer than 15 minutes or the hour. 
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4.4.1 The Initial Data Validation Window 
 
 Validation codes may be applied automatically by using the “Auto Validation” button in 
the Data Validation window, or they may be applied manually by the data analyst when there is a 
need to override the codes applied by the database. When entering the data validation interface, 
the initial Data Validation window can be used to list missing data, blank-fill data, auto validate 
data, display a data grid, or enter the interface to manually apply validation codes.  This window 
is shown in Figure 4-4. 
 

 
Figure 4-4. The Initial Validation Window.  

 
 
 To apply validation codes manually: 
 

• Select the site to validate. 

• Enter the Start Date/Time of the data set to work on. 

• Enter the End Date/Time of the data set to work on. 

• Click the Get ParCodes button. The program queries the database and returns all the 
parameter codes found for the selected site and period in the list box. 
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• Select (highlight) one or more parameter codes in the list box. 

• Select a validation code from the Validation Code drop-down box. 

• Click the Apply Code button. The process window displays a message listing the 
number of updated records. 

Important Note: When using this method, validation codes are committed to the 
database table immediately. This method should only be used for power failures or 
when blank-filling data (see instructions on blank-filling below). 

 
 To apply validation codes automatically: 
 

• Select the site to validate. 

• Enter the Start Date/Time of the data set to work on. 

• Enter the End Date/Time of the data set to work on. 

• Click the Get ParCodes button. The program queries the database and returns all the 
parameter codes found for the selected site and period in the list box. 

• Select (highlight) one or more parameter codes in the list box. 

• Select the Auto Validation button and the database applies a validation code to each 
record selected. 

 
To search for missing data: 
 
• Select the site to validate. 

• Enter the Start Date/Time of the data set to work on. 

• Enter the End Date/Time of the data set to work on. 

• Click the Get ParCodes button. The program queries the database and returns all the 
parameter codes found for the selected site and period in the list box. 

• Select (highlight) one or more parameter codes in the list box. 

• Click the List Missing Data button. The cursor changes to an hourglass. When the 
cursor changes back to a pointer, the process has completed. Missing data within the 
selected data set will be listed in the process box. 

 
  To blank-fill data: 
 

• Select the site to validate. 

• Enter the Start Date/Time of the data set to work on. 

• Enter the End Date/Time of the data set to work on. 

• Click the Get ParCodes button. The program queries the database and returns all the 
parameter codes found for the selected site and period in the list box. 

• Check the blank fill box. 
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• Check the All box and click Get ParCodes to retrieve a list of all parameter codes. 
Select the parameter codes to be blank-filled for the selected site and time period. 

-or- 
Check the pattern date and enter a date that contains the parameter codes that need to 
be blank-filled for the selected period. 

-or- 
Enter an end date just beyond the period of time to be blank-filled that contains all 
parameter codes that need to be blank-filled. Click the Get Par Codes button and 
highlight all parameters listed. 
 

• Select a code from the Validation Code drop-down list box. 

• Click the Apply Code button. Data will be blank-filled with a value of “-999” in the 
raw value and validated value fields, the selected code in the validation code field, 
and a “B” in the source code field. NOTE: The program will not overwrite existing 
data. When the process is complete, the number of blank-filled rows will be indicated 
in the process box. 

 
To display the data grid: 

 
• Select the site to validate. 

• Enter the Start Date/Time of the data set to work on. 

• Enter the End Date/Time of the data set to work on. 

• Click the Get ParCodes button. The program queries the database and returns all the 
parameter codes found for the selected site and period in the list box. 

• Select the parameter code to display. NOTE: If more than one parameter code is 
selected, only data for the first code will be displayed. 

• Click the 24x31 button. The data will be displayed in a grid of 24 hours across by 
days down (optimally one month). For each data point, if any code other than a “V”, 
“VA”, “VM”, or “VZ” exists in the validation code field, the code will be displayed 
in red. Otherwise, the value found in the validated value field is displayed. 

• Select the Print button to print a copy of the data grid. 

• Click the X button to close the window and return to the validation window. 
 

4.4.2 The Data Validation Data Window 
 

The second window available for data validation provides an interface for applying 
validation codes to specific, individually selected data points when the data analyst needs to 
override the codes applied during the Auto Validation process. Data from all columns of the 
database table are displayed in tabular form as shown in Figure 4-5. The data window data can 
be sorted and/or filtered. The interface also provides a means for re-screening data and for hand 
entering data values when necessary. 
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Figure 4-5. Example Data Validation Data Window.  

 
 To open the Data Validation data window: 
 

• In the Initial Data Validation window, select the site to validate. 
• Enter the Start Date/Time of the data set to work on. 
• Enter the End Date/Time of the data set to work on. 
• Click the Get ParCodes button. The program queries the database and returns all the 

parameter codes found for the selected site and period in the list box. 
• Select (highlight) one or more parameter codes in the list box. 
• Click the data table picture button. The Data Validation data window is opened and 

displays the selected set of data in a tabular data window. 
 

To apply validation codes: 
 
• Open the Data Validation data window. 
• Highlight the data points to apply the code to. 
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• Select a code from the Validation Code drop-down list box. 
• Click the Apply Code button. 
 
To sort and filter data: 
 
• Open the Data Validation data window. 

• Right-click anywhere in the data window. 

• Select Filter or Sort from the pop-up menu. A dialog box is displayed. Follow the 
dialog box instructions to apply filter or sorting options. Click the Help button to 
access specific help on the dialog boxes. 

 
4.4.3 Entering Control Values 
 
 Control values can be entered in the Data Validation data window. Control values are 
arithmetic expressions that are applied to or replace raw values and result in adjusted validated 
values. The first character in the control value field must be an arithmetic operator. For example, 
if you determine that the raw data values for wind speed are 10 m/s less than they truly were 
enter +10 in each control value field. This action will add 10 to the raw data values and place the 
result in the validated data fields. When the control value field is used, the final data validation 
code must equal “VA” which means valid, but value adjusted. 
 
 Acceptable operators for control values: 
 
 Operator Result 
 +  adds the control value to the raw value 
 -  subtracts the control value from the raw value 
 *  multiplies the raw value by the control value 
 /  divides the raw value by the control value 
 =  substitutes the control value for the raw value 
 
 To enter control values: 
 

• Open the Data Validation data window. 

• Select (highlight) the data points to apply the VA code to. Note this is a multi-select 
data window and rows can be selected with shift-click and ctrl-click. 

• Select the VA code from the Validation Code drop-down list box. 

• Enter the value to apply in the Control Value box. 

• Click the Apply Code button. 
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4.4.4 Replacing Raw Values 
 
 On rare occasions, it may be necessary to replace raw data values in the database.  
 
 To hand-enter a raw value: 
 

• Open the Data Validation data window. 

• Click on the Source Code field of the raw needing a hand-entered raw value. 

• Enter a source code that will allow a hand-entered value (C, P, U, or D). 
• Click on the Raw Val field and enter the new value.  

 
4.4.5 Screening Data in the Data Validation Window 
 
 Usually, data are screened for anomalies during the data loading process. When 
necessary, however, screening can also be done in the Data Validation data window. To screen 
data: 
 

• Open the Data Validation data window. 

• Click the Screen button. The anomaly screening program will apply the screening flags. 
 
4.4.6 The Data Validation Log 
 
 The Data Validation Log is used to track the completion of each major step of the 
validation process. The master record logs the initials of the IMC staff member completing each 
validation step and when the step occurred. The Comments Table logs comments regarding data 
validation. Most of the output programs query the Data Validation Log so the correct level of 
validation can be applied to the output.  To use the Data Validation Log: 
 

• Select Logs-> Data Validation Log from the AQ and Met Processing frame. 

• Select a site from the Site drop-down box. If no records for the selected site exist, a 
“Site not Found” message is displayed. Click OK. Otherwise, the most recent Master 
Table record and related comments for the selected site are displayed. 

• Select a different month and/or year from the drop-down list boxes to display 
previous month’s records for the site. 

• Records can be added as by right-clicking and selecting Add. 
 
4.5 GROUP PLOT REVIEW 
 
 A plot review is held to review all data collected for a month. Included in the group are 
program and section managers, data analysts, field specialists, and sponsoring organization 
personnel affiliated with the project. All plots are reviewed, questions asked, maintenance issues 
discussed, and questionable validation situations resolved. Any unresolved issues are identified 
and resolved within a few days after the plot review. Problem resolutions are explained at the 
following plot review. 
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4.6 REVIEWING VALIDATED DATA STACKPLOTS AND OTHER OUTPUT 
 
 Additional tools for verifying complete and accurate entry of validation codes are 
available within the AQDBMS. The data analyst completes the following checks: 
 

• Reviews the Data Collection Statistics Table for a site/month, to quickly detect if a 
code was missed for parameters that must be validated identically and to look for 
indications of missed power failures or recorder failures. 

 
• Reviews the High Values Tables for individual pollutant parameters to detect 

calibration points inadvertently left in as valid. This is only done when necessary. 
 

• Reviews validated data stackplots to further verify that no points were missed. 
 

 All of these products can be reviewed either on screen or as printed copy. See TI 
3550-5000, Ambient Air Quality and Meteorological Monitoring Data – Weekly and Monthly 
Reporting, and TI 3550-5050, Ambient Air Quality and Meteorological Monitoring Data – 
Quarterly Reporting, for detailed instructions. 
 
 Preliminary data validation is complete after a plot review is held, validation codes for a 
site/month are entered and validated data output is reviewed. Annotated stackplots and site 
documentation are reviewed to verify that all annotations on the plots are complete and accurate. 
Codes are cross-checked by data analysts during 3rd level validation. The AQDBMS Data 
Validation Log is then updated by entering the date completed and the analyst’s initials into the 
log record for the site/month. 
 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2012, Air Quality Data Base Management System 
          (AQDBMS) User’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps taken by Air Resource Specialists’, Inc. 
(ARS) Information Management Center (IMC) for completing Final validation of ambient air 
quality and meteorological data. These steps apply to all ambient air quality and meteorological 
parameters that are monitored and loaded into the Air Quality Data Base Management System 
(AQDBMS). This TI is referenced from SOP 3350, Collection of Air Quality and Meteorological 
Monitoring Data, and SOP 3450, Ambient Air Quality and Meteorological Monitoring Data 
Validation. 

 
This TI presents the detailed steps used to ensure high quality Final data validation of 

ambient air quality and meteorological data. Data for a site/month must be at Preliminary 
validation before beginning Final validation. The Monthly Validation Checklist is used as a 
guide for the Final validation procedure. The checklist identifies the major steps taken during 
Final validation. Final data validation is accomplished by generating, reviewing, and distributing 
monthly data reports. Occasionally, validation errors will be detected after Final validation has 
been completed and post-final validation steps are taken to record the corrections. 
 
2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager shall oversee validation procedures to 
ensure timely and proper validation. 
 
2.2 DATA ANALYST 
 
 The data analyst shall: 

• Review validated stackplots. 

• Generate the monthly data report. 

• Update the Data Validation Log in the AQDBMS with the Final validation date. 
 
2.3 SITE OPERATOR 
 
 The site operator shall respond to any questions regarding site documentation or data 
events, and forward any additional comments or observations to the IMC. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340, Information 
Management Center (IMC) Concept and Configuration for the National Park Service Gaseous 
Pollutant Monitoring Program, and SOP 3341, Air Resource Specialist’s, Inc. (ARS) Information 
Management Center (IMC) Concept and Configuration. The IMC requires the following 
hardware and software for Final validation of ambient air quality and meteorological data: 
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• IMC hardware: 
− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
• IMC AQDBMS software: 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 

 
4.0 METHODS 
 
 Data for a site/month must be at Preliminary validation before beginning Final validation 
(see Figure 4-1).  The Monthly Validation Checklist, shown in Figure 4-2, is used as a guide for 
the Final validation procedure. The checklist identifies the major steps taken during Final 
validation and provides a record of the date each step was completed and the initials of the 
analyst completing it. This section discusses the methods used to complete Final data validation 
of air quality and meteorological data, and contains the following four (4) major subsections: 
 
 4.1  Review of Validated Data 
 4.2  Making Validation Code Corrections and Completing Final Validation 
 4.3  Post-Final Validation Procedures 
 
4.1 REVIEW OF VALIDATED DATA 
 
 During the Final validation process, a review of all validated data is completed by the 
IMC Manager. This is accomplished by reviewing stackplots of the raw data overlayed with  the 
validated data. These plots allow the IMC Manager to see the validated dataset as well as which 
data points were determined to be invalid. Plots are reviewed to verify that validation is complete 
and accurate. Any discrepancies found are thoroughly investigated and corrections are made if 
determined necessary. 
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Figure 4-1.  General Data Collection, Validation, and Reporting Flow Diagram. 

(Specific processes may vary by monitoring network). 
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Figure 4-2. Monthly Validation Checklist. 
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4.2 MAKING VALIDATION CODE CORRECTIONS AND COMPLETING FINAL 
 VALIDATION 
  
 After the monthly plot review and after review of the validated stackplots (see TI 
3450-5020, Ambient Air Quality and Meteorological Monitoring Data – Preliminary Validation) 
and after problems have been resolved, necessary validation code changes are made in the 
database. To make validation code changes, the Data Validation data window is used, which 
displays a tabular data window of selected data. It provides a way to hand-enter and apply 
validation codes to selected data points within a window.  
 
4.2.1 The Data Validation Data Window 
 
 The Data Validation data window provides an interface for applying validation codes to 
specific, individually selected data points. Data from all columns of the database table are 
displayed in tabular form as shown in Figure 4-3. The data window data can be sorted and/or 
filtered. The interface also provides a means for re-screening data and for hand entering data 
values when necessary. 
 
 To open the Data Validation data window: 
 

• In the Initial Data Validation window, select the site to validate. 
• Enter the Start Date/Time of the data set to work on. 
• Enter the End Date/Time of the data set to work on. 
• Click the Get ParCodes button. The program queries the database and returns all the 

parameter codes found for the selected site and period in the list box. 
• Select (highlight) one or more parameter codes in the list box. 
• Click the data table picture button. The Data Validation data window is opened and 

displays the selected set of data in a tabular data window. 
 
To apply validation codes: 
 
• Open the Data Validation data window. 
• Highlight the data points to apply the code to. 
• Select a code from the Validation Code drop-down list box. 
• Click the Apply Code button. 
 
To sort and filter data: 
 
• Open the Data Validation data window. 

• Right-click anywhere in the data window. 

• Select Filter or Sort from the pop-up menu. A dialog box is displayed. Follow the 
dialog box instructions to apply filter or sorting options. Click the Help button to 
access specific help on the dialog boxes. 
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Figure 4-3.  Example Data Validation Data Window.  

 
4.2.2 Entering Control Values 
 
 Control values can be entered in the Data Validation data window. Control values are 
arithmetic expressions that are applied to or replace raw values and result in adjusted validated 
values. The first character in the control value field must be an arithmetic operator. For example, 
if you determine that the raw data values for wind speed are 10 m/s less than they truly were 
enter +10 in each control value field. This action will add 10 to the raw data values and place the 
result in the validated data fields. When the control value field is used, the final data validation 
code must equal “VA” which means valid, but value adjusted. 
 
 Acceptable operators for control values: 
 
 Operator Result 
 +  adds the control value to the raw value 
 -  subtracts the control value from the raw value 
 *  multiplies the raw value by the control value 
 /  divides the raw value by the control value 
 =  substitutes the control value for the raw value 
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 To enter control values: 
 

• Open the Data Validation data window. 

• Select (highlight) the data points to apply the VA code to. Note this is a multi-select 
data window and rows can be selected with shift-click and ctrl-click. 

• Select the VA code from the Validation Code drop-down list box. 

• Enter the value to apply in the Control Value box. 

• Click the Apply Code button. 
 
4.2.3 The Data Validation Log 
 
 The Data Validation Log is used to track the completion of each major step of the 
validation process. The master record logs the initials of the IMC staff member completing each 
validation step and when the step occurred. The Comments Table logs comments regarding data 
validation. Most of the output programs query the Data Validation Log so the correct level of 
validation can be applied to the output.   To use the Data Validation Log: 
 

• Select Logs-> Data Validation Log from the AQ and Met Processing frame. 

• Select a site from the Site drop-down box. If no records for the selected site exist, a 
“Site not Found” message is displayed. Click OK. Otherwise, the most recent Master 
Table record and related comments for the selected site are displayed. 

• Select a different month and/or year from the drop-down list boxes to display 
previous month’s records for the site. 

• Records can be added by right-clicking and selecting Add. 
 
4.2.4 Completing Final Validation 
 
 After making validation code changes, the following steps are taken to complete Final 
validation: 
 

• The changed data are regenerated into a new stackplot data file to replace the old. 

• The validated stackplots are again reviewed; changes are made if necessary and are 
entered into the database. 

• Monthly reports are generated (see TI 3550-5000, Ambient Air Quality and 
Meteorological Monitoring Data – Weekly and Monthly Reporting, and TI 3550-5050, 
Ambient Air Quality and Meteorological Monitoring Data – Quarterly Reporting). 

• Reports are e-mailed and posted on the project Web site. 

• The Data Validation Log entry for the site/month is updated with the Final validation 
date and initials of the responsible analyst. 

• The Data Validation Log entry for the site/month is updated with the “report mailed” 
date. 
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After completing these steps, Final validation is complete and data are ready to be 
uploaded to AQS, included in data requests, and annual data summary reports. 
 
4.3 POST-FINAL VALIDATION PROCEDURES 
 
 If a validation error is found after the data are labeled as final, the following steps are taken: 
 

• The necessary changes are made in the AQDBMS database. 

• Changes made are logged in N:\project\IMC\data corrections\revalidated_yyyy.xls. 
• If the affected data have been submitted to the Environmental Protection Agency’s 

(EPA) Air Quality System (AQS) database, they must be resubmitted. 

• If the affected data have been submitted to other data depositories (e.g., CASTNet or 
other project-specific databases or Web sites), they must be resubmitted. 
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1.0 PURPOSE AND APPLICABILITY 
 

This standard operating procedure (SOP) outlines the steps of producing ambient air 
quality and meteorological data reports.  Reporting includes preparation and distribution of the 
following report products: 

• Weekly progress reports 
• Monthly and quarterly data reports 
• Semiannual contract status reports 
• Annual data reports 
• Monthly ozone “hit list” during the summer ozone season 

 
Not all reports will be produced for every project. The project-specific quality assurance 

project plan (QAPP) will designate the types of reports required for individual projects. 
 

In addition, at the direction of the client, the IMC will also report criteria pollutant, 
meteorological, and precision and accuracy data to the Environmental Protection Agency’s Air 
Quality System (AQS) database on a monthly basis, and handle individual data requests as they 
are received. Data reporting is the final step in the network data collection, validation, and 
reporting process illustrated in Figure 1-1. 
 
 Weekly progress reports summarize the technical aspects of the specific monitoring 
program performed during the reported week. These reports include the technical progress of 
both network operations and information management tasks, along with project-related 
milestones and maintenance schedules. 
 
 Monthly data reports provide the sponsoring organization, project management,  
individual station operators, and other project-related personnel, the opportunity to view 
summaries of air quality and associated meteorological data collected at individual monitoring 
sites. One summary report is prepared for the entire monitoring network each month. Quarterly 
data reports generally include project timeline, data collection statistics, plots of hourly average 
data, and quarterly summary tables and graphics highlighting the range and frequency of data 
collected during the quarter. 
 
 Semiannual contract status reports include summaries of task orders, modifications, and 
contract funding status for the project. Specific contents of these reports may vary upon direction 
from the project sponsor. 
 
 Annual data summary reports highlight the average range and frequency of data collected 
by a monitoring site during the year.  These summaries provide information on the status and 
trends of air quality conditions and help determine if a site is exceeding the National Ambient 
Air Quality Standards (NAAQS) established by the U.S. Environmental Protection Agency (EPA). 
 
 The monthly ozone “hit list” is a list (generated for the months of April through October) 
of site-specific ozone hourly averages m 100 and > 124 ppb, and 8-hour averages > 75 ppb.  The 
monthly hit list, based on Level 0 data, is forwarded to the sponsoring organization as a 
preliminary indication of which sites recorded high ozone values during the month. 
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 Figure 1-1.   General Data Collection, Validation, and Reporting Flow Diagram. 
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 The EPA AQS database is a repository of air quality-related data from a multitude of 
federal, state, and city agencies.  Data are submitted to the AQS to allow retrieval of the data by 
other government agencies and researchers from a common source. 

 
Data requests are handled on an individual basis.  Requests for non-finalized data are 

authorized by the sponsoring organization before being filled in the IMC. Although data requests 
vary, a standard procedure has been developed for handling them. 
 
 This standard operating procedure (SOP) outlines the data reporting process.  For detailed 
data reporting instructions, refer to the following technical instructions (TIs): 
 

• TI 3550-5000 Ambient Air Quality and Meteorological Monitoring Data –  
   Weekly and Monthly Reporting 

 
• TI 3550-5050 Ambient Air Quality and Meteorological Monitoring Data –  

   Quarterly Reporting 
 
• TI 3550-5100 Ambient Air Quality and Meteorological Monitoring Data –  

   Annual Reporting 
 
• TI 3550-5200 Handling Requests for Ambient Air Quality and Meteorological 
   Monitoring Data 
 
• TI 3550-5300 Submitting Ambient Air Quality and Meteorological Monitoring  
   Data to the EPA AQS Database 

 
2.0 RESPONSIBILITIES 
 
 Staff positions that have data reporting responsibilities are: 
 

• Program manager 
 
• Information management section manager 
 
• Data analyst 
 
• Technical assistant 

 
 Specific Information Management Center (IMC) staff data reporting responsibilities are 
presented in the TIs that support this SOP (see previous Section 1.0). 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340, Information 
Management Center (IMC) Concept and Configuration for the National Park Service Gaseous 
Pollutant Monitoring Program, and SOP 3341, Air Resource Specialists’, Inc. (ARS) Information 
Management Center (IMC) Concept and Configuration. The hardware and software used to 
perform specific data reporting functions are referenced in the TIs that support this SOP (see 
previous Section 1.0). 
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4.0 METHODS 
 
 The report types selected and report generation is project-specific. Reports will be 
generated to meet project-specific schedules as outlined in a project QAPP. Distribution will also 
follow the QAPP guidance. A single report (of each selected type) will be prepared for each 
defined monitoring program. 
 
 The ozone “hit list” is generated from Level 0 data in the AQDBMS database. Data 
requests are typically filled using finalized data in the AQDBMS database.  Final data are 
generally submitted to the EPA AQS database monthly, but no less than quarterly. 
 
 This section includes eight (8) major subsections: 
 
 4.1  Weekly Progress Report 
 4.2  Monthly and Quarterly Data Reports 
 4.3  Semiannual Contract Status Report 
 4.4  Annual Data Report 
 4.5  Ozone Hit List 
 4.6  Data Requests 
 4.7  Distribution 
 4.8  Submitting Data to the EPA AQS Database 
 
These subsections outline the general contents of the identified report types. Actual report 
contents will vary by project-specific requirements. 
 
4.1 WEEKLY PROGRESS REPORT 
 
 Weekly progress reports summarize the progress of program-related tasks during the 
report week.  This report is completed and forwarded to the sponsoring organization by Tuesday 
following the week of record. Specific content of the progress report varies from week to week, 
however, each report generally includes the following: 
 

• Network issues  
 
• Site status board entries 
 
• Site visits, reporting, and data requests 
 
• Other significant events 
 
• Contract information 

 
4.2 MONTHLY AND QUARTERLY DATA REPORTS 
 
 Monthly data reporting involves generating a data summary containing all sites in the  
monitoring program where data were collected during the reported period. Monthly data reports 
are completed and distributed within 35-45 days after the end of the reported month as the 
culmination of data validation. Each data report contains the following sections and products: 
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• Summary of gaseous data by site 
 
• Summary of particulate data by site 
 
• Summary of meteorological data by site 
 
• Collection statistics by site for all parameters 

 
 The steps taken to produce each monthly data report are: 
 

• Verify completion of preliminary data validation of the reported data. 
 
• Print stackplots of validated data for each site. 
 
• Review stackplots for any data that should be invalidated. 
 
• Print report tables. 
 
• Review reports. 
 
• Make corrections. 
 
• E-mail the reports, post the report on the project Web site (if applicable) and file a 

hardcopy original. 
 

 Instead of a monthly data report, project sponsors may opt for a quarterly data report. The 
quarterly data report generally involves generating a data summary containing all sites in the 
monitoring network. The quarterly reports are distributed within 60 days of the end of the 
quarter. This schedule can vary depending on the monitoring of filter-based measurements that 
require laboratory analyses. Each quarterly report contains the following sections and products: 
 

• Operational timelines for each site 
 
• Collection statistics for all parameters 
 
• Stackplots of hourly average of all monitored parameters 
 
• Wind roses (for each monitoring height) 
 
• Pollution roses for each monitored air quality parameter 
 
• Summary of gaseous data by site 
 
• Summary of particulate data by site 
 
• Summary of meteorological data by site 
 
• Summary of quality assurance/quality control documentation 

 
The steps taken to produce each quarterly report are: 

 
• Verify completion of all final data validation 
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• Print graphics (plots and tables) 
 
• Prepare operational timelines 
 
• Prepare and review draft reports 
 
• Copy and distribute reports and file originals 
 
• Create a CD or DVD of all validated data for the quarter to deliver with the report 

 
4.3 SEMIANNUAL CONTRACT STATUS REPORT 
 
 Contract status reports summarize contract tasks and modifications, and include a variety 
of tables such as: 
 

• Listing of task orders and modifications applicable to the program during the period 
of record. 

 
• Summary of total funding to-date and funding allocations of each task or modification 

for the contract. 
 
• Funding details by task or modification. 
 
• Status of task orders and modifications (completed or ongoing). 
 
• Miscellaneous funding details of tasks or modifications (if required). 

 
 Actual content of contract status reports will vary depending upon the needs of the 
project sponsor and their specific contract identification system.  
 
4.4 ANNUAL DATA REPORT 
 
 Annual data reporting involves generating an annual data summary report for each  
monitoring network. Annual data summary reports are completed and distributed within 3-7  
months following the reported year. Annual data reports contain the following sections and 
products: 
 

• Introduction: 
− A description of the monitoring program and its objectives 
− Parameters measured 

 
• Network Description: 

− A description of the monitoring network including a site map 
− A detailed table containing individual monitoring site specifications 
 

• Data Summaries: 
− Gaseous data summaries 
− Particulate data summaries 
− Meteorological data summaries 
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• Data Quality Assurance: 
− Summary table of data collection statistics by site 
− Summary table of overall data collection statistics by network 
− Summary table of gaseous analyzer precision and accuracy 
− Summary table of overall network gaseous analyzer precision and accuracy 
 

 The steps taken to produce each annual summary report are: 
 

• Verify completion of final data validation of the reported data. 
 
• Retrieve and load non-network data into the AQDBMS database. 
 
• Create stackplot data files. 
 
• Review stackplots for any anomalies in the data. 
 
• Investigate data anomalies to determine if the data are valid. 
 
• Print report tables. 
 
• Create report maps. 
 
• Print the cover page, text pages, and map pages. 
 
• Review report. 
 
• Make corrections. 
 
• Copy and distribute the report, and file the original. 

 
4.5 OZONE HIT LIST 
 
 The monthly ozone “hit list” is a list of site-specific ozone hourly averages m100 ppb and 
> 124 ppb, and 8-hour averages > 75 ppb.  The ozone hit list is generated from Level 0 data at 
the end of every month during the ozone season, April through October.  Since the data have not 
yet been validated, the data analysts review the list and exclude values recorded during obvious 
non-ozone events such as daily zero/span calibrations.   
 
4.6 DATA REQUESTS 
 
 Data requests are received from various sources. Final data are publicly available at 
http://ard-request.air-resource.com, and requests may also be fulfilled through the IMC. All raw 
data requests are reviewed with the sponsoring organization and data or products will only be 
provided if approved by the sponsoring organization. For these requests, the data analyst: 
 

• Forwards the request information to the sponsoring organization for authorization. 
 
• Prepares the data files and/or hardcopy output required to fill the request. 
 
• Prepares accompanying support documentation and/or correspondence. 
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• Delivers the request. 
 
• Reports a list of fulfilled data requests in the next progress report. 
 

4.7 DISTRIBUTION 
 
4.7.1 Distribution of Data Reports 
 
 Data reports will be distributed to the persons/organizations designated and according to 
schedule presented in the project-specific QAPP. 
 
4.7.2 Distribution of Data Requests 
 
 Each data request will be distributed to the person making the request. In certain 
situations, a copy of the digital data delivered is archived permanently.  
 
4.8 SUBMITTING DATA TO THE EPA AQS DATABASE 
 
 The steps required to submit data to the EPA AQS database are: 
 

• Create the AQS transaction files for hourly average criteria pollutant and 
meteorological data. 

 
• Create the AQS transaction files for precision data from criteria pollutant analyzer 

precision checks (typically one per week). 
 
• Create the AQS transaction files for accuracy data on criteria pollutant analyzers 

(typically one every 3 months to one year). 
 
• Transfer the files to AQS using CDX (Central Data Exchange). 
 
• Load data into the AQS database, successfully run the AQS statistical analysis 

programs, and post the data to the AQS database. 
 
 These steps are detailed in TI 3550-5300, Submitting Ambient Air Quality and 
Meteorological Monitoring Data to the EPA AQS Database. 
 
 



           
 

 
QUALITY ASSURANCE/QUALITY CONTROL DOCUMENTATION SERIES 

 
TITLE 

 
AMBIENT AIR QUALITY AND METEOROLOGICAL MONITORING 
DATA – WEEKLY AND MONTHLY REPORTING 
 
 

TYPE 
 

TECHNICAL INSTRUCTION 

NUMBER 
 

3550-5000 

DATE 
 

MARCH 1999 

 
AUTHORIZATIONS 

TITLE NAME SIGNATURE 

ORIGINATOR    Laura A. Wilson  

PROJECT MANAGER    Jessica Ward  

PROGRAM MANAGER    David L. Dietrich  

QA MANAGER    Gloria S. Mercer  

COTR   
 

REVISION HISTORY 

REVISION 
NO. 

CHANGE 
DESCRIPTION DATE AUTHORIZATIONS 

1.0 Change all procedures for the DataView system January 2001  

 Reviewed; no changes necessary. January 2002  

 Reviewed; no changes necessary. January 2003  

2.0 Change monthly to weekly progress reports/ 
revise monthly data reports / revise ozone hit list. 

May 2004  

2.1 Changed monthly report process / revised hit list May 2005  

2.2 Revised graphics. February 2006  

 Reviewed; no changes necessary. January 2007  

 -- continued --   
 



           
 

 
 
 
 
 

 
QUALITY ASSURANCE/QUALITY CONTROL DOCUMENTATION SERIES 

 
TITLE 

 
AMBIENT AIR QUALITY AND METEOROLOGICAL MONITORING 
DATA – WEEKLY AND MONTHLY REPORTING 
 
 

TYPE 
 

TECHNICAL INSTRUCTION 

NUMBER 
 

3550-5000 

DATE 
 

MARCH 1999 

 
AUTHORIZATIONS 

TITLE NAME SIGNATURE 

ORIGINATOR    Laura A. Wilson  

PROJECT MANAGER    Jessica Ward  

PROGRAM MANAGER    David L. Dietrich  

QA MANAGER    Gloria S. Mercer  

COTR   
 

REVISION HISTORY 

REVISION 
NO. 

CHANGE 
DESCRIPTION DATE AUTHORIZATIONS 

3.0 Change ozone hit list / monthly report 
preparation. 

January 2008  

4.0 Update with new ozone standard of 75 ppb. January 2009  

4.1 Make client-generic/ added particulates. February 2010  

    

    

    

    

    
 
 

Reviewed; no changes necessary.                       April 2011

GMercer
Stamp



          Number 3550-5000 
          Revision 4.1 
          Date FEB2010 
     Page i of  ii 
 

 

TABLE OF CONTENTS 
Section    Page 
 
1.0 PURPOSE AND APPLICABILITY 1 
 
2.0 RESPONSIBILITIES 1 
 
 2.1 Information Management Section  Manager 1 
 2.2 Data Analyst 1 
 2.3 Technical Assistant 2 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 2 
 
4.0 METHODS  2 
 
 4.1 Weekly Progress Report 3 
 4.2 Monthly Data Report 3 
 
  4.2.1 Monthly Data Report Contents 5 
  4.2.2 Generating a Monthly Data Report 7 
 
    4.2.2.1     Verifying Preliminary Validation Status 8 
    4.2.2.2     Generating Report Tables  9 
 
  4.2.3 Distributing Reports 13 
 
 4.3 Monthly Ozone Hit List 14 
 
  4.3.1 Generating the Monthly Ozone Hit List 14 
  4.3.2 Distributing the Monthly Ozone Hit List 16 
 
5.0 REFERENCES 16 
 
 

LIST OF FIGURES 
Figure     Page 
 
4-1 General Data Collection, Validation, and Reporting Flow Diagram 4 
 
4-2 Example Data Collection Statistics by Site for All Parameters 5 
 
4-3 Example Summary of Ozone Data by Site 6 
 
4-4 Example Summary of Sulfur Dioxide Data by Site 6 
 
 
 
 



          Number 3550-5000 
          Revision 4.1 
          Date FEB2010 
     Page ii of  ii 
 

 

LIST OF FIGURES (CONTINUED) 
Figure     Page 
 
4-5 Example Summary of Selected Meteorological Data by Site 7 
  
4-6 The Data Validation Log 8 
 
4-7 The Reports Interface 9 
 
4-8 The Dates Tab  10 
 
4-9 The Sites Tab   10 
 
4-10 The Parameters Tab 11 
 
4-11 The Options Tab 12 
 
4-12 The Destinations Tab 13 
 
4-13 Example Ozone Hit List 15 
 



          Number 3550-5000 
          Revision 4.1 
          Date FEB 2010 
     Page 1 of 16 
 

 

1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps of producing ambient air quality and 
meteorological weekly progress reports and monthly data reports, and is referenced from SOP 
3550, Ambient Air Quality and Meteorological Monitoring Data Reporting. Reporting of 
ambient air quality and meteorological monitoring by the ARS Information Management Center 
(IMC) includes preparation and distribution of the following report products: 

 
• Weekly progress reports  

• Monthly data reports 

• Monthly ozone “hit list” (prepared during the ozone season, April through October) 
 
 Weekly progress reports summarize the technical aspects of a monitoring program 
performed during the reported week. These reports include the technical progress of both 
network operations and information management tasks, along with project-related milestones 
and maintenance schedules. 
 
 Monthly data reports provide air quality management staff, individual station operators, 
and other project-related personnel, ambient ozone (O3) and/or sulfur dioxide (SO2) data and 
associated meteorological data collected at individual monitoring sites. One report is prepared 
for the entire network each month. 
 
 The monthly ozone “hit list” is a list of ozone 8-hour averages > 75 ppb, indicating the 
locations and frequency of high ozone values .This list is forwarded to the client. 
 
2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager shall oversee all reporting procedures and 
provide direction when required. 
 
2.2 DATA ANALYST 
 
 The data analyst shall: 
 

• Verify that preliminary and final data validation has been successfully completed for 
each month. 

• Prepare monthly data reports and forward the reports to the client and site operators. 

• Prepare and forward the monthly ozone “hit list” to the client. 

• Submit data to the Environmental Protection Agency’s (EPA) Air Quality System 
(AQS) database. 

• Summarize IMC-related progress and forward items to the technical assistant for 
inclusion in the weekly progress report. 
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2.3 TECHNICAL ASSISTANT 
 
 The technical assistant shall: 
 

• Assemble and organize the information for the weekly progress report. 

• Word process the weekly progress report. 

• Copy and deliver the weekly progress report. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Detailed descriptions of all IMC hardware and software, and monitoring station hardware 
requirements are presented by category in SOP 3340, Information Management Center (IMC) 
Concept and Configuration. The IMC requires the following hardware and software for Level 0 
validation of ambient air quality and meteorological data: 
 

• IMC hardware: 
 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
 
• IMC AQDBMS software: 
 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 

 
4.0 METHODS 
 
 One weekly progress report for the network is generated each week and one monthly data 
report for the network is generated each month. The ozone “hit list” is generated monthly from 
raw data in the Air Quality Data Base Management System (AQDBMS) during the summer 
ozone season. 
 
 This section contains the following three (3) major subsections: 
 
 4.1   Weekly Progress Report 
 4.2   Monthly Data Report 
 4.3   Monthly Ozone Hit List 
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4.1 WEEKLY PROGRESS REPORT 
 
 Weekly progress reports summarize the progress of program-related tasks during the 
reported week. This report is completed and distributed by the Tuesday following the week of 
record. Specific content of the progress report varies from week to week, however, each report 
generally includes the following: 
 

• Network issues discussed during project meetings with client personnel 

• Site issues/operational problems resolved and unresolved 

• Site visits performed and scheduled 

• Reporting status and data requests 

• Contract administration items 
 
 Using the previous week’s report as a template, the technical assistant reviews each page 
of the report and makes updates with information from the Site Status Log, trip reports, and other 
information forwarded by the IMC staff and field specialists. 
 
4.2 MONTHLY DATA REPORT 
 
 Monthly data reporting includes generating one data report for an entire monitoring 
network, or for individual stations within a network, as advised by the client. Monthly reports are 
completed and distributed within 35 days following the reported month as the culmination of 
data validation (see Figure 4-1). 
 
 The main steps taken to report monthly data are: 
 

• Determine the specific contents needed for the report. 

• Update the report text. 

• Determine which sites to include in the report tables. 

• Generate and compile the report tables. 

• Review the report. 

• If necessary, make corrections and regenerate affected contents. 

• Distribute the reports. 
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Figure 4-1.  General Data Collection, Validation, and Reporting Flow Diagram. 
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4.2.1 Monthly Data Report Contents 
 
 Before generating report contents, the data analyst determines which sites are to be 
reported and the output that needs to be included in the report. Data reports contain the following 
products: 
 

• Data Collection Statistics by site for all parameters 

• Summary of ozone data by site 

• Summary of sulfur dioxide data by site 

• Summary of PM2.5 data by site 

• Summary of PM10 data by site 

• Summary of selected meteorological data by site 
 

 Figures 4-2 through 4-5 present example report products. 
 

 
 

Figure 4-2.  Example Data Collection Statistics by Site for All Parameters. 
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Figure 4-3.  Example Summary of Ozone Data by Site. 

 
 
 
 

 
 

Figure 4-4.  Example Summary of Sulfur Dioxide Data by Site. 
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Figure 4-5.  Example Summary of Selected Meteorological Data by Site. 

 
 
4.2.2 Generating a Monthly Data Report 
 
 The steps taken to generate each monthly data report are: 
 

• Verify completion of preliminary data validation of the reported data. 

• Print validated stackplots. 

• Review stackplots for any data that should be invalidated. 

• Update report text. 

• Print report tables. 

• Review reports. 

• Make corrections. 

• E-mail reports and post to project Web site;  file a hardcopy original. 
 

 The following subsections explain how each step is accomplished. 
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4.2.2.1  Verifying Preliminary Validation Status 
 
 Before a monthly data report can be generated, Preliminary data validation must be 
complete. The validation status of each site is tracked in the AQDBMS Data Validation Log (see 
Figure 4-6). 

 
Figure 4-6.  The Data Validation Log. 

 
 The Data Validation Log is used to track the completion of each major step of the 
validation process. The master record logs the initials of the IMC staff member completing each 
validation step and when the step occurred. The Comments Table logs comments regarding data 
validation. Most of the output programs query the Data Validation Log so the correct level of 
validation can be applied to the output .To use the Data Validation Log: 

 
• Select Logs-> Data Validation Log from the AQ and Met Processing frame. 
 
• Select a site from the Site drop-down box. If no records for the selected site exist, a 

“Site not Found” message is displayed. Click OK. Otherwise, the most recent Master 
Table record and related comments for the selected site are displayed. 

 
• Select a different month and/or year from the drop-down list boxes to display 

previous month’s records for the site. 
 
• Records can be added as usual. 
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4.2.2.2  Generating Report Tables  
 
 The Reports interface of the AQDBMS provides a single interface for producing various 
types of output products. The initial display of the reports interface is shown in Figure 4-7.  A tab 
control is used to help the user select the specific input required for the selected product. The 
content of each tab updates dynamically to reflect the specific options available for the selected 
product. The interface allows the user to “Run” a job immediately or “Submit” jobs to a queue to 
later be run as a batch of jobs. 

Figure 4-7. The Reports Interface. 
 
To use the Reports interface: 
 

• Select Reports from the AQ and Met Processing frame. 
• Select a product to generate from the list displayed on the Output Products tab. 
• Click on each enabled tab of the tab control (right side of screen) to input the required 

information and select options specific to the selected product.  
• Click Run Now to run the job immediately or click Submit Job to add the job to the 

Submitted Jobs list. 
• Click Run Jobs to begin running the jobs in the Submitted Jobs list. 
 
The tab control on the right side of the Reports interface has five tab screens. Access to 
each screen is updated when the user selects a product in the Output Products list. If the 
tab is disabled, its content does not relate to the selected product. The tab screens are 
discussed below: 
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The Dates tab displays one or more fields for the user to input the desired time period of 
data to be included in the output product. Usually, there are Start Date and End Date 
fields that require dates in mm/dd/yyyy format. Other products may need only a year to 
be entered. Figure 4-8 shows the Dates tab screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-8.  The Dates Tab. 
 
The Sites tab displays a tree view of site groups as configured. Groups and/or individual 
sites can be selected to be included in the output job. Figure 4-9 shows the Sites tab screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-9.  The Sites Tab. 
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The Parameters tab displays a list of all parameters as shown in Figure 4-10. The user 
can also choose the output units for each selected parameter and the output generator will 
convert the values as necessary. To choose output units: 

 
• Click in the Output Units column of the selected parameter. 

 
• From the drop-down list, select an available Unit Code.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-10.  The Parameters Tab. 
 

The Options tab displays additional options for the selected product. An example of the 
Options tab when the “Data Collection Statistics – Selected Parameters” product is 
selected is shown in Figure 4-11. Two sections are found on the page; Standard Options 
and Special Options. The Standard section includes the following: 

 
• Radio buttons for selecting a Validation Level option. Select Raw, 

Preliminary, or Final to force the level to the selected option. 
 

• A page number option to input a report page number. 
 

• A checkbox to place all of the currently selected sites on one page or 
continuous output instead of separate pages or files for each site. 

 
The Special Options section includes special options for the selected report. Examples of 
special options are: 
 

• A Raw Data checkbox. Checking this box instructs the program to use raw 
data and not validated data in the product. 
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• Number of Values to list. Instructs the program to include the number of 
values entered on the product. For example, to list the top 10 Highest Hourly 
Averages. 

 
• Other options exist, depending upon the report type. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-11.  The Options Tab. 
 

 
The Destinations tab displays options on the type of output to produce as shown in 
Figure 4-12. This tab updates dynamically depending on the product selected. Only the 
possible options for the selected product are enabled. More than one option can be 
selected. Destination options are: 

 
• Output to screen. This option causes the output generator to pause after each 

product has been created and display the product on the screen before going 
onto the next. Click the Print button to send the output product to the printer. 
Click the Continue button to close the on-screen display. 
 

• Output to printer. This option sends the output directly to the currently 
selected printer. 
 

• Output to PDF file. This option uses the Adobe Portable Document File (PDF) 
Writer to create PDF files of the output. When the checkbox is selected, an 
input field displays prompting the user to enter a destination folder for the 
generated PDF files. 
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• Output to text file. This option writes the output to ASCII text files. When the 
checkbox is selected, an input field displays prompting the user to enter a 
destination folder for the text files.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4-12.  The Destinations Tab. 

 
 
4.2.3 Distributing Reports 
 
 A hardcopy of each monthly data report is filed permanently in the IMC. Each report is 
e-mailed to: 
 

• The site operators. 

• The client project manager. 

• Client air quality coordinators. 

• A client administrative contact. 
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4.3 MONTHLY OZONE HIT LIST 
 
4.3.1 Generating the Monthly Ozone Hit List 
 
 The monthly ozone “hit list” is a list of site-specific ozone 8-hour averages > 75 ppb. The 
list is generated from raw data at the end of every month during the ozone season (April through 
October). An example hit list is shown in Figure 4-13. Since the data have not yet been validated, 
a data analyst reviews the list and excludes values recorded during obvious non-ozone events 
such as daily zero/span calibrations. 
 
 To generate the ozone hit list, launch the IMC application: 
 

• From the Reports menu, select Episodes with 1-Hour Ozone Concentrations ≥ 100 
 ppb and > 124 ppb. 

 
-  Under the Dates tab, enter the month that just passed. 
-  Under the Sites tab, select Current IMC Sites. 
-  Under the Options tab, leave the defaults at Validation Table and Place groups/sites 
    on one report. 
-  Under the Output tab, select Printer. 

 
• Review the report and check that all values in exceedence are real values and not 

calibrations, instrument warm-ups, or other problem. This is determined by viewing 
stackplots and looking at O3 and O3CAL values together in the validation area of the 
database. If there is an invalid exceedence, invalidate the hour(s) in the database 
temporarily with a “TI” (Temporarily Invalid) code. 

 
• Run the report again and select Printer and PDF file (the files are placed in 

ARSNW1\ project\IMC\hitlist\year). Double-check that all invalid values have been 
removed. 

 
• Repeat the above three (3) steps with the report Episodes with 8-Hour Average 

Ozone Concentrations > 75 ppb. 
 
• Run the report Summer High Ozone List. Direct the output to the printer (or screen, 

then select Print). 
 
• Enter the values from the Summer High Ozone List report into the Word file at 

ARSNW1\project\IMC\Hitlist\year\Hit List Chart month.doc. Update any changes to 
previous months that may have occurred since the last revision. Also update the 
revised date and validation levels for each month. 

 
• E-mail files to the client and IMC personnel. See Section 4.3.2, Distributing the 

Monthly Ozone Hit List for details on the specific files distributed. 
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Figure 4-13.  Example Ozone Hit List. 
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• Continue updates at the beginning of each month until all data are final through 
October. 

 
• When data are finalized through October, run an inclusive report of both the 1-hour 

and 8-hour reports for April through October, and a final hit list chart. Name the 
report files as yyyy Final 1-hr.pdf and yyyy Final 8-hr.pdf, and the name the hit list 
chart Final Hit List Chart yyyy.doc and Final Hit List Chart yyyy.html (with yyyy 
being the year being reported). Distribute the files by e-mail (see Section 4.3.2), and 
add final reports to the Hitlist Notebook. 

 
4.3.2 Distributing the Monthly Ozone Hit List 
 
 The hit list is completed at the beginning of each month following the ozone months of 
April through October, and forwarded to the client by the 5th of the month. The monthly ozone 
hit list is distributed by e-mail to the client and cc’d to: 
 

• The IMC section manager. 

• The field maintenance group section manager. 
• Each member of the IMC staff. 

 
Three files are e-mailed: 
 
• Summer High Ozone List.doc 

• Episodes with 1-Hour Ozone Concentrations ≥ 100 ppb and > 124 ppb for current 
 month 

• Episodes with 8-Hour Average Ozone Concentrations > 75 ppb for current month 
 

5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2001, Air Quality Data Base Management System 
          (AQDBMS) User’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the steps of producing ambient air quality and 
meteorological annual data reports, and is referenced from SOP 3550, Ambient Air Quality and 
Meteorological Monitoring Data Reporting.  Annual data summary reports highlight the average 
range and frequency of data collected at monitoring sites during the year. These summaries 
provide information on the status and trends of air quality conditions and help determine if a site 
is exceeding the National Ambient Air Quality Standards (NAAQS) established by the U.S. 
Environmental Protection Agency (EPA). Reports may be network-specific and include all sites 
where monitoring occurred during the reported year, or they might be for an individual station 
only. By request, data from specific non-network sites are included in annual reports. 

 
Reports are distributed within the timeframe set by the sponsoring organization and are 

reported only after final data validation and a year-end annual data review has occurred. Refer to 
SOP 3450, Ambient Air Quality and Meteorological Monitoring Data Validation, for a full 
explanation of validation procedures and levels. 
 
2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT CENTER SECTION MANAGER 
 
 
 The Information Management Center section manager shall: 
 

• Oversee all reporting preparation and provide direction as necessary. 
• Review draft and final data reports for completeness and accuracy. 
• Verify that completed reports are properly distributed. 

 
2.2 DATA ANALYST 
 
 The data analyst shall: 
 

• Verify that data validation has been successfully completed for the reporting period. 
• Compile data statistics and prepare plots and graphics. 
• Create the annual data report. 
• Prepare a CD or DVD of the annual validated data for delivery with the annual data 

report.  
 

2.3 TECHNICAL ASSISTANT 
 
 The technical assistant shall: 
 

• Assemble and organize the information for the data report. 
• Prepare annual data reports and forward to the project manager for review. 
• Distribute the reports and associated data to the sponsoring agency and other project 

personnel as directed. 
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3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Detailed descriptions of all IMC hardware and software, and monitoring station hardware 
requirements are presented by category in SOP 3340, Information Management Center (IMC) 
Concept and Configuration. The IMC requires the following hardware and software for Final 
validation of ambient air quality and meteorological data: 
 

• IMC hardware: 
 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
 
• IMC AQDBMS software: 
 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 

 
4.0 METHODS 
 
 One annual data report for each site or network is generated for each year of operation.  
The annual reports generally follow calendar years, but may differ for specific projects. This 
section contains the following three (3) major subsections: 
 
 4.1   Annual Data Report Contents 
 4.2   Generating Annual Data Reports 
 4.3   Distributing Annual Data Reports 
 
4.1 ANNUAL DATA REPORT CONTENTS 
 

Before generating report contents, the sponsoring organization determines the sites to be 
reported and the output that needs to be included in the report. Annual reporting of ambient air 
quality and meteorological monitoring includes a discussion of the background of the monitoring 
program and its objectives, and a discussion of the locations and parameters measured.  

 
Air Resource Specialists’, Inc. (ARS) Information Management Center (IMC) prepares 

and distributes some or all of the following report products: 
 
• Operational timelines for each site  
• Collection statistics for all parameters (see Figure 4-1) 
• Stackplots of hourly averages of all monitored parameters (see Figure 4-2) 
• Wind roses (for each monitoring height) (see Figure 4-3) 
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• Pollution roses for each monitored air quality parameter 
• Summary of gaseous data by site  
• Pollutant violation summaries (see Figure 4-4) 
• Resource injury indices 
• Maps displaying pollutant levels at sites within a network (see Figure 4-5) 
• Bar charts displaying pollutant concentrations 
• Summary of particulate data by site 
• Summary of meteorological data by site (see Figure 4-6) 
• Summary of quality assurance/quality control documentation 
 

 Figures 4-1 through 4-6 present example report products. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4-1.  Example Collection Statistics Summary. 
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Figure 4-2.  Example Stackplot of Monitored Parameters. 
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Figure 4-3.  Example Wind Rose Summary. 
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Figure 4-4.  Example Pollutant Violation Summary. 
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Figure 4-5.  Example Map of Pollutant Levels at Network Sites. 
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Figure 4-6.  Example Meteorological Data Summary. 
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4.2 GENERATING ANNUAL DATA REPORTS 
 
 The main steps taken to produce each annual data summary report are: 
 

• Verify completion of final data validation of the reported data. 
 
• Determine the specific contents needed for the report. 
 
• Generate and compile the contents of the report. 
 
• Review the report. 
 
• Make corrections and regenerate affected contents. 
 
• Distribute the reports. 
 

 The following subsections explain how each step is accomplished. 
 
4.2.1  Verifying Preliminary Validation Status 
 
 Before an annual data report can be generated, Final data validation must be complete. The 
validation status of each site is tracked in the AQDBMS Data Validation Log (see Figure 4-7). 
 

 
Figure 4-7.  The Data Validation Log. 
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 The Data Validation Log is used to track the completion of each major step of the 
validation process. The master record logs the initials of the IMC staff member completing each 
validation step and when the step occurred. The Comments Table logs comments regarding data 
validation. Most of the output programs query the Data Validation Log so the correct level of 
validation can be applied to the output.  To use the Data Validation Log: 
 

• Select Logs-> Data Validation Log from the AQ and Met Processing frame. 
 
• Select a site from the Site drop-down box. If no records for the selected site exist, a 

“Site not Found” message is displayed. Click OK. Otherwise, the most recent Master 
Table record and related comments for the selected site are displayed. 

 
• Select a different month and/or year from the drop-down list boxes to display 

previous month’s records for the site. 
 
• Records can be added as usual. 

 
4.2.2  Generating Report Tables and Data Files  
 
 The Reports interface of the AQDBMS provides a single interface for producing various 
types of output products. The initial display of the reports interface is shown in Figure 4-8.  A tab 
control is used to help the user input the specific input required for the selected product. The 
content of each tab page updates dynamically to reflect the specific options available for the 
selected product. The interface allows the user to “Run” a job immediately or “Submit” jobs to a 
queue to later be run as a batch of jobs. 

 
Figure 4-8. The Reports Interface. 
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To use the Reports interface: 
 

• Select Reports from the AQ and Met Processing frame. 
 
 
• Select a product to generate from the list displayed on the Output Products tab. 
 
• Click on each enabled tab of the tab control (right side of screen) to input the required 

information and select options specific to the selected product.  
 
• Click Run Now to run the job immediately or click Submit Job to add the job to the 

Submitted Jobs list. 
 
• Click Run Jobs to begin running the jobs in the Submitted Jobs list. 

 
The tab control on the right side of the Reports interface has five tab screens. Access to 
each screen is updated when the user selects a product in the Output Products list. If the 
tab is disabled, its content does not relate to the selected product. The tab screens are 
discussed below: 
 
The Dates tab displays one or more fields for the user to input the desired time period of 
data to be included in the output product. Usually, there are Start Date and End Date 
fields that require dates in mm/dd/yyyy format. Other products may need only a year to 
be entered. Figure 4-9 shows the Dates tab screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4-9.  The Dates Tab. 
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The Sites tab displays a tree view of site groups as configured. Groups and/or individual 
sites can be selected to be included in the output job. Figure 4-10 shows the Sites tab screen. 
When generating annual report products for network summary reports, it is helpful to create 
an annual report sites group that includes all sites to be included in the annual report. To 
create a new sites group, select Site Groups from the Sites tab in the data collection and 
configuration portion of the AQDBMS. Right-click to add a new group, and copy and paste 
the desired sites from existing site groups into the new group. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-10.  The Sites Tab. 
 
 
The Parameters tab displays a list of all parameters as shown in Figure 4-11. The user 
can also choose the output units for each selected parameter and the output generator will 
convert the values as necessary. To choose output units: 

 
• Click in the Output Units column of the selected parameter. 

 
• From the drop-down list, select an available Unit Code.  
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Figure 4-11.  The Parameters Tab. 
 

 
The Options tab displays additional options for the selected product. An example of the 
Options tab when the “Data Collection Statistics – Selected Parameters” product is 
selected is shown in Figure 4-12. Two sections are found on the page; Standard Options 
and Special Options. The Standard section includes the following: 

 
• Radio buttons for selecting a Validation Level option. Select Raw, 

Preliminary, or Final to force the level to the selected option. 
 

• A page number option to input a report page number. 
 

• A checkbox to place all of the currently selected sites on one page or 
continuous output instead of separate pages or files for each site. 

 
The Special Options section includes special options for the selected report. Examples of 
special options are: 
 

• A Raw Data checkbox. Checking this box instructs the program to use raw 
data and not validated data in the product. 

 
• Number of Values to list. This option instructs the program to include the 

number of values entered on the product. For example, to list the top 10 
Highest Hourly Averages. 

 
• Other options exist, depending upon the report type. 
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Figure 4-12.  The Options Tab. 
 
 
 
The Destinations tab displays options on the type of output to produce as shown in 
Figure 4-13. This tab updates dynamically depending on the product selected. Only the 
possible options for the selected product are enabled. More than one option can be 
selected. Destination options are: 

 
• Output to screen. This option causes the output generator to pause after each 

product has been created and display the product on the screen before going 
onto the next. Click the Print button to send the output product to the printer. 
Click the Continue button to close the on-screen display. 
 

• Output to printer. This option sends the output directly to the currently 
selected printer. 
 

• Output to PDF file. This option uses the Adobe Portable Document File (PDF) 
Writer to create PDF files of the output. When the checkbox is selected, an 
input field displays prompting the user to enter a destination folder for the 
generated PDF files. 
 

• Output to text file. This option writes the output to ASCII text files. When the 
checkbox is selected, an input field displays prompting the user to enter a 
destination folder for the text files.  
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Figure 4-13.  The Destinations Tab. 

 
 
 
4.2.3 Generating Report Maps 
 
 Maps are generated by importing the latitude and longitude coordinates of each site from 
the AQDBMS Site Configuration Table into MapViewer mapping software. The site locations 
are plotted on a map of the United States along with their corresponding values that are being 
summarized on the map. 
 
4.3 NON-NETWORK DATA 
 
 Sponsoring organizations may provide a list of non-network sites for inclusion in annual 
data summary reports. Data for these sites are collected, validated, and submitted to the EPA AQS 
database by other agencies. Data are retrieved from AQS and loaded into the AQDBMS to be 
included in the production of the annual data summary reports. 
 
4.3.1 Retrieving and Downloading Data From AQS 
 
 The AQDBMS includes a program for loading data from Type 1 (one-hour average data) 
AQS records. Before the data can be imported, however, they must be retrieved and downloaded 
from the AQS. Refer to TI 3550-5300, Submitting and Retrieving Ambient Air Quality and 
Meteorological Monitoring Data to the EPA AQS Database. 
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4.3.2 Importing AQS Data into the AQDBMS 
 
 For all data from an AQS file to be successfully imported, site and parameter information 
must be defined in the AQDBMS database for the AQS codes encountered during the import. If 
the program finds undefined codes, an error message is written to a log file, and the undefined 
AQS record is written to a redo file. The data analyst then creates the necessary new records in 
the database tables and runs the program again until all data are imported without error. For 
instructions on adding site and parameter information to the AQDBMS see SOP 3650, IMC 
Staff’s Maintenance Responsibilities for the Ambient Air Quality Data Base Management System 
(AQDBMS). Refer to Section 5.4, Importing Data From AQS Transaction Files, in the Air 
Quality Data Base Management System (AQDBMS) User’s Guide (ARS, 2001) for instructions 
on importing a downloaded AQS file into the AQDBMS database. 
 
4.4 REVIEWING REPORTS 
 
 Annual data summary reports are reviewed by at least three IMC staff or project-related 
personnel. If errors are found, corrections are made and the affected report contents are 
regenerated. 
 
4.5 DISTRIBUTION 
 
 The reports are compiled, assembled, and copied for distribution. Copies are distributed 
as designated by sponsoring organization personnel. Copies may be hard copy or electronic on 
CD. A copy is also maintained by the project manager. 
 
 A digital copy of all validated data (and also raw data if requested) will be delivered to 
the sponsoring agency in conjunction with the quarterly data reports. The data will be provided 
on CD unless another media is requested by the sponsoring agency. 

 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2001, Air Quality Data Base Management System 
          (AQDBMS) User’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the procedures and methods used by the ARS  
Information Management Center (IMC), in handling data requests for ambient air quality and 
meteorological data. Ambient air quality and meteorological data are requested by various 
persons to meet various objectives. An example of a data request is: 

 
“Provide monthly data files containing scalar wind speed, vector wind 
direction, relative humidity, and temperature for Mammoth Cave National 
Park, from January 1991 through August 1992.  Place the files on the 
ARS ftp site for download.” 

 
 The IMC has developed steps for handling data requests to ensure that high quality data 
are readily available to fill these requests. Data requests may also specify a graphics format. This 
TI is referenced from SOP 3550, Ambient Air Quality and Meteorological Monitoring Data 
Reporting.  
 
2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager shall oversee all reporting procedures and 
provide direction when required. 
 
2.2 DATA ANALYST 
 
 The data analyst shall: 
 

• Handle all data requests. 
 
• Communicate with the client regarding data requests. 

 
2.3 DATABASE ADMINISTRATOR/PROGRAMMER 
 
 The database administrator/programmer shall create custom data summaries, data 
listings, or graphics, for data requests requiring non-standard output. 
 
2.4 TECHNICAL ASSISTANT 
 
 The technical assistant shall compile all data requests for inclusion in Weekly Project 
Status Reports. 

 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 Detailed descriptions of all IMC hardware and software, and monitoring station hardware 
requirements are presented by category in SOP 3340, Information Management Center (IMC) 
Concept and Configuration. The IMC requires the following hardware and software for Level 0 
validation of ambient air quality and meteorological data: 
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• IMC hardware: 
 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
 
• IMC AQDBMS software: 
 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 

 
4.0 METHODS 
 
 Data requests are received by the client or IMC and forwarded to the data analyst to fill. 
This section contains the following five (5) major subsections, which detail the steps taken to 
complete data requests: 
 
 4.1  The Data Retrieval Web site 
 4.2  Authorization of Data Requests 
 4.3  Generating Data Files for Data Requests 
 4.4  Other Types of Data Requests 
 4.5  Delivering Data Requests 
 
4.1 THE DATA RETRIEVAL WEB SITE  
 
 Most requesters are directed to the data retrieval Web site, where they can retrieve the 
data they need themselves. Approximately 95% of all data requesters use this “standard” method, 
by logging onto http://ard-request.air-resource.com. Non-standard methods, including download 
via FTP site, transmit via e-mail, or delivery via CD-ROM, are seldom used. The database 
contains all data under final validation.  
  
4.2 AUTHORIZATION OF DATA REQUESTS 
 
 Data requests that can be handled through the standard output interface require only that 
the client be advised. Some data requests, for example those made via the NPS ARD, have an 
implied authorization. The client must authorize each non-standard data request before 
processing the request. Otherwise, details of the data request are forwarded to the client by 
telephone, e-mail, or fax. Authorization is returned to the IMC also by telephone, e-mail, or fax.  
 
 Some data requests can be unusually complex or require large volumes of data or 
non-standard output. In these cases, the IMC section manager must estimate the amount of time 
and materials needed to fill the request and communicate this information to the client. Doing so 
will allow the client to judge if filling the request is an appropriate use of the data analysts’ time 
or if the scope of the request needs to be negotiated with the requester.  
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4.3 GENERATING DATA FILES FOR DATA REQUESTS 
 
 Data requests that are not processed through the Data Retrieval Web site are made by the data 
analyst via the air quality database management system (AQDBMS). The Reports interface of the 
AQDBMS provides a single interface for producing various types of output products. The initial 
display of the reports interface is shown in Figure 4-1. A tab control has been used to help the user 
input the specific information required for the selected product. The content of each tab page updates 
dynamically to reflect the specific options available for the selected product. The interface allows 
the user to “Run” a job immediately or “Submit” jobs to a queue to later be run as a batch of jobs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-1. The Reports Interface. 
 
 To use the Reports interface: 
 

• Select Reports from the AQ and Met Processing frame. 
 
• Select a product to generate from the list displayed on the Output Products tab. 
 
• Click on each enabled tab of the tab control (right side of screen) to input the required 

information and select options specific to the selected product.  
 
• Click Run Now to run the job immediately or click Submit Job to add the job to the 

Submitted Jobs list. 
 
• Click Run Jobs to begin running the jobs in the Submitted Jobs list. 
 
The tab control on the right side of the Reports interface has five tab screens. Access to 
each screen is updated when the user selects a product in the Output Products list. If the 
tab is disabled, its content does not relate to the selected product. The tab screens are 
discussed below: 
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The Dates tab displays one or more fields for the user to input the desired time period of 
data to be included in the output product. Usually, there are Start Date and End Date 
fields that require dates in mm/dd/yyyy format. Other products may need only a year to 
be entered. Figure 4-2 shows the Dates tab screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-2.  The Dates Tab. 
 
The Sites tab displays a tree view of site groups as configured. Groups and/or individual 
sites can be selected to be included in the output job. Figure 4-3 shows the Sites tab screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-3.  The Sites Tab. 
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The Parameters tab displays a list of all parameters as shown in Figure 4-4. The user 
can also choose the output units for each selected parameter and the output generator will 
convert the values as necessary. To choose output units: 

 
• Click in the Output Units column of the selected parameter. 

 
• From the drop-down list, select an available Unit Code.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                       Figure 4-4.  The Parameters Tab. 
 

The Options tab displays additional options for the selected product. An example of the 
Options tab when the “Data Collection Statistics – Selected Parameters” product is 
selected is shown in Figure 4-5. Two sections are found on the page; Standard Options 
and Special Options. The Standard section includes the following: 

 
• Radio buttons for selecting a Validation Level option. Select Raw, 

Preliminary, or Final to force the level to the selected option. 
 

• A page number option to input a report page number. 
 

• A checkbox to place all of the currently selected sites on one page or 
continuous output instead of separate pages or files for each site. 

 
The Special Options section includes special options for the selected report. Examples of 
special options are: 
 

• A Raw Data checkbox. Checking this box instructs the program to use raw 
data and not validated data in the product. 
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• Number of Values to list. This option instructs the program to include the 
number of values entered on the product. For example, to list the top 10 
Highest Hourly Averages. 

 
• Other options exist, depending upon the report type. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                 Figure 4-5.  The Options Tab. 
 
The Destinations tab displays options on the type of output to produce as shown in 
Figure 4-6. This tab updates dynamically depending on the product selected. Only the 
possible options for the selected product are enabled. More than one option can be 
selected. Destination options are: 

 
• Output to screen. This option causes the output generator to pause after each 

product has been created and display the product on the screen before going 
onto the next. Click the Print button to send the output product to the printer. 
Click the Continue button to close the on-screen display. 
 

• Output to printer. This option sends the output directly to the currently 
selected printer. 
 

• Output to PDF file. This option uses the Adobe Portable Document File (PDF) 
Writer to create PDF files of the output. When the checkbox is selected, an 
input field displays prompting the user to enter a destination folder for the 
generated PDF files. 
 

• Output to text file. This option writes the output to ASCII text files. When the 
checkbox is selected, an input field displays prompting the user to enter a 
destination folder for the text files.  



          Number 3550-5200 
          Revision 2.5 
          Date FEB 2010  
     Page 7 of  10 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                                Figure 4-6.  The Destinations Tab. 

 
 
4.4 OTHER TYPES OF DATA REQUESTS 
 
 Some data requests may include requests for standard monthly or annual report tables or 
plots. Standard output can be generated by the AQDBMS application at any time. Refer to TI 
3550-5000, Ambient Air Quality and Meteorological Monitoring Data – Weekly and Monthly 
Reporting,  TI 3550-5100, Ambient Air Quality and Meteorological Monitoring Data - Annual 
Reporting or the Air Quality Data Base Management System (AQDBMS) User’s Guide (ARS, 
2001) for instructions on generating standard output.  
 
 Data requests may also include requests for custom data summaries or lists meeting 
certain criteria or graphics. In these cases, the data analysts work with the database 
administrator/programmer to generate the necessary output. Additional information in creating 
graphics is provided in the following subsections.  
 
4.4.1 AQDBMS Graphics Products 
 
 Four programs are available to create graphical representations of AQDBMS data 
directly from the database. The graphics products are also available from the data request Web 
site. The AQDBMS graphics programs provide the following common features: 
 

• Execution directly from the AQDBMS or the Windows desktop 

• Single-site plot vs. submit file option to create multiple-site plots 

• Printer destination and setup selection 

• Start and end date selection 
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• Monthly, quarterly, and annual plots (except One-Year and Three-Year Summary plots) 

• Plot title customization 

• Plotting scale adjustment 

• Force Final Validation footnote for historical data 

• Automatic printing option 

• Windows metafile output 
 

4.4.1.1  Description of AQDBMS Products 
 

A Rose Plot summarizes the relationship between wind speed or a user-selected pollutant 
parameter in a standard wind rose. Before creating these plots, verify that the submit file is 
current and contains all sites to be plotted. See Section 4.3.4.3 on creating plots for multiple sites 
from the AQDBMS graphics programs, for information on creating a submit file and how to 
create plots for multiple sites. 
 

A Three-Year Summary Plot summarizes user-selected pollutant parameters in a bar 
chart that compares the second highest 1-hour average on a monthly basis. 

 
A Diurnal Plot summarizes user-selected pollutant parameters in a line graph that bins the 

values by time of day. 
 
A Summay by Month Plot summarizes user-selected pollutant parameters in a bar chart 

that compares highest hourly averages, highest 8-hour averages, and monthly averaages by month. 
 

These graphics products query data directly from the AQDBMS. The user interface for 
these programs have many similar features that are described in the next section. Options unique 
to each of these products are described in subsections following this. 
 
4.4.1.2  Creating Plots From the AQDBMS Graphics Programs 
 
 The AQDBMS graphics programs may be run directly from a Windows desktop icon.  To 
create a plot: 
 

• Double-click the icon for the desired graphics product on the Windows desktop. 

• Select a site from the Select Site drop-down list box. 

• Enter the start and end dates for the period to be plotted in the Start and End boxes. 

• Click the Get Parameter List button. The program retrieves a parameter code list for 
the selected site/period. 

• Select the parameter to be plotted from the Available Parameter List drop-down list box. 

• Select applicable options. Each type of plot has one or more options that can be changed. 

• To print the plot automatically, click the AutoPrint checkbox. 

• Click the Draw Plot button. The program retrieves and plots the data. 
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• If needed, modify the default graph scaling values, then click the Redraw button. 

• Click the Print button to print the plot. 
 
4.4.1.3  Creating Plots for Multiple Sites From the AQDBMS Graphics Programs 
 
 Plots can be created for multiple sites/parameters for the same time period. To create 
multiple plots in a single run, a submit file containing a list of the site/parameters to be plotted is 
created in advance. The sites/parameters included in a submit file will be plotted with common 
options. Sites with parameters that do not use common options – such as a scaling change – must 
be run in a single site mode. Create separate submit files for each of the graphics products. 
 
 To create a submit file: 
 

• Open a new file in a text file editor such as Windows Notepad (do not use a word 
processor such as Microsoft Word). 

 
• On the first line of this file: 
 

− Type a four-character site abbreviation followed by a comma <,>. 

− Type a parameter abbreviation followed by a hyphen <-> and a comma <,>. 

− Type  a Y followed by a comma <,>. 

− Type three more commas, then press <Enter>. For example, type BIBE,O3-4,Y,,,, 
to plot ozone data for Big Bend National Park. 

 
• Repeat the above step for each combination of site/parameter that you want to include 

in the batch of plots. 
 
• Select Save As from the File menu. Save the file in the folder and with the filename 

of your choice. 
 
To create plots for multiple sites: 

 
• Double-click the icon for the desired graphics product on the Windows desktop. 
 
• Set up the printer: 
 

- From the File menu, choose Select Printer. 

- Select the desired Printer destination. 

- Set the paper orientation for the current graphic product (all are portrait except 
the One-Year Summary plot, which is landscape). 

 
• Enter the start and end dates for the period to be plotted in the Start and End boxes. 
 
• Select applicable options. Each type of plot has one or more options that can be changed. 
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• To not automatically print the plots, click the AutoPrint checkbox to deselect the 
auto printing feature. 

 
• From the File menu, select Run a Submit File. 
 
• Select the submit file you previously created and saved from the File-open dialogue 

box and click OK. 
 
4.5 DELIVERING DATA REQUESTS 
 
 Hardcopy data requests are mailed or faxed to the recipient. Digital data requests are 
delivered in one of the following ways depending on the volume of data and/or how the 
recipients want to receive the data: 
 

• Downloaded by the recipient from the ARS FTP site. 
• Transmitted via an e-mail attachment. 
• Written to CD-ROM and mailed. 
 

 If the data files are to be downloaded from the ARS FTP site: 
 

• The files are uploaded to the site. 
• An-e-mail message is sent, which includes instructions for downloading the files. 
• The message is sent. 
• The files are removed from the FTP site after it is confirmed that the recipient has 

successfully retrieved them. 
 

 If the data files are transmitted via an e-mail attachment: 
 

• The data file(s) are attached to the e-mail message and the message is sent. 
 

 If data files are written to CD-ROM:  
 

• The data analyst copies the files to the appropriate media and labels each piece as to 
its contents. 

 
• The data analyst prepares a cover letter and the package is sent first class mail unless 

directed otherwise by the ARD.   
 

 After the request is completed and delivered, the technical assistant prepares a list of all 
requests filled during the week and includes them in the Weekly Progress Status Report 
delivered to the contracting officer’s technical representative (COTR). 
 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2001, Air Quality Data Base Management System 
          (AQDBMS) User’s Guide. 
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1.0 PURPOSE AND APPLICABILITY 
 

This technical instruction (TI) describes the procedures and methods used by the National 
Park Service (NPS) Air Resources Division’s (ARD) Information Management Center (IMC), 
for submitting data to the Environmental Protection Agency’s (EPA) Air Quality System (AQS) 
database. These data include hourly average ambient air quality and meteorological data, 
precision data from criteria pollutant analyzer precision checks, and accuracy data from twice-
annual maintenance visits and external audits of criteria pollutant analyzers. 

 
All data and associated AQS codes required for creating AQS transactions are stored in 

the Air Quality Data Base Management System (AQDBMS). Computer programs within the 
AQDBMS create the AQS transaction files; data are submitted on a monthly basis for hourly 
data, and on a quarterly basis for precision and accuracy data, after all data for the quarter are at 
the Final validation level. This TI is referenced from SOP 3550, Ambient Air Quality and 
Meteorological Monitoring Data Reporting.  
 
2.0 RESPONSIBILITIES 
 
2.1 INFORMATION MANAGEMENT SECTION MANAGER 
 
 The information management section manager shall oversee all reporting procedures and 
provide direction when required. 
 
2.2 DATA ANALYST 
 
 The data analyst shall: 
 

• Maintain the required AQS codes for all sites and parameters within the monitoring 
network within the AQDBMS and in AQS. 

 
• Be adequately trained in operating the EPA AQS interface and be familiar with the 

set of EPA-issued AQS documentation. 
 
• Be responsible for generating and submitting hourly ambient and meteorological data 

and precision and accuracy data to the EPA AQS on at least a quarterly basis. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
3.1 SYSTEM HARDWARE AND SOFTWARE REQUIREMENTS 
 
 Detailed descriptions of all IMC hardware and software, and monitoring station hardware 
requirements are presented by category in SOP 3340, Information Management Center (IMC) 
Concept and Configuration. The IMC requires the following hardware and software for  
validation of ambient air quality and meteorological data: 
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• IMC hardware: 
 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
 
• IMC AQDBMS software: 
 

− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 

 
3.2 COMMUNICATIONS REQUIREMENTS 
 
 Submitting data to AQS requires connecting directly to AQS by accessing the Internet 
using DSL, cable, T1, or other high-speed connection. 
 
3.3 EPA AQS TRAINING AND DOCUMENTATION 
 
 The EPA provides regularly scheduled training sessions on the EPA AQS.  The data 
analyst will attend training sessions as needed to keep skills and knowledge current. In addition, 
the IMC holds a complete set of EPA issued documentation on AQS. The data analyst is familiar 
with and will use this documentation as a supplement to this TI and when working within AQS. 
 
4.0 METHODS 
 
 All hourly average ambient air quality and meteorological data at the Final validation 
level are submitted to AQS on a monthly basis. Precision data from criteria pollutant analyzer 
precision checks and accuracy data from twice-annual maintenance visits and external audits of  
criteria pollutant analyzers are submitted on a quarterly basis. 
 
 This section contains the following three (3) major subsections, which detail the steps 
taken to complete data submittal to AQS: 
 
 4.1  Generating AQS Files From the AQDBMS 
 4.2  Transferring an AQS File to AQS via CDX 
 4.3  Loading, Statistical Analysis, and Posting of Data to AQS 
 
 The steps required to submit data to the EPA AQS database are: 
 

• Create and verify the accuracy of AQS transaction files for hourly average ambient 
air quality and meteorological data. 

 
• Create and verify the accuracy of AQS transaction files for precision data from 

criteria pollutant analyzer precision checks (typically one per week per site/analyzer). 
 
• Create and verify the accuracy of AQS transaction files for accuracy data from audit 

reports on criteria pollutant analyzers (typically one every 6-12 months per 
site/analyzer). 
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• Transfer the files to AQS using CDX (Central Data Exchange). 
 
• Load data into the AQS database, successfully run the AQS statistical analysis 

programs, and post data to the AQS database. 
 
 Refer to the Air Quality System User Guide (EPA, 2006) for detailed information about 
submitting data to AQS. 
 
4.1 GENERATING AQS FILES FROM THE AQDBMS 
 
4.1.1 Hourly Average Files 
 
 Hourly average ambient air quality and meteorological data must be formatted as AQS 
Type RD transactions to be submitted to AQS.  A program in the AQDBMS generates Type RD 
transaction files. 
 
 To generate transaction Type RD AQS files: 
 

• From the AQDBMS, select  AQ and Met Processing. 
 
• Select Reports. 
 
• Select Export Hourly Data to NEW AQS Format. 
 
• Select the sites, parameters (defaults to select all parameters with AQS codes), and 

dates of the data set to use. 
 
• Click the Run button. 

 
 Unless renamed under “options” before running, a file called AQS.DAT is written to the 
\\arsnw1\vol4\project\imc\aqs directory.  A message displays if the file already exists.  Answer 
Yes to append to the existing file or No to overwrite the existing file. 
 
Notes: 
 

• The program looks up each selected site in the Site Configuration Table. This is 
where the AQS site code (state, county, and site number) is stored. If this information 
is not filled in, a message is displayed and that site will not be written to the AQS 
data file.  If the information is wrong, problems will occur in AQS. 

 
• If a site does not exist for the entire period that was selected, only the period where a 

record exists in the database will be written to the file (i.e., nothing will be written for 
the times when there are no records). If a record does exist, however, even if it’s 
coded NA, it will be written to the file. Likewise, if a parameter is chosen and a site 
does not have that monitor, then that parameter will be skipped. 

 
• Each parameter’s associated AQS code, method code, and POC code is defined in the 

Parameter Codes Table, under table maintenance. 
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4.1.2 Precision Data AQS Files 
 
 The weekly precision checks conducted on criteria pollutant analyzers within the network 
are submitted to AQS as precision or Type RP transactions. A program in the AQDBMS 
generates Type RP transaction files. 
 
 To generate transaction Type RP AQS files: 
 

• From the AQDBMS, select  AQ and Met Processing. 
 
• Select Reports. 
 
• Select Export Precision Data to New AQS Format. 
 
• Select the sites, parameters, and dates of the data set to use. 
 
• Click the Run button. 

 
 A file called PARS.DAT is written to the \\arsnw1\vol4\project\imc\aqs\ directory.  A 
message displays if the file already exists.  Answer Yes to append to the existing file or No to 
overwrite the existing file. 
 
4.1.3 Accuracy Data AQS Files 
 
 Data from twice-annual or external audits conducted on criteria pollutant analyzers 
within the network are submitted to AQS as accuracy or Type RA transactions. A program in the 
AQDBMS generates Type RA transaction files. 
 
 To generate transaction Type RA AQS files: 
 

• From the AQDBMS, select  AQ and Met Processing. 
 
• Select Reports. 
 
• Select Export Audit Data to New AQS Format. 
 
• Select the sites, parameters, and dates of the data set to use. 
 
• Click the Run button. 

 
 Unless renamed under “options” before running, a file called AUDIT.DAT is written to 
the \\arsnw1\vol4\project\imc\aqs\ directory.  A message displays if the file already exists.  
Answer Yes to append to the existing file or No to overwrite the existing file. 
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4.2 TRANSFERRING AN AQS FILE TO AQS VIA CDX 
 
 Once the AQS data file is generated and deemed accurate by the data analyst, it is ready 
to be sent to the AQS database. Files are transferred using the program CDX. To transfer files:  
 

• Login to your CDX account on any high-speed Internet connection, using your 
current ID and password, at https://cdx.epa.gov/SSL/cdx/login.asp. 

 
• Click on the file transfer profile AQS: Air Quality System – File Transfer, to 

access the AQS Web Submittal Form. 
 
• Click on the box titled Select from the right side of the screen. This will bring up a 

browsing window where you select and open the files created in Section 4.1. These 
files will then appear in the list of files box. 

 
• Highlight the file(s) to transfer, and click the Send box at the bottom of the screen. 

 
The system will send an e-mail informing when the files are in the system and are ready 

to load into AQS. 
 

4.3 LOADING, STATISTICAL ANALYSIS, AND POSTING OF DATA TO AQS 
 
4.3.1 Loading Records into AQS 
 

• Login to your AQS account on any high-speed Internet connection. From the bottom 
of the page at http://www.epa.gov/ttn/airs/airsaqs/aqsweb/aqswebhome.htm, click 
Proceed to AQS. 
 

• Click on I agree to these terms and want to enter the AQS application. 
 
• Enter your current ID and password, and aqsprod for database. 
 
• Click on Session, highlight the appropriate screening group, press OK, and then go to 

the Batch menu. 
 
• Under the Batch Load tab, highlight the appropriate file from the CDX list, and click 

Load File (see Figure 4-1). When the file has loaded, you will receive an e-mail with 
the file’s status from AQS (see Figure 4-2). 

 
NOTE: At this point, raw data records loading without errors are in “preproduction”, 
while raw data records containing an error are in “staging tables” of AQS. Precision 
and/or accuracy data are automatically posted at this stage. You do not need to run 
statistics on, nor post precision and/or accuracy data). 
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Figure 4-1.  Batch Load Tab AQS Screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-2.  Example E-mail Confirming File Load. 
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 If the file loaded without errors, more files may be loaded using the same procedure, or 
continue to Statistical Analysis. 
 
 If the file did not load, or if it loaded with errors, the e-mail will contain a listing of the 
errors, and the issues must be researched and addressed before continuing. Records with errors 
can be retrieved and corrected manually in AQS from the main menu under Correct → Raw. To 
make a global change, such as changing all input codes from I to U, query Staging Table records 
using the wildcard % in any field, and AQS should return all data with errors. If you continue 
without correcting errors, records with errors will not be posted, but will remain in Staging 
Tables. If left at this point, there will be holes in the data, percentage data completeness will be 
in error, and records left in Staging Tables will remain to confuse the user during future loads. 
With proper authority, if data cannot be corrected, or should for any reason not be uploaded, all 
data remaining in Staging Tables can be deleted at once by clicking Correct → Delete by 
screening group. AQS will return the question, “You are about to delete all correct data for 
screening group NATIONAL PARK SERVICE. Do you want to continue? Yes/No. 
 
 When corrections are complete, reload the corrected data from Staging Tables by clicking 
on the Submit Correct D[ata] button from the Batch screen. If there are still errors, continue to 
make corrections as above. When data load completely without errors, continue to Statistical 
Analysis. 
 
4.3.2 Statistical Analysis in AQS 
 
 Under the Batch Load tab, check that the current session is highlighted, and click Stats 
CR. AQS will forward an e-mail when the report is complete (see Figure 4-3). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-3.  Example E-mail Confirming Complete Report. 
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 Flagged data can be reviewed under the Batch Reports tab by clicking on Scan Report 
and/or Stat Evaluation (see Figure 4-4). Figure 4-4 shows the Batch Reports tab. Stats CR can 
also be run against past loads, by highlighting the desired session in the list and pressing Stats 
CR. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-4.  Batch Reports Tab AQS Screen. 
 
4.3.3 Posting Data to AQS 
 
 Under the Batch Load tab, check that the current session is highlighted, and click Post. 
AQS will forward an e-mail when the post is complete (see Figure 4-5). 
 
 When complete, go to the Batch Reports tab, and click on Raw Data Inventory. This 
will provide you with a report of all posted data – keep this report for future reference. This 
report only works for raw data (not precision or accuracy data). 
 
5.0 REFERENCES 
 
Environmental Protection Agency (EPA), 2006, Air Quality System User Guide, January. 
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Figure 4-5.  Example E-mail Confirming Complete Post. 
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1.0 PURPOSE AND APPLICABILITY 
 
 This standard operating procedure (SOP) describes the steps taken by ARS’ Information 
Management Center (IMC) for maintaining network configuration and related information in the 
Air Quality Data Base Management System (AQDBMS). The data are stored in Oracle database 
tables and other digital files and must be accurate and thorough in order to operate all aspects of 
the AQDBMS including data collection, loading data into the database, data validation, data 
reporting, and submitting data to AQS.  This SOP describes the IMC staff’s responsibilities for 
maintaining the AQDBMS. This SOP is to be used as a guide through the onscreen AQDBMS 
displays. The user is expected to view the AQDBMS screens while using this SOP. All available 
screen displays are not presented in this SOP as hardcopy printouts. 
 
2.0 RESPONSIBILITIES 
 
2.1 IMC STAFF 
 
 IMC staff shall accurately maintain network configuration and related information in the 
AQDBMS. 
 
2.2 FIELD SPECIALIST 
 
 The field specialist shall: 
 

• Notify the IMC of additions and modifications to the air quality network. 
 
• Provide accurate site instrumentation, support systems, and the datalogger 

configuration information to the IMC. 
 
3.0 REQUIRED EQUIPMENT AND MATERIALS 
 
 All IMC equipment and materials are fully described in SOP 3340/3341, Information 
Management Center (IMC) Concept and Configuration. 
 
4.0 METHODS 
 
 This section includes seven (7) major subsections: 
 
 4.1 Adding New Site Information 
 4.2 Modifying Site Information 
 4.3 Adding a New Parameter and/or Parameter Code 
 4.4 Adding a Conversion Formula 
 4.5 Adding a New Measurement Unit 
 4.6 Adding a New AQS Method Code 
 4.7 Creating or Modifying Files for Stackplots 
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4.1 ADDING NEW SITE INFORMATION 
 
 The specific tasks required for adding new site information include: 
 

• Collecting the site configuration information from the field specialist. 
 
• Creating AQS site and monitor records. 
 
• Adding the site and its current datalogger configuration to the Site Configuration 

Table in the Oracle database. 
 
• Adding screening ranges information for each  monitoring parameter at the new site 

to the Screening Ranges Table. 
 
• Creating a stackplot configuration (.stk) file. 

 
 After the ARD notifies the IMC of plans for a new site, a New Site/Site Relocation Form 
(Figure 4-1) is forwarded to the field specialist. This form includes information that will be 
required to configure the site in the AQS database as well as the AQDBMS. Information on the 
form includes location information, modem, datalogger, and parameter information. This form 
must be completed and returned to the IMC before the IMC can begin collecting data from the 
site. When the IMC receives the completed form, the information from it is used to complete the 
tasks detailed in the following subsections. 
 
4.1.1 Creating AQS Site and Monitor Records 
 
 Before data can be successfully submitted to AQS, related site and monitor records must 
exist within AQS. When a new site is configured, or an existing site adds or deletes a parameter, 
these records must be created.  See Technical Instruction 3550-5300, Submitting Ambient Air 
Quality and Meteorological Monitoring Data to the EPA AQS Database for instructions. 
 
4.1.2 Adding a Site to the Site Configuration Table 
 
 To correctly load data, each site currently being monitored must be properly defined in 
the AQDBMS Site Configuration Table. The information in the polling configuration is critical 
for data collection and must be accurate. Errors in the polling information may cause the data to 
not be retrieved, be written to the database incorrectly, or not be written at all. Follow these 
guidelines when adding or modifying polling configurations: 
 

• Configure new sites in the Site Specifications configuration window before 
attempting to add a new polling configuration record. 

 
• Sites can have multiple polling configurations for multiple dataloggers. 

 
• The raw data configuration and data parameter configuration must be up-to-date 

before adding or modifying a site. Attempting to configure the polling information 
with an undefined raw data format will cause an error. 



           
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-1. Example New Site Configuration Form. 
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Figure 4-1 (continued)  Example New Site Configuration Form. 
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Figure 4-1  (Continued).   Example New Site Configuration Form. 
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Figure 4-1  (Continued).   Example New Site Configuration Form. 
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Figure 4-1  (Continued).   Example New Site Configuration Form. 
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• If the On box is checked, a complete and accurate polling configuration is expected. 
Fill in all boxes. Check the DataView box if DataView is operating at the site. Do not 
check Retry. Check the days of the week to poll (usually all days are checked). The 
polling minutes are used to define the polling order of the sites within each hour. 
Using lower polling minutes will cause a site to be polled before other sites with 
higher polling minutes. Entering any minute value (including zero) into any hourly 
field will cause the data to be polled for that hour. 

 
• Add or delete linked raw data configurations to a site’s polling configuration from the 

Configured Data Format IDs data window. 
 
 A raw data format configuration defines what type of data are collected by each channel 
in the datalogger and is used to relate the incoming raw data to information stored in the 
database.  To access the raw data formats configuration, select Configuration -> Raw Data 
Formats from the Configuration frame. Then select an abbreviation from the Select Site 
drop-down list box or add a new record. When configuring raw data formats, follow these 
guidelines: 
 

• For hourly data collected on ESC dataloggers, the Data Field and Data Label columns 
must reflect what the datalogger is providing in the raw data. (The Data Field column 
maps to the channel number). 

 
• The collected data type must already exist in the data parameter configuration. If it 

does not exist, it will not be available in the Par Code drop-down list box and cannot 
be used. In this case, a new data parameter is being defined and must be added to the 
Data Parameters configuration before continuing. 

 
• For calibration data collected on ESC dataloggers: 
 

− The Data Field column should contain 0. 
 
− The Data Label column must contain an appropriate label for the calibration data 

type (SPAN, PREC, or ZERO). 
 
− The Par Code column must contain the appropriate primary parameter name code 

rather than a specific parameter code (i.e., “O3” not “O3-10”). The data loading 
program assigns the correct par code by querying the hourly data. 

 
− The Code Field, Code Exp, Cal Type, and Cal Val Type columns tell the data 

loading program where in the reformatted cal file to look for the data. 
 
− Calibration configurations are not straightforward. Seek the help of the database 

administrator if a new configuration is required. 
 

• To add a new format ID, click the New Format button to show a blank configuration 
interface. 

 
• Enter information into the site configuration record.  
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4.1.3 Adding Screening Ranges Records 
 
 The anomaly screening configuration is used to flag raw data that fall outside of expected 
values so the data will be quickly inspected to rule out instrument problems and to aid the data 
analyst during the validation process. Currently, there is no “wizard” type interface for this 
configuration and, due to its complexity, only the database administrator should modify this 
configuration. 
 
4.1.4 Creating or Modifying Stackplot Configuration Files 
 
 The stackplot configuration consists of configuring each plot (titles, temporary plot file, 
etc.) and each graph on each plot (plotting parameters, line types, etc.). A plot represents a 
physical page and a graph represents a trace of data for a parameter drawn on the page. A site 
can have one or more plots associated with it and each plot can have one or more graphs on it. 
 
 Each plot configuration requires information specific to the plot page as shown in Figure 
4-2. When configuring a plot, follow these guidelines: 
 

• The contents of the Stkplot File field must be unique because it is used to create 
temporary ASCII files that are accessed by the Stkwin program for generating 
stackplots. 

 
• The Min. Increment must contain the shortest interval of time that will be plotted 

(usually 1 or 24 hours) on this plot page). 
 
• Check the Include in Daily Review box for the plot to be generated as part of the 

polling process. When this box is checked, also enter the number of Days back to 
plot. Check the Today box to plot through the current date; leave it unchecked to plot 
through the day before the current date. 

 
 Each graph on the plot has many parameters specifying how data will look on the graph 
and how the graph will look on the plot. Though some plotting parameters are not configurable 
and most of them have default settings, it is necessary to configure each graph at least once. 
Figure 4-3 shows an example stackplot parameter configuration. When configuring stackplot 
parameters, follow these guidelines: 
 

• The Par Code, Table, and Column Name fields must be configured properly in order 
for the program to find the correct data.  If necessary, refer back to the polling 
configuration to see the specific parameter codes assigned to a site’s data. 

 
• One or two parameters can be plotted on the same graph. Use the Yes and No radio 

buttons to toggle this option. 
 
• Configuring stackplot parameters takes practice and often requires several 

modifications before the plot looks right. 
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Figure 4-2.  Stackplot Page Configuration. 

 
Figure 4-3.  Stackplot Parameter Configuration. 
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4.2 MODIFYING SITE INFORMATION  
 
 Changes in site configuration require modifications to the site information.  Several 
examples of configuration changes and the actions required are: 
 
Change      Actions 
A new site begins monitoring • Add the site name to .SBM files. 

 
A site begins monitoring an 
additional parameter. 

• Add the datalogger column information to the site’s record 
in the Site Configuration Table. 

• Add the parameter to the site’s standard stackplot 
configuration file if the parameter should be plotted. 

• Submit the new monitoring information to AQS. 
 

A site discontinues all monitoring. • Uncheck the Include in Auto Poll box in the site’’ record 
in the Site Configuration Table. 

• Submit the termination dates to AQS. 
• Delete the site name from the .SBM files. 

 
A site discontinues monitoring of 
one or more parameters. 

• Modify the site’s record in the Site Configuration Table to 
reflect the new datalogger configuration. 

• Submit changes to AQS. 
• Modify the site’s stackplot file to remove the discontinued 

parameters  if they had been plotted. 
 

A site begins monitoring a 
parameter with a different 
measurement unit or model of 
analyzer. 

• Change the parameter code for the appropriate datalogger 
column in the site’s record in the Site Configuration Table. 

  
 For detailed instructions for each of these actions, or any other network changes that 
require site information modifications in the AQDBMS, refer to TI 3550-5300, Submitting 
Ambient Air Quality and Meteorological Monitoring Data to the EPA AQS Database. 
 
4.3 ADDING A NEW PARAMETER AND/OR PARAMETER CODE 
 
 Two tables exist in the database that define the collected parameters in the air quality 
network. The Parameter Table holds the records for each basic parameter monitored, such as ozone 
(O3) or sulfur dioxide (SO2). Each record in this table has a unique entry in the parameter field and a 
unique set of AQS codes. The Parameter Codes Table holds records that further define each 
parameter, such as the units of measurement and the AQS method code for the type of analyzer 
used. If a gaseous pollutant or meteorological parameter is added to the network, one that has never 
been collected at any site in the network, the parameter must be added to the Parameter Table. If an 
already existing parameter changes with regard to any of its defining elements (units of 
measurement, method code, or parameter occurrence code) a new parameter code must be added.  
For instructions for adding new parameters and parameter codes, see the adding a new parameter 
and/or parameter code section in the Air Quality Data Base Management System (AQDBMS) User’s 
Guide (ARS, 2008). 
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4.4 ADDING A CONVERSION FORMULA 
 
 Most network parameters are collected in standard units; however, throughout the history of 
the air quality network, parameters have been collected in varying units of measurement, often 
varying from one period to another at a specific site. The AQDBMS stores all data in the originally 
collected units, therefore the reporting programs have been developed to handle these variations.  
During execution, the reporting program queries a table in the AQDBMS that holds the conversion 
formulas and converts values as needed in order to correctly generate output. If a new parameter 
type is defined or if an existing parameter is going to be collected in different units that exist in the 
Parameter Table, the table must be modified to handle the unit conversion requirements. 
 
 The following examples are provided to illustrate when additional conversion formulas are 
necessary: 
 
 Event: The ozone analyzers at all sites have been collecting data in parts per million (ppm).  

Glacier National Park begins collecting ozone data in parts per billion (ppb). 
 

Action:  Add two records to the Conversion Formula Table; one for converting ozone in 
ppm to ppb and one to convert ozone in ppb to  ppm. 
 
Event:  Chiricahua National Monument begins collecting ozone data in parts per billion 
(ppb). 
 

 Action:  None, because the required conversion formula records already exist. 
 
 For instructions on adding conversion formulas, see the adding a conversion formula section 
of the Air Quality Data Base Management System (AQDBMS) User’s Guide (ARS, 2008). 
 
4.5 ADDING A NEW MEASUREMENT UNIT 
 
 Each data value in the AQDBMS database is tagged with a parameter code. The parameter 
definition includes the measurement unit. Therefore, RNF-1 is defined as rainfall (precipitation) in 
mm and RNF-2 is defined as rainfall in in. Another table, the Units Table, is used to define what mm 
and in are, millimeters and inches. This table also stores the equivalent AQS code for each unit. 
Since AQS uses thousands of different units, only those required by the AQDBMS have been 
defined in the Units Table and new units must be added. 
 
 If a site begins collecting data using a unit that has not been previously used at any site for 
any parameter, a record defining the unit must first be added to the Units Table before the unit can 
be used to define a parameter code. For example, if Big Bend National Park began collecting 
rainfall in buckets instead of millimeters or inches, the IMC data analyst would find the AQS unit 
code for buckets in the AQS documentation and then add a new record to its Units Table defining 
buckets. After adding the new unit, a new parameter code would be added. To add a new unit, see 
the adding new units section of the Air Quality Data Base Management System (AQDBMS) User’s 
Guide (ARS, 2008). 
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4.6 ADDING A NEW AQS METHOD CODE 
 
 AQS uses a method code in its database to define the type of instrumentation  used to collect 
data. For instruments that collect pollutant parameters, the method codes differ not only with the 
type of analyzer but also with the specific analyzer make and model. The AQDBMS must know 
what method code to associate with each data value when creating records to submit to AQS. Again, 
the parameter code is used to accomplish this. For example, the parameter code O3-5 is defined as 
ozone collected in ppm with method code 83. The unit ppm is defined in the Units Table and, 
similarly, method code 83 is defined in the Methods Codes Table. Since AQS uses thousands of 
different method codes, only those required by the AQDBMS have been defined in its Method 
Codes Table and any  new method codes must be added. To add a new method code, see the adding 
a new parameter or parameter section in the Air Quality Data Base Management System 
(AQDBMS) User’s Guide (ARS, 2008). 
  
4.7 CREATING OR MODIFYING FILES FOR STACKPLOTS 
 
 Setting up a stackplot is complex due to the large number of possible data combinations 
and options. Therefore, a set of standard setup files (.STK file) have been created for plots that 
are created on a regular basis with only a change in the time period to be plotted. These files are 
maintained in \\ARSNW1\vol4\project\imc\stkplots\dailyreviewl. File names are ssssSTD.STK, 
where ssss is the 4-letter site abbreviation. Refer to the Stackplot User’s Guide (ARS, 2007) for 
layout information. 
 
5.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2007, Stackplot User’s Guide. 
 
Air Resource Specialists, Inc. (ARS), 2008, Air Quality Data Base Management System 
(AQDBMS) User’s Guide. 
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1.0 Introduction

This document discusses the designs, definitions, specifications, and current maintenance
schedule for the Air Quality Data Base Management System (AQDBMS) developed by Air
Resource Specialists, Inc. (ARS) for the National Park Service (NPS) Air Resources Division’s
(ARD) Information Management Center (IMC).  When combined with the documentation
provided by the commercial software vendors involved, this document will help the experienced
Oracle database administrator and/or database programmer to understand and maintain the
operational Oracle database and interface applications. Specific categories that will be addressed
include:

• Overall system description
• Database design
• Client installation instructions
• Database startup and shutdown instructions
• Oracle database maintenance schedule and instructions

Note:  System hardware and software requirements are specified in SOP 3340,
Information Management Center (IMC) Concept And Configuration.

2.0 AQDBMS Overview

 The AQDBMS IMC Oracle database (IMC database) is specifically designed to hold air
quality network data and related site information data, validation data, diagnostic data, and
parameter data that accommodate the many temporal, spatial, and functional variations found
within an air quality network.  The database resides on a network server computer.  The
AQDBMS also includes a custom database user interface developed by Air Resource Specialists,
Inc. (ARS) with Powersoft PowerBuilder Enterprise for Windows and Microsoft Visual Basic.
Both are graphical application development environments that provide the tools needed to build
easy to use, powerful database applications for Windows operating systems.  The interface
consists of menus and windows (or screens that users interact with) and makes extensive use of
standard point and click window controls and functions, such as:

• Command buttons, check boxes, and radio buttons.
• Drop-down lists to facilitate data entry and ensure data integrity.
• Dialog boxes that prompt the user for information or display error messages.
• Tab controls for organizing processes and user input.
• The ability to open more than one window (screen) at a time for "multi-tasking."

 
 The custom interface supplies the following functions:
 

• Primary gaseous pollutant and meteorological data loading and storage
• Precision checks and audit data loading and storage
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• Site and parameter configurations maintenance
• Data validation
• Data reporting
• Data retrieval and export including creation and loading of EPA AIRS transaction files
• Logging of site problems, instrument maintenance, etc.

The Air Quality Data Base Management System (AQDBMS) User's Guide (ARS, 1999, 2001)
provides detailed instructions on using the interface to accomplish these tasks.

3.0 Database Description

The IMC database has been designed using the entity-relationship model and Codd’s rules
of normalization.  In summary, this means the database is a collection of tables containing
columns and rows and the data in each table are related to data in one or more other tables.  In
addition:

• Each entry in a table occurs only once, (i.e., each row is unique).
• Each column is named.
• All values of a given column are of the same type.
• Column order is immaterial.
• Row order is immaterial.

Because common columns relate tables in a relational database, the rules that govern the
relationship of the columns must be maintained.  Referential integrity rules enforced by foreign
key constraints guarantee that these relationships are preserved.  This means that no user may at
any time or through any data access path enter undefined or incomplete information, nor can a
user delete a row for which related rows exist.  In addition, Oracle database triggers are used to
enforce the rules of allowable combinations of values that may be entered into the main data table
(primary_data). A database trigger is a stored database procedure automatically invoked by the
Relational Data Base Management System (RDBMS) during insert, update, or delete operations
on the table for which it has been defined.

A list of IMC database tables and associated tablespaces is shown in Table 3-1.  Foreign key
constraints are presented in Table 3-2.  An Appendix to this document contains a description of
each table, including column names, data types, indexes, and triggers.
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Table 3-1

Tables in the IMC Database

Name Owner Tablespace
AIRS_METHODS   DPC CODES
AMBIENT_AQ_STANDARDS   DPC CODES
AQMET_SPECS   DPC SITE_CONFIGURATION
AQ_CAL   DPC CAL_DATA
AUDIT_DATA   DPC CAL_DATA
COLUMNS   DPC POLLING
CONVERSIONS   DPC DATA_VALIDATION
DATA_FORMS   DPC DATA_VALIDATION
DATA_VALIDATION_LOG   DPC DATA_VALIDATION
DATA_VALIDATION_COMMENTS   DPC DATA_VALIDATION
DATA_VALIDATION_LOG_DETAIL2   DPC DATA_VALIDATION
DATA_WINDOW   DPC USER_DATA
INTERVAL_CODES   DPC CODES
MESSAGES   DPC SITE_CONFIGURATION
OUTPUT_GROUPINGS   DPC SITE_CONFIGURATION
OUTPUT_GROUPS   DPC SITE_CONFIGURATION
OUTPUT_PRODUCTS   DPC SITE_CONFIGURATION
OUTPUT_PRODUCTS_OPTIONS   DPC SITE_CONFIGURATION
PARAMETER_CODES   DPC CODES
PARAMETERS   DPC CODES
PARS_INFO   DPC CODES
POLLING   DPC SITE_CONFIGURATION
POLLING_DETAIL   DPC SITE_CONFIGURATION
POLLING_LINE_ID   DPC SITE_CONFIGURATION
PRIMARY_DATA   DPC DPC_DATA
SCREENING_TABLE1   DPC SITE_CONFIGURATION
SITES   DPC SITE_CONFIGURATION
SITE_GROUPINGS   DPC SITE_CONFIGURATION
SITE_GROUPINGS   DPC SITE_CONFIGURATION
SITE_GROUPS   DPC SITE_CONFIGURATION
SITE_LOGS   DPC DATA_VALIDATION
SITE_STATUS_LOG   DPC SITE_STATUS_LOG
SITE_STATUS_LOG_DETAIL   DPC SITE_STATUS_LOG
SITE_STATUS_LOG_DETAIL   DPC SITE_STATUS_LOG
SOURCE_CODES   DPC CODES
SOURCE_CODES   DPC CODES
STKPLOT_MASTER   DPC SITE_CONFIGURATION
STKPLOT_MASTER   DPC SITE_CONFIGURATION
STKPLOT_DETAIL   DPC SITE_CONFIGURATION
STKPLOT_DETAIL   DPC SITE_CONFIGURATION
TIME_ZONES   DPC SITE_CONFIGURATION
UNIT_CODES   DPC CODES
VALIDATION_CODES   DPC CODES
VALIDATION_CODES   DPC CODES



Table 3-2

Foreign Key Constraints on IMC Tables

Foreign Key Name Child Table Parent Table
Table Name Column Names Table Name Column Names

FK_AQ_CAL AQ_CAL SITE_NO SITES SITE_NO
FK_AQMET_SPECS AQMET_SPECS SITE_NO SITES SITE_NO
FK_AUDIT_PAR AUDIT_DATA PAR_CODE PARAMETER_CODES PAR_CODE
FK_AUDIT_SITE AUDIT_DATA SITE_NO SITES SITE_NO
FK_CONVERSIONS_PARAMETER CONVERSIONS PARAMETER PARAMETERS PARAMETER
FK_CONVERSIONS_FROMUNITCODE CONVERSIONS FROM_UNIT_CODE UNIT_CODES UNIT_CODE
FK_CONVERSIONS_TOUNITCODE CONVERSIONS TO_UNIT_CODE UNIT_CODES UNIT_CODE
FK_DAILY_OUTPUT DAILY_OUTPUT SITE_NO SITES SITE_CONFIGURATION
FK_DATA_VALIDATION_LOG DATA_VALIDATION_COMMENTS SITE_NO

YEAR
MONTH

DATA_VALIDATION_LOG SITE_NO
YEAR
MONTH

FK_DATA_VALIDATION_LOG DATA_VALIDATION_DETAIL2 SITE_NO
YEAR
MONTH

DATA_VALIDATION_LOG SITE_NO
YEAR
MONTH

FK_DATAVALIDATIONLOG_SITENO DATA_VALIDATION_LOG SITE_NO SITES SITE_NO
FK_OUTPUT_GROUP_NO OUTPUT_GROUPINGS GROUP_NO OUTPUT_GROUPS GROUP_NO
FK_OUTPUT_PROD_NO OUTPUT_GROUPINGS PROD_NO OUTPUT_PRODUCTS PROD_NO
FK_OUTPUT_OPTIONS OUTPUT_PRODUCT_OPTIONS PROD_NO OUTPUT_PRODUCTS PROD_NO
FK_PARAMETERS PARAMETER_CODES PARAMETER PARAMETERS PARAMETER
K_UNIT_CODE PARAMETER_CODES RAW_UNIT_CODE UNIT_CODES UNIT_CODE
FK_PARS_INFO_PAR PARS_INFO PARAMETER PARAMETERS PARAMETER
FK_PARS_INFO_UNIT PARS_INFO UNIT_CODE UNIT_CODES UNIT_CODE
FK_POLLING POLLING SITE_NO SITES SITE_NO
FK_TIMEZONE POLLING LOGGER_TIMEZONE TIMEZONES TIMEZONE_ABBR
FK_POLLING_DETAIL_SITE PARS_DETAIL SITE_NO

LOGGER_NO
POLLING SITE_NO

LOGGER_NO
FK_POLLING_DETAIL_LINE POLLING_DETAIL LINE_ID POLLING_LINE_ID LINE_ID
FK_POLLING_LINE_COL POLLING_LINE_ID COLUMN_NAME COLUMNS COLUMN_NAME
FK_POLLING_LINE_TAB POLLING_LINE_ID TABLE_NAME TABLES TABLE_NAME
FK_PARCODE PRIMARY_DATA PAR_CODE PARAMETER_CODES PAR_CODE
FK_SITENO PRIMARY_DATA SITE_NO SITES SITE_NO
FK_SOURCE PRIMARY_DATA SOURCE_CODE SOURCE_CODES SOURCE_CODE
FK_SITE_GROUPINGS SITE_GROUPINGS GROUP_NO SITE_GROUPS GROUP_NO
FK_SITE_LOGS SITE_LOGS SITE_NO SITES SITE_NO
FK_SITESTATUSLOG_SITENO SITE_STATUS_LOG SITE_NO SITES SITE_NO
FK_SITE_STATUS_LOG SITE_STATUS_LOG_DETAIL SITE_NO

REF_NO
SITE_STATUS_LOG SITE_NO

REF_NO
FK_STKPLOT_DETAIL STKPLOT_DETAIL SITE_NO

PLOT_NO
STKPLOT_MASTER SITE_NO

PLOT_NO
FK_STKPLOT_MASTER STKPLOT_MASTER SITE_NO SITES SITE_NO

4
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4.0 The Oracle RDBMS

Oracle provides the ability to store and access data in a manner consistent with the
relational model.  Because of this, Oracle is referred to as a relational database management
system (RDBMS).  The Oracle RDBMS is available for a number of specific platforms.
Currently, the AQDBMS uses the Oracle 8i 8.1 Server for Netware with the TCP/IP Protocol
Adapter to provide database access from Windows client workstations to the database residing on
a Netware server.  This section provides information and instructions for managing the database
in this environment.

Note: System hardware and software requirements are specified in SOP 3340,
Information Management Center (IMC) Concept And Configuration.

4.1 Oracle Database Files

The Oracle RDBMS uses files to store its data. In addition, files are used to store
configuration and initialization parameters.  A set of system tables, called the Oracle data
dictionary, tracks all of the database files; where they reside on the file server, their time stamps,
and other information.  To ensure integrity of the database, the database will not successfully
open on startup if the physical files have been moved or if the files have inconsistent timestamps.
Table 4-1 lists the paths and names of the physical files, tablespace names, and/or purposes.

4.2 Loading and Unloading the Oracle Server Netware Loadable Modules

The Oracle Netware Loadable Modules (NLMs) must be loaded into memory on the Netware
Server in order for the database to be accessed. As the NLMs are loaded, settings in the
CONFIG.ORA are used.  Figure 4-1 shows the contents of the current CONFIG.ORA file. See
Oracle 8i 8.1.6 Server Getting Started for NetWare (Oracle Corporation, 2000). Table 4-2 is list
of the current Novell Netware NLMs  and Oracle NLMs required by the Oracle server. Once the
NLMs are loaded, the database can be started.

Ø To Load the Oracle 8i Server:

 1 Verify that the required Novell Netware NLMs have been loaded (see Table 4-2).
 2 At the Netware Server console, type ORALOAD.  This is the name of the Oracle

Netware Configuration File (NCF) that loads all of the required Oracle NLMs.  After
loading the NLMs, the database administrator must startup the database. See Section 5.2
IMC Database Startup and Shutdown for instructions.

Ø To Unload the Oracle 8i Server:

 1 At the Netware Server console, type ORAUNLD.  This is the name of the Oracle
Netware Configuration File (NCF) that unloads all of the Oracle NLMs.



6

Table 4-1

IMC Database Data Files

Netware File Name Tablespace Name or purpose File type Size

Sys\database\caldata1.dbf CAL_DATA Binary 35mb
Sys\database\codes1.dbf CODES Binary 30mb
Sys\database\dval1.dbf DATA_VALIDATION Binary 68mb
Sys\database\datatmp1.dbf DATATEMP Binary 20mb
Sys\database\data1.dbf DPC_DATA Binary 2.3gb
Sys\database\site1.dbf
Vol2\database\site2.dbf

SITE_CONFIGURATION Binary 25mb
10mb

Sys\database\stat1.dbf SITE_STATUS_LOG Binary 30mb
Sys\oranw803\database\dbs1imc.ora
Sys\database\sys2.dbf

SYSTEM (System tables) Binary 9mb
100mb

IMC database control file Binary 141kb
Database log files Binary 201kb

201kb
Sys\database\rbig1.dbf RBS_BIG (Large rollback segments) Binary 140mb
Sys\database\rollback.dbf ROLLBACK_SEGS (Rollback segments) Binary 30mb
Sys\database\temp1.dbf TEMP (temporary segments) Binary 100mb
Sys\database\user1.dbf
Vol2\database\userdat2.ora

USER_DATA Binary 15mb
5mb

Vol2\database\prndx1.dbf PR_NDX (primary_data table index) Binary 2.8gb
Vol2\database\tmpirg.dbf
Vol5\database\tmplg2.dbf

TEMP_LARGE (Large temp segments) Binary 50mb
4gb

Vol2\database\calndx1.dbf CAL_NDX (cal_data table index) Binary 15mb
Vol2\database\ndx_01.dbf DPC_NDX (other table indexes) Binary 70mb
Vol5\orahome1\nlm\config.ora Oracle Server Initialization file Text 1kb
Vol5\orahome1\database\pwdimc.ora Oracle IMC Password file Binary-

encrypted
2kb

Initimc.ora Oracle IMC Instance initialization file Text 5kb
wgctl2.ora IMC database backup control file Binary 141kb
Vol5\orahome1\network\admn\listener.ora Oracle server listener configuration Text 1kb
Vol5\orahome1\network\admin\tnsnames.ora Oracle service names configuration Text 2kb
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Table 4-2

Netware Requirements

Operating System Netware 5 or 5.1
Novell NLMs • CLIB

• MATHLIB
• STREAMS

CLIB will automatically load additional NLMs

OS_NAME=netware
ORACLE_HOME=VOL5:\OraHome1
NETWORK=VOL5:\OraHome1\NETWORK
ORA_NLS33=VOL5:\OraHome1\OCOMMON\NLS\ADMIN\DATA
NLSRTL33=VOL5:\OraHome1\OCOMMON\NLS\ADMIN\DATA
ORACORE=VOL5:\OraHome1\RDBMS
NLS_LANG=AMERICAN_AMERICA.WE8ISO8859P1
PROD_HOME=VOL5:\OraHome1\oracle.swd.oui
ORD=VOL5:\OraHome1\ord
RDBMS=VOL5:\OraHome1\RDBMS
PLSQL=VOL5:\OraHome1\PLSQL
MD=VOL5:\OraHome1\MD
NW_ENABLE_SID_SUPPORT=TRUE
# Setting NW_FSTYPE to DFS is not supported on
# Volumes with Block Suballocation ON
NW_FSTYPE=CLIB
CTX=VOL5:\OraHome1\CTX
SQLPLUS=VOL5:\OraHome1\SQLPLUS
PRECOMP=VOL5:\OraHome1\PRECOMP
SQLPATH=VOL5:\OraHome1\SQLPATH
API=VOL5:\OraHome1\RDBMS
LOCAL=ARS_IMC-orcl-beq.world
UTILITY_MSG+VOL5:\OraHome1\RDBMS

Figure 4-1.  The Config.ora file.
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Important Note: Do not unload the Oracle NLMs without first shutting down the
database. See Section 5.2, IMC Database Startup and Shutdown.

4.3 IMC Database Backup and Recovery

Several operating system files contain the objects and initialization parameters for the IMC
database as shown in Table 4-1.  These files should be backed up on a regular basis.  Oracle
Corporation guarantees  only those backups performed when the database is shutdown (referred
to as "cold" backups) or databases running in "archive" mode.  This database was installed to run
in "no archive" mode.  This means that any updates to the database since the last backup could be
lost if the file server goes down with a critical disk error.

Ø To Backup the IMC Database:

 1 Shutdown the database prior to the start of the network backup procedure (see Section
5.2,  IMC Database Startup and Shutdown).

 2 Make sure all the database files in Table 4-1 are included in the list of files to be backed
up during the network backup procedure.

Ø To Recover the Oracle Database:

 1 Restore the database files from the backup media used during the last successful backup
to the paths listed in Table 4-1.

 2 Startup the database.

4.4 Database Security and Netware Rights

To run the AQDBMS client application and graphics programs, users must have Netware
file scan and read rights to the directories containing the executable application code as specified
in Sections 7.0 and 8.0.  In addition, several processes in the AQDMBS application read or write
files external to the database, so users must be given Netware scan, read, and modify rights to
these directories.  The specific directories and files are referenced in the Air Qualitiy Data Base
Management System (AQDBMS) User's Guide (ARS, 1999, 2001).

5.0 IMC Database Administration Tasks

The Database Administrator (DBA) is responsible for providing a database that is robust,
dependable, secure, extensible, and designed to meet the objectives of the applications it supports.
A complete discussion of managing all of the database’s internal architecture to meet these
objectives is beyond the scope of this document.  The following subsections, however, include an
overview of the utilities used to manage the IMC database and discussion, and instructions for
several ongoing and scheduled DBA tasks.
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5.1 Oracle DBA Utilities

Version 8i of the Oracle Client Software includes a package of Database Administration
Utilities collectively called The Oracle Enterprise Manager (OEM).  The OEM is installed on the
DBA’s workstation and provides graphical interfaces for performing many tasks.  A sub-set of
utilities collectively referred to as DBA Management Tools contain the components of OEM used
for managing the IMC database. These components are:

• The Instance Manager for monitoring database connections and for database startup and
shutdown. See the next section for instructions on using this utility to startup and
shutdown the database.

• The Schema Manager for easy execution of data definition language (DDL) commands.
• The Security Manager for managing database users and roles and their properties.
• The Storage Manager for monitoring and modifying data files.
• The SQL Worksheet for issuing Structured Query Language (SQL) commands in either

command line or script form.

See OEM online help for information on using these utilities.

5.2 IMC Database Startup and Shutdown

Several utilities may be used to startup and shutdown the IMC database. One is Instance
Manager, a graphical interface and component of the Enterprise Manager installed on a client
workstation.  The other is Server Manager, a non-graphical DOS program.  Both server and client
versions of Server Manager are available.

Ø To Startup the IMC Database Using Instance Manager from a Workstation:

 1 Launch the Instance Manager (typically from the Oracle Toolbar or find it in the
Windows program list).

 2 In the “User name” field of the login window, type SYS.
 3 In the “Password” field of the login window, type the database password.
 4 In the “Service” field of the login window, type IMC.
 5 Select sysdba from the connection type drop-down.
 6 Click on the database icon under the correct instance in the Instance Manager window.
 7 From the “Object” menu, select Startup.
 8 Enter the IMC Database initialization file path and name:

\\ARS_IMC\VOL5\ORHOME1\DATABASE\INITIMC.ORA.
 9 Click the Startup button.

Ø To Shutdown the IMC Database Using Instance Manager from a Workstation:

 1 Launch the Instance Manager (typically from the Oracle Toolbar or find it in the
Windows program list).

 2 In the “User name” field of the login window, type SYS.
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 3 In the “Password” field of the login window, type the database password.
 4 In the “Service” field of the login window, type IMC.
 5 Select sysdba from the connection type drop-down.
 6 Click on the database icon under the correct instance in the Instance Manager window.
 7 From the “Object” menu, select Shutdown.
 8 Click the radio button for the type of shutdown to perform, Normal, Immediate, or

Abort.  In most cases, Normal or Immediate are appropriate options.  Use Abort only
in times of critical server errors.

 9 Click the Shutdown button.

Ø To Startup the IMC Database Using Server Manager from the Server Console:

 1 At the server console, type svrmgr31 and press ENTER. The Server Manager utility is
launched.

 2 Type set instance imc. Server Manager responds with “Instance set.”
 3 Type connect sys/******@imc as sysdba and press ENTER (***** indicates the

database password.)  Server Manager responds with “Connected.”
 4 Type startup pfile=vol5:\orahome1\database\initimc.ora  and press ENTER.  Server

Manager responds with database startup information.
 5 Type disconnect and press ENTER. Server Manager responds with “Disconnected.”
 6 Type exit and press ENTER.

Ø To Shutdown the IMC Database Using Server Manager from the Server
Console:

 1 At the server console, type svrmgr31 and press ENTER. The Server Manager utility is
launched.

 2 Type set instance imc. The Server Manager responds with “Instance set.”
 3 Type connect sys/******@imc as sysdba and press ENTER (***** indicates the

database password.)  Server Manager responds with “Connected.”
 4 Type shutdown normal (or immediate or abort) and press ENTER.  Server Manager

responds with “Database closed.”
Note:  In most cases, normal or immediate are appropriate options.  Use abort only in
times of critical server errors.

 5 Type disconnect and press ENTER.
 6 Type exit and press ENTER.

5.3 Monitoring IMC Database Data File Usage

The IMC database data files (tablespaces) have been sized based on estimates of the amount
of data to be stored.  Since these are only estimates, the data file space usage should be checked
on a monthly basis and data files extended or new data files added as required.  The Storage
Manager component of the OEM is used to monitor, add, and extend data files.  See the OEM
online documentation for instructions.
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5.4 Using the Oracle Analyze Command

The Oracle analyze command is used to collect statistics on a database object.  The
statistics are stored in the data dictionary and used by the Oracle optimizer to choose the
execution plan for SQL statements. Since thousands of rows are added to the primary_data table
on a daily basis, the analyze command should be run on the primary_data table and its primary
index at least once every three months.

Note:  Users will not be able to access the primary_data table during this process.

Ø To run the analyze command on the primary_data table:

 1 Launch the SQL Worksheet utility (typically from the Oracle Toolbar or find it in the
Windows program list).

 2 In the “User name” field of the login window, type SYSTEM.
 3 In the “Password” field of the login window, type the password for user system.
 4 In the “Service” field of the login window, type IMC.
 5 In the “SQL Worksheet” area, type analyze dpc.primary_data estimate statistics

percent 15.  Click the execute button.
 6 When the process has finished, type analyze dpc.pk_primary_data estimate statistics

percent 15. Click the execute button.

6.0 Oracle Workstation Client Software Installation

Each Windows workstation client that will access the IMC database must have the Oracle
client software installed. The current version is Oracle 8.1.6.

Ø To install the Oracle Client Software:
 1 Insert the Oracle 8..1.6 Client CD and either allow it to auto run or run “setup.exe.”
 2 Follow the prompts, the Oracle home should be set to a directory on the local drive.
 3 Select Custom Installation then click NEXT.
 4 From the “Available Components” list, select Net8 Client 8.1.6 and Oracle ODBC

Driver 8.1.6, then click NEXT.
 5 Click INSTALL.
 6 From the “Protocols List” select TCP/IP Protocol Adapter then click NEXT.
 7 Hold down the CTRL key and click to select Oracle8 ODBC Driver 8.03.03.
 8 If the install program attempts to run the configuratin assistant, cancel out of it.
 9 Follow the prompts to finish and exit the install program.
 10 After the install is complete, copy the files SQL.ORA and TNSNAMES.ORA from

\\ars_net3\sys\ars_soft\programs\sqlnet to the \network\admin directory under the Oracle
Home directory on the local drive.

 11 Test the connection. From the MS-DOS prompt type TNSPING IMC from the bin
directory under the Oracle Home directory on the local drive.
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7.0 The PowerBuilder Application Files and Deployment

 The AQDBMS PowerBuilder Application was originally written in Powerbuilder Version 4 and
has been migrated to Versions 5, 6, and to the current Version 7. The PowerBuilder interface
supplies the following functions:
 

• Primary gaseous pollutant and meteorological data loading and storage
• Precision checks and audit data loading and storage
• Site and parameter configurations maintenance
• Data validation
• Output of non-graphic data reports
• Data retrieval and export including creation of EPA AIRS transaction files
• Logging of site problems, instrument maintenance, etc.

The PowerBuilder application source code is contained in PowerBuilder libraries in the
directory \\ARS_AQDB\VOL4\POWERBUILDER\AQDB\VERSION 2. The library files have a
PBL file extension.  The PowerBuilder application object is named ARSMON and is contained in
ARSMONAPP.PBL. The main executable file is ARSMON.EXE and the compiled library files
have a PBD file extension.  The application has been compiled using a project object also called
ARSMON and is compiled using the native executable format (non-machine code).  The compiled
code is stored in the directory \\ARS_NET3\ARS_SOFT\PROGRAMS\AQDB\VERSION2.
Users must have file scan and read rights to this directory to run the AQDBMS application.  They
must also have the correct version of the PowerBuilder deployment files installed in the
windows\system directory on their workstation. Table 7-1 is a list of the required PowerBuilder
deployment files for this application.

Table 7-1

Required PowerBuilder Deployment Files

PBVM70.DLL
PBDWE70.DLL
LIBJCC.DLL
PBTRA70.DLL

8.0 The Microsoft Visual Basic Graphics Programs and Deployment

Graphics programs are written in Microsoft Visual Basic Version 5, Service Pack 3.
Table 8-1 lists the programs and the paths to the source code and to the executable code. Users
must have file scan and read rights to the executable code directories.
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Table 8-1

Visual Basic Source and Executable Files

Name/Description Path and File
Stkwin: generate stack plots Source:\\ars_net3\sys\ars_soft\source\vb\stkwin32.5

Executable: \\ars_net\sys\ars_soft\programs\stkwin.exe
Roseplot: generate rose plots Source: \\ars_net3\sys\ars_soft\source\vb\dpc_ro32.5

Executable: \\ars_net\sys\ars_soft\programs\aqrose.exe
3YrSummary: generate 3-year
summary plots

Source: \\ars_net3\sys\ars_soft\source\vb\dpc_su32.5
Executable: \\ars_net\sys\ars_soft\programs\aqsumm.exe

Barplot:  generate bar charts Source: \\ars_net3\sys\ars_soft\source\vb\dpc_ba32.5
Executable: \\ars_net\sys\ars_soft\programs\aqbar.exe

To generate diurnal plots Source: \\ars_net3\sys\ars_soft\source\vb\dpc_di32.5
Executable: \\ars_net\sys\ars_soft\programs\aqdiur.exe

Visual Basic deployment software must be installed on the user workstation as described below.

Ø To Install Visual Basic Graphics Programs:

 1 Run “setup.exe” from the \\ars_net3\sys\ars_soft\install\aq 3yrSummary Install
(vb32.5sp3)\144\Disk1 directory.

 2 Accept all default values from the setup program.  This will install and register all
Windows 95 runtime files on the workstation that are necessary for the IMC graphics
programs.

 3 When the setup program is complete, open Windows Explorer and delete the folder
named “c:\program files\dpc sum plot.”  All of the executable programs are run directly
from the network by the IMC AQDBMS application so it is not necessary to retain this
local folder.

 4 Delete the “AQ 3Year Summary Plot” folder from the Windows 95 Start\Programs
folder.

The graphics programs that retrieve data directly from the IMC database use the Oracle 8 ODBC
client driver.  Configuration instructions follow.

Ø To Configure the Oracle ODBC Driver:

 1 Install the Oracle 8 ODBC driver as explained in Section 6.0, Oracle Workstation Client
Software Installation.

 2 From the Windows 95 control panel, double-click the 32-bit ODBC icon.
 3 In the “Data Sources” dialog box, click the Add button.
 4 Select Oracle 8 ODBC from the list of Installed ODBC Drivers, then click OK.
 5 Type IMC in the Data Source field of the “Oracle ODBC Setup dialog” box.



14

 6 Type a description, such as IMC 8, in the Description field of the “Oracle ODBC Setup
dialog” box.

 7 Type IMC in the SQL*Net Connect String field of the “Oracle ODBC Setup dialog”
box.

 8 Click the Close button in the “Data Sources dialog” box.

9.0 References

Air Resource Specialists, Inc. (ARS), 1999, 2001 Air Quality Data Base Management System
          (AQDBMS) User’s Guide

Oracle Corporation, 2000, Oracle 8i Server Getting Started for NetWar, Release 8.1.6.
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AIRS_METHODS: A look-up table to describe the method codes used in the PARAMETER_CODES
table.

Column List
Name Type P M

METHOD_CODE NUMBER(3) Yes Yes
DESCRIPTION VARCHAR2(250) No No

Index List
Index Code P F A U C Column Code Sort

PK_METHOD_CODES Yes No No No No METHOD_CODE ASC

AMBIENT_AQ_STANDARDS: A table to define the air quality standards as defined in AIRS.  Used in
generating AIRS-type reports.

Column List
Name Type P M

STATE CHAR(2) Yes Yes
PAR VARCHAR2(25) Yes Yes
UNIT_CODE VARCHAR2(20) No Yes
MAX_VALUE NUMBER No No
SEA_STARTMO NUMBER(2) No No
SEA_ENDMO NUMBER(2) No No

Index List
Index Code P F A U C Column Code Sort

PK_AQ_STANDARDS Yes No No No No STATE
PAR

ASC
ASC
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AQMET_SPECS:  Air quality and meteorological site specifications. It has a one-to-one relationship with
the SITES table, but has been used to allow for flexibility if other types of data are introduced into the
database.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
AQMET_ABBR VARCHAR(15) No Yes
AIRS_STATE_CODE NUMBER(2) No No
AIRS_COUNTY_CODE NUMBER(3) No No
AIRS_SITE_CODE NUMBER(4) No No
AIRS_AGENCY_CODE NUMBER(3) No No
LONG_DEG NUMBER(3) No No
LONG_MIN NUMBER(2) No No
LONG_DEC NUMBER(2) No No
LAT_DEG NUMBER(3) No No
LAT_MIN NUMBER(2) No No
LAT_SEC NUMBER(2) No No
ELEVATION NUMBER(4) No No
FLOW_ABBR VARCHAR(6) No No

Index List
Index Code P F A U C Column Code Sort

PK_AQMET
UK_AQMET_ABBR

Yes
No

No
No

No
No

No
Yes

No
No

SITE_NO
AQMET_ABBR

ASC
ASC

AQ_CAL:  Actual and indicated values for zero, precision, and span readings for raw criteria pollutants
used for diagnostic and validation purposes. Zero and precision data are also submitted to AIRS.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
RECORD_DATE DATE Yes Yes
PAR_CODE VARCHAR2(25) Yes Yes
CAL_TYPE NUMBER(15,3) Yes Yes
VAL_TYPE VARCHAR2(10) Yes Yes
CAL_VAL NUMBER(15,7) No Yes
FLAGS VARCHAR2(10) No No
CAL_TYPE NUMBER(15,3) Yes Yes
CAL_TYPE NUMBER(15,3) Yes Yes
VAL_TYPE VARCHAR2(10) Yes Yes
VAL_TYPE VARCHAR2(10) Yes Yes
CAL_VAL NUMBER(15,7) No Yes
CAL_VAL NUMBER(15,7) No Yes
FLAGS VARCHAR2(10) No No
FLAGS VARCHAR2(10) No No

Index List
Index Code P F A U C Column Code Sort

PK_AQ_CAL Yes No No Yes No SITE_NO
RECORD_DATE
PAR_CODE
CAL_TYPE
VAL_TYPE

ASC
ASC
ASC
ASC
ASC
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AUDIT_DATA:  Ambient audit (or accuracy) data collected and logged on-site and hand-entered via the
data entry screen.   Includes multipoint calibrations.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
RECORD_DATE DATE Yes Yes
PAR_CODE VARCHAR2(25) Yes Yes
AUDIT_SOURCE VARCHAR2(50) No No
AIRS_AUDIT_TYPE NUMBER(1) No No
STANDARD_SOURCE CHAR(1) No No
ACTUAL_ZERO NUMBER(15,3) No No
INDICATED_ZERO NUMBER(15,3) No No
ACTUAL_LEVEL1 NUMBER(15,3) No No
INDICATED_LEVEL1 NUMBER(15,3) No No
ACTUAL_LEVEL2 NUMBER(15,3) No No
INDICATED_LEVEL2 NUMBER(15,3) No No
ACTUAL_LEVEL3 NUMBER(15,3) No No
INDICATED_LEVEL3 NUMBER(15,3) No No
ACTUAL_LEVEL4 NUMBER(15,3) No No
INDICATED_LEVEL4 NUMBER(15,3) No No
ACTUAL_LEVEL5 NUMBER(15,3) No No
INDICATED_LEVEL5 NUMBER(15,3) No No
TO_AIRS CHAR(1) No No

Index List
Index Code P F A U C Column Code Sort

PK_AUDIT_DATA Yes No No Yes No SITE_NO
RECORD_DATE
PAR_CODE

ASC
ASC
ASC

COLUMNS:  Table column names to provide drop-down data entry and data integrity for polling
configuration.

Column List
Name Type P M

COLUMN_NAME VARCHAR2(25) Yes Yes
COLUMN_NAME VARCHAR2(25) Yes Yes
DESCRIPTION VARCHAR2(50) No No
DESCRIPTION VARCHAR2(50) No No
COLUMN_NAME VARCHAR2(25) Yes Yes
COLUMN_NAME VARCHAR2(25) Yes Yes
DESCRIPTION VARCHAR2(50) No No
DESCRIPTION VARCHAR2(50) No No

Index List
Index Code P F A U C Column Code Sort

PK_COLUMNS Yes No No Yes No COLUMN_NAME ASC
PK_COLUMNS Yes No No Yes No COLUMN_NAME ASC
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CONVERSIONS:  The AQDBMS reporting programs must sometimes convert data values in order to
correctly report the data.  The programs access the formulas in this table as needed.

Column List
Name Type P M

PARAMETER VARCHAR2(25) Yes Yes
FROM_UNIT_CODE VARCHAR2(20) Yes Yes
TO_UNIT_CODE VARCHAR2(20) Yes Yes
FORMULA VARCHAR2(100) No No
ACCURACY NUMBER(2) No No
MULTIPLIER NUMBER(15,8) No No
OFFSET NUMBER(10,5) No No

Index List
Index Code P F A U C Column Code Sort

PK_CONVERSIONS Yes No No Yes No PARAMETER
FROM_UNIT_CODE
TO_UNIT_CODE

ASC
ASC
ASC

DATA_FORMS: A look-up table of data form names used during data entry of site log information.

Column List
Name Type P M

FORM_NAME VARCHAR2(40) Yes Yes

Index List
Index Code P F A U C Column Code Sort

PK_DATAFORMS Yes No No Yes No FORM_NAME ASC
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DATA_VALIDATION_LOG:  Used to track the completion of each major step of the validation process
and the initials of the IMC staff member completing the step.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
YEAR NUMBER(4) Yes Yes
MONTH NUMBER(2) Yes Yes
LEVEL_0 DATE No No
PRELIM_VAL_DATE DATE No No
PRELIM_VAL_BY VARCHAR2(25) No No
FINAL_VAL_DATE DATE No No
FINAL_VAL_BY VARCHAR2(25) No No
PLOT_COM_DATE DATE No No
PLOT_COM_BY VARCHAR2(25) No No
PLOT_REVIEW_DATE DATE No No
REPORTS_MAILED_DATE DATE No No
AIRS_SUBMIT_DATE DATE No No
AIRS_SUBMIT_BY VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_DATAVALIDATIONLOG Yes No No Yes No SITE_NO
YEAR
MONTH

ASC
ASC
ASC

DATA_VALIDATION_COMMENTS:  Provides the opportunity for the data analysts to comment on the
validation process for each site/month.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
YEAR NUMBER(4) Yes Yes
MONTH NUMBER(2) Yes Yes
LINE_NO NUMBER(2) Yes Yes
COMMENTS VARCHAR2(2500) No No
COMMENTS VARCHAR2(2500) No No
COMMENTS VARCHAR2(2500) No No
COMMENTS_DATE DATE No No
COMMENTS_DATE DATE No No
COMMENTS_DATE DATE No No
COMMENTS_DATE DATE No No
COMMENTS_BY VARCHAR2(25) No No
COMMENTS_BY VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_DATAVALIDATION_COMMENTS Yes No No Yes No SITE_NO
YEAR
MONTH
LINE_NO

ASC
ASC
ASC
ASC
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DATA_VALIDATION_LOG_DETAIL2 (Detail):  This table logs the receipt of the various supporting
documents received from the site operators for each row in the master table. NOTE: Rows are no longer
being inserted on this table as the process of logging site documentation has changed.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
YEAR NUMBER(4) Yes Yes
MONTH NUMBER(2) Yes Yes
LINE_NO NUMBER(2) Yes Yes
DATE_RECD DATE No No
FORM_NAME VARCHAR2(40) No No
START_DATE DATE No No
END_DATE DATE No No
YES_NO CHAR(1) No No
COMMENTS VARCHAR2(2000) No No
POST_CARD_DATE DATE No No

Index List
Index Code P F A U C Column Code Sort

PK_DATAVALIDATIONLOGDETAIL2 Yes No No Yes No SITE_NO
YEAR
MONTH
LINE_NO

ASC
ASC
ASC
ASC
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DATA_WINDOW:  This table is used to simplify the programming and formatting of certain output
products by providing temporary holding places for data from other tables.  It has no permanent rows.

Column List
Name Type P M

REC_NO NUMBER(3) Yes Yes
COL_1_DEC NUMBER(15,3) No No
COL_2_DEC NUMBER(15,3) No No
COL_3_DEC NUMBER(15,3) No No
COL_4_DEC NUMBER(15,3) No No
COL_5_DEC NUMBER(15,3) No No
COL_1_STR VARCHAR2(100) No No
COL_2_STR VARCHAR2(100) No No
COL_3_STR VARCHAR2(100) No No
COL_4_STR VARCHAR2(100) No No
COL_5_STR VARCHAR2(100) No No
GROUP_COL CHAR(1) No No
COL_1_INT NUMBER(4) No No
COL_2_INT NUMBER(4) No No
COL_3_INT NUMBER(4) No No
COL_4_INT NUMBER(4) No No
COL_5_INT NUMBER(4) No No
COL_6_DEC NUMBER(15,3) No No
COL_7_DEC NUMBER(15,3) No No
COL_8_DEC NUMBER(15,3) No No
COL_9_DEC NUMBER(15,3) No No
COL_10_DEC NUMBER(15,3) No No
COL_11_DEC NUMBER(15,3) No No
COL_12_DEC NUMBER(15,3) No No
COL_13_DEC NUMBER(15,3) No No
COL_6_STR VARCHAR2(100) No No
COL_7_STR VARCHAR2(100) No No
COL_8_STR VARCHAR2(100) No No
COL_9_STR VARCHAR2(100) No No
COL_9_STR VARCHAR2(100) No No
COL_10_STR VARCHAR2(100) No No
COL_10_STR VARCHAR2(100) No No
COL_11_STR VARCHAR2(100) No No
COL_11_STR VARCHAR2(100) No No
COL_12_STR VARCHAR2(100) No No
COL_12_STR VARCHAR2(100) No No
COL_1_DATE DATE No No
COL_1_DATE DATE No No
COL_2_DATE DATE No No
COL_2_DATE DATE No No

Index List
Index Code P F A U C Column Code Sort

PK_DATAWINDOW Yes No No Yes No REC_NO ASC
PK_DATAWINDOW Yes No No Yes No REC_NO ASC
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INTERVAL_CODES: Interval code information to allow for flexibility if data with other than hourly
average intervals are introduced to the database.

Column List
Name Type P M

INTERVAL_CODE VARCHAR2(25) Yes Yes
INTERVAL VARCHAR(15) No No
QUANTITY NUMBER(7) No No
TIME_UNIT VARCHAR2(15) No No
AVG_TYPE VARCHAR2(15) No No
DESC VARCHAR2(50) No No

Index List
Index Code P F A U C Column Code Sort

PK_INTERVAL_CODES Yes No No Yes No INTERVAL_CODE ASC

MESSAGES:  Messages accessed by the Powerbuilder application.

Column List
Name Type P M

MSGID VARCHAR2(40) Yes Yes
MSGTEXT VARCHAR(255) No No
MSGICON VARCHAR2(12) No No
MSGBUTTON VARCHAR2(17) No No
MSGDEFAULTBUTTON NUMBER(6) No No
MSGSEVERITY NUMBER(6) No No
MSGPRINT VARCHAR2(1) No No
MSGUSERINPUT VARCHAR2(1) No No

Index List
Index Code P F A U C Column Code Sort

PK_MSGID Yes No No Yes No MSGID ASC
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OUTPUT_GROUPINGS: Links output products and groups.

Column List
Name Type P M

GROUP_NO NUMBER(3) Yes Yes
PROD_NO NUMBER(3) Yes Yes

Index List
Index Code P F A U C Column Code Sort

PK_OUTPUT_GROUPINGS Yes No No Yes No SITE_NO
PROD_NO

ASC

OUTPUT_GROUPS: Groups of output products based on data types.

Column List
Name Type P M

GROUP_NO NUMBER(3) Yes Yes
GROUP_NAME VARCHAR2(50) No No
GROUP_TYPE VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_OUTPUT_GROUPS Yes No No Yes No GROUP_NO ASC

OUTPUT_PRODUCTS: List of output products, associated function names and common options. Used
by the reporting module of the interface.

Column List
Name Type P M

PROD_NO NUMBER(3) Yes Yes
FUNC_NAME VARCHAR2(50) No No
PROD_NAME VARCHAR2(250) No No
SITES NUMBER(1) No No
DATES NUMBER(1) No No
PARS NUMBER(1) No No
PRINT NUMBER(1) No No
SCREEN NUMBER(1) No No
BREATK NUMBER(1) No No
PDF NUMBER(1) No No
PAGE_NO NUMBER(1) No No
FILEOUT NUMBER(1) No No
USER_LEVEL NUMBER(1) No No
PAR_BREAK NUMBER(1) No No
LAUNCH_PROG NUMBER(1) No No

Index List
Index Code P F A U C Column Code Sort

PK_OUTPUT_PRODUCTS Yes No No Yes No PROD_NO ASC
PK_OUTPUT_PRODUCTS Yes No No Yes No PROD_NO ASC
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OUTPUT_PRODUCT_OPTIONS: List of output products and variable options. Used by the reporting
module of the interface.

Column List
Name Type P M

PROD_NO NUMBER(3) Yes Yes
OPTION_NO NUMBER(2) Yes Yes
OPTION_NAME VARCHAR2(250) No No
DATATYPE VARCHAR2(25) No No
DEFAULT_VAL VARCHAR2(25) No No
ITEM_LIST VARCHAR2(250) No No

Index List
Index Code P F A U C Column Code Sort

PK_OUTPUT_OPTIONS Yes No No Yes No PROD_NO
OPTION_NO

ASC

PARAMETER_CODES: This table contains the definition of each parameter code referenced in other
tables (such as Primary_Data).  Specifically defined parameter codes, such as "O3-1" and "O3-2," reflect
critical variations in the derivation of the data, such as instrument type or model and the associated AIRS
method code and parameter occurrence code (POC), units used, and decimal precision of the raw values
collected.  Each parameter code is derived from a base code that must exist in the Parameter Table
(such as "O3").

Column List
Name Type P M

PAR_CODE VARCHAR2(25) Yes Yes
RAW_UNIT_CODE VARCHAR2(20) No No
PARAMETER VARCHAR2(25) No No
RAW_WIDTH NUMBER(3) No No
RAW_PREC NUMBER(3) No No
METHOD_CODE NUMBER(3) No No
MORE_INFO VARCHAR2(150) No No
POC NUMBER(1) No No
PRC NUMBER(1) No No
PAR_ABBR VARCHAR2(25) No No
INTERVAL VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_PARAMETERCODES Yes No No Yes No PAR_CODE ASC
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PARAMETERS:  This table defines each parameter in general terms to allow grouping of the parameter
codes, definition of standard output units and decimal precision, and AIRS monitor codes. Additional
fields (plot order, stats_report, etc.) are used during generation of various output products.

Column List
Name Type P M

PARAMETER VARCHAR2(25) Yes Yes
AIRS_CODE NUMBER(5) No No
AIRS_METHOD NUMBER(3) No No
DESCRIPTION VARCHAR2(50) No No
PARS_CODE NUMBER(5) No No
DATA_TYPE VARCHAR2(15) No No
REPORT_UNIT_CODE VARCHAR2(20) No No
REPORT_WIDTH NUMBER(3) No No
REPORT_PRECISION NUMBER(3) No No
REPORT_ORDER NUMBER(3) No No
PLOT_ORDER NUMBER(3) No No
STATS_REPORT CHAR(1) No No
STACK_PLOT CHAR(1) No No
PAR_TYPE VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_PARAMETERS Yes No No Yes No PARAMETER ASC

PARS_INFO: Defines parameter/unit_code specific information which is used primarily during generation
of varoius output products.

Column List
Name Type P M

PARAMETER VARCHAR2(25) Yes Yes
UNIT_CODE VARCHAR2(20) Yes Yes
PRECISION_FROM NUMBER(7,3) No No
PRECISION_TO NUMBER(7,3) No No
LEVEL1_FROM NUMBER(7,3) No No
LEVEL1_TO NUMBER(7,3) No No
LEVEL2_FROM NUMBER(7,3) No No
LEVEL2_TO NUMBER(7,3) No No
LEVEL3_FROM NUMBER(7,3) No No
LEVEL3_TO NUMBER(7,3) No No
LEVEL4_FROM NUMBER(7,3) No No
LEVEL4_TO NUMBER(7,3) No No
PLOT_MAX NUMBER(7,3) No No
PLOT_STOP NUMBER(7,3) No No
PLOT_NAAQS NUMBER(7,3) No No
PLOT_FMT NUMBER(7,3) No No
ROSE_STEP NUMBER(7,3) No No
ROSE_STEP NUMBER(7,3) No No

Index List
Index Code P F A U C Column Code Sort

PK_PARAMETERS Yes No No Yes No PARAMETER ASC
PK_PARAMETERS Yes No No Yes No PARAMETER ASC
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POLLING:  Contains information on each current datalogger and is used by the polling program to
determine the auto polling schedule.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
LOGGER_NO NUMBER(2) Yes Yes
POLLING_ABBR VARCHAR2(4) No Yes
ON_OR_OFF CHAR(30) No Yes
LOGGER_TYPE VARCHAR2(15) No Yes
PHONE_NO VARCHAR2(50) No No
PASSWORD VARCHAR2(20) No No
SUCCESS_TIME DATE No No
HOUR_00 NUMBER(2) No No
HOUR_01 NUMBER(2) No No
HOUR_02 NUMBER(2) No No
HOUR_03 NUMBER(2) No No
HOUR_04 NUMBER(2) No No
HOUR_05 NUMBER(2) No No
HOUR_06 NUMBER(2) No No
HOUR_07 NUMBER(2) No No
HOUR_08 NUMBER(2) No No
HOUR_09 NUMBER(2) No No
HOUR_10 NUMBER(2) No No
HOUR_11 NUMBER(2) No No
HOUR_12 NUMBER(2) No No
HOUR_13 NUMBER(2) No No
HOUR_14 NUMBER(2) No No
HOUR_15 NUMBER(2) No No
HOUR_16 NUMBER(2) No No
HOUR_17 NUMBER(2) No No
HOUR_18 NUMBER(2) No No
HOUR_19 NUMBER(2) No No
HOUR_20 NUMBER(2) No No
HOUR_21 NUMBER(2) No No
HOUR_22 NUMBER(2) No No
HOUR_23 NUMBER(2) No No
SUN CHAR(1) No No
MON CHAR(1) No No
TUE CHAR(1) No No
WED CHAR(1) No No
THU CHAR(1) No No
FRI CHAR(1) No No
SAT CHAR(1) No No
RETRY CHAR(1) No No
RETRY_COUNT NUMBER(2) No No
ADJ_MIN NUMBER(2) No No
LOGGER_ID VARCHAR2(10) No No
PATH_NAME VARCHAR2(100) No No
DATA_VIEW CHAR(1) No No
LOGGER_TIMEZONE VARCHAR2(10) No No

Index List
Index Code P F A U C Column Code Sort

PK_POLLING Yes No No Yes No SITE_NO
LOGGER_NO

ASC
ASC
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Index Code P F A U C Column Code Sort
UK_POLLING_ABBR No No No Yes No POLLING_ABBR ASC

POLLING_DETAIL:  Links the rows in the POLLING table to the LINE_ID and is used during the data
loading process.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
LOGGER_NO NUMBER(2) Yes Yes
LINE_ID VARCHAR2(15) Yes Yes

Index List
Index Code P F A U C Column Code Sort

PK_POLLING_DETAIL Yes No No Yes No SITE_NO
LOGGER_NO
LINE_ID

ASC
ASC
ASC

POLLING_LINE_ID:  Datalogger configurations used during the polling and loading processes.

Column List
Name Type P M

LINE_ID VARCHAR2(15) Yes Yes
LOGGER_FIELD NUMBER(3) Yes Yes
CODE_FIELD NUMBER(2) Yes No
CODE_EXP VARCHAR2(25) Yes No
LOGGER_LABEL VARCHAR2(8) No No
PAR_CODE TABLE_TYPE No No
TABLE_TYPE VARCHAR2(30) No No
COLUMN_NAME VARCHAR2(15) No No
DESCRIPTION VARCHAR2(50) No No
CAL_TYP VARCHAR2(10) No No
MINUTES_ADJUSTED NUMBER(2) No No
CAL_VAL_TYPE VARCHAR2(10) No No
CAL_VAL_EXP VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_POLLING_LINE_ID Yes No No Yes No LINE_ID
LOGGER_FIELD
CODE_FIELD
CODE_EXP

ASC
ASC
ASC
ASC
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PRIMARY_DATA:  Each row represents a single measurement. This structure allows for flexibility
without carrying null values or repeating information. Raw values are not modified once they have been
appended (except on rare occasions and then under controlled conditions). The validation code column
is used during the validation process to store datalgoger codes, to flag anomalies and to store the
preliminary or final data validation code. The validated value column is initialized to –999 and is updated
during the validation process. Each row also contains a placeholder for a control value that may be used
during the valiation process.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
RECORD_DATE DATE Yes Yes
PAR_CODE VARCHAR2(25) Yes Yes
VALIDATION_CODE VARCHAR2(12) No No
CONTROL_VAL VARCHAR2(35) No No
VALIDATED_VAL NUMBER(15,3) No No
RAW_VAL NUMBER(15,3) No Yes
SOURCE_CODE CHAR(1) No Yes

Index List
Index Code P F A U C Column Code Sort

PK_PRIMARY_DATA Yes No No Yes No SITE_NO
RECORD_DATE
PAR_CODE

ASC
ASC
ASC

Trigger List
Name: Validate_Data
Body:
BEGIN
 /* If the first character of the validation code is not V then the validated value must be -999*/
 IF SUBSTR(:NEW.VALIDATION_CODE,1,1) <> 'V' AND :NEW.VALIDATED_VAL <> -999 THEN
  RAISE_APPLICATION_ERROR(-20001,'-20001 Check '||to_char(:old.record_date,'MM/DD/YY HH24')||’ ||:old.par_code);
 END IF;
 /*If the validated_val=-999 then the first char of validation code can not be V */
 IF SUBSTR(:NEW.VALIDATION_CODE,1,1) = 'V' AND :NEW.VALIDATED_VAL = -999 THEN
  RAISE_APPLICATION_ERROR(-20002,'-20002 Check '||to_char(:old.record_date,'MM/DD/YY HH24')||' '||:old.par_code);
 END IF;
        /* If the validation code is V then the validated value must equal the raw value*/
 IF :NEW.VALIDATION_CODE = 'V' AND :NEW.VALIDATED_VAL <> :NEW.RAW_VAL THEN
  RAISE_APPLICATION_ERROR(-20003,'-20003 Check '||to_char(:old.record_date,'MM/DD/YY HH24')||' '||:old.par_code);
 END IF;
 /*If the validation code is VA then ctrl_val must contain a value. */
        IF :NEW.VALIDATION_CODE = 'VA' AND :NEW.CONTROL_VAL IS NULL THEN
  RAISE_APPLICATION_ERROR(-20004,'-20004 Check '||to_char(:old.record_date,'MM/DD/YY HH24')||' '||:old.par_code);
 END IF;
 /*If the validation code is VA and raw_value <> 0 then the validated_val must not equal the raw value.*/
        IF :NEW.VALIDATION_CODE = 'VA' AND :NEW.RAW_VAL<>0 AND :NEW.VALIDATED_VAL=:NEW.RAW_VAL
THEN
  RAISE_APPLICATION_ERROR(-20005,'-20005 Check '||to_char(:old.record_date,'MM/DD/YY HH24')||' '||:old.par_code);
 END IF;
END;
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SCREENING_TABLE1:  Contains information used by the anomaly screening process. The SITE_NO
field may contain the value of 0 which indicates the default set of screening criteria.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
PARAMETER VARCHAR2(25) Yes Yes
INTERVAL VARCHAR2(25) Yes Yes
LINE_NO NUMBER(2) Yes Yes
COLUMN_NAME VARCHAR2(25) No No
VAL_OPERATOR VARCHAR2(10) No No
PAR_COL_OR_VAL VARCHAR2(25) No No
FLAG_OR_FILE VARCHAR2(25) No No
FLAG_PAR_OR_COL VARCHAR2(25) No No
DATA_POINTS NUMBER(4) No No
BACK_OR_FORE VARCHAR2(8) No No
ADJ_TO NUMBER(7,4) No No
ADJ_PAR_OR_COL VARCHAR2(25) No No
FLAG_PAR_INTERVAL VARCHAR2(25) No No
PERCENT_VALID NUMBER(2) No No
UNIT_CODE VARCHAR2(20) No No
DESCRIPTION VARCHAR2(500) No No

Index List
Index Code P F A U C Column Code Sort

PK_SCREENING_TABLE1 Yes No No Yes No SITE_NO
PARAMETER
INTERVAL
LINE_NO

ASC
ASC
ASC
ASC
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SITES: This table contains one row for each monitoring site (current and historical).

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
ABBR VARCHAR2(10) No No
NAME VARCHAR2(255) No No
NAME2 VARCHAR2(255) No No
PRINT_NAME2 CHAR(1) No Yes

Index List
Index Code P F A U C Column Code Sort

PK_SITES Yes No No Yes No SITE_NO ASC

SITE_GROUPINGS: Links site groups and sites or other groups together for reporting purposes. Each
row must contain a value in either SITE_MEM_NO or GROUP_MEM_NO but not both.

Column List
Name Type P M

GROUP_NO NUMBER(3) Yes Yes
SITE_MEM_NO NUMBER(3) Yes No
GROUP_MEO_NO NUMBER(3) Yes No
DATABASE VARCHAR2(15) No No
NAME VARCHAR2(150) No No

Index List
Index Code P F A U C Column Code Sort

PK_SITE_GROUPINGS Yes No No Yes No GROUP_NO
SITE_MEM_NO
GROUP_MEM_NO

ASC
ASC
ASC

SITE_GROUPS: Defines groups for reporting purposes.

Column List
Name Type P M

GROUP_NO NUMBER(3) Yes Yes
DESCRIPTION VARCHAR2(250) No No
GROUP_ABBR VARCHAR2(25) No No
GROUP_TYPE VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_GROUPS Yes No No Yes No GROUP_NO ASC
PK_GROUPS Yes No No Yes No GROUP_NO ASC
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SITE_LOGS: Contains site (station) logs of operator maintenance information collected by the DataView
application.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
RECORD_DATE DATE Yes Yes
LINE_NO NUMBER(2) Yes Yes
OPERATION VARCHAR2(100) No No
LOGGED_BY VARCHAR2(25) No No
MESSAGE VARCHAR2(2500) No No

Index List
Index Code P F A U C Column Code Sort

PK_SITE_LOGS Yes No No Yes No SITE_NO
RECORD_DATE
LINE_NO

ASC
ASC
ASC

SITE_STATUS_LOG (Master):  This table is a diary of site operations with the purpose of aiding the
field specialists with tracking and resolving problems and the data validation staff with data validation
procedures.  Date and time columns define when the problem occurred and other events such as site
visits, audits, precision checks, etc.  The affected parameters column is a variable length column which
allows entry of multiple parameters which are effected by the event described.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
REF_NO NUMBER Yes Yes
PROBLEM_FLAG CHAR(1) No No
START_DATE DATE No No
STOP_DATE DATE No No
ARS_VISIT DATE No No
OP_VISIT DATE No No
AUDIT_DATE DATE No No
PREC_CK DATE No No
MULTIPNT_CAL DATE No No
AFFECTED_PARS VARCHAR2(250) No No
ABBR_DESC VARCHAR2(250) No No
ABBR_DESC VARCHAR2(250) No No
DATA_LOST CHAR(1) No No
DATA_LOST CHAR(1) No No

Index List
Index Code P F A U C Column Code Sort

PK_SITESTATUSLOG Yes No No Yes No SITE_NO
REF_NO

ASC
ASC

PK_SITESTATUSLOG Yes No No Yes No SITE_NO
REF_NO

ASC
ASC
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SITE_STATUS_LOG_DETAIL (Detail):  This table contains detail information describing events related
to a row in the master table.

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
REF_NO NUMBER Yes Yes
LINE_NO NUMBER(4) Yes Yes
NOTE VARCHAR2(2000) No No
DATE_ENTERED DATE No No
ENTERED_BY VARCHAR2(25) No No
DATE_REPORTED DATE No No
REPORTED_BY VARCHAR2(25) No No

Index List
Index Code P F A U C Column Code Sort

PK_SITESTATUSLOGDETAIL Yes No No Yes No SITE_NO
REF_NO
LINE_NO

ASC
ASC
ASC

SOURCE_CODES:  A look up table for the primary data table source_code column that defines the
codes and is used to programmatically determine if the code opens up the raw_val column for a
manually entered replacement value.

Column List
Name Type P M

SOURCE_CODE CHAR(1) Yes Yes
DESCRIPTION VARCHAR2(250) No No
REPLACE_RAW CHAR(1) No No

Index List
Index Code P F A U C Column Code Sort

PK_SOURCECODES Yes No No Yes No SOURCE_CODE ASC
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STKPLOT_MASTER: Contains information for the stackplot program (one row per plot).

Column List

Name Type P M
SITE_NO NUMBER(3) Yes Yes
PLOT_NO NUMBER(3) Yes Yes
DESCRIPTION VARCHAR2(500) No No
STKPLOT_FILE VARCHAR2(8) No Yes
MAIN_TITLE VARCHAR2(200) No No
X_TITLE VARCHAR2(50) No No
SETUP_BY VARCHAR2(25) No No
SETUP_DATE DATE No No
STK_X_PLOT_SIZE NUMBER(15,4) No No
INC_MIN NUMBER(4) No No
TIME_UNITS VARCHAR2(15) No No
B_MARGIN NUMBER(3,2) No No
T_MARGIN NUMBER(3,2) No No
L_MARGIN NUMBER(3,2) No No
FOOTNOTE VARCHAR2(25) No No
HOUR_INTERVAL NUMBER(2) No No
HOUR_LABELS CHAR(1) No No
PLOT_TYPE VARCHAR2(25) No No
DAILY_REVIEW CHAR(1) No No
DAYS_BACK NUMBER(3) No No
FROM_TODAY CHAR(1) No No

Index List

Index Code P F A U C Column Code Sort
PK_STKPLOT_MASTER

UK_STKPLOT_FILE

Yes

No

No

No

No

No

Yes

Yes

No

No

SITE_NO
PLOT_NO
STKPLOT_FILE

ASC
ASC
ASC
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STKPLOT_DETAIL:  Contains detail information for the stackplot program (one row per plot/parameter).

Column List
Name Type P M

SITE_NO NUMBER(3) Yes Yes
PLOT_NO NUMBER(3) Yes Yes
INPUT_FIELD NUMBER(3) Yes Yes
PAR_CODE VARCHAR2(25) No Yes
TABLE_TYPE VARCHAR2(50) No No
CAL_TYPE VARCHAR2(10) No No
COLUMN_NAME VARCHAR2(25) No No
NEXT_GRAPH CHAR(1) No No
LINE_TYPE NUMBER(3) No No
FIELD_NAME VARCHAR2(30) No No
YMIN VARCHAR2(10) No No
YMAX VARCHAR2(10) No No
MAJOR_TIC NUMBER(15,4) No No
LABEL_DEC NUMBER(3) No No
LINE_COLOR NUMBER(3) No No
SYMBOL CHAR(1) No No
Y_GAP NUMBER(7,4) No No
Y_AXIS_SIZE NUMBER(7,4) No No
AVG_PERIOD VARCHAR2(25) No No
IPOST NUMBER(1) No No
POST_ALIGN CHAR(1) No No
POST_CHH NUMBER(4,2) No No
POST_FORM VARCHAR2(10) No No
CAL_VAL_TYPE VARCHAR2(10) No No

Index List
Index Code P F A U C Column Code Sort

PK_STKPLOT_DETAIL Yes No No Yes No SITE_NO
PLOT_NO
INPUT_FIELD

ASC
ASC
ASC
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TIME_ZONES:  This is a look-up table for the daily datalogger report that compares datalogger times to
current time.

Column List
Name Type P M

TIMEZONE_ABBR VARCHAR2(10) Yes Yes
HOURS_DIFF NUMBER(2) No No
TIMEZONE_DESC VARCHAR2(5) No No

Index List
Index Code P F A U C Column Code Sort

PK_TIMEZONE Yes No No Yes No TIMEZONE_ABBR ASC

UNIT_CODES:  This is a look-up table for the unit_code columns of the parameter, parameter_codes
and conversions tables.  It defines the codes and provides the equivalent AIRS codes during generation
of AIRS transaction files.

Column List
Name Type P M

UNIT_CODE VARCHAR2(20) Yes Yes
UNIT_DESCRIPTION VARCHAR2(250) No No
AIRS_UNIT_CODE NUMBER(3) No No

Index List
Index Code P F A U C Column Code Sort

PK_UNITCODES Yes No No Yes No UNIT_CODE ASC

USERS:  This is a look-up table used by the application to determine user accessibility to various parts
of the application.

Column List
Name Type P M

USER_NAME VARCHAR2(50) Yes Yes
USER_LEVEL NUMBER(1) No Yes
USER_DB NUMBER(1) No Yes

Index List
Index Code P F A U C Column Code Sort

PK_USERS Yes No No Yes No USER_NAME ASC
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VALIDATION_CODES:  This is a look-up table for the validation_code column of the primary_data table.
It defines the codes and provides equivalent codes for data import and export.

Column List
Name Type P M

VALIDATION_CODE VARCHAR2(12) Yes Yes
DESCRIPTION VARCHAR2(250) No No
AIRS_CODE NUMBER(4) No No
REASON VARCHAR2(25) No No
OLD_CODE NUMBER(5) No No
ESE_FLOW_CODE CHAR(1) No No
AIRS_CODE_IN CHAR(1) No No
TYPE VARCHAR2(15) No No

Index List
Index Code P F A U C Column Code Sort

PK_VALIDATIONCODES Yes No No Yes No VALIDATION_CODE ASC
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The Air Quality Database Management System (AQDBMS) 
User's Guide 

 
1.0 Introduction 
 
 This guide provides users of the Air Quality Database Management System (AQDBMS), 
developed by Air Resource Specialists, Inc., with an overview of the system and with 
information for running the database interface.  By referring to this guide while running the 
interface programs, users receive step-by-step textual instructions for completing specific tasks 
such as loading data into the database, validating data, and reporting data.   
 
2.0 AQDBMS Overview 
 
 The AQDBMS is comprised of two main components: 

 
1)  An Oracle database specifically designed and developed by Air Resource Specialists, 
      Inc. (ARS) to hold air quality network data and to accommodate the many temporal, 
      spatial, and functional variations found within an air quality network. 
 
2)  Customized software programs developed by ARS that provide an interface to the 
       Oracle database. 

 
2.1 The Oracle Database 
 
 Although not necessary for operating the interface, it is helpful for users of the AQDBMS 
to have a basic understanding of the structure of the Oracle database. The Oracle database is a 
relational database containing many related tables.  A table is the basic unit of data storage in an 
Oracle database.  Table data is stored in rows (records) and columns (fields).  Each table has a 
column or set of columns that is unique for each row as the primary key.  Each table is related to 
one or more other tables by linking common columns. The following are descriptions of some of 
the database tables and relationships: 
 
 Sites and AQMet Specs Tables.  The Sites Table contains one row for each monitoring 
site (current or historical) identified by a unique site number (primary key).  The AQMet Specs 
Table includes constant information such as site abbreviation, geographic information, and the 
AQS state, county, and site codes.  
 
 Polling Table.  Variable information reflecting the site’s current datalogger(s) polling 
schedule is stored here.  Each record is identified by combination of the site number and logger 
number (an incremental number).  A unique constraint has also been placed on the polling 
abbreviation field (polling_abbr) of this table. 
 
 Polling Line ID Table.  This table stores datalogger configurations and controls how data 
are loaded into the database from the captured datalogger files. Typically, several records exist 
for each configuration. Combining the polling line ID and logger field number provides the 
primary key on this table. These records are linked to the polling table through the Polling Detail 
Table.   
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 Polling Detail Table.  This table links each record in the Polling Table with the correct 
datalogger configuration record in the Polling Line ID Table.  
 
 Primary Data Table.  Each row in this table contains the raw value, datalogger flag, 
validation code, validated value, and source code for a raw gaseous pollutant or meteorological 
parameter value for each unique combination of site number, parameter code, date and beginning 
hour (primary key). The validation code column is used during the validation process to store 
datalogger codes, to flag anomalies and to store the preliminary or final data validation code.  
The validated value column is initialized to -999 and is updated during the validation process. 
Each row also contains a placeholder for a control value that may be used during the validation 
process. 
  
 AQ Cal Table.  This table contains the actual and indicated values for zero and precision 
check readings recorded for raw criteria pollutant analyzers in the monitoring network. A unique 
combination of site number, parameter code, date, calibration type, and value type provide the 
primary key.  Zero and precision data are stored here for future submission to AQS.  
 
 Audit Data Table.  Each row in this table contains the readings recorded during 
instrument audits as actual and indicated values for audit level zero through audit level five for 
each site's unique site number, parameter code, and date (primary key). Additional columns store 
information required by AQS for submitting accuracy data. 
  
 Parameter Table.  This table defines each parameter (primary key) in general terms to 
allow grouping of the parameter codes, definition of standard output units and decimal precision, 
and AQS monitor codes.   
 
 Parameter Codes Table.  This table contains the definition of each parameter code (primary 
key) referenced in other tables (such as the Primary Data Table).  Specifically defined parameter 
codes, such as "O3-1" and "O3-2," reflect critical variations in the derivation of the data, such as 
instrument type or model and the associated AQS method code and parameter occurrence code 
(POC), units used, and decimal precision of the raw values collected. Each parameter code is 
derived from a base code that must exist in the Parameter Table (such as "O3").  
 
 Screening Ranges Table.  This table contains records that define and control anomaly 
screening for each site and parameter code as raw data are loaded into the database. This design 
allows each screening element to be defined independently from the other. Information in this 
table is applied to the data each time the data are loaded into the database and the flags resulting 
from each screening are written to the validation code column of the Primary Data Table.  
 
 Site Status Log - Master Table.  This table is a diary of site operations with the purpose 
of aiding both the field specialists and data validation staff with data validation procedures. Date 
and time columns define when the problem occurred and other events such as site visits, audits, 
precision checks, etc.  The affected parameters column is a variable length column which allows 
entry of multiple parameters which are affected by the event described.  Each row contains a 
unique combination of the site number and computer-generated reference number (primary key).  
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 Site Status Log - Detail Table.  This table contains detail information (one or more rows) 
describing events related to a row in the Site Status Log - Master Table.  By using this separate 
Detail Table, duplicate information is avoided while allowing multiple entries on multiple days 
by multiple technicians regarding the same problem or event.  Each detail row contains the site 
number and reference number of the related Master Table row and a computer generated line 
number as the primary key. The other columns include the date entered, who made the entry, and 
the comment (a variable length column with a maximum of 2,000 characters). 
  
 Data Validation Log - Master Table.  This table contains a row for each unique 
combination of site number, month, and year.  It is used to track the completion of each major 
step of the validation process, the initials of the IMC staff member completing the step, and the 
initials of the site operator responsible for operation of the site for the month. 
  
 Data Validation Log - Comments Table.  This table logs validation comments for the site, 
month, and year. A row exists for each unique combination of site, month, and year, and 
computer-generated line number (primary key). By using a separate Detail Table, duplicate 
information is avoided while allowing variations on the types of information logged from month 
to month and from site to site.  
 
 Stack Plot Configuration – Master.  This table contains stackplot configuration 
information. One row exists for each unique combination of site number and plot number 
(primary key).  The master record defines the global characteristics of the plot such as titles, plot 
type, margins, etc. 
 
 Stack Plot Configuration – Detail.  This table contains details of each stackplot parameter 
to be plotted on a plot.  One row exists for each unique combination of site number, plot number, 
and input field (primary key).  The information here includes plot details like line type and color, 
minimum and maximum graph settings, etc., and specifies where the data comes from (raw or 
validated data, etc.). 
  
 Look-up Tables.  The Validation Codes, Source Codes, AQS Method Codes, Unit Codes, 
Interval Codes, and Conversion Tables are essentially "look-up tables" that have been added to 
the database to enforce data integrity by controlling data entry and providing full definition of 
the codes used.  These tables generally include two columns: 1) the code column (primary key) 
and 2) a description column (a variable length column with a maximum of 250 characters) that 
define the code.  They also contain equivalent codes for conversion of data during import and/or 
export to other data file formats. 
 
 Primary Key Constraints.  Each table in the database has a column or set of columns 
defined as the primary key to ensure that no duplicate rows exist in the table. Oracle also uses 
primary keys as indexes to greatly increase the speed of data retrieval. 
 
 Not Null Constraints.  A not null constraint placed on a column requires that no nulls (the 
absence of a value) be allowed in the column.  Not null constraints are automatically applied to 
primary key columns.  Not null constraints have also been applied to other critical data columns 
such as the raw value and validated value columns of the Primary Data Table. 
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 Foreign Key Constraints (Referential Integrity).  Because common columns relate tables 
in a relational database, the rules that govern the relationship of the columns must be maintained.  
Referential integrity rules enforced by foreign key constraints guarantee that these relationships 
are preserved.  This means that no user may at any time or through any data access path enter 
undefined or incomplete information, nor can a user delete a row for which related rows exist.  
Rules enforced by foreign key constraints within the AQDBMS include, but are not limited to, 
the following: 
 

• A site must exist in the Sites and AQMet Specs Tables before rows related to the site 
can be appended to any other table containing the site number column. A site 
configuration row cannot be deleted if any other table references the site number.  

 
• A parameter code must exist in the Parameter Codes Table before a row containing 

the parameter code can be appended to any other table containing the parameter code 
column.  A parameter code row cannot be deleted if any other table references the 
parameter code (with the exception of the Parameter Table). 

 
• The parameter name (e.g., “O3”) must exist in the Parameter Table before the 

parameter code (e.g., “O3-1”) can be added to the Parameter Codes Table. A 
parameter name row cannot be deleted if any row in the Parameter Codes Table 
references the parameter name. 

 
• Rows in the Site Status Log or Data Validation Log Master Tables cannot be deleted 

if related rows exist in the Detail Tables.  Similarly, a row cannot be added to the 
Detail Tables if related rows do not exist in the Master Tables. 

 
 Database Triggers.  A database trigger is a stored database procedure automatically 
invoked by the RDBMS during insert, update, or delete operations on the table for which it has 
been defined.  Within the AQDBMS, database triggers are used to enforce the rules of allowable 
combinations of values that may be entered into the Primary Data Table, such as: 
 

• If the validated value column contains any value other than "-999" then the validation 
code column must contain "V" (valid), "VA" (valid, adjusted from raw),"VZ" (valid, 
zero adjusted) or "VM" (valid, maximum adjusted). 

 
• If the validation code column equals "VA," the control value cannot be null.  

 
2.2 The Custom Interface 
 
 The AQDBMS includes a custom database user interface developed by ARS with 
Powersoft PowerBuilder Enterprise for Windows and Microsoft Visual Basic. Both are graphical 
application development environments that provide the tools needed to build easy to use, 
powerful database applications for Windows operating systems. The interface consists of menus 
and windows (or screens that users interact with) and makes extensive use of standard point-and-
click window controls and functions, such as: 
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• Command buttons, checkboxes, and radio buttons. 
 
• Drop-down lists to facilitate data entry and ensure data integrity. 
 
• Dialog boxes that prompt the user for information or display error messages. 
 
• Tab controls for organizing processes and user input. 
 
• The ability to open more than one window (screen) at a time for "multi-tasking." 
 

 The custom interface is the tool used by the IMC staff for data management, validation, 
and reporting. The remaining sections of this document provide detailed instructions on using the 
interface to accomplish these tasks and presented under the following major headings: 
  

Section 3.0 Basic Concepts and Functions  
Section 4.0 System Configuration  
Section 5.0 Data Collection  
Section 6.0 Data Validation  
Section 7.0 The Data Validation Log 
Section 8.0 The Site Status Log 
Section 9.0 Output Products 
Section 10.0 References 

 
 To launch the AQDBMS application: 

1 Click the ARS MON V2 icon on the desktop. 
2 Select NPS IMC from the Select Database pop-up window. The Configuration frame is 

displayed. 
 
3.0 Basic Concepts and Functions 
 
 The various components of the main AQDBMS module have been designed to operate in 
similar ways whenever possible.  Several concepts and global functions are discussed here. 
 
3.1 Application Frames 
 
 Currently, two application frames exist within the AQDBMS.  For most users, the initial 
frame displayed after launching the application is the Data Collection and Configuration frame 
as shown in Figure 3-1. This frame contains the menu commands for accessing most of the 
configuration data of the application (See Section 4.0 System Configuration). 
 

 
 

Figure 3-1.  The Data Collection and Configuration Frame. 
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 Clicking the Data Menu on the menu bar in the Data Collection and Configuration frame 
displays a list of additional application frames as shown in Figure 3-2.  Currently, the AQ and 
Met Data Processing frame is the only other working frame for the IMC AQDBMS.  The AQ 
and Met Processing frame is shown in Figure 3-3 and contains menu commands specific to 
validation and reporting of gaseous and meteorological data. 

 
 

Figure 3-2.  The Data Menu List of Application Frames. 
 

 
Figure 3-3.  The AQ and Met Processing Frame. 

 
3.2 Tool Bar Icons 
 
 As seen in Figures 3-1, 3-2, and 3-3, several tool bar icons are available to speed up 
menu command selection.  Micro help has been added to each icon to indicate the menu 
command associated with the icon.  To display the micro help, suspend the mouse cursor over 
the icon for 1-2 seconds. 
 
3.3 Pop-up Calendar Control 
 
 A pop-up calendar control has been implemented to facilitate data entry of date 
throughout the windows of the AQDBMS.  To access the control, right-click on a date-type data 
entry field.  The pop-up calendar will display as shown in Figure 3-4.  Use the outer, bold arrow 
buttons to move backward or forward one full year. Use the inner arrow buttons to move 
backward or forward one month.  Click a day number to apply the selected date to the date field.  
Click the X button in the lower-right of the control to exit the pop-up without selecting a date. 
 
Note:  The pop-up calendar does not function on date fields within data windows. 
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Figure 3-4.  Pop-up Calendar Control. 

 
3.4 Data Windows 
 
 Nested windows that contain rows of data are located within many of the main windows 
of the AQDBMS, are nested windows that contain rows of data. The rows of a data window 
might be displayed in tabular form or as single records. There might be a single data window or 
multiple data windows that are related to each other.  The following subsections discuss how to 
perform data entry operations and how to maneuver through the rows of data windows. 
 
3.4.1 The Data Window Menu 
 
 Most data windows have an associated pop-up menu that is accessed by clicking the right 
mouse button as the mouse cursor is positioned over the data window as shown in Figure 3-5.  
Depending on the rules governing the data window, the following options are available by 
selecting the option from the menu (when options are grayed out, they have been disabled for the 
current data window): 
 

• Cut - Causes the contents of the field below the mouse cursor to be cut to the 
Windows clipboard. 

 
• Copy - Causes the contents of the field below the mouse cursor to be copied to the 

Windows clipboard. 
 
• Paste - Causes the contents of the Windows clipboard to be pasted into the field 

below the mouse cursor. 
 
• Insert - Adds a row to the data window. Depending on the type of data window and 

the rules governing it, a new row will be inserted above the current row. 
 
• Add – Adds a row to the data window at the end. 
 
• Delete – Deletes the current row from data window. 
 
• Restore – Restores the last deleted row to the data window. 

 

 
Figure 3-5.  The Data Window Pop-up Menu. 



8 

3.4.2 Modifying Data 
 

Data cannot be modified directly by the user in some of the data windows in the 
AQDBMS.  However, many of the data windows allow the user to modify the data simply by 
selecting the field to be modified and entering new data. Use the following guidelines when 
modifying data: 

 
• Read-only data windows are typically a gray color and are not affected by mouse 

clicks.  Use horizontal and vertical scroll bars to view all of the data in a read-only 
data window. 

 
• When entering data, click on a field to move to that field or use the <Tab> key to 

advance to the next field. 
 
• Any validation rules on the field are applied to the data as the cursor leaves the field 

(the user tabs out or clicks on another field). If the modified data do not pass 
validation rules, an error message will display. 

 
• To speed up data entry and/or to ensure data integrity, many fields can be modified 

by selecting data from a drop-down list box.  Some fields will allow the user to type 
the data in or select an entry from a drop-down list box. 

 
Important Note: Changes to the data are usually committed to the database 
immediately.  However, in some cases, the user must click a <Save> button in order 
to commit the changes.  This is done to provide a way for the users to change their 
mind and not save changes. When the user attempts to leave a changed but unsaved 
record, a dialog window will be displayed asking the user if changes should be saved 
or not. 

 
3.4.3 Moving Through the Rows of a Data Window 
 

Use the following guidelines to move through the rows of a data window: 
 
• Whenever data are displayed one record at a time, controls on the window will 

facilitate moving from one record to another. The control may be a drop-down list 
(such as a list of site abbreviations) or buttons that state “Next Rec”/”Prev Record.” 

   
• When records are displayed in tabular format, horizontal and/or vertical scroll bars 

are evident when all the data will not fit in the data window. Use the scroll bars to 
move through the data.  Click on a row to make it the current row and to begin data 
entry.   

 
• Typically, any changes made to a row are saved when the current row changes.   
 
• Tables that are read-only do not accept mouse clicks; use horizontal and vertical 

scroll bars to view all of the data. 
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3.4.4 Moving Through Multiple Data Windows 
 
 Multiple data windows are often displayed within a single window of the AQDBMS.   
This allows the user to view and/or modify related records from separate tables from within one 
interface. The following additional guidelines apply to moving through multiple, related data 
windows: 

 
• Usually, the Master Data window controls the display of the detail records. The 

Master Table is presented at the top of a window or on the first tab of a tab control.  
As the master record changes, the Detail Tables are refreshed to contain only the 
records that are related to the current master record. 

 
• Sometimes, the Master Data window and related Detail Data windows will hold all 

records from their underlying database tables. In these cases, moving from row to row 
on the Master Data window will cause the Detail Data windows to scroll to the 
section of related records.  

 
4.0 System Configuration 
 
 Accurate configuration is critical to the correct operation of the AQDBMS and the 
integrity of the data stored in the Oracle database.  There are six primary configuration areas: 
 

• Sites Configuration 
 
• Polling and Stackplot Configuration 
 
• Raw Data Formats Configuration 
 
• Data Parameters Configuration 
 
• Anomaly Screening Configuration 
 

 The following subsections discuss maintaining these configuration areas. 
 
4.1 Sites Configuration 
 
 The Site Specifications Tables track global information about a site including its name, 
geographic location information and AQS codes. Records exist for all sites, current and 
historical, in these tables. When new sites are introduced to the network, the sites must first be 
added and configured here before other configurations concerning the sites can be set. AQS 
codes must be correctly entered for correct export of AQS formatted data.  Figures 4-1 and 4-2 
are examples of contents in the Sites Specifications window. 
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Figure 4-1.  The General Site Info Page of the Site Specifications Window. 
 
 
 
 

 
 

Figure 4-2.  The Gaseous and Met Instrumentation Page of the Site Specifications Window. 



11 

 
 To access the Site Specifications window: 

1 Select Sites -> Sites Specifications from the Configuration frame. 
2 Select an abbreviation from the Select Site drop-down list box or add a new record. 
3 Click on the Gaseous & Met tab to view, add, or modify the related information. 
4 Use the Data Window menu for adding and modifying records (See Section 3.4.1 The Data 

Window Menu). 
 
 Site groupings allow individual sites to be grouped together for reporting purposes.  A 
group can also contain another group as one of its members (nested groups).   For ease of use, 
the site groups have been displayed in a tree-view data window (see Figure 4-2). 
 

 To access the Site Groupings window: 
1 Select Sites -> Site Groupings from the Configuration frame. 
2 Click on + to expand groups. Click on – to contract groups. 
3 Click on boxes next to group or site names to select. 
4 Use the Data Window menu for adding, modifying, and deleting groups or group members.  

(See Section 3.4.1 The Data Window Menu). 
 
4.2 Polling and Stackplot Configuration 
 
 The Polling and Stackplot Configuration interface consists of four tabs as shown in 
Figure 4-3: 
 

• Site Information: Site name(s) and abbreviation. 
 
• Polling Information: Datalogger type, telephone number, polling schedule, and 

configured data formats information. 
 
• Stack Plots : Plots (pages) configured for the site. 
 
• Stack Plot Parameters: Content of each plot (page). 

 
 To access Polling and Stackplot Configuration: 

1 Select Configuration -> Polling & Stackplot from the Configuration frame. 
2 Select an abbreviation from the Select Site drop-down list box. 

 
4.2.1 Polling Configuration 
 
 Figure 4-3 is an example polling configuration. The information in the polling 
configuration is critical for data collection and must be accurate. Errors in the polling 
information may cause the data to not be retrieved, be written to the database incorrectly, or not 
be written at all.  Follow these guidelines when adding or modifying polling configurations: 
 

• Configure new sites in the Site Specifications Configuration window before 
attempting to add a new polling configuration record.   
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• Sites may have multiple polling configurations for multiple dataloggers. 
• The raw data configuration and data parameter configuration must be up-to-date 

before adding or modifying a site. Attempting to configure the polling information 
with an undefined raw data format will cause an error. 

 
• If the On box is checked, a complete and accurate polling configuration is expected.  

Fill in all boxes.  Check the DataView box if DataView is operating at the site. Do 
not check Retry. Check the days of the week to poll (usually all days are checked). 
The polling minutes are used to define the polling order of the sites within each hour.  
Using lower polling minutes will cause a site to be polled before other sites with 
higher polling minutes.  Entering any minute value (including zero) into any hourly 
field will cause the data to be polled for that hour.  

 
• Add or delete linked raw data configurations to a site’s polling configuration from the 

Configured Data Format IDs data window. 

 
 
 

Figure 4-3.  Polling Configuration. 
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4.2.2 Stackplot Configuration 
 
 The stackplot configuration consists of configuring each plot (titles, temporary plot file, 
etc.) and each graph on each plot (plotting parameters, line types, etc.). A plot represents a 
physical page and a graph represents a trace of data for a parameter drawn on the page. A site 
can have one or more plots associated with it and each plot can have one or more graphs on it. 
 
4.2.2.1  Stackplot Page Configuration 
 
 Each plot configuration requires information specific to the plot page as shown in 
Figure 4-4.  When configuring a plot, follow these guidelines: 
 

• The contents of the Stkplot File field must be unique because it is used to create 
temporary ASCII files that are accessed by the Stkwin program for generating 
stackplots. 

 
• The Min. Increment must contain the shortest interval of time that will be plotted 

(usually 1 or 24 Hours) on this plot page. 
 
• Check the Include in Daily Review box for the plot to be generated as part of the 

polling process. When this box is checked, also enter the number of Days back to 
plot.  Check the Today box to plot through the current date; leave it unchecked to 
plot through the day before the current date. 

 
Figure 4-4.  Stackplot Page Configuration. 
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4.2.2.2  Stackplot Parameters Configuration 
 
 Each graph on a plot has many parameters specifying how data will look on the graph 
and how the graph will look on the plot.  Though some plotting parameters are not configurable 
and most of them have default settings, it is necessary to configure each graph at least once.  
Figure 4-5 shows an example stackplot parameter configuration. When configuring stackplot 
parameters follow these guidelines: 
 

• The Par Code, Table, and Column Name fields must be configured properly in order 
for the program to find the correct data.  If necessary, refer back to the polling 
configuration to see the specific parameter codes assigned to a site’s data. 

 
• One or two parameters can be plotted on the same graph.  Use the Yes and No radio 

buttons to toggle this option. 
 
• Configuring stackplot parameters takes practice and often requires several 

modifications before the plot looks right.   
 

 
Figure 4-5.  Stackplot Parameter Configuration. 
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4.2.2.3  Copying Stackplot Configurations 
 
 A new site being added to the network may have a configuration similar to an existing 
site.  In this case, the Copy Records function can be used to facilitate setting up stackplot 
configurations as shown in Figure 4-6.  
 

 To use the Copy Records function: 
1 Determine which stackplot configuration most closely resembles the new configuration. 
2 Select the new site’s abbreviation from the drop-down list box and click on the Stack 

Plots tab. 
3 Click the Copy Records button.  A pop-up list box is displayed. 
4 Select the configuration determined in step 1, then click Continue. The records in the 

Stackplot Configuration Tables for the selected configuration will be duplicated and added 
to the current site’s configuration. 

5 Modify the duplicated records as needed. 
 
 

 
 

Figure 4-6.  Stackplot Configuration Pop-up Window. 
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4.3 Raw Data Formats Configuration 
 
 A Raw Data Format configuration defines what type of data is collected by each channel 
in the datalogger and is used to relate the incoming raw data to information stored in the 
database. Figure 4-7 is an example of a Raw Data Format for hourly data. Figure 4-8 is an 
example of a Raw Data Format for ESC calibration sequence. 
 

 
Figure 4-7.  A Raw Data Format for Hourly Data. 

 
Figure 4-8.  A Raw Data Format for an ESC Calibration Sequence. 
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 To access the Raw Data Formats configuration: 

1 Select Configuration -> Raw Data Formats from the Configuration frame. 
2 Select an abbreviation from the Select Site drop-down list box or add a new record. 

 
When configuring Raw Data Formats follow these guidelines: 
 

• For hourly data collected on ESC dataloggers, the Data Field and Data Label columns 
must reflect what the datalogger is providing in the raw data.  (The Data Field column 
maps to the channel number.) 

 
• The collected data type must already exist in the data parameter configuration.  If it 

does not exist, it will not be available in the Par Code drop-down list box and cannot 
be used.  In this case, a new data parameter is being defined and the must be added to 
the Data Parameters configuration before continuing. 

 
• For calibration data collected on ESC dataloggers: 
 

− The Data Field column should contain 0. 
 
− The Data Label column must contain an appropriate label for the calibration data 

type (SPAN, PREC, or ZERO). 
 
− The Par Code column must contain the appropriate primary parameter name code 

rather than a specific parameter code (i.e., “O3” not “O3-10”).  The data loading 
program assigns the correct par code by querying the hourly data. 

 
− The Code Field, Code Exp, Cal Type, and Cal Val Type columns tell the data 

loading program where in the reformatted cal file to look for the data. 
 
− Calibration configurations are not straightforward.  Seek the help of the database 

administrator if a new configuration is required. 
 

• To add a new format ID, click the New Format button to show a blank configuration 
interface. 

 
4.4 Data Parameters Configuration 
 
 The Data Parameters configuration is used to relate incoming raw data to what is stored 
in the database and to define the associated AQS codes for each parameter. It also defines all 
historical data stored in the database. 
 

 To access the Data Parameters Formats configuration: 
1 Select Configuration -> Data Parameters formats from the Configuration frame. 

 
 The Data Parameter configuration interface, shown in Figure 4-9, includes the following 
five data windows: 
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• Parameters: Shows all of the types of data in the database and the associated AQS 

codes.  It is important to note that, although raw relative humidity data may be 
labeled as RH at one site and RELHUM at another site, it is still relative humidity and 
is mapped to the parameter RH in the parameters window. 

 
• Parameter Codes: Shows how the various raw data parameters are mapped to the 

appropriate parameters shown in the Parameters windows (described above). The 
Parameter Codes window includes specific information about each parameter, 
including AQS method code, units, and decimal precision. Note that for some 
parameters such as scalar wind speed, one site may use m/s as the units, while another 
may use mph. These two have different parameter codes (PAR CODE) such as 
SWS-1 and SWS-2.  

 
• Unit Codes: Shows the units associated with the parameter currently selected 

(highlighted) in the Parameters window or the Parameter Codes window.  Only units 
defined in the Unit Codes window can be associated with a parameter. 

 
• Conversion Formulas: Shows the conversion formulas defined for the parameter 

currently selected (highlighted) in the Parameters window.  The formulas are used 
during data reporting processes to standardize output. 

 
• Interval Codes:  Displayed here for convenience only; the records are not linked to 

the currently selected parameter or parameter code. 
 

 
Figure 4-9. The Data Parameters Configuration. 
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Follow these guidelines when modifying the data parameters configuration: 
 

• NEVER attempt to delete any records from any of the tables in the data parameters 
configuration.  This configuration defines the data in the database. 

 
• Editing the parameter information must be done with caution.  Any changes made to 

the parameter configuration affect the definition of the data within the database and 
affect data polling and reporting functions. 

 
• Adding new configurations must be done in a logical order. 

 
4.5 Anomaly Screening Configuration 
 
 The anomaly screening configuration is used to flag raw data that fall outside of expected 
values so the data will be quickly inspected to rule out instrument problems and to aid the data 
analyst during the validation process. Currently, there is no “wizard” type interface for this 
configuration and, due to its complexity, only the database administrator should modify this 
configuration. 
 
5.0 Data Collection 
 
 Several methods exist for placing data into the Oracle database. Usually, hourly data are 
loaded through a series of automated processes.  Currently, a Windows operating system utility 
called System Agent is utilized to launch the application with a command line argument at a 
scheduled time.  The AQDBMS application detects the command line argument, automatically 
connects to the NPS IMC database and enables the auto polling function.  A system timer 
queries the polling configuration tables continually to determine if it is time to poll any sites.  
When the query returns a result set of sites and polling configurations, the program loops 
through the list, calling the dataloggers and loading the data into the database.   
 
 Data can also be loaded for one site for one day at a time using the Manual command 
button in the polling window.  Either way, the polling program issues a call to the site, captures 
data for the requested date and writes it to an ASCII file, reformats the ASCII file and loads the 
data into the database.  As data are being loaded for each site, the header columns of the ASCII 
file must match the datalogger column information stored in the Polling Line ID Table.  Figure 
5-1 shows the polling interface. 
 
 Data can also be hand-entered or blank-filled in the Data Validation interface. Data entry 
forms for entering non-hourly aerosol data, precision check data, and data from audit reports are 
also available. 
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Figure 5-1.The Polling Interface. 
 
 

 To open the Polling window: 
1 Select Polling from the Configuration frame. 

 
5.1 Starting the Auto Poll Process 
 
 Usually, Windows System Agent will launch the AQDBMS application and enable the 
auto load process.  Sometimes the auto load process must be manually started.  
 

 To run Auto Poll: 
1 In the Polling window, click the Enable Auto Poll command button. The button text 

changes to read “Disable Auto Poll.” 
 
5.1.1 Polling Order 

 
The order in which the sites are polled is determined by the following: 
 
1. Polling time specified in each site’s configuration. 
 
2. Alphabetically by site name. 
 
Sites with identical polling times will be polled alphabetically.  To change the polling 

order of a site, edit the polling configuration as described. 
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5.1.2 Manual Data Polling 
 
 Manual data polling provides functionality not included in the automatic data collection 
process.  Manual data collection is used in the following situations: 
 

• When automatic data collection from a site has failed and the data are needed in the 
database. 

 
• When recent data are needed for immediate use. 
 
• When archived or edited raw data need to be written to the database without polling 

the site. 
 

 Manual data polling cannot be used at the same time as automatic data collection.  It is 
necessary to disable automatic data collection. 
 

 To run Manual Poll: 
1 Select the sites to poll by clicking on them (use standard Windows keys for multi-select). 
2 Select the Process Only checkbox if the raw data file already exists (no polling of the 

site(s) will be performed). 
3 Select the Get All Data checkbox to poll a 21X or CR10 datalogger and attempt to retrieve 

all of the data contained therein.  This may take a long time and may return many months 
of data.  This option is recommended only in extreme situations.  Note:  This option only 
applies to Campbell dataloggers.  

     -or 
Select the Get Single Day checkbox to poll an ESC datalogger for one specific day. 

 -or 
Leave both the Get All Data and Get Single Day checkboxes unchecked.  The dates polled 
will be from the date listed next to each site in the Select Sites list box to the current day.  
The date listed may also be changed by clicking in the field and entering a new date. 

4 Click the Start button to begin processing the site(s) in the order they appear in the list. 
 
 The manual data collection process operates similarly to the automatic data collection 
process regarding log files, etc. 
 
5.1.3 Reviewing the Log and Err Files 
 
 The Auto Poll and Manual Poll programs write messages to files tracking the data polling 
and loading processes. The log files are called yyyymmdd.log where yyyy is the year, mm the 
month number and dd the day number.  (For example, the file 20001128.log holds the log entries 
for November 28, 2000)  The error files are called yyyymmdd.err. Both files are stored in the 
n:\project\esc_sitecall\logs directory and can be viewed by either clicking the View Sitecall 
Logs button in the Polling window or by opening directly in any text editor.  Figure 5-2 is a 
sample log file and Figure 5-3 is a sample err file. 
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Figure 5-2.  A Sample Data Collection Log. 

 
Figure 5-3.  A Sample Data Collection Error File. 

DATA_COLLECTION: Site No: Figure 0-1 SHBM 01-25-200105:38:29 ---------- Begin 
Site: SHBM ---------- 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 SHBM 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 540999369834 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 BM 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 2 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 ESC8816 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 36896 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM005a.2001r 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM.dat 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM.cal 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.LOG 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 
\\ars_net3\sys\ars_soft\programs\campbell\ 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 NONE 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:29 Turning modem ON... 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:33 Turning modem ON... 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:37 HANGUP: Opening port #2 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:38 HANGUP: AT&FV1&W 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:45 HANGUP: ATH0 
DATA_COLLECTION: Site No: SHBM 01-25-200105:38:54 HANGUP: DTR toggle 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:09 HANGUP: Close port 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:09 Turning modem OFF... 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 Offline 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 GetDataESC8816() started 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 Getting ESC8816 data: 
F:\COM_SOFT\ATMAPPS\XTALK32\XTALK30.exe SHBM(NPSAIR BM 01/05/01 5 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM005a.2001r 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.LOG 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\200101 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 Executing: 
F:\COM_SOFT\ATMAPPS\XTALK32\XTALK30.exe SHBM(NPSAIR BM 01/05/01 5 
\\ars_net3\vol4\project\IMC\esc_sitecall\SHBM005a.2001r 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.LOG 
\\ars_net3\vol4\project\imc\esc_sitecall\logs\20010105.ERR 1 PS 
DATA_COLLECTION: Site No: SHBM 01-25-200105:39:13 OS version: Win 9x 

i i i

XTALK - shbm 1/25/2001 5:42:33 AM-XTALK data collection failed - shbm 
(01/05/01) 
FMT8816: SHBM 038 01/25/2001 05:42:37 >> Bad filename and/or path 
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5.1.4 Daily Output 
 

 In addition to polling and loading data, the Polling window performs several other 
functions: 

 
• Update of stackplot files (auto mode) 
 
• Auto printing of anomaly flag listings (auto and manual modes) 
 
• Auto printing of datalogger summary files (auto mode) 
 
• Generation of span files (auto and manual modes) 
 

 To manually generate daily output : 
1 From the Configuration menu, click Polling. 
2 Select the sites to poll by clicking on them (use standard windows keys for multi-select). 
3 Click the Daily Output button. 

 
5.2 Viewing Data Onscreen 
 
 Hourly and calibration data can be viewed in a monthly tabular data window as shown in 
Figure 5-4.  The data in this window can also be sorted and filtered but cannot be edited in any 
way.   
 

 
 

Figure 5-4.  The View Tables Monthly Data Window. 
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 To view Monthly Data Windows onscreen: 
1 Select View Data Tables from the Data Collection and Configuration frame. 
2 Select a site from the Site drop-down box. 
3 Select a month and year to view from the Month and Year drop-down boxes. 
4 Select the table type (AQMet or AQCal) from the Table Type drop-down box. 
5 Click the Retrieve button. 
 

 To sort or filter data in the Monthly Data window: 
1 Follow steps 1 – 5 of  “To view Monthly Data Windows onscreen” above. 
2 Right-click anywhere within the data window. 
3 Select Filter or Sort from the pop-up menu.  A dialog box is displayed.  Follow the dialog 

box instructions to apply filter or sorting options.  Click the Help button to access specific 
help on the dialog boxes. 

 
5.3 Entering Audit Data From Audit Reports 
 
 The Audit Data command displays a data entry form for entering information from audit 
reports.  The information is stored in a permanent table in the database and is used to create 
Accuracy Data AQS transactions.  The Audit Data Entry Form is shown in Figure 5-5. 
 
 

 
Figure 5-5.  The Audit Data Entry Form. 
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 To enter audit data: 
1 Select Load Data -> Audit Data from the AQ and Met Processing frame. 
2 Click the down arrow in the Site box and select a site. 
3 In the Date box, enter the date of the audit report in mm/dd/yy format (that is 02/11/01 for 

February 11, 2001). 
4 Click the down arrow in the Parameter box and select the parameter that was audited. 
5 Click the down arrow in the Audit Type box and select the type of audit performed.  

 
Note:  When all required information has been entered in the top part of the window, an 
additional data entry form appears in the lower window.  Data in the shaded section have 
been filled in using the information already entered.  The unshaded area contains data 
entry fields for the audit information. These fields will either be empty or will contain data 
previously entered for the site, date, and parameter selected. Complete the form by 
entering numerical audit data in the appropriate fields. 

 
Important : Before entering the audit data, verify that the information listed in the shaded 
area is correct for the audit data being entered.  The Delete Record button is used to delete 
the record if the wrong combination of site, date, parameter has been selected. Changing 
one of these values will not modify the current record but will create a new record or 
retrieve it if it already exists.  

 
6.0 Data Validation 
 
 The Data Validation interface is used to apply validation codes to the data via two 
windows.  The initial window provides a way to apply codes to all data points, list missing data, 
and blank fill data within a selected set of data. The second window displays a tabular data 
window of the selected data and provides a way to apply validation codes to selected data points 
within the window.  It provides an interface for sorting and applying specific filters to the data 
and for hand entering data.   
 

 To open the Data Validation window: 
1 Select Validate from the AQ and Met Processing frame. 

 
6.1 The Initial Data Validation Window 
 
 Sometimes fairly large sets of data for a site require the same validation code. For 
example, a power failure lasting for several hours or days requires a validation code of  “PF” to 
be applied to the affected data. The easiest way to accomplish this is to use the initial Data 
Validation window that is displayed when entering the data validation interface. The user can 
also see a list of missing data, blank fill data, and display a data grid from this window. This  
window is shown in Figure 6-1. 
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Figure 6-1.  The Initial Data Validation Window. 

 
 

 To apply validation codes: 
1 Select the site to validate.  
2 Enter the Start Date/Time of the data set to work on. 
3 Enter the End Date/Time of the data set to work on. 
4 Click the Get ParCodes button. The program queries the database and returns all the 

parameter codes found for the selected site and period in the list box. 
5 Select (highlight) one or more parameter codes in the list box. 
6 Select a validation code from the Validation Code drop-down box. 
7 Click the Apply Code button.  The process window displays a message listing the number 

of updated records. 
 

Important Note: When using this method, validation codes are committed to the database 
table immediately.   
 

 To search for missing data: 
1 Follow steps 1 – 5 of  “To apply validation codes” above. 
2 Click the List Missing Data button.  The cursor changes to an hourglass. When the cursor 

changes back to a pointer, the process has completed. Missing data within the selected data 
set will be listed in the process box. 

 
 

 To blank fill data: 
1 Follow steps 1 – 4 of  “To apply validation codes” above. 
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2 Check the blank fill box. 
3 Check the All box and click Get ParCodes to retrieve a list of all parameter codes.  Select 

the parameter codes to be blank-filled for the selected site and time period. 
 -or 

Check the pattern date and enter a date that contains the parameter codes that need to be 
blank-filled for the selected period. 

4 Select a code from the Validation Code drop-down list box. 
5 Click the Apply Code button. Data will be blank-filled with a value of “–999” in the raw 

value and validated value fields, the selected code in the validation code field, and a “B” in 
the source code field.  Note:  The program will not overwrite existing data. When the 
process is complete, the number of blank-filled rows will be indicated in the process box. 

 
 To display the data grid: 

1 Follow steps 1 – 4 of  “To apply validation codes” above. 
2 Select the parameter code to display.  Note:  If more than one parameter code is selected, 

only data for the first code will be displayed. 
3 Click the 24x31 button.  The data will be displayed in a grid of 24 hours across by days 

down (optimally one month).  For each data point, if any code other than a “V”, “VA”, or 
“VZ” exists in the validation code field, the code will be displayed in red.  Otherwise, the 
value found in the validated value field is displayed. 

4 Click the X button to close the window and return to the validation window. 
 
6.2 The Data Validation Data Window 
 
 The second window available for data validation provides an interface for applying 
validation codes to specific, individually selected data points. Data from all columns of the 
database table are displayed in tabular form as shown in Figure 6-2.  The Data window data can 
be sorted and /or filtered.  The interface also provides a means for re-screening data and for hand 
entering data values when necessary. 
 

 To open the Data Validation Data window: 
1 In the Initial Data Validation window, select the site to validate.  
2 Enter the Start Date/Time of the data set to work on. 
3 Enter the End Date/Time of the data set to work on. 
4 Click the Get ParCodes button. The program queries the database and returns all the 

parameter codes found for the selected site and period in the list box. 
5 Select (highlight) one or more parameter codes in the list box. 
6 Click the data table picture button.  The Data Validation 

Data window is opened and displays the selected set of 
data in a tabular data window. 
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Figure 6-2.  The Data Validation Data Window. 
 

 To apply validation codes: 
1 Follow steps 1 – 6 of  “To open the Data Validation Data window” above. 
2 Select (highlight) the data points to apply the validation code to.  Note: This is a multi-

select data window and rows can be selected with shift-click and ctrl-click in the standard 
Windows way. 

3 Select a code from the Validation Code drop-down list box. 
4 Click the Apply Code button. 

 
 To sort and filter data: 

1 Follow steps 1 – 6 of “To open the Data Validation Data window” above. 
2 Right-click anywhere in the data window. 
3 Select Filter or Sort from the pop-up menu. A dialog box is displayed. Follow the dialog 

box instructions to apply filter or sorting options.  Click the Help button to access specific 
help on the dialog boxes. 
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6.2.1 Entering Control Values 
 
 Control values can be entered in the Data Validation Data window. Control values are 
arithmetic expressions that are applied to or replace raw values and result in adjusted validated 
values. The first character in the control value field must be an arithmetic operator.  For 
example, if you determine that the raw data values for wind speed are 10 m/s less than they truly 
were, enter “+10” in each control value field.  This action will add 10 to the raw data values and 
place the result in the validated data fields. 
 
Important:  When the control value field is used, the final data validation code must equal 
“VA” which means valid, but value adjusted.  
 
Acceptable operators for control values: 
 Operator Result 

+   adds the control value to the raw value 
-  subtracts the control value from the raw value 
*  multiplies the raw value by the control value 
/  divides the raw value by the control value 
=  substitutes the control value for the raw value 

 
  To enter control values: 

1 Follow steps 1 – 6 of  “To open the Data Validation Data window” above. 
2 Select (highlight) the data points to apply the VA code to.  Note: This is a multi-select 

data window and rows can be selected with shift-click and ctrl-click in the standard 
Windows way. 

3 Select the VA code from the Validation Code drop-down list box. 
4 Enter the value to apply in the Control Value box. 
5 Click the Apply Code button. 

 
6.2.2 Replacing Raw Values 
 
 On rare occasions, it may be necessary to replace raw data values in the permanent table 
of the database. You may determine that data from a non-digital source, such as data reduced 
from strip chart, is of higher quality than the digital data collected by the datalogger.   
 

 To hand enter a raw value: 
1 Follow steps 1 – 6 of  “To open the Data Validation Data window” above. 
2 Click on the Source Code field of the row needing a hand-entered raw value. 
3 Enter a source code that will allow a hand-entered value (C, P or U). 
4 Click on the Raw Val field and enter the new value.  Note: Only raw values of -999 should 

be replaced in this manner. Use the value adjust method for other raw values. 
 
6.2.3 Screening Data in the Data Validation Window 
 
 Usually data are screened for anomalies during the data loading process. When 
necessary, however, screening can also be done in the Data Validation Data window. 
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 To screen data: 
1 Follow steps 1 – 6 of  “To open the Data Validation Data window” above. 
2 Click the Screen button.  The anomaly screening program will apply the screening flags. 

 
7.0 The Data Validation Log 
 
 The Data Validation Log is used to track the completion of each major step of the 
validation process.  The master record logs the initials of the IMC staff member completing each 
validation step and when the step occurred.  The Comments Table logs comments regarding data 
validation. Most of the output programs (see Section 9.0, Creating Output Products) query the 
Data Validation Log so the correct level of validation can be applied to the output.  The Data 
Validation Log is shown in Figure 7-1. 
 

 
 

Figure 7-1.  The Data Validation Log. 
 

 To use the Data Validation Log: 
1 Select Logs -> Data Validation Log from the AQ and Met Processing frame.  
2 Select a site from Site drop-down box. If no records for the selected site exist, a "Site not 

Found" message is displayed. Click OK. Otherwise, the most recent Master Table record 
and related comments for the selected site are displayed. 

3 Select a different month and/or year from the drop-down list boxes to display previous 
months records for the site. 

4 Records can be added as described in Section 3.4, Data Windows.  Note: Normally, 
records should not be deleted. 
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8.0 The Site Status Log 
 
 The Site Status Log (shown in Figure 8-1) is a diary of site-related events such as 
instrument malfunctions and repAQS, data adjustments, calibrations, special site visits, weather 
episodes, etc. that may be relevant to data validation.  A basic description of each event is 
entered as a record in the Master Table. The master record contains the site number and name, a 
reference number assigned by the program, date started and stopped fields to define the period of 
time involved, and an affected parameters field to indicate which data parameters are possibly 
affected by the event. Another field indicates if the event is considered to be a problem or not.  
This field is used to quickly create a list of current problems found in the log. The Detail Table 
holds as many records as needed to record notes about each event.  Normally, a master record 
will have at least one detail record.  Entries can be added, modified, or deleted in both the Master 
Table and Detail Table. 
 
 Before entering information into the Site Status Log, determine if it is a note relating to a 
previously entered event or if it relates to a new event. If this is a new event, first insert a new 
Master Table record for the site and then enter the detail notes. If it relates to a previously 
entered event, locate the master record in the log and then enter the new detail notes.  
 

 
 

Figure 8-1.  The Site Status Log. 
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 To use the Site Status Log: 

1 Select Logs -> Site Status Log -> Data Entry from the AQ and Met Processing frame.  
2 Select a site from Site drop-down box. If no records for the selected site exist, a "Site not 

Found" message is displayed. Click OK. Otherwise, the most recent Master Table record 
and related comments for the selected site are displayed. 

3 Use the VCR buttons to move from record to record for the site. 
4 Records can be added as described in Section 3.4, Data Windows.  Note: Normally, 

records should not be deleted. 
 

Tip:  To enter affected parameters, click in the Affected Parameters field then click the 
right mouse button.  A drop-down list box is displayed. Click the down arrow on the box 
and then select a parameter from the list.  The parameter will be added to the affected 
parameters field.  Repeat until all affected parameters have been selected. You may also 
type directly in this field.  
 
Tip:  Use the Problem? Yes indicator for an event that can be described as problematic and 
requires further action. 
 
Tip:  Fill in the Date Closed field when all issues related to the event have been resolved.  
 
Tip:  Each detail record note field holds up to 2,000 characters.  If you need more space, 
insert another row in the Detail Table. 
 

9.0 Output Products 
 
 The AQDBMS includes programs that provide a variety of hardcopy products including 
data summaries and graphical representations of the data (plots) as well as summary lists from 
the Site Status and Data Validation Logs.  Table 9-1 lists the printed output products provided,  
how to generate them, additional information about generating each product, and output options 
that are available for each.  Output options include sending the output to: a printer, the screen, a 
PDF file (Adobe Portable Document Format), and writing to an ASCII file.  
 
Important Note:  When measurement units of a parameter vary over time, output programs 
convert values as necessary to match the unit in force at the end of the selected period or to a 
standard unit, depending on the design specifications for the particular product. 
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Table 9-1 
 

Output Products and Options 
 

Product How To Generate Additional 
Info 

Output 
Options 

3-year Summary Plot.  A stacked bar chart comparing 
monthly values over a 3-year period of a user-selected 
pollutant parameter.  Three graphs contain the second highest 
value, the highest 3-hour average and highest 24-hour average 
concentrations by month over a 3-year period with the values 
grouped by month. 
 

Three-Year 
Summary desktop 
icon 

Plots pollutant 
parameters 
only in ppb, 
ppm, or ug/m3. 

Printer 
Screen 
PDF 
 

Bar Plot. A bar/line graph showing the yearly variation of a 
pollutant grouped by month.  The highest value, second 
highest value, highest 24-hour average during a month, and the 
monthly average are plotted for a 13-month period. 

Bar Plot desktop 
icon 

Plots pollutant 
parameters 
only in ppb, 
ppm, or ug/m3. 
 

Printer 
Screen 
PDF 
 

Current Problems in the Site Status Log.  Lists the current 
open problems in site/date order from the Site Status Log. 

Select Logs-> Site 
Status Log -> List 
Current Problems 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 

Data Collection Statistics – All parameters for the period.  
Number possible and valid for each site selected and the 
parameters monitored at the site during the selected period.  

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 

Data Collection Statistics – Group of Sites.  Number 
possible and valid for each site selected and the selected 
parameters monitored at the sites during the selected period on 
one report. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

Select 
parameters 
from the 
parameters list. 

Printer 
Screen 
PDF 

Data Collection Statistics – Selected Parameters.  Number 
possible and valid for each site selected and the selected 
parameters monitored at the site during the selected period.  

Select Reports 
from the “AQ and 
Met Processing” 
frame 
 

Select 
parameters 
from the 
parameters list. 

Printer 
Screen 
PDF 

Diurnal Plot. A line graph showing the average daily variation 
of a given parameter.  Three lines are plotted representing the 
maximum, minimum, average and standard deviation of the 
parameter for each hour of the day for user selected site and 
period of time. 
 

Diurnal Plot 
desktop icon. 

 Printer 
Screen 
PDF 
 

Export  Data to ASCII comma delimited (CSV) row format Select Reports 
from the AQ and 
Met Processing 
frame 
 

 File 

Export audit data to AQS format Select Reports 
from the AQ and 
Met Processing 
frame 
 

 File 

-- continued -- 
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Table 9-1  (Continued) 
 

Output Products and Options 
 

Product How To Generate Additional 
Info 

Output 
Options 

Export Data to ASCII fixed length columnar format Select Reports 
from the AQ and 
Met Processing 
frame 
 

  
File 

Export Data to ESC specified format.  Creates text files for 
each selected site/period in a special form for providing to an 
outside contractor. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

Select all 
parameters or 
deselect for 
flow only 

File 

Export hourly data to AQS format Select Reports 
from the AQ and 
Met Processing 
frame 
 

 File 

Export precision data to AQS format Select Reports 
from the AQ and 
Met Processing 
frame 
 

 File 

Highest 8-hour running averages (hour beginning) -  
designed for ozone but will work for any parameter.  Lists the 
top selected number of 8-hour running averages. 

Select Reports 
from the AQ and 
Met Processing 
frame 

Select 
parameters 
from the 
parameter list.  
Select number 
of values to 
list. 
 

Printer 
Screen 
PDF 
 

Highest Daily Maximum 8-hour running averages (hour 
beginning) -  designed for ozone but will work for any 
parameter.  Lists the top selected number of 8-hour running 
averages daily maximums. 

Select Reports 
from the AQ and 
Met Processing 
frame 

Select 
parameters 
from the 
parameter list.  
Select number 
of values to 
list. 
 

Printer 
Screen 
PDF 
 

Highest Values – The highest values found for the selected 
site/period/parameter. 

Select Reports 
from the AQ and 
Met Processing 
frame 

Select 
parameters 
from the 
parameter list.  
Select number 
of values to 
list. 
 

Printer 
Screen 
PDF 
 

Meteorological Data Summary.  Pertinent met data statistics 
for the selected site/period. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 

-- continued -- 
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Table 9-1  (Continued) 
 

Output Products and Options 
 

Product How To Generate Additional 
Info 

Output 
Options 

Monthly Grids for selected parameters.  All values or 
invalid codes and statistics for one site/month/parameter.   

Select Reports 
from the AQ and 
Met Processing 
frame 
 

Select 
parameters 
from the 
parameters list. 

Printer 
File 
PDF 

O3 – Episodes with Concentrations >100 ppb.  Lists the 
date/time and validated values for the selected site/period 
where the ozone concentrations is > 100 ppb. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 

O3 - Highest Concentrations.  Ten highest one-hour averages 
for the selected site/period. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 

O3 – RAW Episodes with Concentrations >100 ppb.  Lists 
the date/time and raw values for all sites for the selected period 
where the ozone concentrations is > 100 ppb. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 

Ozone Quick Look (annual only).  Creates an annual Quick 
Look table (AQS format) for ozone for the selected site/year. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 
 

Ozone Rank for all sites. Creates an annual report table of 
ozone rank listings of 2nd highest 1-hour averages, 4th highest 
8-hour averages, and annual SUM60 exposure index for all 
sites. 

Select Reports 
from the AQ and 
Met Processing 
frame 

This report 
takes a long 
time to run 
(perhaps an 
hour or more). 
 

Printer 
Screen 
PDF 
 

Ozone Standards Report (annual only). Creates an annual 
ozone standards report for the selected site/year. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 
 

Ozone with 8-hour averages > 84 ppb.  Lists the date/time 
(hour beginning) and raw or validated values (as selected ) for 
the selected site/period where the 8-hour average was > 84 
ppb. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 
 

Precision Check Summary.  If precision check data exist for 
the selected site/parameter/period, a table with quarterly 
summaries is produced. Period is 1/1 through 12/31 based on 
the start year. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

Select 
parameters 
from the 
parameter list.  

Printer 
Screen 
PDF 
 

-- continued -- 
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Table 9-1  (Continued) 
 

Output Products and Options 
 

Product How To Generate Additional 
Info 

Output 
Options 

Progress Report.  A report table indicating validation 
progress for the past 13 months.  Based on the Data Validation 
Log. 

Select Reports 
from the AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 
 

Rose Plot. A specialized graph showing the wind or pollutant 
frequency relative to wind direction for a user-selected site and 
period of time. 

Rose Plot desktop 
icon. 

 Printer 
Screen 
PDF 
 

SO2 - Highest Concentrations.  Five highest one-hour 
averages, five highest 3-hour block averages, and five highest 
24-hour averages for the selected site/period. 

Select Reports 
from the “AQ and 
Met Processing 
frame 
 

 Printer 
Screen 
PDF 
 

Stackplot. A time plot of multiple graphs representing user 
selected data sets.  Many data sets may be plotted on the y-axis 
of  “stacked” graphs vs. a single x-axis of time. 

Stackplot from 
desktop icon. 

 Printer 
Screen 
PDF 
 

Stackplots – from configuration files. Creates text files of 
raw or validated values for the selected sites/period based on 
the Stackplot configuration records. See Stackplot. 

Select Reports 
from the AQ and 
Met Processing 
frame 

Select type of 
plots to 
generate and 
to reuse or 
replace data 
files 
 

File 

Yearly Frequency Distribution for O3 or SO2. Creates 
annual frequency distribution reports for the selected site/year 
for O3 and SO2 only. 

Select Reports 
from the AQ and 
Met Processing 
frame 

 Printer 
Screen 
PDF 
 

 
 
9.1 The Reports Interface 
 
 The Reports interface provides a single interface for producing various types of output 
products.  The initial display of the reports interface is shown in Figure 9-1.  This interface has 
been developed with the following two facts in mind: 
 

1. Required user input (such as sites, dates, parameters, etc.) to generate a product varies 
from product to product.  

 
2. Sometimes, the user wants to quickly view a single product on screen.  Other times, 

an entire suite of products for all the current sites are required.  
 

To meet the challenge of the first, a tab control has been used to help the user enter the 
specific input required for the selected product. The content of each tab page updates 
dynamically to reflect the specific options available for the selected product.  For the second, the 
interface allows the user to “Run” a job immediately or “Submit” jobs to a queue to later be run 
as a batch of jobs.  
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Figure 9-1.  The Reports Interface. 

 
 To use the Reports interface: 

1 Select Reports from the AQ and Met Processing frame. 
2 Select a product to generate from the list displayed on the Output Products tab. 
3 Click on each enabled tab of the tab control to input the required information and select 

options specific to the selected product. (See Section 9.1.1, The Reports Interface Tab 
Control). 

4 Click Run Now to run the job immediately or click Submit Job to add the job to the 
submitted jobs list. 

5 Click Run Jobs to begin running the jobs in the submitted jobs list.  
 
9.1.1 The Reports Interface Tab Control 
 
 The tab control on the left side of the reports interface has five tab pages. Access to each 
page is updated when the user selects a product in the Output Products list.  If the tab for a page 
is disabled, the page content does not relate to the selected product.  The tab pages are Dates, 
Sites, Parameters, Options, and Destinations.  The pages are discussed in the following 
subsections. 
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9.1.1.1  The Dates Tab 
 
 This tab page displays one or more fields for the user to input the desired time period of 
data to be included in the output product.  Usually, there are Start Date and End Date fields that 
require dates in mm/dd/yy format.  Other products may need only a year to be entered.  The 
Dates tab page is shown in Figure 9-1. 
 
9.1.1.2  The Sites Tab 
 
 The Sites tab page displays a tree view of site groups as configured (see Section 4.1, Sites 
Configuration). Groups and/or individual sites can be selected to be included in the output job. 
Figure 9-2 shows the Sites tab. 

 
 

Figure 9-2.  The Sites Tab Page in the Reports Interface. 
 
9.1.1.3  The Parameters Tab 
 
 The Parameters tab page displays a list of all parameters as shown in Figure 9-3.  The 
user can also choose the output units for each selected parameter and the output generator will 
convert the values as necessary.   
 

 To choose output units: 
1  Click in the Output Units column of the selected parameter. 
2 From the drop-down list, select an available Unit Code.  Note:  Only unit codes with 

defined conversion formulas are listed. 
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Figure 9-3.  The Parameters Tab of the Reports Interface. 

 
 
9.1.1.4  The Options Tab 
 
 The tab displays additional options for the selected product.  An example of the Options 
tab when the Stkplots – from configuration tables product is selected is shown in Figure 9-4.  
Two sections are found on the page; Standard Options and Special Options.  The standard 
section includes the following: 
 

• Radio buttons for selecting a Validation Level option.  Choose Validation Log 
(default option) for the program to query the Data Validation Log for the validation 
level information.  Choose Raw, Preliminary, or Final to force the level to the 
selected option. 

 
• A page number field to input a report page number. 
 
• A checkbox to place all of the currently selected sites on one page or continuous 

output instead of separate pages or files for each site.   
 
 The Special section includes special options for the selected report.  Examples of special 
options are: 
 

• A Raw Data checkbox.  Checking this box instructs the program to use raw data and 
not validated data in the product. 

 
• Number of Values to list.  Instructs the program to include the number of values 

entered on the product.  For example, to list the top 10 Highest Hourly Averages.    
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Figure 9-4.  The Options Tab of the Reports Interface. 

 
9.1.1.5  The Destinations Tab 
 
 The Destinations tab displays options on the type of output to produce as shown in Figure 
9-5.  Again, this tab updates dynamically depending on the product selected.  Only the possible 
options for the selected product are enabled.  More than one option can be selected.  Destination 
options are: 
 

• Output to screen.  This option causes the output generator to pause after each 
product has been created and display the product on the screen before going on to the 
next.  Click the Print button from the on-screen display to send the output product to 
the printer.  Click the Continue button to close the on-screen display. 

 
• Output to printer.  This option sends the output directly to the currently selected 

Windows printer. 
 
• Output to PDF file.  This option uses the Adobe Portable Document File (PDF) 

Writer to create PDF files of the output.  When the checkbox is clicked, an input field 
displays prompting the user to enter a destination folder for the generated PDF files.  
The complete path and folder name can be typed in or click the Browse 
button to point to a destination folder. Important Note: The PDF 
Writer must be installed on the user’s workstation for this option to work properly. 

 
• Output to text file.  This option writes the output to ASCII text files. When the 

checkbox is clicked, an input field displays prompting the user to enter a destination 
folder for the text files.  The complete path and folder name can be typed in or click 
the Browse button to point to a destination folder. 
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Figure 9-5.  The Destinations Tab of the Reports Interface. 
 
 
9.2 AQDBMS Graphics Products 
 
 Four programs are provided to create graphical representations of AQDBMS data 
directly from the database. The Stackplot program runs in a manner different from the other 
graphics programs and is described in Section 9.2.6. The AQDBMS graphics programs provide 
the following common features: 
 

• Execution directly from the AQDBMS or the Windows desktop 
 
• Single-site plot vs. submit file option to create multiple-site plots 
 
• Printer destination and setup selection 
 
• Start and end date selection 
 
• Monthly, quarterly, and annual plots (except One-Year and Three-Year Summary plots) 
 
• Plot title customization 
 
• Plotting scale adjustment 
 
• Force Final Validation footnote for historical data 
 
• Automatic printing option 
 
• Windows metafile output 
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9.2.1 Description of AQDBMS Products 
 
 A One-Year (13-month) Summary Bar Plot summarizes user-selected pollutant 
parameters in a bar chart and line-graph over a 13-month period to illustrate seasonal changes 
over that period.  Information presented on the plot includes: 
 

• Highest hourly average 
 
• Second highest 1-hour average 
 
• Highest 24-hour average 
 
• Monthly average 
 
• NAAQS 
 
A Diurnal Plot summarizes diurnal characteristics of user-selected pollutant parameter.  

For each hour of the day during the user-selected period the plot shows: 
 

• Maximum hourly average 
 
• Mean hourly average with standard deviation 
 
• Minimum hourly average 
 
• Number of samples per hour 
 
• NAAQS standard 
 

 A Rose Plot summarizes the relationship between wind speed or a user-selected pollutant 
parameter in a standard wind rose. 

 
 A Three-year Summary Plot summarizes user-selected pollutant parameters in a bar 
chart that compares the second highest 1-hour average on a monthly basis. 

  
 These graphics products query data directly from the AQDBMS.  The user interface for 
these programs have many similar features that are described in the next section.  Options unique 
to each of these products are described in subsections following this.  
 
9.2.2 Creating Plots From the AQDBMS Graphics Programs 
  
 The AQDBMS graphics programs may be run directly from a Windows desktop icon. 
 

 To create a plot: 
1 Double-click the icon for the desired graphics product on the Windows desktop. 
2 Set up the printer: 

a From the File menu, choose Select Printer.   
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b Select the desired printer destination.   
c Set the paper orientation for the current graphic product (all are portrait except 

                  the One-Year Summary plot, which is landscape). 
3 Select a site from the Select Site drop-down list box. 
4 Enter the start and end dates for the period to be plotted in the Start and End boxes. 
5 Click the Get Parameter List button. The program retrieves a parameter code list for the 

selected site/period. 
6 Select the parameter to be plotted from the Available Parameter List drop-down list box. 
7 Select applicable options.  Each type of plot has one or more options that can be changed.  

See the following sections for a description of these options. 
8 To print the plot automatically, click the AutoPrint checkbox. 

 
Note:  This checkbox stays in effect until switched off or until the program is exited so 
that each new site/date/parameter plotted is automatically printed. 

 
9 Click the Draw Plot button. The program retrieves and plots the data. 

10 If needed, modify the default graph scaling values, then click the Redraw button. 
11 Click the Print button to print the plot. 

 
9.2.3 Creating Plots for Multiple Sites From the AQDBMS Graphics Programs 
 

Plots can be created for multiple sites/parameters for the same time period. To create 
multiple plots in a single run, a submit file containing a list of the sites/parameters to be plotted 
is created in advance. The sites/parameters included in a submit file will be plotted with common 
options.  Sites with parameters that do not use common options--such as a scaling change--must 
be run in single site mode.  Create separate submit files for each of the graphics products. 

 
 To create a submit file: 

1 Open a new file in a text file editor such as Windows Notepad (do not use a word 
processor such as Word for Windows). 

2 On the first line of this file: 
a Type a four-character site abbreviation followed by a comma <,>. 
b Type a parameter abbreviation followed by a hyphen <-> and a comma <,>. 
c Type a Y followed by a comma <,>. 
d Type three more commas, then press <Enter>. For example, type BIBE,O3-4,Y,,,, to 

plot ozone data for Big Bend National Park. 
3 Repeat Step 2 for each combination of site/parameter that you want to include in the batch 

of plots. 
4 From the File menu, select Save As. Save the file in the folder and with the filename of 

your choice.  
 

 To create plots for multiple sites: 
1 Double-click the icon for the desired graphics product on the Windows desktop. 
2 Set up the printer: 

a From the File menu, choose Select Printer.   
b Select the desired printer destination.   
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c Set the paper orientation for the current graphic product (all are portrait except the 
One-Year Summary plot, which is landscape). 

3 Enter the start and end dates for the period to be plotted in the Start and End boxes. 
4 Select applicable options.  Each type of plot has one or more options that can be changed.  

These options are described in Sections 9.2.4, Common Options in the AQDBMS Graphics 
Programs, and Section 9.5, Plot-Specific Options in the AQDBMS Graphics Programs. 

5 To not automatically print the plots, click the AutoPrint checkbox to deselect the auto 
printing feature. 

 
Note: The Run Submit File option automatically switches the AutoPrint checkbox to on.  
The AutoPrint checkbox may be switched off any time during the plotting process.  The 
program may not respond immediately, however, if data are being retrieved from the 
AQDBMS depending on the length of the period being plotted.  

 
6 From the File menu, select Run a Submit File. 
7 Select the submit file you previously created and saved from the File-open dialogue box 

and click OK. 
 
9.2.4 Common Options in the AQDBMS Graphics Programs 
 
 The AQDBMS graphics programs have several common options that allow the user to 
manage how the plots are generated and to manipulate the output.  These common options are 
described in this section.  Plot-specific options are described below: 
  

• Draw Plot versus Redraw Buttons: The Draw Plot button always starts a new plot by 
retrieving data from the database, creating the plot title, setting the plot units, 
calculating relevant statistics, and drawing the plot.  The Redraw button redraws the 
current plot incorporating changes made to the title, scaling, or other cosmetic option 
changes, and does not retrieve new data from the database.  A change in any of the 
primary data selection options such as site, period, parameter, or quarterly plot will 
not be accounted for in a Redraw. These option changes require a new plot to be 
drawn. 

 
• Customizing the Plot Title: The plot title is created from default information based on 

the site, parameter, and period selected.  On single-site plot runs, the operator may 
edit the automatically defined title after the  plot is displayed on the screen. After 
editing is complete, click the Redraw button. 

 
• Creating Monthly, Quarterly, Annual Plots: The AQDBMS graphics products may be 

plotted in monthly, quarterly, or annual plots except for the One-Year and Three-Year 
Summary plots that by definition are plotted on an annual basis.  The start and end 
dates define a monthly versus annual period.  An annual period may also be plotted as 
four quarterly plots on a single page by clicking on the Quarterly Plots checkbox 
before drawing the plot. Other periods may not be selected since the statistics 
inherent to these plots are time-dependent.   
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• Adjusting plotting scales: The default plotting scale is parameter-dependant and is set 
in the parameter definition table in the AQDBMS.  The vertical or y-axis scale may 
be adjusted for variations in data on a single-site plot run.  If a site/parameter is 
consistently abnormal, it may be useful to exclude it from a submit file.   

 
• Adobe PDF output: It is possible to send the plot output to an Adobe PDF file for 

transporting the image electronically. Click the Auto PDF checkbox before printing the 
plot if this is desired. 

 
9.2.5 Plot-Specific Options in the AQDBMS Graphics Programs 
 
 Each of the AQDBMS graphics programs has set-up options and other information 
specific to its purpose and how the program functions: 
 

• One-Year (13-month) Summary Plot Setup Options: The One-Year (13-month) 
Summary Plot allows the operator to compare pollutant data over a 13-month period.  
It has few options and is simple to run.  The associated statistics assume that the start 
and end dates include a 13-month period (01/01/96 to 01/31/97 for example). 

 
• Diurnal Plot Setup Options: The Diurnal Plot only has one unique option.  The 

operator may choose to not plot a minimum hourly average line.  This option is useful 
when the data consistently has a minimum value of zero. 

 
• Rose Plot Setup Options: The Rose Plot program has several unique options: 

− 40% Circle – click this checkbox if a rose petal exceeds 40%.  This will scale the 
outermost circle to 40% instead of the default 20%. 

− Make a .ROS File – click this checkbox if an ASCII rose frequency distribution 
data file is desired.  This table contains 16 rows of wind direction versus columns 
of wind speed or hourly pollutant concentrations.  The file is written to the 
\\ars_net3\npsair\dpc\ros folder and named ssssAyy.Rpp where ssss is the site 
abbreviation, A indicates annual data, yy the year, and pp the parameter.  For 
example, BIBEA98.RO3 contains the frequency distribution data for Big Bend 
National Park ozone/wind direction for all of 1995.  For quarterly data, the A is 
replaced with Q1, Q2, etc.  For example, BIBEQ198.RSW contains the frequency 
distribution data for wind speed/wind direction at Big Bend National Park for 
January through March 1998. 

 
• Three-year Summary Plot Setup Options: The Three-year Summary Plot has no 

unique options. 
 
9.2.6 The Stackplot Graphics Program 
 
 A stackplot may include single or multiple user-selected parameters on line or bar graphs 
plotted against time on the x-axis.  Up to 16 parameters may be plotted on up to 8 separate 
graphs (1 or 2 parameters per graph) in a stack. Temporal data variations are then easy to 
compare. Stackplot provides a variety of options. Setting up a stackplot is complex due to the 
large number of possible data combinations and options.  Therefore, a set of standard setup files 
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(.STK file) have been created for plots that are created on a regular basis with only a change in 
the time period to be plotted.  These files are maintained in a standard location for access from 
the AQDBMS. 
 

 To run Stackplot: 
1 Select Stackplots – from configuration tables from Output Products tab in the AQDBMS 

Reports Interface (see Section 9.1, The Reports Interface). 
-or 

1 Launch the Stackplot program from the desktop icon. 
2 From the File menu in the Stackplot program window, select Open. 
3 Select the Stackplot configuration file (.stk) or submit file (.sbm) to open.   

 
Note:  For instructions on creating Stackplot configuration (.stk) files, see the document 
titled STKWIN User Documentation (ARS, 2008) and Section 4.2.2, Stackplot 
Configuration of this document. For instructions on creating submit (.sbm) files, see 
Section 9.2.3 Creating Plots for Multiple Sites From the AQDBMS Graphics Programs. 

 
9.3 Printer Settings for HP Laserjet Printers 
 
 The output products have been printed extensively on Hewlett-Packard (HP) Laserjet  
printers. ARS has determined optimum settings each the two types of output products and default 
values defined for those settings. 
 
10.0 References 
 
Air Resource Specialists, Inc. (ARS), 2008, STKWIN User Documentation. 
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A Program to Generate Stacked Plots 
Of Time-Dependant Data Sets 

 
USER DOCUMENTATION 

 
 

Code Revision 1.20070801 
 

Documentation Revision date: January 23, 2008 
 

Air Resource Specialists, Inc. 
 

 
 
                                                                                                                             
INTRODUCTION 
 

STKWIN creates single or stacked graphs with up to 20 data sets in up to 10 graphs per page plotted against 
time as the independent variable.  Although it is possible to plot more than 10 individual graphs on a plot page, 
labeling the y-axes becomes difficult due to crowding.  The X-axis or independent variable is time and only time (or 
something faked into looking like time).  If you need to plot scatter plots of 2 independent variables try another 
software package.  STKWIN was written for the purpose of stacking time-dependant data sets.  The input date and 
plot date may be specified as either calendar (yymmdd or yyyymmdd) or Julian (jjj) independently.  Input data may 
be fixed format (standard FORTRAN i/o format statement) or free-format. 

 
The input data may be real or integer but the input format must specify real (F) format.  Except for the date 

and time fields which must be first on the record and integer, input data may be in any order and plotted in any 
order.  Two data fields may be plotted together on the same graph.  Multiple plots per STKWIN run may be made. 
 
 Details of all these things follow...read on. 
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 PROGRAM STKWIN 
 A STKWIN plot consists of a single x axis (time) with any number of days (limited by  resolution of plot) 
per page.  A single plot may be divided vertically into any number of individual graphs, (<10 graphs per plot due to 
axis label and data resolution restrictions) and up to two data fields may be plotted per graph.  Note the terminology; 
a plot fills a page and consists of 1 or more graphs; each graph may contain 1 or 2 data sets.  Figure 1 is an 
example plot with 6 graphs and 2 
variables per graph. 
 The data may be 
represented with: 
⋅    Bars  
⋅    Continuous Lines 
⋅    Dots + Lines 
⋅    Dots Only 
⋅    One data set per graph 
⋅    Two data sets per graph 
 Parameters that define this 
option and others are written in a 
plot control file (.STK file).  The 
data to be plotted is contained in a 
separate file (.DAT file). 
 
PLOT CONTROL FILE 
 The plot control file 
defines all user defined options 
for the plot (refer to Figure 2 for 
an example).  This file is a 
FORTRAN NAMELIST formatted file.  The syntax of the control file is critical.  The file name extension should be 
.STK for consistency. 
 There are three namelist groups of parameters required in the control file.  Each set must be preceded by the 
appropriate NAMELIST group name as described below: 
 
 NAMELIST GROUP DESCRIPTION 
 STKFILES  general parameters that define the input data file 
 PAGE_DEF  general parameters that define the overall plot appearance 
 VAR_DEF  specific parameters that define each dependant variable graph 
 
Parameters are defined in the next section. 
 
 

 

Figure 1. Example STKWIN output. 
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Figure 2. Example Plot Control File (.STK file). 

&STKFILES 
   INPUT_FILE      = 'GCAP_UNF.98A' 
   DATA_FORMAT     = 'FREE_NO_HEADER' 
   NUM_IN_FIELDS   =  6  
   NUM_TO_GRAPH    =  6  
   DATA_DATE       = 'CALENDAR' 
   GMT_DIF         =  0  
   MISSING         = -99  
   TIME_UNITS      = 'HOUR' 
   PERIOD          =  1  
   File_Tag        = T 
 / 
 &PAGE_DEF 
   Page_Orientation= 'LANDSCAPE' 
   Date_Format     = 'DD' 
   Footnote        = '' 
   Main_Title      = 'GRAND CANYON AIRPORT, ARIZONA - Unfiltered Nephelometer and Meteorological Data' 
   Plot_Date       = 'CALENDAR' 
   Time_Zone       = 'LST' 
   X_Title         = 'OCTOBER 1998',  'NOVEMBER 1998',  'DECEMBER 1998'  
 
   N_GRAPHS        =  6  
   N_PLOTS         =  3  
   MONTH           =  10,  11,  12 
   FIRST_DAY       =  1,  1,  1 
   N_DAYS          =  31,  30,  31 
   YEAR            =  1998,  1998,  1998 
 
   Bar_Width       =  4.166667E-02  
   B_MARGIN        =  1.25  
   CHAR_CHH        =  6  
   FIRST_FIELD     =  1  
   HOUR_INTERVAL   =  12  
   LAST_FIELD      =  6  
   LINE_WIDTH      =  1  
   L_MARGIN        =  1.3125  
   MAIN_CHH        =  0.12  
   SYM_SIZE        =  3  
   T_MARGIN        =  0  
   WKID            =  1  
   X_LABEL_INTERVAL=  1  
   X_PLOT_SIZE     =  8.4  
   X_TITLE_MARGIN  =  0  
 
   Clip            = F 
   Colorop         = T 
   DASH_OP         = F 
   Frame           = F 
   HOUR_LABELS     = F 
   PLOT_DOW        = F 
   Title_top       = T 
   XGRID           = T 
   YGRID           = T 
 / 
 &VAR_DEF 
    INPUT_FIELD    =  5                 ,  4            ,  3            ,  1            ,  2            ,  6             
    FIELD_NAME     = 'WD StDev (deg)'   , 'WD (deg)'    , 'WS (m/s)'    , 'AT (C)'      , 'RH (%RH)'    , 'Bsp (Mm-1)'   
    COMMENT        = ''                 , ''            , ''            , ''            , ''            , ''             
    YMIN           =  0                 ,  0            ,  0            , -10           ,  0            ,  0             
    YMAX           =  100               ,  360          ,  20           ,  50           ,  100          ,  160           
    MAJOR_TIC      =  25                ,  90           ,  5            ,  20           ,  25           ,  40            
    LINE_TYPE      =  1                 ,  3            ,  1            ,  1            ,  1            ,  1             
    LABEL_DEC      =  0                 ,  0            ,  0            ,  0            ,  0            ,  0             
    LINE_COLOR     =  5                 ,  2            ,  6            ,  4            ,  7            ,  6             
    ygap           =  .15               ,  .15          ,  .15          ,  .15          ,  .15          ,  .15           
    Y_AXIS_SIZE    =  .7                ,  .7           ,  .7           ,  .7           ,  .7           ,  1.6           
    ICLOSED        = F                  , F             , F             , F             , F             , T              
    ILOG           = F                  , F             , F             , F             , F             , F              
    IKEY           = T                  , T             , T             , T             , T             , T              
    SYMBOL         = 'o'                , 'o'           , 'o'           , 'o'           , 'o'           , 'o'            
    IPOST          = F                  , F             , F             , F             , F             , F              
    POST_ALIGN     = 'L'                , 'L'           , 'L'           , 'L'           , 'L'           , 'L'            
    POST_CHH       =  5                 ,  5            ,  5            ,  5            ,  5            ,  5             
    POST_FORM      = '0.0'              , '0.0'         , '0.0'         , '0.0'         , '0.0'         , '0.0'       
 / 
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SETUP OPTIONS 
 
File/Open:  Open one of the following types of files 

• stackplot configuration (stkfile) – stackplot configuration 
• data file – data file containing data to be plotted 
• submit file – file with list of stkfiles to be plotted 
Note that any of the files shown in the Open Files dialogue box may be opened in an editor, modified, and 
saved to the same location prior to clicking the Open button if you need to make adjustments to the file. 
 

File/Select Output Device:  use this to change your output device.  When Stkwin is closed, it will ask if you wish 
to reset the printer default to a different device.  This process is the same as clicking on Printers and 
changing/resetting the default printer. 
 
File/Edit Printer Graphics Settings:  use this to modify standard printer settings for width and dash-dots for 
different printers. 
 
File/ Recent File List:  Recent stkfiles opened at your workstation may be recalled here.  You may also clear this 
list by choosing File/ Clear Recent File List. 
 
Plotting options:   

• Draw/Restart, Redraw & Print– after initially opening a stkfile or submit file, click the Draw button to 
begin processing and displaying the plot.  The Draw button text will change to Restart. 

o Click Restart if the input data changes or start/stop dates change.  Forces a re-read of the data 
file. 

o Click Redraw if you change the plot configuration only.  This simply redraws the plot but does 
not re-read the data file.  For large, high-resolution plots, this would be much faster than Restart. 

o Click Print to send the plot to the current output device.  If Auto Print is chosen, you do not need 
to click the Print button (see description of the Auto Print button below) 

• Next – click to move to the next plot.  This may be the next time period within a stkfile or the next stkfile.  If 
a submit file has been opened, all files to be processed are listed in the Stack file text box.  If you wish to 
skip to a stkfile farther down the list, double-click the name in the Stack file text box and click Restart. 

• Draw to Screen – draws each plot to screen.  This can be turned off for large batch printing jobs to save 
time 

• Continuous – after opening a stkfile or submit file, and the Draw button is clicked, all plots waiting in the 
queue will be drawn continuously.  This is helpful for batch print jobs from a submit file. 

• Auto Print – after Draw button is clicked, each plot will automatically be sent to the current output device 
• Auto PDF – selects the Adobe PDF printer driver as the output device (if installed).  Plots generated will 

automatically be named.  The output path is selected after clicking this box. 
•  No Dashed Lines – draw dashed lines as solid. 
• Heavier Data Line – draws the data line heavier.  This may be used to enhance data lines for presentation or 

for printers that do not print a very heavy line.  Use this in combination with the Edit Printer Graphics 
Settings described above. 

• Page # Leader – enter a report section here such as “3-“.  Each plot will have a different page number 
starting with the number specified in First Page 

• Monitor Processing – update the status text box with processing information 
• Portrait/Landscape – change the basic orientation of the page.  You will need to adjust the X- and Y- axis 

lengths in the stkfile to accommodate this change. 
• Full Screen – draws the plot full screen.  Click the Close button when done to return to the control interface. 
• Plot Options –  

o Stkfile Parameter edit screen – edit the parameters that describe the content of the data file 
o Page_Def Parameters edit screen – edit the parameters that describe the plot page 
o Var_Def parameters edit screen – edit the parameters that describe each graph 

The contents of a stkfile are described in detail in the next sections.  Changes made in the Plot Options 
sections may be saved to the current stkfile for future use. 

• Screen Font Size -  change the screen font size of characters on the plot.  Does not affect the hardcopy.
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STACKPLOT CONFIGURATION FILE (stkfile) FORMAT 
 
 Plot definition parameters are stored in the .STK file in namelist format based on the NAMELIST convention 
(see example below).  These parameters may be changed in the STKWIN program (Plot Options) and then saved or 
this file can be directly edited using any text editor.  However, the file format must be properly maintained as 
described here. 

 
 The name of the namelist group is the first item in the namelist.  The first character in the namelist name 
must be the & (ampersand) character.  Each variable within that set is then defined with the exact spelling of the 
variable name (case independent - _ (underline) required if present) followed by the = (equals sign) and followed by 
the actual value to assign to that variable.  Each namelist group must be terminated with a / (forward slash) 
character.  All text input must be enclosed in single apostrophes.  Numerical data must follow standard syntax for 
integer/real format.  Variables are described below with the variable description.  Logical data type is specified with 
either a T or a F for true or false. 
 
 Not all variables are required in the control file.  The following tables define if a variable is required or 
optional and what the default value is if it is not included in the file.  
 

&STKFILES   <-------------------------------------namelist group name  
INPUT_FILE=      'TEST.MET' <------------------------ | 
DATA_FORMAT=     '(2I8,11F8.0)'           | 
NUM_IN_FIELDS=   11      | 
NUM_to_graph=    10      | 
DATA_DATE=       'JULIAN'     |group parameters 
T_DIF=         -700      | 
MISSING=         999.00     | 
TIME_UNITS=      'MINUTES'     | 
PERIOD=          5.0000 <------------------------ | 
/ <---------------------------------- namelist group terminator
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NAMELIST PARAMETER DESCRIPTIONS 
 
Namelist Group - &STKFILES 
 
 Namelist group &STKFILES describes the input data file.  All data to be plotted must be in this file. 
 
 
 

TABLE 1.  STKFILES NAMELIST GROUP VARIABLE DEFINITIONS 
 

NAME DESCRIPTION ACCEPTABLE VALUE DATA TYPE 

INPUT_FILE Data file name DOS file name Alpha (‘  ‘) 

DATA_FORMAT Data format FORTRAN,  ‘FREE’, FIXED or 
‘FREE_NO_HEADER’DF 

Alpha( ‘  ‘) 

NUM_IN_FIELDS # of input fields <20 integer 

NUM_TO_GRAPH # of fields to plot <20NG integer 

DATA_DATE Data date type JULIAN, CALENDAR Alpha (‘  ‘) 

DATA_DATE_FORMAT Data date format As  yyyy, mm, dd  Alpha (‘  ‘) 

GMT_DIF Time correctionTC Plus/minus hundred hours integer 

MISSING Missing data value Plus/minus valuemv real/integer 

TIME_UNITS Time units HOURS, MINUTES Alpha (‘  ‘) 

PERIOD # of time unitsP Number real 

DF – See data input file  below section for details 
TC – Time correction for GMT, DST, etc. (in hundred hours) 
P  - # of Time units between data readings 
NG – Num_to_graph is limited to 2*N_graphs (see next page) 
MV – Missing values – any input value <= to this value will not be plotted 
All parameters are required 
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NAMELIST GROUP - &PAGE_DEF -  Namelist group &PAGE_DEF describes the appearance of the plot.  

TABLE 4.  PAGE_DEF NAMELIST GROUP VARIABLE DEFINITIONS 

TYPE NAME DESCRIPTION ACCEPTABLE 
VALUE 

DATA 
TYPE 

REQUIRED DEFAULT 

PLOT LAYOUT N_plots # of plots (pages) <52  Integer Yes  

 N_GRAPHS***    Ignored (see footnote)     

 First_field First field to plot 1-num_to_graph Integer No 1 

 Last_field Last field to plot 1-num_to_graph Integer No Num_to_graph 

 X_PLOT_SIZE Size of x-axis in inches Decimal inch Real Yes  

MARGINS B_MARGIN Bottom of page <-> bottom 
edge of 1st graph 

Decimal inch Real Yes  

 L_MARGIN Bottom of page <-> left edge 
of  graphs 

Decimal inch Real Yes  

 T_MARGIN Bottom of main title <-> top 
of top graph 

Decimal inch Real Yes  

 X_TITLE_ MARGIN Bottom of x-title <-> bottom 
of 1st graph 

Decimal inch Real yes  

DATE RANGE YEARdate Data year Yyyy Integer Yes  

 MONTH(1-nNP) # of month to plot 1-12M Integer Yes  

 First_day(1-nNP) First day to plot FD Integer Yes  

 N_days(1-nNP) # of days to plot FD Integer Yes  

TITLING (main) MAIN_TITLE Main Page title ‘Text ‘ MT Str (‘  ‘) Yes  

 MAIN_CHH Character size of main title Decimal inches or 
PTs 

Real Yes  

 TITLE_TOP  Main title on top T(rue) F(alse) logical No Bottom of page 

TITLING (x-axis) X_TITLE X-axis title ‘Text’ Str No Month, Year 

 PLOT_DATE Type of date in x-axis    Julian, calendar, or 
both 

Str (‘  ‘) Yes  

 TIME_ZONE  Data time zone 3 characters (MST, 
LST) 

Str (‘  ‘) Yes  

 DATE_ FORMAT Date label format Any comb. Of 
MMDDYY 

Str (‘  ‘) Yes  

 X_LABEL_ 
INTERVAL 

# of days between date 
labels on x-axis.  Negative to 
turn label vertical 

1-n where n is the 
number of days in 
the plot 

integer Yes  

 HOUR_LABELS Hour label option T(rue), F(alse) logical No  

 HOUR_INTERVAL # of hours between hour 
labels on x-axis 

1-24 integer Yes  

 PLOT_DOW Draw the day-of-week T(rue), F(alse) logical no False 

OTHER OPTIONS PAGE_ 
ORIENTATION 

Page orientation ‘Landscape’, or 
‘Portrait’ 

Str no Current default 
printer value 

 FRAME  Frame option T(rue) F(alse) logical No True 

 DASH_OP Dashed line optionDL T(rue) F(alse) logical No True 

***n_graphs parameter is now ignored - first_field, last_field and line_type defines n_graphs 
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TABLE 4.  PAGE_DEF NAMELIST GROUP VARIABLE DEFINITIONS (continued) 

TYPE NAME DESCRIPTION ACCEPTABLE 
VALUE 

DATA 
TYPE 

REQUIRED DEFAULT 

OPTIONS (continued) COLOROP Color option T(rue) F(alse) logical No True 

 CLIP  Clip  option T(rue) F(alse) logical No False 

 FOOTNOTE Add footnote in lower left 
corner 

‘Text’ Str No -- 

 CHAR_CHH Plot body character size Decimal inch or PTs real No ? 

 SYM_SIZE Scatter plot symbol character 
size 

Decimal inch or PTs real No ? 

 LINE_WIDTH Line “weight” of all of plot 1-3 integer No 1 

 YGRID Add y-grid lines T(rue) F(alse) Logical No F 

 BAR_WIDTH Width of barchart bar Decimal number 
(inches) 

Real No Proportional 

 XGRID Add x-grid lines T(rue) F(alse) Logical No F 

NP – Month, First_day, and N_days are repeated 1-N_plots (pages) 
DATE – Can override at execution time by STARTDATE and STOPDATE 
NG - Limited by physical space available on a page - <6 is optimum 
M  - ignored if Julian data 
FD - Julian or calendar day (of month if calendar) depending on input date type 
DL - Make the 2nd line of a 2 variable graph dashed. 
WKID - 1(display);  2(printer);  3(plotter);  4(metafile).  This can be overridden from the STKWIN command line. 
MT – Use the ~ (tilde) character to wrap text to a new line 
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NAMELIST GROUP - &VAR_DEF 
 
 This namelist group defines each data field to be plotted.  Each of the variables defined in &VAR_DEF is 
repeated once for each data field to be plotted (do not repeat the NAMELIST group name).  The first set is the 
lowest plot on the page with legend on the left.  If two data fields are to be plotted on a graph, the second legend is 
on the right side of the graph.  Each data set may be selected independently from the input data file by specifying 
the input field (input_field) # for each data set (1 being the first plotted data field - not including the date and/or 
time fields).  For example - input field 7 could be plotted in the 3rd graph from the bottom by specifying it 3rd 
(Input_field(3)=7...etc.). 
 

TABLE 5.  VAR_DEF NAMELIST GROUP VARIABLE DEFINITION 
 

NAME DESCRIPTION ACCEPTABLE VALUE DATA TYPE REQUIRED DEFAULT 

INPUT_FIELD(n)NG Input field # 1-Num_to_graph integer Yes  

FIELD_NAME(n) Y-axis title <20 characters Str (' ') Yes  

Comment(n)leg Graph legend <80 characters Str (' ') No  

YMIN(n) Y-axis minimum  --- real Yes  

YMAX(n)) Y-axis maximum  --- real Yes  

MAJOR_TIC(n)) NT Y-axis major tics --- real Yes  

LINE_TYPE(n)LT Graph line type -3 to +3 integer Yes  

LABEL_DEC(n) Y label # decimal 0-___ integer No 2 

Line_Color(n) Line/dot color Color index c  Integer No 0 (black) 

Y_GAP Space between graphs Decimal inch Real yes  

Y_AXIS_SIZE y-axis size Decimal inch real Yes  

ICLOSED y-axis continuous T(rue), F(alse) logical yes  

ILOG y-axis lognormal T(rue), F(alse) logical yes  

IKEY Draw data set line key T(rue), F(alse) logical yes  

SYMBOL Character for symbol graph Alpha/numeric Str (‘ ‘) no ‘solid dot’ 

IPOST Draw data values T(rue), F(alse) logical yes  

POST_ALIGN Alignment of posted value Left, right, top, bottom Str Yes  

POST_CHH Character height of value Decimal inch or PTs real Yes  

POST_FORM Format of posted # ‘0.0’ (VB style format) Str (‘ ‘) Yes 0.0 

NG - each of these variables must be repeated 1-Num_to_graph times   
leg - string of text placed in the upper left corner of the graph 
LT - Line_type defined as: 
0 a bar chart (can only be single graph or 2nd set in graph) 
1 continuous lines (no dots) 
2 single dots + lines 
3 single dots only 
+ one data set per graph 
- two data sets per graph (this one and the following)  the first set has its legend and axis labels on the left, the second on the right. 

 the second Line_type of a double graph must be >0 
c – Paint by the numbers – 0=black, 1=white, w=red, 3=green, 4=blue, 5=yellow, 6=cyan, 7=magenta, 8=gray 

NT -Major_tic -  Enter a 0 (zero) for no axis labels or tics.  
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INPUT DATA FORMAT 
 
 The input data consists of:  

- 1 record per date/time 
- each record contains fields of date, time, and time-dependant data to be plotted.  

  
The data may be comma-separated free format  or fixed-format columns.   
 
Here are a few things to keep in mind when setting up the data and input format. 
 

1) Site name/numbers.  Stkplot does not use site name/numbers.   If your file has a site name/number at the 
beginning of each record you must use the FORTRAN fixed format so you can exclude the site 
name/number.  For Example: 

 the data file contains – 
 
 BIBE 341    2120    7.02   40.97   11.29   109.6    9.07   11.29   11.16     110    8.93    
 BIBE 341    2125   6.911   41.34   12.22     107    9.26   12.22   12.06   106.7    9.29    
 

The format would be specified as:   
DATA_FORMAT='(5X,2I8,10F8.0)'    
where the 5X tells the input reader to ignore the 1st 5 characters of each record. 
 

2) Date format type.   
CALENDAR 
The date for CALENDAR data must be some form of yyy, ymm, dd.  Examples:   
 yymmdd, yyyymmdd, mm/dd/yyyy 
JULIAN 
The date format for JULIAN data must be ddd.  No month or year 

 
3) Time.  The time on each record must be in the form hhmm (no colon). 

 
4) Data Format. 
• All time dependant data is considered floating-point during plotting but may be integer in the data file. 
• Data formats: 

- FREE - comma delimited file with or without header line(s) 
- FREE_NO_HEADER - comma delimited file without header line(s) - very useful for faster 

processing of large high resolution files 
- FIXED - space-delimited, fixed-width columns of data.  The column width and format of every line 

must be exactly alike 
- FORTRAN fixed format - similar to FIXED but with definition of decimal/integer.  This format 

must include 2 integer descriptors at the beginning for date & time (see example below) 
 

Free format data can be read with a fixed format to solve inconsistencies in the data.  The decimal 
point and comma in the data file override the format and the format handles the minimum required 
number of decimal places.  The following 2 lines illustrate a problem that can be solved by using fixed 
format: 

 the data file contains – 
 
 341    2120    7.02   40.97   11.29   109.6    9.07   11.29   11.16     110    8.93    .446  
 341    2125   6.911   41.34   12.22     107    9.26   12.22   12.06   106.7    9.29    .437  
 

The format would be specified as:  DATA_FORMAT='(2I8,10F8.0)'.   
The F8.0 ensures that the 107 above will be read properly and the decimal points within the other data 
will override this format (109.60)  

 
5) Other notes / weirdnesses: 
• If the first plotted day is less than the first data day, a bogus initial data record must be inserted with that 

first date and all plottable data set to the missing value. 
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• Date-axis title.  Plots will do whatever you tell it to in the startday and number of days parameters.  

Thus, a plot can span month and year boundaries.  The default X-axis title will specify either the julian 
first day or the month of the first day of the plot.  You can override the default date-axis title in the x 

 

An example data file is shown in figure 3. 
 
 
   Figure 3.   Example Data File. 

19981208 0000 -17.95  90.10   0.76 54.58  41.58      12
19981208 0100 -18.05  89.80   0.67  41.40  46.39      13 
19981208 0200 -16.51  91.50   0.92  47.61  24.98       6 
19981208 0300 -15.48  92.80   0.65  61.41  37.26       9 
19981208 0400 -16.32  91.70   0.67  82.60  61.41       9 
19981208 0500 -16.27  91.70   0.56  93.70  49.32      12 
19981208 0600 -16.66  91.20   0.51  86.10  43.88      24 
19981208 0700 -16.27  91.10   0.55  72.50  43.92      24 
19981208 0800 -15.34  92.00   0.67  61.67  36.97      52 
19981208 0900 -11.37  94.70   0.79  47.28  30.39      11 
19981208 1000  -4.50 100.90   1.78  39.67  18.07       7 
19981208 1100  -1.66 102.40   2.25  57.22  23.87       4 
19981208 1200  -0.91 102.90   2.52  49.64  21.10       2 
19981208 1300  -0.47 102.60   2.76  52.54  22.19       4 
19981208 1400   1.24  98.70   2.59  51.64  24.93       1 
19981208 1500   2.99  85.70   2.19  21.00  24.92       1 
19981208 1600   1.28  81.10   2.59  32.01  14.84       2 
19981208 1700   1.88  79.80   1.40  39.15  27.38      18 
19981208 1800  -2.64  83.40   1.18  33.16  19.47      20 
19981208 1900  -5.63  89.30   0.56  31.95  22.53      12 
19981208 2000  -8.24  89.60   0.91  45.63  22.63       7 
19981208 2100 -10.21  88.30   0.79  37.49  27.80       6 
19981208 2200 -11.90  88.20   0.94  32.55  13.96       7 
19981208 2300 -12.94  87.70   1.10  29.58   8.41       2 
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COMMAND LINE OPTIONS 
 
Optional command line parameters may also be used for plot output. 
 

TABLE 1.   COMMAND LINE OPTIONS 
Name Description Acceptable Argument Default 
Autoprint Auto prints plots -- Off 
Autoexit Exits STKWIN at completion -- Off 
AutoPDF Automatically prints to Adobe 

PDF file.  Windows default 
printer must be set to hardcopy 
printer device before execution. 
PDFFile option MUST  be 
included1 

-- Off 

PDFfile= Sets path and name of PDF file PDFFILE=[d]:\[path]\file.pdf none 
Continuous Runs ALL plots of multiple plot 

set (n_plots>1 or submit file) 
continuously (useful for “batch” 
hardcopy jobs) 

-- Off 

Maxplot Full screen plot  Off 
Startdate= Set first date to plot STARTDATE=mm/dd/yyyy Set in .STK file 
Stopdate= Set last date to plot STOPDATE=mm/dd/yyyy Set in .STK file 
Stkfile= Sets name of .STK file STKFILE=[d]:\[path]\file.stk -- 
Datfile= Sets name of .DAT file DATFILE=[d]:\[path]\file.DAT Set in .STK file 
ViewOnly Blocks user from option menus. 

 Close command button closes 
Stkwin. 

 Off 

PrintOnly Prints – does not display.  Error 
if no stkfile argument. 

 Off 

Submit file File of multiple .STK files [d]:\path\file.SBM -- 
1 As of 01/31/05, the AutoPDF  option will only work with Adobe PDFWRITER version 4 or 5. 

 

 

SUBMIT FILES 
A Submit file (.SBM) is a file containing a list of .STK files to be plotted together as a batch.  

Each .STK file is listed in the .SBM file one per line and must reside in the same directory (folder) as 
the .SBM file.  
 
 
COMMAND EXAMPLES (SET IN WIN95 SHHORTCUT PROPERTIES): 
 
STKWIN MONTHLY.SBM 
 Runs a submit job called monthly.sbm which contains a list of .stk files to review on screen one at a time. 
 
STKWIN REVIEW.SBM AUTOPRINT CONTINUOUS AUTOEXIT STARTDATE=12/01/98 STOPDATE=12/08/98 

Runs a submit job called review.sbm which contains a list of .stk files to plot to hardcopy (default printer) for the 
period 12/1/98 to 12/8/98 and automatically exit STKWIN. 

 
STKWIN STKFILE=GRCA.STK DATFILE=GRCA1298.DAT 

Runs GRCA.STK plot control file with GRCA1298.DAT as the data input file. 
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STKWIN EXECUTION NOTES 
 
STKWIN may be run on a Microsoft Windows 98, 2000, XP, or NT machine.    
 
If you are plotting hardcopy, the default printer is used.    
 
Adobe PDF files may optionally be generated if  a pdfwriter printer driver (or equivalent) has been 
installed on the machine.  The Print to PDF will not be visible in Stackwin if the driver has not been 
installaed. 
 
 
Microsoft WINDOWS File Association 
 
Microsoft Windows can be configured to run STKWIN by double-clicking a .STK file in Windows 
Explorer. To configure this option in Windows Explorer: 

 right-click a .STK file 
 click Open With 
 select Stkwin from the list  
 -or- if not listed 
 Choose Program  
 Other 
 F:\ARS_SOFT\STKWIN.EXE 
 Always use this program to run this type of file 
 OK 

 
Thereafter,  double-clicking a .STK file will always run load the file in STKWIN and draw the plot. 
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